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Introducing Access 2007
Microsoft Offi ce Access 2007 is a powerful relational database application that includes 

hundreds of tools that allow you to quickly start tracking, sharing, and reporting informa-

tion, even if you are new to database development. Users have access to a large library of 

professionally designed application templates, wizards that automatically create tables, 

forms, queries, and reports, and extensive local and online help resources. 

Access supports sharing data with other sources, including other programs in the 

2007 Microsoft Offi ce system, Microsoft SQL Server, Microsoft SharePoint Services, 

and documents in XML, HTML, XPS, and PDF formats. Advanced features allow you 

to create sophisticated executable database applications for use by employees and 

customers to gather and view data without their needing to know anything at all 

about database design or development.

This book gives you straightforward instructions for using Access to create databases. 

It takes you from knowing little or nothing about Access—or, for that matter, about 

databases—to a level of expertise that will enable you to create complex databases for 

use by one person or by many people.

New Features
There’s no question that Microsoft Offi ce Access has been extensively reworked and 

improved with this version. The new user interface, designed to make the features 

you need easily available when you need them, is an obvious indicator. But beyond 

the appearance and navigation, Access 2007 also has a lot of new and improved 

features that really do make this a superior program to its predecessors. Because 

there are so many changes in this version, we don’t identify new features with a 

special margin icon (as we did in previous versions of this book).  We do, however, 

list them here. Throughout this book, we include complete coverage of features that 

are new in Access 2007, including the benefi ts of the feature, how to use it, and any 

potential problems you might encounter.

Tip Included in the back of this book is a four-color poster provided for your reference. 

This convenient guide points out some of the best new features of the redesigned Offi ce 

user interface and includes tips to get you started. You will learn about these features and 

many more while working through this book.
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If you’re upgrading to Access 2007 from a previous version, you’re probably more inter-

ested in the differences between the old and new versions and how they will affect you 

than you are in the basic functionality of Access. To help you identify the entire scope 

of change from the version of Access you’re familiar with, we’ve listed here the new 

features introduced in Access 2002 and Access 2003, as well as in Access 2007.

If You Are Upgrading from Access 2003
Access 2007 has a long list of new and improved features that make it easier than ever to 

create databases to track, share, manage, and audit information. To locate information 

about a specifi c feature, see the index at the back of this book:

 O The Ribbon. The new user interface organizes the most common commands for 

any database object into tabs and groups so that the appropriate commands are 

immediately accessible for the current object.

 O Quick Access Toolbar. Customize a portion of the toolbar to include commands 

you regularly use, regardless of which tab or object is currently active in the data-

base window.

 O Navigation Pane. The customizable Navigation Pane replaces the Database win-

dow from Access 2003. You can display or hide all tables, queries, forms, reports, 

macros, and modules, or create a custom group that displays only the objects you 

want to work with at the moment. You can even hide the Navigation Pane to make 

more room on the screen for your database object.

 O View toolbar. This context-sensitive toolbar provides single-click switching among 

the supported views of the current database object. Quickly switch between 

Datasheet view, Design view, PivotTable view, PivotChart view, Form view, Layout 

view, Report view, and other views appropriate to the current object.

 O Tabbed documents. Open multiple database objects and switch between them 

quickly by clicking tabs at the top of the database window.

 O Template library. Quickly locate and download professionally designed templates 

for common database projects.

 O Improved sorting and fi ltering. Easily sort all records in a table based on one 

or more fi elds, or fi lter a table or form to display or not display records matching 

multiple criteria.

 O Layout view. Redesign a form or report while viewing it.

 O Stacked and Tabular layouts. Group controls in a form or report layout so you can 

easily manipulate the entire group as one unit.
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 O Automatic calendar. The date/time data type includes an optional calendar control. 

Click the calendar, and select the date you want.

 O Rich Text. Memo fi elds now support most common formatting options, including 

fonts, color, and character formatting. The formatting is stored with the database.

 O Create tab. Quickly create a new table, form, query, report, macro, SharePoint list, 

or other Access object.

 O Totals function. Add a totals row to a query, and select from a list of formulas to 

automatically calculate aggregate values for forms and reports.

 O Field List pane. Drag and drop fi elds from one or more related or unrelated tables 

onto your active table.

 O Attachment data type. Attach photos and other fi les to a database record.

 O Embedded macros. Macros embedded in a form or report offer a higher level of 

security in database applications.

 O Microsoft Access Help. Easily search end-user and developer help content from 

within Access.

 O Share information. Easily import and export data between Access and other 

Microsoft Offi ce applications, or XML, HTML, PDF, and dBase fi les; collect in-

formation through e-mail surveys in Microsoft Offi ce Outlook and automati-

cally update your database with the responses; create or link a database with a 

SharePoint list; publish your database to a SharePoint library and allow users to 

update and extract information.

 O Improved report design. Quickly create a professional-looking report, complete 

with logo, header, and footer; use Report view, combined with fi lters, to browse 

only selected records in the report.

 O Group, Sort, and Total pane. This feature makes it much easier to group and sort 

data in reports, and add totals from a drop-down list.

 O Enhanced security. Adding password protection to a database now causes Access 

to automatically encrypt the database when it closes, and decrypt it when it opens.

If You Are Upgrading from Access 2002
In addition to the features listed in the previous section, if you’re upgrading from Access 

2002 (part of the Microsoft Offi ce XP program suite), you’ll fi nd the following:

 O Smart Tags. Track types of data, such as dates, names, and addresses, which can be 

used in multiple ways.

 O Transform. Transform script to data when you import or export it.
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 O Support for Windows Theming. Change your display theme.

 O Property Update Options. Quickly update input mask options.

 O Automatic Error Checking. Identify and correct errors in forms and reports.

 O Back Up Database. Quickly back up your database with the click of a button.

If You Are Upgrading from Access 2000
In addition to the features listed in the previous sections, if you’re upgrading from 

Access 2000, you’ll fi nd the following:

 O Speech recognition. Give commands and dictate text.

 O Data Access Page Designer. Effi ciently design data access pages.

 O Save as data access pages. Save existing forms and reports as pages that can be 

viewed over the Web.

 O Conversion error logging. Log errors when converting Access 95, Access 97, and 

Access 2000 databases to Access 2002 fi le format.

 O Multiple undo and redo. Undo or redo several actions instead of just the last one.

 O PivotTables and PivotCharts. Analyze data by creating dynamic views of data.

 O XML input and output. Import XML data and publish Access data to the Web by 

exporting it in XML format.

 O Stored Procedure Designer. Create simple SQL Server stored procedures.

 O Batch updating. Save updates to records on a local computer, and send them to 

the server all at once.

 O Script language support. Set preferences for complex script languages, including 

the reading direction.

Let's Get Started!
There are so many new and improved features to this already feature-rich program 

that there are bound to be some exciting discoveries for even the most advanced 

users. If you are new to Access, you will fi nd many automated features that let you 

painlessly create databases and add queries, forms, and professional-looking reports 

to track and share your data. We look forward to showing you around Microsoft Offi ce 

Access 2007.



Information for Readers Running 
Windows XP

The graphics and the operating system–related instructions in this book refl ect the 

Windows Vista user interface. However, Windows Vista is not required; you can also use 

a computer running Microsoft Windows XP.

Most of the differences you will encounter when working through the exercises in this 

book on a computer running Windows XP center around appearance rather than func-

tionality. For example, the Windows Vista Start button is round rather than rectangular 

and is not labeled with the word Start; window frames and window-management but-

tons look different; and if your system supports Windows Aero, the window frames 

might be transparent. 

In this section, we provide steps for navigating to or through menus and dialog boxes 

in Windows XP that differ from those provided in the exercises in this book. For the most 

part, these differences are small enough that you will have no diffi culty in completing 

the exercises.

Managing the Practice Files
The instructions given in the “Using the Book’s CD” section are specifi c to Windows 

Vista. The only differences when installing, using, uninstalling, and removing the practice 

fi les supplied on the companion CD are the default installation location and the uninstall 

process.

On    a computer running Windows Vista, the default installation location of the practice 

fi les is Documents\MSP\SBS_Access2007. On a computer running Windows XP, the default 

installation location is My Documents\MSP\SBS_Access2007. If your computer is running 

Windows XP, whenever an exercise tells you to navigate to your Documents folder, you 

should instead go to your My Documents folder.

To uninstall the practice fi les from a computer running Windows XP:

 1. On the Windows taskbar, click the Start button, and then click Control Panel.

 2. In Control Panel, click (or in Classic view, double-click) Add or Remove Programs.
   xv
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 3. In the Add or Remove Programs window, click Microsoft Offi ce Access 2007 Step 
by Step, and then click Remove.

 4. In the Add or Remove Programs message box asking you to confi rm the deletion, 

click Yes.

Important If you need help installing or uninstalling the practice fi les, please see the 

“Getting Help” section later in this book. Microsoft Product Support Services does not 

provide support for this book or its companion CD.

Using the Start Menu
To    start Access 2007 on a computer running Windows XP:

 � Click the Start button, point to All Programs, click Microsoft Offi ce, and then click 

Microsoft Offi ce Access 2007.

Folders on the Windows Vista Start menu expand vertically. Folders on the Windows XP 

Start menu expand horizontally. You will notice this variation between the images shown 

in this book and your Start menu.
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Navigating Dialog Boxes
On   a computer running Windows XP, some of the dialog boxes you will work with in the 

exercises not only look different from the graphics shown in this book but also work dif-

ferently. These dialog boxes are primarily those that act as an interface between Access 

and the operating system, including any dialog box in which you navigate to a specifi c 

location. For example, here are the Open dialog boxes from Access 2007 running on 

Windows Vista and Windows XP and some examples of ways to navigate in them.

Windows Vista versionWindows XP version

To navigate to the Chapter01 folder in Windows Vista:

 � In the Favorite Links pane, click Documents. Then in the folder content pane, 

double-click MSP, SBS_Access2007, and double-click Chapter01.

To move back to the SBS_Access2007 folder in Windows Vista:

 � In the upper-left corner of the dialog box, click the Back button.

To navigate to the Chapter01 folder in Windows XP:

 � On the Places bar, click My Documents. Then in the folder content pane, 

double-click MSP, SBS_Access2007, and then Chapter01.

To move back to the SBS_Access2007 folder in Windows XP:

 � On the toolbar, click the Up One Level button.

BackBack

Up One LevelUp One Level



The Microsoft Business Certifi cation 
Program

Desktop computing profi ciency is becoming increasingly important in today’s business 

world. As a result, when screening, hiring, and training employees, more employers 

are relying on the objectivity and consistency of technology certifi cation to ensure the 

competence of their workforce. As an employee or job seeker, you can use technology 

certifi cation to prove that you already have the skills you need to succeed, saving cur-

rent and future employers the trouble and expense of training you.

The Microsoft Business Certifi cation program is designed to assist employees in validat-

ing their Windows Vista skills and 2007 Microsoft Offi ce program skills. There are two 

paths to certifi cation:

 O A Microsoft Certifi ed Application Specialist (MCAS) is an individual who has dem-

onstrated worldwide skill standards for Windows Vista or the 2007 Microsoft Offi ce 

suite through a certifi cation exam in Windows Vista or in one or more of the 2007 

Microsoft Offi ce programs, including Microsoft Offi ce Word 2007, Microsoft Offi ce 

Excel 2007, Microsoft Offi ce PowerPoint 2007, Microsoft Offi ce Outlook 2007, and 

Microsoft Offi ce Access 2007.

 O A Microsoft Certifi ed Application Professional (MCAP) is an individual who has 

taken his or her knowledge of the 2007 Microsoft Offi ce suite and of Microsoft 

SharePoint products and technologies to the next level and has demonstrated 

through a certifi cation exam that he or she can use the collaborative power of the 

Offi ce suite to accomplish job functions such as Budget Analysis and Forecasting, 

or Content Management and Collaboration.

After attaining certifi cation, you can include the MCAS or MCAP logo with the appro-

priate certifi cation designator on your business cards and other personal promotional 

materials. This logo attests to the fact that you are profi cient in the applications or 

cross-application skills necessary to achieve the certifi cation.
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Selecting a Certifi cation Path
When selecting the Microsoft Business Certifi cation path that you would like to pursue, 

you should assess the following:

 O The program and program version(s) with which you are familiar

 O The length of time you have used the program

 O Whether you have had formal or informal training in the use of that program

Candidates for MCAS-level certifi cation are expected to successfully complete a wide 

range of standard business tasks, such as formatting a document or spreadsheet. 

Successful candidates generally have six or more months of experience with Windows 

Vista or the specifi c Offi ce program, including either formal, instructor-led training or 

self-study using MCAS-approved books, guides, or interactive computer-based materials.

Candidates for MCAP-level certifi cation are expected to successfully complete more 

complex, business-oriented tasks utilizing advanced functionality with the combined 

2007 Microsoft Offi ce suite of products. Successful candidates generally have between 

six months and one or more years of experience with the programs, including formal, 

instructor-led training or self-study using MCAP-approved materials.

Becoming a Microsoft Certifi ed Application 
Specialist—Microsoft Offi ce Access 2007

Every MCAS and MCAP certifi cation exam is developed from a set of exam skill standards 

that are derived from studies of how Windows Vista and the 2007 Offi ce programs are 

used in the workplace. Because these skill standards dictate the scope of each exam, they 

provide you with critical information on how to prepare for certifi cation.

To become certifi ed as a Microsoft Certifi ed Application Specialist for Microsoft Offi ce 

Access 2007, you must demonstrate profi ciency in these six areas:

 O Structuring a database. You must demonstrate the ability to defi ne the appropriate 

tables, fi elds, and data types for a database; create, modify, and print table relation-

ships; set, change, and remove primary keys; and split a database.

 O Creating and formatting database elements. You must demonstrate the ability 

to create a database from scratch and from a template; create, modify, rename, 

summarize, and delete tables; create and modify fi elds and fi eld properties; 

create and modify various types of forms and reports.
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 O Entering and modifying data. You must demonstrate the ability to enter, edit, 

delete, and move among records; fi nd and replace data; attach documents to 

records; and import data or link to external data.

 O Creating and modifying queries. You must demonstrate the ability to create 

various types of queries based on one table or multiple tables; add tables to and 

remove tables from queries; add criteria, joins, calculated fi elds, and aliases; and 

create sum, average, min, max, and count queries.

 O Presenting and sharing data. You must demonstrate the ability to sort and fi lter 

data in tables, queries, reports, and forms; create and modify charts; export data 

from tables and queries; save database objects as other fi le types; and print data-

base objects.

 O Managing and maintaining databases. You must demonstrate the ability to back 

up, compact, and repair a database; encrypt a database by using a password; set 

database options and properties; identify object dependencies; print database 

information; and reset or refresh table links.

Taking a Microsoft Business Certifi cation Exam
The MCAS and MCAP certifi cation exams for Windows Vista and the 2007 Offi ce 

programs are performance-based and require you to complete business-related tasks 

by using an interactive simulation (a digital model) of the Windows Vista operating 

system of one or more of the programs in the Offi ce suite.

Test-Taking Tips
 O Follow all instructions provided in each question completely and accurately.

 O Enter requested information as it appears in the instructions, but without duplicating 

the formatting unless you are specifi cally instructed to do otherwise. For example, 

the text and values you are asked to enter might appear in the instructions in bold 

and underlined (for example, text), but you should enter the information without 

applying these formats.

 O Close all dialog boxes before proceeding to the next exam question, unless you are 

specifi cally instructed to do otherwise.

 O Don’t close task panes before proceeding to the next exam question unless, you 

are specifi cally instructed to do otherwise.

 O If you are asked to print a document, spreadsheet, chart, report, or slide, perform 

the task, but be aware that nothing will actually be printed.
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 O Don’t worry about extra keystrokes or mouse clicks. Your work is scored based 

on its result, not on the method you use to achieve that result (unless a specifi c 

method is indicated in the instructions), and not on the time you take to complete 

the question.

 O If your computer becomes unstable during the exam (for example, if the exam 

does not respond or the mouse no longer functions) or if a power outage occurs, 

contact a testing center administrator immediately. The administrator will restart 

the computer and return the exam to the point where the interruption occurred 

with your score intact.

Certifi cation
At the conclusion of the exam, you will receive a score report, which you can print with 

the assistance of the testing center administrator. If your score meets or exceeds the 

passing standard (the minimum required score), you will be mailed a printed certifi cate 

within approximately 14 days.

More Information
To learn more about the Microsoft Certifi ed Application Specialist exams and 

courseware, visit

www.microsoft.com/learning/mcp/mcas/

To learn more about the Microsoft Certifi ed Application Professional exams and 

courseware, visit

www.microsoft.com/learning/mcp/mcap/



Features and Conventions of 
This Book

This book has been designed to lead you step by step through all the tasks you are most 

likely to want to perform in Microsoft Offi ce Access 2007. If you start at the beginning and 

work your way through all the exercises, you will gain enough profi ciency to be able to 

manage complex databases through Access. However, each topic is self contained. If you 

have worked with a previous version of Access, or if you completed all the exercises and 

later need help remembering how to perform a procedure, the following features of this 

book will help you locate specifi c information:

 O Detailed table of contents.   A listing of the topics and sidebars within each 

chapter.

 O Chapter thumb tabs.   Easily locate the beginning of the chapter you want.

 O Topic-specifi c running heads.  Within a chapter, quickly locate the topic you want 

by looking at the running head of odd-numbered pages.

 O Quick Reference.  General instructions for each procedure covered in specifi c detail 

elsewhere in the book. Refresh your memory about a task while working with your 

own documents.

 O Detailed index.  Look up specifi c tasks and features and general concepts in the 

index, which has been carefully crafted with the reader in mind.

 O Companion CD.  Contains the practice fi les needed for the step-by-step exercises, as 

well as a fully searchable electronic version of this book and other useful resources.

 O Full-color poster. This handy reference guide introduces you to the basic features 

of the 2007 Microsoft Offi ce system user interface, which you will learn more about 

in this book.

In addition, we provide a glossary of terms for those times when you need to look up 

the meaning of a word or the defi nition of a concept.

You  can save time when you use this book by understanding how the Step by Step series 

shows special instructions, keys to press, buttons to click, and so on.
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Convention Meaning

This  icon at the end of a chapter introduction indicates information 

about the practice fi les provided on the companion CD for use in 

the chapter.

USE This  paragraph preceding a step-by-step exercise indicates the practice 

fi les that you will use when working through the exercise.

BE SURE TO This  paragraph preceding or following an exercise indicates any require-

ments you should attend to before beginning the exercise or actions 

you should take to restore your system after completing the exercise.

OPEN This  paragraph preceding a step-by-step exercise indicates fi les that 

you should open before beginning the exercise.

CLOSE This  paragraph following a step-by-step exercise provides instructions 

for closing open fi les or programs before moving on to another topic.

1
2

Blue  numbered steps guide you through step-by-step exercises and 

Quick Reference versions of procedures.

1
2

Black numbered steps guide you through procedures in sidebars and 

expository text.

� An arrow indicates a procedure that has only one step.

See Also These  paragraphs direct you to more information about a given topic 

in this book or elsewhere.

Troubleshooting These  paragraphs explain how to fi x a common problem that might 

prevent you from continuing with an exercise.

Tip These  paragraphs provide a helpful hint or shortcut that makes work-

ing through a task easier, or information about other available options.

Important These  paragraphs point out information that you need to know to 

complete a procedure.

Save

The  fi rst time you are told to click a button in an exercise, a picture of 

the button appears in the left margin. If the name of the button does 

not appear on the button itself, the name appears under the picture.

F In step-by-step exercises, keys you must press appear as they would on 

a keyboard.

H+> A plus sign (+) between two key names means that you must hold 

down the fi rst key while you press the second key. For example, “press 

H+>” means “hold down the H key while you press the > key.”

Program interface 
elements

In   steps, the names of program elements, such as buttons, commands, 

and dialog boxes, are shown in black bold characters.

User input Anything  you are supposed to type appears in blue bold characters.

Glossary terms Terms  that are explained in the glossary at the end of the book are 

shown in blue italic characters.



Using the Book’s CD
The companion CD included with this book contains the practice fi les you’ll use as you 

work through the book’s exercises, as well as other electronic resources that will help 

you learn how to use Microsoft Offi ce Access 2007.

What’s on the CD?
The   following table lists the practice fi les supplied on the book’s CD.

Chapter Files

Chapter 1: 

Exploring Access 2007

01_Working.accdb

03_Opening.accdb

04_Tables.accdb

05_Queries.accdb

06_Forms.accdb

07_Reports.accdb

09_Print.accdb

Chapter 2: 

Creating a Database

03_TableTemplate.accdb

04_Manipulating.accdb

Chapter 3: 

Populating a Database

01_ImportAccess.accdb

01_Products.accdb

02_Customers.xlsx

02_ImportExcel.accdb

05_Employees.txt

05_ImportText.accdb

06_ImportXML.accdb

06_OrderDetails.xml

06_OrderDetails.xsd

06_Orders.xml

07_ImportHTML.accdb

07_NewCust.html

09_ImportDbase.accdb

09_Ship.dbf
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Chapter Files

Chapter 4: 

Sharing and Reusing Information

01_ExportAccess.accdb

01_Exported.accdb

02_ExportExcel.accdb

04_ExportWord.accdb

05_ExportText.accdb

06_ExportXML.accdb

07_ExportHTML.accdb

08_CopyOffi ce.accdb

Chapter 5: 

Simplifying Data Entry by 

Using Forms

01_CreateFormTool.accdb

02_Refi neProperties.accdb

03_Refi neLayout.accdb

04_AddControls.accdb

04_CustomersFormLogo.jpg

05_VBA.accdb

05_AftUpdate.txt

06_CreateWizard.accdb

07_AddSubform.accdb

Chapter 6: 

Locating Specifi c Information

01_SortTable.accdb

02_FilterTable.accdb

03_FilterForm.accdb

04_MultipleCriteria.accdb

05_QueryDesign.accdb

06_QueryWizard.accdb

07_Calculate.accdb

Chapter 7: 

Keeping Your Information Accurate

01_FieldTest.accdb

02_Size.accdb

03_Accurate.accdb

04_Validate.accdb

05_SimpleLookup.accdb

06_MulticolumnLookup.accdb

07_Update.accdb

08_Delete.accdb

09_Prevent.accdb
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Chapter Files

Chapter 8: 

Working with Reports

01_Wizard.accdb

02_ModifyDesign.accdb

03_Manually.accdb

04_ModifyContent.accdb

05_AddSubreport.accdb

06_Printing.accdb

Chapter 9: 

Making Your Database Easy to Use

01_Switchboard.accdb

02_CustomCategory.accdb

03_Features.accdb

Chapter 10: 

Securing and Sharing Information

01_Password.accdb

02_Prevent.accdb

03_Distribute.accdb

In  addition to the practice fi les, the CD contains some exciting resources that will really 

enhance your ability to get the most out of using this book and Access 2007, including 

the following:

 O Microsoft Offi ce Access 2007 Step by Step in eBook format

 O Microsoft Computer Dictionary, 5th ed. eBook

 O First Look 2007 Microsoft Offi ce System (Katherine Murray, 2006)

 O Sample chapter and poster from Look Both Ways: Help Protect Your Family on the 
Internet (Linda Criddle, 2007)

Important The companion CD for this book does not contain the Access 2007 software. 

You should purchase and install that program before using this book.
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Minimum System Requirements

2007 Microsoft Offi ce System
The      2007 Microsoft Offi ce system includes the following programs:

 O Microsoft Offi ce Access 2007

 O Microsoft Offi ce Communicator 2007

 O Microsoft Offi ce Excel 2007

 O Microsoft Offi ce Groove 2007

 O Microsoft Offi ce InfoPath 2007

 O Microsoft Offi ce OneNote 2007

 O Microsoft Offi ce Outlook 2007

 O Microsoft Offi ce Outlook 2007 with Business Contact Manager

 O Microsoft Offi ce PowerPoint 2007

 O Microsoft Offi ce Publisher 2007

 O Microsoft Offi ce Word 2007

No single edition of the 2007 Offi ce system installs all of the above programs. Specialty 

programs available separately include Microsoft Offi ce Project 2007, Microsoft Offi ce 

SharePoint Designer 2007, and Microsoft Offi ce Visio 2007.

To install and run these programs, your computer needs to meet the following minimum 

requirements:

 O 500  megahertz (MHz) processor

 O 256   megabytes (MB) RAM

 O CD or DVD drive

 O 2 gigabytes (GB) available hard  disk space; a portion of this disk space will be freed 

if you select the option to delete the installation fi les

Tip Hard disk requirements will vary depending on confi guration; custom installation 

choices might require more or less hard disk space.

 O Monitor   with 800×600 screen resolution; 1024×768 or higher recommended

 O Keyboard and mouse or compatible pointing device
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 O Internet  connection, 128 kilobits per second (Kbps) or greater, for download and 

activation of products, accessing Microsoft Offi ce Online and online Help topics, 

and any other Internet-dependent processes

 O  Windows Vista or later, Microsoft Windows XP with Service Pack 2 (SP2), or 

Microsoft Windows Server 2003 or later

 O Windows Internet Explorer 7 or Microsoft Internet Explorer 6 with service packs

The 2007 Microsoft Offi ce suites, including Offi ce Basic 2007, Offi ce Home & Student 

2007, Offi ce Standard 2007, Offi ce Small Business 2007, Offi ce Professional 2007, Offi ce 

Ultimate 2007, Offi ce Professional Plus 2007, and Offi ce Enterprise 2007, all have similar 

requirements.

Step-by-Step Exercises
In  addition to the hardware, software, and connections required to run the 2007 

Microsoft Offi ce system, you will need the following to successfully complete the 

exercises in this book:

 O Access 2007, Excel 2007, and Outlook 2007

 O Access to a printer

 O 52 MB of available hard disk space for the practice fi les

Installing the Practice Files
You   need to install the practice fi les in the correct location on your hard disk drive 

before you can use them in the exercises. Follow these steps:

 1. Remove the companion CD from the envelope at the back of the book, and insert 

it into the CD drive of your computer.

The Step By Step Companion CD License Terms appear. Follow the on-screen 

directions. To use the practice fi les, you must accept the terms of the license 

agreement. After you accept the license agreement, a menu screen appears.

Important If the menu screen does not appear, click the Start button, and then click 

Computer. Display the Folders list in the Navigation Pane, click the icon for your CD 

drive, and then in the right pane, double-click the StartCD executable fi le.

 2. Click Install Practice Files.
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 3. Click Next on the fi rst screen, and then click Next to accept the terms of the license 

agreement on the next screen.

 4. If you want to install the practice fi les to a location other than the default folder 

(Documents\MSP\SBS_Access2007), click the Change button, select the new drive 

and path, and then click OK.

Important If you install the practice fi les to a location other than the default, you 

will need to substitute that path within the exercises.

 5. Click Next on the Choose Destination Location screen, and then click Install on 

the Ready to Install the Program screen to install the selected practice fi les.

 6. After the practice fi les have been installed, click Finish.

 7. Close the Step by Step Companion CD window, remove the companion CD from 

the CD drive, and return it to the envelope at the back of the book.

Adding the Practice File Folder to the 
Trusted Locations List

The databases provided as practice fi les for this book contain macros. You can enable 

the macros in all the practice databases by adding the practice fi le folder to the list of 

Trusted Locations for Access 2007.

Follow these steps:

 1. Click the Microsoft Offi ce Button, and then click Access Options.

 2. On the Trust Center page of the Access Options dialog box, click Trust Center 
Settings.

 3. On the Trusted Locations page of the Trust Center dialog box, click Add new 
location.

 4. In the Microsoft Offi ce Trusted Location dialog box, click Browse.

 5. In the Browse dialog box, browse to your Documents\MSP\SBS_Access2007 folder, 

and then click OK.

 6. In the Microsoft Offi ce Trusted Location dialog box, select the Subfolders of this 
location are also trusted check box, and then click OK in each of the open dialog 

boxes.
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If you prefer to not do this, you can enable macros in an individual database by clicking 

Options in the Security Warning area that appears at the top of the content pane. In the 

Microsoft Offi ce Security Options dialog box, selecting the Enable This Content option, 

and then clicking OK.

See Also For more information about the Access 2007 Trust Center macro settings, see the 
sidebar “Enabling Macros and Other Database Content” in Chapter 1, “Exploring Access 2007.”

Using the Practice Files
When you install the practice fi les from the companion CD that accompanies this 

book, the fi les are stored on your hard disk in chapter-specifi c subfolders under 

Documents\MSP\SBS_Access2007. Each exercise is preceded by a paragraph that lists 

the fi les needed for that exercise and explains any preparations needed before you 

start working through the exercise. Here are examples:

USE the 03_Opening database. This practice fi le is located in the Chapter01 subfolder 

under SBS_Access2007.

BE SURE TO start your computer, but don’t start Access before starting this exercise.

You can browse to the practice fi les in Windows Explorer by following these steps:

 1. On the Windows taskbar, click the Start button, and then click Documents.

 2. In your Documents folder, double-click MSP, double-click SBS_Access2007, and 

then double-click a specifi c chapter folder.

You can browse to the practice fi les from an Access 2007 dialog box by following these 

steps:

 1. On the Favorite Links pane in the dialog box, click Documents.

 2. In your Documents folder, double-click MSP, double-click SBS_Access2007, and 

then double-click the specifi ed chapter folder.

USE the the 03_Opening03_Opening database. This practice fi le is located in the database. This practice fi le is located in the Chapter01Chapter01 subfolder subfolder 

under under SBS_Access2007SBS_Access2007..7777

BE SURE TO start your computer, but don’t start Access before starting this exercise.start your computer, but don’t start Access before starting this exercise.

StartStart
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Removing and Uninstalling the Practice Files
After you fi nish working through this book, delete the practice messages, appoint-

ments, contacts, and other Outlook items you created while working through the 

exercises, and then uninstall the practice fi les that were installed from the companion 

CD. Follow these steps:

 1. On the Windows taskbar, click the Start button, and then click Control Panel.

 2. In Control Panel, under Programs, click the Uninstall a program task.

 3. In the Programs and Features window, click Microsoft Offi ce Access 2007 
Step by Step, and then on the toolbar at the top of the window, click the 

Uninstall button.

 4. If the Programs and Features message box asking you to confi rm the deletion 

appears, click Yes.

See Also If you need additional help installing or uninstalling the practice fi les, see “Getting 
Help” later in this book.

Important Microsoft Product Support Services does not provide support for this book or 

its companion CD.

StartStart



Getting Help
Every effort has been made to ensure the accuracy of this book and the contents of its 

companion CD. If you do run into problems, please contact the sources listed below for 

assistance.

Getting Help with This Book and Its Companion CD
If  your question or issue concerns the content of this book or its companion CD, please 

fi rst search the online Microsoft Press Knowledge Base , which provides support informa-

tion for known errors in or corrections to this book, at the following Web site:

www.microsoft.com/mspress/support/search.asp

If you do not fi nd your answer at the online Knowledge Base, send your comments or 

questions to Microsoft Press Technical Support at:

mspinput@microsoft.com

Getting Help with Access 2007
If  your question is about Microsoft Offi ce Access 2007, and not about the content of 

this Microsoft Press book, your fi rst recourse is the Access Help system. This system is 

a combination of tools and fi les stored on your computer when you installed the 2007 

Microsoft Offi ce system and, if your computer is connected to the Internet, information 

available from Microsoft Offi ce Online. There are several ways to fi nd general or specifi c 

Help information:

 O To   fi nd out about an item on the screen, you can display a ScreenTip. For example, 

to display a ScreenTip for a button, point to the button without clicking it. The 

ScreenTip gives the button’s name, the associated keyboard shortcut if there is one, 

and unless you specify otherwise, a description of what the button does when you 

click it.

 O In  the Access program window, you can click the Microsoft Offi ce Access Help but-

ton  (a question mark in a blue circle) at the right end of the Ribbon to display the 

Access Help window. 
   xxxiii
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 O After opening a dialog box,   you can click the Help button (also a question mark) 

at the right end of the dialog box title bar to display the Access Help window with 

topics related to the functions of that dialog box already identifi ed.

To practice getting help, you can work through the following exercise.

BE SURE TO start Access before beginning this exercise.

 1. At the right end of the Ribbon, click the  Microsoft Offi ce Access Help button.

The Access Help window opens.

 2. In  the list of topics in the Access Help window, click Activating Access.

Access Help displays a list of topics related to activating Microsoft Offi ce system 

programs. You can click any topic to display the corresponding information.

BE SURE TO start Access before beginning this exercise.start Access before beginning this exercise.

Microsoft Offi ce 
Access Help

Microsoft Offi ce 
Access Help
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 3. On   the toolbar, click the  Show Table of Contents button.

The  Table Of Contents appears in the left pane, organized by category, like the 

table of contents in a book.

Clicking any category (represented by a book icon) displays that category’s topics 

(represented by help icons).

TopicCategory

If you’re connected to the Internet, Access displays categories, topics, and training 

available from the Offi ce Online Web site  as well as those stored on your computer.

 4. In    the Table of Contents, click a few categories and topics, then click the Back and 

Forward buttons to move among the topics you have already viewed.

Show Table of 
Contents

Show Table of 
Contents

 
 Back Forward

 
 Back Forward
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 5. At the right end of the Table of Contents title bar, click the Close button.

 6. At   the top of the Access Help window, click the Type word to search for box, type 

Help window, and then press the F key.

The Access Help window displays topics related to the words you typed.

 7. In   the results list, click Print a Help topic.

The selected topic appears in the Access Help window, explaining that you can click 

the Print button on the toolbar to print any topic.

 8. Below   the title at the top of the topic, click Show All.

Access displays any hidden auxiliary information available in the topic and changes 

the Show All button to Hide All. You can display or hide an individual item by click-

ing it. When you click the Print button, Access will print all displayed information.

CLOSE the Access Help window.

CloseClose
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More Information
If  your question is about Microsoft Offi ce Access 2007 or another Microsoft software 

product and you cannot fi nd the answer in the product’s Help system, please search the 

appropriate product solution center or the Microsoft Knowledge Base  at:

support.microsoft.com

In the United States, Microsoft software product support issues not covered by the 

Microsoft Knowledge Base are addressed by  Microsoft Product Support Services. 

Location-specifi c software support options are available from:

support.microsoft.com/gp/selfoverview/



Quick Reference

 1 Exploring Access 2007

To open a table, page 5

 � In   the Navigation Pane, expand the Tables category, and then double-click the 

table you want to open.

To access additional datasheet formatting options, page 6

 � In   Datasheet view, on the Home tab, click the Font Dialog Box Launcher.

To hide the Ribbon, page 7

 � Double-click   the active tab.

To display the Ribbon when it is hidden, page 8

 � Click  any tab.

To unhide the Ribbon, page 8

 � Double-click the active tab.

To enable macros in the current database, page 12

 1. In  the Security Warning area, click Options.

 2. In the Microsoft Offi ce Security Options dialog box, select the Enable this 
content option, and then click OK.

To add the publisher of a digitally signed database to the Trusted Publishers list, 
page 12

 1. In  the Security Warning area, click Options.

 2. In the Microsoft Offi ce Security Options dialog box, select the Trust all documents 
from this publisher option, and then click OK.

To add the location of this database to the Trusted Locations list, page 12

 1. In   the Microsoft Offi ce Security Options dialog box, click Open the Trust Center.

 2. In the page list in the left pane of the Trust Center, click Trusted Locations.

 3. On the Trusted Locations page, click Add new location.

 4. In the Microsoft Offi ce Trusted Location dialog box, click Browse.

 5. In the Browse dialog box, browse to the folder containing the current database, 

and then click OK.
   xxxix
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6. In the Microsoft Offi ce Trusted Location dialog box, select the Subfolders of this 
location are also trusted check box if you want to do so, and then click OK in each 

of the open dialog boxes.

To change the way Access handles macros in all databases, page 13

1. Click   the Microsoft Offi ce Button, and then click Access Options.

2. On the Trust Center page of the Access Options dialog box, click Trust Center 
Settings.

3. On the Macro Settings page of the Trust Center, select the option for the way you 

want Access to handle macros:

O Disable all macros without notifi cation. If a database contains macros, 

Access disables them and doesn’t display the security warning to give you the 

option of enabling them.

O Disable all macros with notifi cation. Access disables all macros and displays 

the security warning.

O Disable all macros except digitally signed macros. Access automatically 

enables digitally signed macros.

O Enable all macros. Access enables all macros.

4. Click OK in the Trust Center and in the Access Options dialog box.

To open an existing database, page 13

1. On   the Start menu, point to All Programs, click Microsoft Offi ce, and then click 

Microsoft Offi ce Access 2007.

2. In the Open Recent Database list, click More, navigate to the folder in which the 

database is stored, and then double-click the database.

To close a database, page 14

 � Click   the Microsoft Offi ce Button, and then click Close Database.

To view records in a table subdatasheet, page 17

 � Click  the Expand button at the left end of the record.

To hide records in a subdatasheet, page 17

 � Click  the Collapse button at the left end of the record.

To close a document window, page 17

 � Click   the Close Window button at the right end of the document tab.

To move through a table one record at a time, page 18

 � On   the record navigation bar, click the Next Record button.
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To move to a specifi c record on a datasheet, page 18

 � On   the record navigation bar, select the current record number, type the number 

of the record you want, and then press F.

To switch from Datasheet View to Design View, page 19

 � On   the View toolbar, click the Design View button.

To view the properties of a query, page 21

 � In  the Navigation Pane, right-click the query, and then click Object Properties.

To process (or run) a query, page 21

 � In   the Navigation Pane, right-click the query name, and then click Open.

To move through records in a form, page 25

 � On   the record navigation bar, click the Next Record to move forward and the 

Previous Record button to move backward.

To view a form in Design view when you are currently in Form view, page 26

 � On  the Home tab, in the Views group, click the View button.

To preview a report, page 27

1. In   the Navigation Pane, right-click the report, and then click Print Preview.

2. Click the report to display a larger view.

To view a table in Print Preview, page 31

 � Click   the Microsoft Offi ce Button, point to Print, and then click Print Preview.

To change the page orientation of a table before printing, page 32

 � On    the Print Preview tab, in the Page Layout group, click the Portrait button or 

the Landscape button.

To close Print Preview, page 33

 � On   the Print Preview tab, click the Close Print Preview button.

2 Creating a Database

To open a template and save it as a new database, page 39

1. On the Getting Started with Microsoft Offi ce Access page, in the Template 
Categories list, click a category.

2. Click the template icon for the template you want to open.

3. In the File Name box, type a new name for the database, and note the default path.

4. Click the Create button.
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To open a new blank database, page 42

1. Open   Access.

2. On the Getting Started with Microsoft Access page, click Blank Database.

3. In the File Name box, type the name for the database.

4. Click the Browse for a location button, browse to the folder where you want to 

save the database, click OK, and then click Create.

To enter information in a database, page 43

 � Click  in an empty cell, type your text, and then press D to move to the next cell.

To change a fi eld name, page 44

 � Double-click  the fi eld name, and then type the new name.

To change the data type of a fi eld, page 46

 � In Design view , click in the data type cell you want to change, click the arrow that is 

displayed, and then click the data type you want to use.

To change the size of a fi eld, page 46

1. In  Design view, click the fi eld name. 

2. In the Field Properties area, select the current fi eld size, and then enter the new 

fi eld size.

To close and save a table, page 46

 � Click     the Close button to close the table, and then click Yes to save changes.

To create a table by using a template, page 46

 � On   the Create tab, in the Tables group, click the Table Templates button, and then 

click the type of template you want to create.

To add a new fi eld name to a table and assign it a data type, page 46

1. Click  in the fi rst blank Field Name cell below the existing fi eld names, type the fi eld 

name, and then press D.

2. Click the Data Type arrow for the new fi eld, and then click the data type that you 

want assigned to the fi eld.

To delete a table row while in Design view, page 47

 � Right-click   in the row you want to delete, and then click Delete Rows.

To edit a fi eld name, page 47

 � Select  the part of the fi eld name you want to edit, and then type the new 

information.
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To change the size of a table column, page 48

1. With  the table in Datasheet View, drag the vertical bar at the right edge of a column 

header to the left or right until the column is the size you want.

2. To size a column to the minimum width that will display all the text in that fi eld in 

all records, point to the vertical bar on the right of the column header, and when 

the pointer changes to a double-headed arrow, double-click.

To change the height of all rows in a table, page 49

 � With  the table in Datasheet View, on the left side of the datasheet, drag the 

horizontal bar between any two record selectors up or down until the rows are 

the height you want.

To reset all rows in a table to standard height, page 50

1. With  the table in Datasheet View, on the Home tab, in the Records group, click 

More, and then click Row Height to display the Row Height dialog box.

2. In the Row Height dialog box, select the Standard Height check box or type in the 

height you want in the Row Height box, and then click OK.

To hide and unhide columns, page 50

1. Click   anywhere in the column you want to hide, and in the Records group, click 

More. Then click Hide Columns.

2. To restore the hidden column, click More again, and then click Unhide Columns to 

display the Unhide Columns dialog box.

3. In the Unhide Columns dialog box, select the check box of the column you want to 

unhide, and then click Close.

To freeze and unfreeze columns, page 51

1. Drag   through the column header of the column or columns you want to freeze.

2. With the columns selected, click the More button, and then click Freeze.

3. To restore the columns to their normal condition, click More, and then click 

Unfreeze.

3 Populating a Database

To import tables from one Access database into another, page 55

1. Open    the database that you want to import to.

2. On the External Data tab, in the Import group, click the Access button to open the 

Get External Data wizard, and then on the Select the source and destination of 
the data page, click Browse.

3. In the File Open dialog box, navigate to the database you want to use, click it, and 

then click Open.
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4. On the Select the source and destination of the data page, with the Import 
tables, queries, forms, reports, macros, and modules into the current database 

option selected, click OK.

5. In the Import Objects dialog box, on the Tables tab, click Select All to select all the 

tables, or select only the tables you want to import, and then click OK to import 

any tables you selected.

To migrate a database from an earlier version of Access, page 57

1. Open   the database, click the Microsoft Offi ce Button, point to the Save As arrow, 

and then click Access 2007 Database.

2. In the Save As dialog box specify a name and location for the database, and then 

click Save.

To import information from an Excel worksheet into an existing table in an Access 
database, page 58

1. On   the External Data tab, in the Import group, click the Excel button.

2. In the Get External Data wizard, on the Select the source and destination of the 
data page, click Browse.

3. In the File Open dialog box, navigate to the workbook you want to use, and then 

click Open.

4. On the Select the source and destination of the data page, select the Append a 
copy of the records to the table option, click the arrow and select the table you 

want to use in the list, and then click OK.

5. In the Import Spreadsheet wizard, ensure your worksheet or range is selected, and 

then click Next. 

6. If appropriate, select the First Row Contains Column Headings check box, click 

Next, and then click Finish to import the fi le.

To import a SharePoint list from a collaboration site, page 61

1. Locate   the SharePoint site that contains the list you want to import, and make a 

note of the site address.

2. On the SharePoint site, identify the lists you want to copy to the database, and then 

decide whether you want the entire list or just a particular view.

3. Review the columns in the source list or view, and identify the database into which 

you want to import the lists.

4. On the External Data tab, in the Import group, click the SharePoint List button.

5. On the Select the source and destination of the data page, under Specify a 
SharePoint site, click the address of the site you want to connect to, or type it in 

the box.
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6. Select the Import the source data or Link to the data source option, and click 

Next. Then, if prompted to do so, enter your site credentials.

7. In the Import column, select the check box of each list you want to import into 

the database.

8. In the Items to Import column, for each of the selected lists, select the view that 

you want to import into the database.

9. With the Import display values instead of IDS for fi elds that look up values 
stored in another list check box selected, click OK.

10. If you want to save the import parameters for reuse, select the Save Import Steps 
check box. On the Save Import Steps page, enter a name and description for the 

specifi cation, and then click Save Import.

To create an e-mail survey form, and then send the e-mail survey, page 64

1. Create  a database table containing the fi elds you want to include in your survey. 

Position the insertion point in the fi rst empty record.

2. On the External Data tab, in the Collect Data group, click the Create E-mail button.

3. Follow the steps in the Collect Data Through E-mail Messages wizard to create 

the form, add and reorder the fi elds from the table, change fi eld labels, specify the 

Outlook folder to which the survey results will be delivered, elect to have Outlook 

automatically add replies to the original Access database table, and specify the 

survey recipients.

4. Customize the text of the e-mail message that will be created, and then on the 

Create the e-mail message page, click Create. Make any changes you want to the 

message, address it to the survey recipients, and then send it.

To import information from a comma-delimited text fi le, page 66

1. On    the External Data tab, in the Import group, click the Text File button.

2. In the Get External Data wizard, on the Select the source and destination of the 
data page, click the Browse button, navigate to the location of the text fi le, click 

the fi le, and then click Open.

3. Select the Append a copy of the records to the table option, and in the list, click 

the text fi le you want to use. Then click OK.

4. In the Import Text wizard, click Next.

5. Select or clear the check boxes you want, click Next, and click Finish to import the 

text fi le into the table. Then on the Save Import Steps page, click Close.
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To import information from an XML fi le, page 69

1. On   the External Data tab, in the Import group, click the XML File button.

2. On the Select the source and destination of the data page of the Get External 
Data wizard, click the Browse button, and in the File Open dialog box, navigate to 

the location of the fi le, click the one you want to use, and then click Open.

3. On the Select the source and destination of the data page, click OK.

4. In the Import XML dialog box, select the Structure and Data import option, and 

click OK. Then on the Save Import Steps page, click Close.

To import information from an HTML fi le into an existing table, page 72

1. On   the External Data tab, in the Import group, click the More button, and then in 

the list, click HTML Document.

2. On the Select the source and destination of the data page of the Get External 
Data wizard, click the Browse button, navigate to the fi le you want to use, click the 

fi le, and then click Open.

3. Select the Append a copy of the records to the table option, click the fi le in the 

list that you want to use, and then click OK.

4. In the Import HTML wizard, select the First Row Contains Column Headings check 

box, and then click Finish.

5. On the Save Import Steps page, click Close.

To import information from an Outlook folder into a new table in an Access 
database, page 74

1. On   the External Data tab, in the Import group, in the More list, click Outlook 
Folder.

2. In the Get External Data wizard, with the Import the source data into a new 
table in the current database option selected, click OK.

3. Expand your primary mailbox folder, click the folder you want to import, and then 

click Next.

4. On the Field Options page, click on fi elds you don’t want to import, select the Do 
not import fi eld (Skip) check box, and then click Next.

5. On the Primary Key page, decide whether you want to create your own key, let 

Access create the key, or have no key, and click Next. Then click Finish to import 

the contents of the folder.

6. On the Save Import Steps page, click Close.

To import information from a dBASE fi le into an existing table in an Access 
database, page 76

1. On   the External Data tab, in the Import group, in the More list, click dBase File. 
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2. On the Select the source and destination of the data page of the Get External 
Data wizard, navigate to the fi le you want to use, click the fi le, and then click Open.

3. Select the Import the source data into a new table in the current database option, 

and then click OK. 

4. On the Save Import Steps page, click Close.

4 Sharing and Reusing Information

To export a table from one Access database to another, page 81

1. In   the Navigation Pane, under Tables, select the table you would like to export.

2. On the External Data tab, in the Export group, click the More button, and then in 

the list, click Access Database.

3. In the Export – Access Database wizard, click the Browse button. In the File Save 

dialog box, navigate to the folder you want to export to, click it, and then click Save.

4. In the Export – Access Database wizard, click OK. In the Export dialog box, select 

the options you want, and then click OK.

5. In the Export dialog box, with the name of the exported table showing in the 

Export to: box, and Defi nition and Data selected under Export Tables, click OK.

6. On the Save Export Steps page, click Close.

To export a table from a database to an Excel workbook, page 83

1. Open the table in Datasheet view. Then on the External Data tab, in the Export 
group, click the Export to Excel spreadsheet button.

2. In the Export – Excel Spreadsheet wizard, click the Browse button. Then in the File 
Save dialog box, navigate to the folder you want to save the table in, and click Save.

3. In the Export – Excel Spreadsheet wizard, select the Export data with formatting 
and layout check box. Then select the Open the destination fi le after the export 
operation is complete check box.

4. With Excel Workbook selected in the File format list, click OK.

5. On the Save Export Steps page, click Close.

To export the contents of a table to a SharePoint site, page 85

1. In    the Navigation Pane, select (but don’t open) the object you want to export.

2. On the External Data tab, in the Export group, click the SharePoint List button.

3. In the Export – SharePoint Site wizard, specify the SharePoint site where you want 

to create the list, change the list name and type a description if you want, and then 

click OK. Enter your SharePoint site credentials if prompted to do so.
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To export a form from a database to an RTF document in Word, page 87

1. In    the Navigation Pane, under Forms, double-click the form you want to export.

2. On the External Data tab, in the Export group, click the Word button.

3. In the Export – RTF File wizard, click Browse. In the File Save dialog box, navigate 

to the folder you want to save the form in, and then click Save.

4. In the Export – RTF File wizard, select the Open the destination fi le after the export 
operation is complete check box, and then click OK.

To export a table to a text fi le with formatting, page 90

1. Open the table in Datasheet view. Then on the External Data tab, in the Export 
group, click the Text File button.

2. In the Export – Text File wizard, click Browse. In the File Save dialog box, navigate 

to the folder in which you want to save the fi le, and then click Save.

3. In the Export – Text File wizard, select the Export data with formatting and layout 
check box. Then select the Open the destination fi le after the export operation is 
complete check box, and click OK.

4. In the Encode As dialog box, select the options you want, and then click OK.

To export a table from a database to an XML fi le, page 93

1. On    the External Data tab, in the Export group, click the More button, and then in 

the list, click XML File.

2. In the Export – XML File wizard, click Browse, and in the File Save dialog box, 

navigate to the folder you want to store the fi le in, and click Save. 

3. In the Export – XML File wizard, click OK.

4. In the Export XML dialog box, with the Data (XML) and Schema of the data (XSD) 
check boxes selected, click OK. Then in the Export – XML File wizard, click Close.

To export a report from a database to an HTML fi le, page 95

1. In    the Navigation Pane, double-click the report you want to export.

2. On the External Data tab, in the Export group, click the More button, and then 

click HTML Document.

3. In the Export – HTML File wizard, click Browse. Then in the File Save dialog box, 

navigate to the folder you want to save the report in, and click Save.

4. In the Export – HTML File wizard, select the Open the destination fi le after the 
export operation is complete check box, and then click OK.

5. In the HTML Output Options dialog box, select the encoding format options you 

want, and then click OK to export the fi le.
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To copy and paste records between an Access database table and other Offi ce 
programs, page 98

1. Select  the records you want to copy by pointing to the row selector of the fi rst 

record you want to select, holding down the primary mouse button, and dragging 

to the last record you want to select.

2. On the Home tab, in the Clipboard group, click the Copy button.

3. Start the Offi ce program you want to copy to, and click where you want to paste 

the records. Then on the Home tab, in the Clipboard group, click the Paste button.

5 Simplifying Data Entry by Using Forms

To create a form based on a table by using the Form tool, page 105

1. Open  the table on which you want to base the form.

2. On the Create tab, in the Forms group, click the Form button.

To move labels on a form, page 109

 � Select   the labels to be moved by dragging through them, drag them to a blank 

section of the form, and then release the selection.

To change the font and font size of a label on a form, page 109

1. Open   the form in Design View, and click the label (not its text box) you want 

to change.

2. On the Design contextual tab, in the Font group, click the Font arrow, and then in 

the list, click the font you want to use.

3. With the label still selected, click the Font Size arrow, and then in the list, click the 

size you want.

To edit form control properties by using the Property Sheet pane, page 109

1. Open   the form in Design view, and if the Property Sheet pane is not visible, 

right-click the desired control, and then click Properties.

2. In the Property Sheet pane, click the property you want to change, and either type 

the new value, or click the down arrow and select the value you want. Repeat for all 

properties that you want to change.

To edit multiple form control properties at once, page 110

1. Click  anywhere in the Detail section of the form, and then drag diagonally to draw 

a rectangle through some portion of all the controls to select them.

2. In the Property Sheet pane, click the property you want to change, click the arrow 

that appears, and then click the option you want. Repeat for all properties that you 

want to change.
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To set the background properties of all controls on a form, page 111

1. Select  all the controls on the form. Then on the Format tab of the Property Sheet 
pane, click Back Style, and set it to the option you want.

2. Click Back Color, and then click the ellipsis button.

3. In the Color Builder, click the square of the color you want.

4. Set the Special Effect property to the option you want, and the Border Color 
property to the color you want.

To edit the caption of a form control, page 112

 � Click  the label whose caption you want to change. Then in the Property Sheet pane, 

click the Caption property, change the text to what you want, and press F.

To change the layout of controls on a form, page 112

 � Drag  through all the controls on the form to select them. Then on the Arrange tab, 

in the Control Layout group, click the Remove button.

To delete a form control label, page 113

 � Click   the label you want to delete, and then press the A key.

To select specifi c control labels on a form, page 113

 � Hold   down the G key as you click each control or drag through just the labels 

you want to select.

To align form controls, page 113

 � Select   the labels (but not their corresponding text boxes), and then in the Property 
Sheet pane, set the Text Align property to the alignment you want.

To size form control labels to fi t their contents, page 113

 � Select   the labels to be sized, and then on the Arrange contextual tab, in the Size 

group, click the Size To Fit button.

To insert space between form control labels and text boxes, page 114

 � Select  all the text boxes (but not their corresponding labels). Then in the Property 
Sheet pane, click the Left property, and then change the setting to the amount of 

space you want.

To save the design of a form, page 114

 � On   the Quick Access Toolbar, click the Save button.

To expand the Detail area of a form, page 115

 � Point  to the right edge of the form Detail grid, and when the pointer changes to a 

double-headed arrow, drag the edge of the background to the right.
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To move a label or text box control on a form, page 116

 � Click  a label or text box, move the pointer over its border, and when the pointer 

changes to a four-way arrow, drag it to a new location.

To create an AutoFormat form template, page 117

1. On   the Arrange contextual tab, in the AutoFormat group, click the AutoFormat 
button.

2. At the bottom of the AutoFormat gallery, click AutoFormat Wizard.

3. In the AutoFormat dialog box, click the Customize button.

4. In the Customize AutoFormat dialog box, click Create a new AutoFormat based 
on the Form option, and then click OK.

5. In the New Style Name dialog box, type a name for the new style, and then click OK.

6. Click OK to close the AutoFormat dialog box. Then click the Save button, and close 

the form.

To add a graphic to a form control, page 120

1. In   the Navigation Pane, under Forms, right-click the form you want to use, and 

then click Design View.

2. On the Design contextual tab, in the Controls group, click the Image button, and 

then click the area where you want to place the image, drag diagonally to draw a 

rectangle, and release the mouse button.

3. In the Insert Picture dialog box, navigate to the folder where the graphic you want 

to use is located, and then double-click the graphic.

To add a caption below a picture, page 121

1. In  the Controls group, click the Label button, and then drag diagonally to draw a 

rectangle where you want it to appear.

2. In the active label control, type the caption text, and then press F.

To size a label control to fi t the text, page 121

 � Click  the label control, and then on the Arrange tab, in the Size group, click the 

Size to Fit button.

To add a combo box control without using a wizard, page 122

1. On   the Design tab, in the Controls group, look at the Use Control Wizards button. 

If the button is active (orange), click it to deactivate it.

2. In the Controls group, click the Combo Box button, and then drag diagonally in 

the form to draw a rectangle where you want the combo box to appear.
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To copy the formatting of one control to another, page 122

 � Click   the box whose formatting you want to copy, and in the Font group, click 

the Format Painter button. Then click the box to which you want to apply the 

formatting.

To remove the record selector and scroll bar controls from a form, page 124

1. In     Design view, click the Form selector (the box at the junction of the horizontal 

and vertical rulers), and then press $ to display the Property Sheet pane for the 

entire form (if the sheet is not already displayed).

2. On the Format tab, change Record Selectors to No, and Scroll Bars to Neither.

To create a form based on the fi elds in a table by using the Form wizard, page 129

1. In  the Navigation Pane, under Tables, click the table in which you want to create 

the AutoForm.

2. On the Create tab, in the Forms group, click the More Forms button, and then in 

the list, click Form Wizard.

3. With the open table selected in the Tables/Queries list, click the Move All button 

to move all the table fi elds to the Selected Fields list, and then click Next.

4. On the second page of the wizard, choose the layout of the fi elds in the new form. 

On the third page, select a style option.

5. On the fourth page, with the Open the form to view or enter information option 

selected, click Finish.

To create a form and subform simultaneously, page 132

1. On   the Create tab, in the Forms group, click the More Forms button, and then 

click Form Wizard.

2. On the fi rst page of the Form wizard, in the Tables/Queries list, click the table on 

which you want to base the form. Then click the Move All button to include all the 

table fi elds in the new form.

3. To create the subform, display the Tables/Queries list, and then click the table on 

which you want to base the subform.

4. In the Available Fields list, double-click the fi elds you want to include in the sub-

form to move them to the Selected fi elds list, and then click Next.

5. With your primary table and Form with subform(s) selected, click Next.

6. With Datasheet selected, click Next.

7. On the last page of the wizard, select a style, and then click Finish.



 Quick Reference  liii

 

 

 

 
 

 

 
 

 

 

To add a subform to a form, page 134

1. Open  the form in Design view. Then on the Design tab, in the Controls group, 

make sure the Use Control Wizards button is active (orange).

2. In the Controls group, click the Subform/Subreport button, and then drag 

diagonally to draw a rectangle in a section where you want to put the subform.

3. On the Subform wizard’s fi rst page, with the Use existing Tables and Queries 
option selected, click Next.

4. In the Tables/Queries list, click the type of item you want to use.

5. Add fi elds to the Selected Fields list by double-clicking each fi eld. Then click Next, 
select the options you want, and click Finish.

6 Locating Specifi c Information

To sort information in one column, page 146

 O Click   the arrow at the right side of the column header for the column you want to 

sort, and then click the direction you want to sort the information.

 O Click the header of the column you want to sort, and then on the Home tab, in the 

Sort and Filter group, click the Ascending or Descending button.

To sort information in multiple columns, page 147

 � Select the adjacent columns you want to sort  , right-click the column header area of 

your selection, and then click how you want to sort the columns.

To move a fi eld, page 147

 � Click  the column head you want to move, and then drag it to the position you want.

To fi lter records by a single criterion, page 149

1. In the fi eld, click any instance of the record you want to fi lter by.

2. On the Home tab, in the Sort & Filter group, click the Selection button, and then 

in the list, click Equals “[the term you want to fi lter on]”.

To remove a fi lter, page 149

 � In  the Sort & Filter group, click the Toggle Filter button.

To fi lter records with a text fi lter, page 149

1. Click  the column header arrow, point to Text Filters, and then click the criterion 

you want to fi lter by.

2. In the Custom Filter dialog box, in the ItemText begins with box, type the fi rst few 

letters of the text you want to fi lter by. Then click OK.
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To fi lter records with a “does not equal” fi lter, page 151

 � In   the column, right-click any instance of the criterion you don’t want to fi lter, and 

then click Does Not Equal “[the item you don’t want to fi lter]”.

To use the Filter By Form command, page 154

1. In  the Navigation Pane, under Forms, double-click the form you want to search.

2. On the Home tab, in the Sort & Filter group, click the Advanced button, and then 

in the list, click Filter By Form.

3. Click the box you want to search in, type the search criterion, and then press F.

4. In the Sort and Filter group, click the Toggle Filter button.

To use the Advanced Filter/Sort command to sort tables, page 157

1. On  the Home tab, in the Sort & Filter group, click the Advanced Filter Options 
button, and then in the list, click Advanced Filter/Sort.

2. In the fi eld list, double-click a fi eld to copy it to the fi rst cell in the fi rst column of 

the design grid.

3. In the Criteria cell under the fi eld you just copied, type the search criterion, and 

then press F.

4. Repeat Steps 2 and 3 for any other fi elds you want to fi lter on.

5. In the Sort & Filter group, click the  Toggle Filter button to view the records that 

match the criteria.

To create a query in Design view, page 162

1. On  the Create tab, in the Other group, click the Query Design button.

2. In  the Show Table dialog box, on the Tables tab, double-click any tables you want 

to add to the query window. Then close the dialog box.

3. Drag   the fi elds to be used in the query from the fi eld lists to consecutive columns 

in the design grid.

4. On   the Design contextual tab, in the Results group, click the Run button to run the 

query and display the results in Datasheet view.

7 Keeping Your Information Accurate

To set the data type for a fi eld, page 181

1. With  the table in Design view, click the Data Type cell next to the desired fi eld.

2. Click the Data Type arrow, and then in the list, click the data type you want.
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To view the properties of a fi eld, page 182

 � With  the table in Design view, click the fi eld name to display its properties in the 

Field Properties area.

To set the Field Size property for text, number, and autonumber fi elds, page 185

 � With    the table in Design view, click any cell in a fi eld, and then in the Field 
Properties area, change the Field Size property to what you want.

To use the Input Mask wizard, page 188

1. With  the table in Design view, select a fi eld, and then click Input Mask in the Field 
Properties area.

2. Click the ellipsis button to the right of the cell to start the Input Mask wizard. 

(Click Yes if Access prompts you to install this feature.)

3. Select an available mask in the Input Mask list, and then click Next.

4. In the Input Mask and Placeholder character boxes, make any changes you want, 

and then click Next.

5. Choose whether to store the data with the symbols, and then click Finish.

6. Press F to accept the mask. Then save your changes.

To set a fi eld validation rule, page 192

1. With  the table in Design view, select a fi eld, and then click in the Validation Rule 

box in the Field Properties area.

2. Type an expression in the Validation Rule box, or click the ellipsis button to use the 

Expression Builder.

3. Press F. Then save the table.

To test the validation rules in a table, page 193

 � Open the table in Design view. Then right-click  its title bar, and click Test 
Validation Rules.

To select an entire fi eld, page 193

 � Move   the pointer to the left end of a fi eld, and when the pointer changes to a thick 

cross, click the fi eld.

To set a table validation rule, page 193

1. Right-click  in the table window, and then click Properties.

2. Click in the Validation Rule box, type the information for the rule, press F, and 

then save the table.
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To create a lookup list with the Lookup wizard, page 195

1. Set  the data type of a fi eld to Lookup Wizard.

2. Select the options you want, and then click Next.

3. Continue selecting the options you want, clicking Next when you are done with 

each page. When you are done fi lling out the wizard, click Finish.

4. On the Quick Access Toolbar, click the Save button.

To restrict what can be entered in a lookup list, page 198

1. In  Design view, in the Field Properties area, click the Lookup tab.

2. Change Limit To List to Yes.

3. Change Allow Value List Edits to No.

4. Save the table.

To create a multi-column lookup list, page 198

1. Add  a new fi eld, name it, and then set the data type to Lookup Wizard.

2. Select the values option you want, and then click Next.

3. Type the number of columns you want, and then enter the data you want in each 

column.

4. Click Next, and then click Finish.

5. Save your changes.

To prevent a column from being displayed in a multi-column lookup list, page 201

 � In  Design view, on the Lookup tab, in the Column Widths box, change the width 

for the column you don’t want displayed to 0. Then save your changes.

To fi lter selections in a multi-column lookup list, page 201

1. Right-click  any cell in a column you want to fi lter, point to Text Filters, and then 

click the fi lter option you want.

2. In the Custom Filter box, type criterion you want to fi lter for, and then press F.

To create a select query, page 203

1. You  must fi rst create a select query. On the Create tab, in the Other group, click 

the Query Design button.

2. In the New Query dialog box, with Simple Query Wizard selected, click OK.

3. In the Tables/Queries list, click the option you want. Then in the Available Fields 
list, double-click the fi elds you want to move to the Selected Fields list.

4. In the Simple Query Wizard dialog box, click Finish to create the select query.
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To create an update query, page 203

1. First, create a select query that selects the records you want to update.

2. Open the select query in Design view. Then on the Design contextual tab, in the 

Query Type group, click the Update button.

3. In the design grid, type the expression for your update.

To create an action query, page 204

1. First, create a select query that selects the records you want to manipulate.

2. Open the select query in Design view. Then on the Design contextual tab, in the 

Query Type group, click the Make Table, Append, Update, or Delete button.

3. Provide the information requested for the specifi ed query type.

To create a delete query, page 206

1. First, create a select query that selects the records you want to delete.

2. Open the select query in Design view. Then on the Design contextual tab, in 

the Query Type group, click the Delete button to convert this select query to 

a delete query.

3. In the design grid, set the delete criteria.

To back up a database, page 211

1. Click   the Microsoft Offi ce Button, point to Manage, and then click Back Up 
Database.

2. In the Save As dialog box, navigate to the folder in which you want to store the 

backup, and then click Save.

To compact a database, page 212

 � Click   the Microsoft Offi ce Button, point to Manage, and then click Compact and 
Repair Database. Acknowledge the safety warning if prompted to do so.

To analyze the performance of a database, page 213

1. On  the Database Tools tab, in the Analyze group, click the Analyze Performance 

button.

2. In the Performance Analyzer dialog box, on the All Object Types tab, click Select 
All, and then click OK.

3. Click each result in the Analysis Results box to display more information about that 

result in the Analysis Notes area.

To document a database, page 214

1. On   the Database Tools tab, in the Analyze group, click the Database Documenter 
button.



lviii  Quick Reference

 

 

 
 

 

 
 
 
 

 

 

 
 
 

 
 
 

 

2. In the Documenter dialog box, select the options you want on each tab. Then click 

OK to start the documentation process.

8 Working with Reports

To create a report by using the Report wizard, page 222

1. On   the Create tab, in the Reports group, click the Report Wizard button.

2. On the fi eld selection page, click the Tables/Queries arrow, and then in the list, 

click the table or query that you want to base your report on.

3. In the Available Fields list, double-click the fi elds you want to move to the 

Selected Fields list.

4. To select fi elds from additional tables or queries, repeat Steps 2 and 3.

5. On the fi eld selection page, click Next.

6. On the grouping page, select how you want to view your data, and then click Next.

7. On the grouping levels page, add up to four grouping levels by double-clicking 

fi eld names to move them to the top of the preview pane. Then click the Grouping 
Options button.

8. In the Grouping Intervals dialog box, click the Grouping intervals arrow next to 

each grouping level and select the desired interval, click OK, and then click Next.

9. On the sort order page, click the arrow to the right of the fi rst box, and select a 

fi eld to sort on; repeat for each fi eld you want to sort on, and then click Next.

10. On the layout page, select the options you want, and then click Next.

11. On the style selection page, click the style you want, and then click Next.

12. In the title box, type a title for the report, and then with the Preview the report 
option selected, click Finish.

To preview a print version of a report, page 227

 � In   the Navigation Pane, right-click the desired report, and then click Print Preview.

To adjust the height of a report section, page 229

1. In  the Navigation Pane, right-click the desired report, and then click Design View.

2. Point to the top edge of a section selector. 

3. When the pointer changes to a two-headed vertical arrow, drag the selector in the 

direction you want.

To insert the current date in a report, page 229

1. In   Design view, on the Design contextual tab, in the Controls group, click the 

Date & Time button.
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2.  In the Date And Time dialog box, select a date format option, and clear the 

Include Time check box if you want to include only the date. Then click OK.

To reposition a text box in a report, page 230

 � In   Design view, select the text box, then drag it to the desired location.

To align text in a report, page 230

 � In    Design view, select the text box, and in the Font group, click one of the 

alignment buttons.

To delete a text box from a report, page 230

 � In    Design view, click the text box to select it, and then press A.

To move controls as a group, page 230

1. In  Design view, drag diagonally to draw a rectangle through some portion of all the 

labels and the text boxes you want to move.

2. Drag the selected controls to where you want them.

To change the page width of a report, page 230

1. In  Design view, click the Report Selector. Then press $ to display the Property 
Sheet pane.

2. On the Format tab, change the Width setting.

To group and sort data in a report, page 231

1. Switch    to Design view. 

2. On the Design tab, in the Grouping & Totals group, click the Group & Sort button.

3. In the Group, Sort, and Total pane, in the Group on bar, click More to see additional 

options, and then choose the ones you want. 

4, Click the Group & Sort button to close the Group, Sort, and Total pane.

To insert a horizontal line in a report, page 232

1. In   Design view, in the Controls group, click the Line button.

2. Click the location where you want the horizontal line to appear.

3. Press $ to display the Property Sheet pane. Then set the Left, Width, and Border 
Color properties as desired.

To align the columns of a report, page 232

1. In   Design view, select the label and text box for the column you want to align.

2. Press $ to display the Property Sheet pane. Then set the Left and Width properties 

to precisely align the column on the page.
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3. Repeat Step 2 for each column you want to align.

To change the Design view grid for a report, page 235

1. In  Design view, click the Report selector, and then press $ to open the Property 
Sheet pane.

2. On the Format tab, change the Grid X and Grid Y properties to the number of dots 

per inch that you want to show on the grid.

To set the height of a section in a report, page 235

 � Click  the section, and on the Format tab in the Property Sheet pane, set the 

Height property to the measurements you want.

To save a new report, page 236

1. On   the Quick Access Toolbar, click the Save button. 

2. In the Save As dialog box, type a name for the new report in the Report Name 

box, and then click OK.

To insert a title in a report, page 237

 � Open  the report in Design view. Then on the Design contextual tab, in the 

Controls group, click the Title button.

To insert a page number in a report, page 238

1. Open   the report in Design view. Then in the Controls group, click the Insert Page 
Number button. 

2. In the Page Numbers dialog box, select the desired format, position, and alignment 

options. Then click OK.

To insert a subreport in a report, page 240

1. Open  the main report in Design view. Then double-click the Report Selector to 

display the Property Sheet pane.

2. On the Data tab, click the Record Source arrow, and select the table or query on 

which the subreport will be based.

3. On the Design contextual tab, in the Controls group, click the Subform/Subreport 
button, and then click a point on the main report.

4. In the Subreport wizard, with the Use existing Tables and Queries option selected, 

click Next.

5. In the Tables/Queries list, click the query you want to use.

6. In the Available Fields list, double-click the fi elds you want to use to move them to 

the Selected Fields list, and then click Next.

7. Select the appropriate options to defi ne the fi elds you want to include in the 

subform.
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8. Click Next, and then click Finish.

To view a report in Print Preview mode, page 247

 O If   the report is not open, right-click it in the Navigation Pane, and then click Print 
Preview.

 O If the report is open, on the Home tab, in the Views group, click the View arrow, 

and then click Print Preview, or click the Print Preview button on the View toolbar.

To view a report in Layout View mode, page 248

 O If   the report is not open, right-click it in the Navigation Pane, then click Layout View.

 O If the report is open, on the Home tab, in the Views group, click the View arrow, 

and then click Layout View, or click the Layout View button on the View toolbar.

To print a report, page 248

1. Either   open the report or select it in the Navigation Pane.

2. Click the Microsoft Offi ce Button, and then click Print.

3. In the Print dialog box, set the properties you want, and then click OK.

9 Making Your Database Easy to Use

To create a switchboard, page 253

1. On  the Database Tools tab, in the Database Tools group, click the Switchboard 
Manager button, and then click Yes if Access asks whether you want to create a 

switchboard.

2. With Main Switchboard (Default) selected in the Switchboard Pages list, click Edit. 

3. In the Switchboard Name box, replace Main Switchboard with a name for your 

switchboard. Then click Close.

To add a new page to a switchboard, page 254

1. On  the Database Tools tab, in the Database Tools group, click the Switchboard 
Manager button.

2. In the Switchboard Manager window, select the type of switchboard you want, 

and then click New.

3. Replace the default new switchboard page name with the name you want, and 

then click OK.

To create a button on a switchboard page, page 255

1. On   the Database Tools tab, in the Database Tools group, click the Switchboard 
Manager button.

2. With the switchboard selected in the Switchboard Pages list, click Edit.
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3. In the Edit Switchboard Page window, click New.

4. In the Edit Switchboard Item dialog box, in the Text box, type a name for the 

button label.

5. If you want to change the command assigned to the button, click the Command 

arrow, and then click your selection in the list.

6. If there is a box below the Command box, click the arrow next to it, and in the list, 

select the appropriate option. Then click OK.

7. In the Edit Switchboard Item dialog box, click OK.

To create a custom category, page 260

1. Right-click  the category header at the top of the Navigation Pane, and then click 

Navigation Options.

2. In the Grouping Options area of the Navigation Options dialog box, click the Add 
Item button.

3. Replace the default name of the new category with the name you want, and then 

press F.

4. Click the Add Group button, and then in the Groups list, replace Custom Group 1 

with the new group name.

5. In the Navigation Options dialog box, click OK.

To add shortcuts to a category, page 261

1. Click   the category header at the top of the Navigation Pane, and then click the 

custom category that you want to add shortcuts to.

2. In the Unassigned Objects group, click the object you want to add to a custom 

group, and drag the object on top of the desired group header to add a shortcut 

to the group; or right-click the desired object, point to Add to group, and click the 

group you want to add the shortcut to.

To add any command to the Quick Access Toolbar, page 268

1. At  the right end of the Quick Access Toolbar, click the Customize Quick Access 
Toolbar button.

2. Near the bottom of the Customize Quick Access Toolbar menu, click More 
Commands.

3. In the Access Options window, click the Choose commands from arrow, and in the 

list, click the area from which you want to add a command.

4. In the available commands list, locate and click the command you want to add to 

the Quick Access Toolbar. Then between the two command lists, click Add.

5. At the bottom of the Customize page, click OK.
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To reposition commands on the Quick Access Toolbar, page 270

1. On  the Customize page of the Access Options window, click the command you 

want to move, and then click the Move Up or the Move Down button until the 

command is in the position you want.

2. At the bottom of the Customize page, click OK.

To add a command from the Ribbon to the Quick Access Toolbar, page 271

 � Right-click   the command on the Ribbon, and then click Add to Quick Access 
Toolbar.

To remove a command from the Quick Access Toolbar, page 271

1. At   the right end of the Quick Access Toolbar, click the Customize Quick Access 
Toolbar button.

2. Near the bottom of the Customize Quick Access Toolbar menu, click More 
Commands.

3. In the toolbar commands list, click the command you want to remove. Then between 

the two command lists, click Remove.

4. At the bottom of the Customize page, click OK.

10 Securing and Sharing Information

To assign a password to a database, page 276

1. Start  Access 2007.

2. Click the Microsoft Offi ce Button, and then on the menu, click Open.

3. In the Open dialog box, navigate to the folder where the database is located, and 

click the database to select it. Then click the Open arrow, and in the list, click Open 
Exclusive.

4. On the Database Tools tab, in the Database Tools group, click the Encrypt with 
Password button.

5. In the Password box of the Set Database Password dialog box, type a password, 

and then press the D key.

6. In the Verify box, type the same password you typed in the Password box. Then 

click OK.

To test a database password, page 277

1. Open  the database.

2. In the Enter database password box of the Password Required dialog box, type an 

incorrect password, and then click OK.



lxiv  Quick Reference

 

 

 
 
 

 

 

 

 
 

 
 

 

 
 

 

3. In the Microsoft Offi ce Access message box warning you that the password you 

entered is not valid, click OK. 

4. In the Password Required dialog box, type the correct password, and then click OK.

To remove a password from a database, page 277

1. Start  Access 2007.

2. Click the Microsoft Offi ce Button, and then on the menu, click Open.

3. In the Open dialog box, navigate to the folder where the database is located, and 

click the database to select it. Then click the Open arrow, and in the list, click Open 
Exclusive.

4. On the Database Tools tab, in the Database Tools group, click the Decrypt 
Database button.

5. In the Password box of the Unset Database Password dialog box, type the current 

password, and then click OK.

To secure VBA code in a database by using a password, page 278

1. Open   a database, and on the Database Tools tab, in the Macro group, click the 

Visual Basic button.

2. On the Tools menu of the Visual Basic Editor, click Base Properties.

3. On the Protection tab of the Project Properties dialog box, select the Lock project 
for viewing check box.

4. In the Password box, type a password, and then press the D key.

5. In the Confi rm Password box, type the same password you entered in the 

Password box, and then click OK.

6. Close the Visual Basic Editor, and then close the database.

To test a VBA-securing password, page 279

1. Open  the database.

2. On the Database Tools tab, in the Macro group, click the Visual Basic button (or 

press J+~).

3. Click the Expand button to the left of the database project.
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4. In the Password dialog box, type the password for the database, and then click OK.

To remove the security from the VBA code in a database, page 280

1. On   the Visual Basic Editor Tools menu, click Base Properties.

2. On the Protection tab, clear the Lock project for viewing check box, and delete 

the asterisks from the two password boxes. Then click OK.

To secure a database by saving it as a distributable ACCDE fi le, page 282

1. Open   a database, and on the Database Tools tab, in the Database Tools group, 

click the Make ACCDE button.

2. In the Save As dialog box, navigate to the folder you want to save the fi le in, and 

then click Save.
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  1 1 Exploring  Exploring 
  Access 2007  Access 2007

In this chapter, you will learn to:

 � Work in Access 2007.

 � Understand database concepts.

 � Open an existing database.

 � Explore tables, queries, forms, reports, and other Access objects.

 � Preview and print Access objects.

Microsoft Offi ce Access 2007 is part of the 2007 Microsoft Offi ce system, so the basic 

interface objects—such as the Offi ce menu, the Quick Access Toolbar, the Ribbon, and 

dialog boxes—will be familiar if you have used other Offi ce 2007 products. However, 

Access has more dimensions than most of those other products or programs, so it 

might seem more complex until you become familiar with it.

If you are upgrading from an earlier version of Access, then you should review “Introducing 

Access 2007” in the front of this book to learn about differences between earlier versions 

and Access 2007.

In this chapter, you will learn to work in the Access program window and learn about the 

concepts and structure of data storage in Access, including types of databases, types of 

Access objects, and relationships between objects. You will experiment with a complete 

working database, learning about interesting features of Access as well as functionality 

that you will explore in more depth in later chapters.

See Also Do you need only a quick refresher on the topics in this chapter? See the Quick 
Reference entries on pages xxxix–lxv.

Important Before you can use the practice fi les in this chapter, you need to install them 

from the book’s companion CD to their default location. See “Using the Book’s CD” on page 

xxv for more information.
   1
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Troubleshooting Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and you 

experience trouble following the instructions as written, please refer to the “Information for 

Readers Running Windows XP” section at the beginning of this book.

Working in Access 2007
When you create or open a database, it opens in a database window. The  new Access 

database window interface is designed to more closely refl ect the way people generally 

work with a database or database object. 

Ribbon

Navigation Pane Document window

Microsoft Office Button
Quick Access Toolbar Title bar

The interface includes the following elements:

 O Commands related to managing databases (such as creating, saving, printing, 

backing up, and publishing) are available from the menu that appears when 

you click the  Microsoft Offi ce Button in the upper-left corner of the program 

window. This menu, which we refer to throughout this book as the  Offi ce menu, 

takes the place of the File menu that appeared in pre-vious versions of Access.

 O Some commands are represented by buttons on the  Quick Access Toolbar to the 

right of the Microsoft Offi ce Button. By default, the database window Quick Access 

Toolbar displays the Save, Undo, and Redo buttons.  You can add commands to the 

Troubleshooting Graphics and operating system–related instructions in this book refl ect Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and youthe Windows Vista user interface. If your computer is running Microsoft Windows XP and you

experience trouble following the instructions as written, please refer to the “Information forexperience trouble following the instructions as written, please refer to the “Information for

Readers Running Windows XP” section at the beginning of this book.Readers Running Windows XP” section at the beginning of this book.
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Quick Access Toolbar so that they are available regardless of which tab or object is 

currently active in the database window.

See Also For information about customizing the Quick Access Toolbar commands 
and location, see “Making Favorite Access Commands Quickly Available” in Chapter 9, 
“Making Your Database Easy to Use.”

 O The  title bar displays the name of the active database object (if it is maximized). 

At the right end of the title bar are the three familiar buttons that have the same 

function in all Windows programs.  You can temporarily hide the Access window by 

clicking the Minimize button , adjust the size of the window by clicking the Restore 

Down/Maximize button , and close the active window or quit Access by clicking the 

Close button .

 O Below  the title bar is the Ribbon, a  new feature in many of the programs in the 

Offi ce system. Commands are presented on the Ribbon rather than on the more-

traditional menus or toolbars so that you can work most effi ciently within the win-

dow. The Ribbon is organized into task-specifi c  tabs, which are further divided into 

feature-specifi c or task-specifi c groups of commands.

 O The buttons in each group change size depending on the width of the program 

window. They might be large, small, or wide, and might be labeled with the button 

name, icon, or both. Pointing to any button displays the button name in a ScreenTip 

that sometimes also describes the button’s function.

Some      buttons have arrows, but not all arrows function the same way. If you point 

to a button that has an arrow is incorporated into the button body, clicking the 

button will display a list of options for you to choose from. If the arrow is separate 

from the button body, clicking the arrow will display a list of options and clicking 

the button will perform the currently selected action.

 O Related but less common commands are not represented in a group as buttons. 

Instead they are available from a dialog box, which you can display by clicking the 

 Dialog Box Launcher at the right end of the group title bar.

 O The Microsoft Offi ce Access Help button appears at the right end of the Ribbon.

 O The Navigation Pane displays fi ltered lists of database objects. You can change the 

objects included in the list by clicking the list header and then clicking the category 

or group of objects you want to display.

The goal of the redesigned environment is to make working within an item window 

more intuitive. Commands for tasks you perform often are no longer hidden on menus 

and in dialog boxes, and features that you might not have discovered before are now 

plainly visible.

Dialog Box 
Launcher

Dialog Box 
Launcher
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By default, Access 2007 displays database objects as   tabbed documents in the document 

window. If you prefer to display each object in a separate window rather than on a sepa-

rate tab, you can do so by clicking Access Options on the Offi ce menu, and then on the 

Current Database page, selecting the   Overlapping Windows option. 

When displaying Tabbed Documents, a Close button for the active database object ap-

pears to the right of the document tabs. When displaying Overlapping Windows, in a 

maximized database object window, the Minimize, Maximize/Restore Down, and Close 

buttons for the object window appear on the right end of the Ribbon, and the Access 

icon appears to the left of the Home tab. Clicking the Access icon opens the control 

menu , displaying a list of commands related to managing the active object window: 

Restore, Move, Size, Minimize, Maximize, and Close. When not maximized, clicking the 

object icon at the left end of the object window title bar displays the control menu.

In this exercise, you will take a tour of the command structure in an Access 2007 

database window.

USE the 01_Working database. This practice fi le is located in the Chapter01 subfolder 

under SBS_Access2007.

1. On the Start menu, click Documents. Then in your Documents folder, browse to 

the MSP\SBS_Access2007\Chapter01 subfolder, and double-click the 01_Working 

database.

The database opens, with the Navigation Pane displaying the All Access Objects 

list. In the   database window, the Ribbon includes four tabs:

O Home

O Create

O External Data

O Database Tools

Tip Depending on what programs are installed on your computer, tabs and groups 

other than those described here might also appear on the Ribbon.

USE the the 01_Working01_Working database. This practice fi le is located in the database. This practice fi le is located in the Chapter01Chapter01 subfolder  subfolder 

under under SBS_Access2007SBS_Access2007..7777
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The   Home tab is active by default. Because no database object is currently open, 

only a few buttons on the Home tab are available.

 2. In the upper-left corner of the database window, click the   Microsoft Offi ce Button.

The Offi ce menu opens.

You can create a database, but not a database object, from this menu. We’ll talk 

about the commands available from the Offi ce menu in other chapters of this 

book.

 3. Click away from the Offi ce menu to close it.

 4. In the Navigation Pane, under Tables, double-click Categories.

The Categories table opens, an associated Table Tools contextual tab (Datasheet) 

appears, and more of the Home tab becomes active. 

Microsoft Offi ce 
Button

Microsoft Offi ce 
Button
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GroupsAccess Ribbon tabs Contextual tab

Buttons representing commands related to working with database content are 

organized on this tab in seven groups:

O Views

O Clipboard

O Font

O Rich Text

O Records

O Sort & Filter

O Find

Only    the buttons for the commands that can be performed on the currently 

selected database object are active.

Important Depending   on your screen resolution and the size of the database 

window, you might see more or fewer buttons in each of the groups, the buttons 

you see might be represented by larger or smaller icons than those shown, or the 

group might be represented by a button that you click to display the group’s com-

mands. Experiment with the size of the database window to understand the effect 

on the appearance of the tabs.
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 5. On  the Home tab, click the Font Dialog Box Launcher.

The Datasheet Formatting dialog box opens.

You can access certain settings not available from the Font group, such as Cell 

Effect and Border Styles, from this dialog box.

 6. In the Datasheet Formatting dialog box, click Cancel.

 7. Click the   Create tab.

Buttons representing commands related to creating database objects are organized 

on this tab in four groups:

 O Tables

 O Forms

 O Reports

 O Other

 8. Double-click the Create tab.

Double-clicking  the active tab hides the Ribbon and provides more space for the 

active database object.

Dialog Box 
Launcher

Dialog Box 
Launcher
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9. Click the External Data tab.

The Ribbon reappears, with the External Data tab active. 

Buttons representing commands related to moving information between a database 

and other sources are organized on this tab in four groups:

O Import

O Export

O Collect Data

O SharePoint Lists

10. Click anywhere in the open table.

The Ribbon hides again. When you hide the Ribbon, it remains hidden except when 

active, until you again double-click a tab.

11. Double-click   the Database Tools tab to display the tab and redisplay the Ribbon.
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Buttons representing commands related to managing, analyzing, and protecting 

information are organized on this tab in fi ve groups:

 O Macro

 O Show/Hide

 O Analyze

 O Move Data

 O Database Tools

CLOSE the 01_Working database.

Understanding Database Concepts
Simple database programs, such as the Database component of Microsoft Works, can 

store information in only one table. These simple databases are often called fl at fi le data-

bases, or just fl at databases.  More   complex database programs, such as Access, can store 

information in multiple related tables, thereby creating what are referred to as relational 
databases. If the information in a relational database is organized correctly, you can treat 

these multiple tables as a single storage area and pull information electronically from dif-

ferent tables in whatever order meets your needs.

A  table is just one of the types of objects that you can work with in Access. Other object 

types include queries, forms, reports, pages, macros, and modules.

Of  all these object types, only one—the table—is used to store information. The rest are 

used to manage, manipulate, analyze, retrieve, display, or publish information stored in a 

table—in other words, to make the information as accessible and therefore as useful as 

possible.

Tip Access   2007 introduces a new file storage format that uses the .accdb extension. 

You can open old Access databases (with an .mdb extension) in Access 2007 and save 

them in the new format, but after they’re converted, you will not be able to open them 

with a previous version of Access.

The new format supports many new features. For more information about this format, 

search Access Help for accdb.

Over the years, Microsoft has put a lot of effort into making Access not only one of the 

most powerful consumer database programs available, but also one of the easiest to 

learn and use. Because  Access is part of the Microsoft Offi ce system, you can use many 
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of the techniques you know from using other Offi ce programs, such as Microsoft Offi ce 

Word and Microsoft Offi ce Excel, when using Access. For example, you can use familiar 

commands, buttons, and keyboard shortcuts to open and edit the information in Access 

tables. And  because Access is integrated with other members of the suite, you can easily 

share information between Access and Word, Excel, or other programs.

In  its most basic form, a database is the electronic equivalent of an organized list of 

information. Typically, this information has a common subject or purpose, such as the 

list of employees shown here:

ID Last name First name Title Hire date

1 Anderson Nancy Sales Rep May 1, 2003

2 Carpenter Chase Sales Manager Aug 14, 2001

3 Emanuel Michael Sales Rep Apr 1, 1999

4 Furse Karen Buyer May 3, 2004

This list is arranged in a table of columns and rows.  Each column represents a fi eld—a 

specifi c type of information about an employee: last name, fi rst name, hire date, and so 

on.  Each row represents a record—all the information about a specifi c employee.

If a database did nothing more than store information in a table, it would be no more 

useful than a paper list. But because the database stores information in an electronic 

format, you can manipulate the information in powerful ways to extend its utility.

For example, if you want to locate a person or a business in your city, you can do so 

because the information in the telephone book is organized in an understandable 

manner. If you want to get in touch with someone a little further away, you can go to 

the public library and use its collection of phone books, which probably includes one for 

each major city in the country. However, if you want to fi nd the phone numbers of all 

the people in the country with your last name, or if you want to fi nd the phone number 

of your grandmother’s neighbor, these phone books won’t do you much good because 

they aren’t organized in a way that makes that information easy to fi nd.

When the information published in a phone book is stored in a database, it takes up 

far less space, it costs less to reproduce and distribute, and, if the database is designed 

correctly, the information can be retrieved in many ways. The real power of a database 

isn’t in its ability to store information; it is in your ability to quickly retrieve exactly the 

information you want from the database.

Because you can use standard Web programming code to easily manipulate the infor-

mation in an Access 2007 database, you can create Web sites based on the information 

in your database or share that information with visitors to your site.
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Opening an Existing Database
Throughout this book, you will be working with databases that contain information 

about the employees, products, suppliers, and customers of a fi ctional company. As you 

complete the exercises in this book, you will develop an assortment of queries, forms, 

reports, data access pages, macros, and modules that can be used to enter, edit, and 

manipulate the information in many ways.

When you start Access without opening a database, you see the Getting Started With 

Microsoft Offi ce Access window . You  can return to this window at any time by clicking 

the Microsoft Offi ce Button and then clicking New.

From this window you can open a blank database, create a new database from one 

of the many templates supplied with Access, from a template you download from the 

Microsoft Offi ce Online Web site, or from a custom template saved on your computer or 

on a network share. You can also open a database you worked in recently, or navigate to 

any database on your computer and open it.

From the section at the bottom of the Getting Started window, you can link to the 

Microsoft Offi ce Online Web site , where you can fi nd information about all aspects of 

Offi ce and download useful tools.
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Enabling Macros and Other Database Content
Some databases, such as those provided for your use in this book, contain 

Microsoft Visual Basic for Applications (VBA) macros that can run code on your 

computer. In most cases, the code is there to perform a database-related task, but 

hackers can also use macros to spread a virus to your computer.

When you open a database containing one or more macros,    if the database is not 

stored in a Trusted Location or signed by a Trusted Publisher, Access displays a 

security warning just below the Ribbon.

While the security warning is displayed, the macros in the database are disabled. 

You can enable macros in three ways:

O By enabling the macros in the database for use in the current database session.

O By adding the database publisher to a list of Trusted Publishers. Access will 

automatically enable macro content in any database signed by that publisher.

O By placing the database in a Trusted Location. Access will automatically enable 

macro content in any database saved in that location. The Trusted Locations 

you specify within Access are not also trusted by other Offi ce programs.

To enable macros for the current database session only:

 1. In the Security Warning area, click Options.

 2. In the Microsoft Offi ce Security Options dialog box, select the Enable this 
content option, and then click OK.

To add the publisher of a digitally signed database to the Trusted Publishers list:

 1. In the Security Warning area, click Options.

 2. In the Microsoft Offi ce Security Options dialog box, select the Trust all 
documents from this publisher option, and then click OK.

To add the location of this database to the Trusted Locations list:

 1. In the Microsoft Offi ce Security Options dialog box, click Open the Trust 
Center.

 2. In the page list in the left pane of the Trust Center, click Trusted Locations.

 3. On the Trusted Locations page, click Add new location.

Enabling Macros and Other Database Content
Some databases, such as those provided for your use in this book, containSome databases, such as those provided for your use in this book, contain

Microsoft Visual Basic for Applications (VBA) macros that can run code on yourMicrosoft Visual Basic for Applications (VBA) macros that can run code on your

computer. In most cases, the code is there to perform a database-related task, butcomputer. In most cases, the code is there to perform a database-related task, but

hackers can also use macros to spread a virus to your computer.hackers can also use macros to spread a virus to your computer.

When you open a database containing one or more macros,When you open a database containing one or more macros, if the database is not  if the database is not 

stored in a Trusted Location or signed by a Trusted Publisher, Access displays a stored in a Trusted Location or signed by a Trusted Publisher, Access displays a 

security warning just below the Ribbon. just below the Ribbon.

While the security warning is displayed, the macros in the database are disabled. While the security warning is displayed, the macros in the database are disabled. 

You can enable macros in three ways:You can enable macros in three ways:

O By enabling the macros in the database for use in the current database session.By enabling the macros in the database for use in the current database session.

O By adding the databaseBy adding the database publisher to a list of Trusted Publishers. Access will  to a list of Trusted Publishers. Access will r
automatically enable macro content in any databaseautomatically enable macro content in any database signed by that publisher.by that publisher.d

O By placing the database in a Trusted Location. Access will automatically enableBy placing the database in a Trusted Location. Access will automatically enable

macro content in any database saved in that location. The Trusted Locationsmacro content in any database saved in that location. The Trusted Locations

you specify within Access are not also trusted by other Offi ce programs.you specify within Access are not also trusted by other Offi ce programs.

To enable macros for the current database session only:To enable macros for the current database session only:

1. 1. In theIn the Security WarningSecurity Warning area, click area, click OptionsOptions..

2. 2. In theIn the Microsoft Offi ce Security OptionsMicrosoft Offi ce Security Options dialog box, select the dialog box, select the Enable this Enable this 
contentcontent option, and then click option, and then click OKOK..

To add the publisher of a digitally signed database to the Trusted Publishers list:To add the publisher of a digitally signed database to the Trusted Publishers list:

1. 1. In theIn the Security WarningSecurity Warning area, click area, click OptionsOptions..

2. 2. In theIn the Microsoft Offi ce Security OptionsMicrosoft Offi ce Security Options dialog box, select the dialog box, select the Trust allTrust all
documents from this publisherdocuments from this publisher option, and then clickoption, and then click OKOK..

To add the location of this database to the Trusted Locations list:To add the location of this database to the Trusted Locations list:

1. 1. In theIn the Microsoft Offi ce Security OptionsMicrosoft Offi ce Security Options dialog box, click dialog box, click Open the TrustOpen the Trust
CenterCenter..rrrr

2. 2. In the page list in the left pane of theIn the page list in the left pane of the Trust CenterTrust Center, click, clickrr Trusted LocationsTrusted Locations..

3. 3. On theOn the Trusted LocationsTrusted Locations page, click  page, click Add new locationAdd new location..
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 4. In the Microsoft Offi ce Trusted Location dialog box, click Browse.

 5. In the Browse dialog box, browse to the folder containing the current 

database, and then click OK.

 6. In the Microsoft Offi ce Trusted Location dialog box, select the Subfolders of 
this location are also trusted check box if you want to do so, and then click 

OK in each of the open dialog boxes.

If you prefer, you can change the way Access handles macros in all databases:

 1. Click the Microsoft Offi ce Button, and then click Access Options.

 2. On the Trust Center page of the Access Options dialog box, click Trust 
Center Settings.

 3. On the Macro Settings page of the Trust Center, select the option for the 

way you want Access to handle macros:

O Disable all macros without notifi cation. If a database contains macros, 

Access disables them and doesn’t display the security warning to give 

you the option of enabling them.

O Disable all macros with notifi cation. Access disables all macros and 

displays the security warning.

O Disable all macros except digitally signed macros. Access automatically 

enables digitally signed macros.

O Enable all macros. Access enables all macros.

 4. Click OK in the Trust Center and in the Access Options dialog box.

In this exercise, you will open a database, explore some of the objects it contains, and 

then close the database.

USE the 03_Opening database. This practice fi le is located in the Chapter01 subfolder 

under SBS_Access2007.

BE SURE TO start your computer, but don’t start Access before starting this exercise.

1. On    the Start menu, point to All Programs, click Microsoft Offi ce, and then click 

Microsoft Offi ce Access 2007.

The Getting Started With Microsoft Offi ce Access window opens.

2. In   the Open Recent Database list, click More.

4. 4. In theIn the Microsoft Offi ce Trusted LocationMicrosoft Offi ce Trusted Location dialog box, click dialog box, click BrowseBrowse..

5. 5. In the In the BrowseBrowse dialog box, browse to the folder containing the current  dialog box, browse to the folder containing the current 

database, and then click database, and then click OKOK..

6. 6. In theIn the Microsoft Offi ce Trusted LocationMicrosoft Offi ce Trusted Location dialog box, select the dialog box, select the Subfolders of Subfolders of 
this location are also trustedthis location are also trusted check box if you want to do so, and then click  check box if you want to do so, and then click 

OKOK in each of the open dialog boxes. in each of the open dialog boxes.KK

If you prefer, you can change the way Access handles macros in all databases:If you prefer, you can change the way Access handles macros in all databases:

1. 1. Click theClick the Microsoft Offi ce ButtonMicrosoft Offi ce Button, and then click , and then click Access OptionsAccess Options..

2. 2. On theOn the Trust CenterTrust Center page of the  page of the Access OptionsAccess Options dialog box, click  dialog box, click TrustTrust
Center SettingsCenter Settings..

3. 3. On theOn the Macro SettingsMacro Settings page of the  page of the Trust CenterTrust Center, select the option for the, select the option for therrrr
way you want Access to handle macros:way you want Access to handle macros:

O Disable all macros without notifi cationDisable all macros without notifi cation. If a database contains macros,. If a database contains macros,

Access disables them and doesn’t display the security warning to give Access disables them and doesn’t display the security warning to give 

you the option of enabling them.you the option of enabling them.

O Disable all macros with notifi cationDisable all macros with notifi cation. Access disables all macros and. Access disables all macros and

displays the security warning.displays the security warning.

O Disable all macros except digitally signed macrosDisable all macros except digitally signed macros. Access automatically . Access automatically 

enables digitally signed macros.enables digitally signed macros.

O Enable all macrosEnable all macros. Access enables all macros.. Access enables all macros.

4. 4. Click Click OKOK in the in the KK Trust CenterTrust Center and in theand in the Access OptionsAccess Options dialog box. dialog box.

USE the the 03_Opening03_Opening database. This practice fi le is located in the database. This practice fi le is located in the Chapter01Chapter01 subfolder subfolder 

under under SBS_Access2007SBS_Access2007..7777

BE SURE TO start your computer, but don’t start Access before starting this exercise.start your computer, but don’t start Access before starting this exercise.
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 3. In the Open dialog box, navigate to your Documents\MSP\SBS_Access2007\
Chapter01 folder, and then double-click the 03_Opening database.

The  database window opens.

Troubleshooting If this is the fi rst time you’ve run Access, you might see a security 

warning below the Ribbon. Just ignore this warning for the moment, but be sure to 

read the sidebar “Enabling Macros and Other Database Content” to learn about Access 

security options.

The Navigation Pane on the left side of the program window lists the Access database 

objects. You can use the Navigation Pane to group and fi lter these objects in various 

ways.  You can display only one type of object (for example, all tables) by clicking the 

list title bar and then the category or group of objects you want to display.

If      the Navigation Pane is in your way, you can click the Shutter Bar Open/Close 

button  in its upper-right corner, or press F11, to minimize it. To redisplay the 

Navigation Pane, click the Shutter Bar Open/Close button or press F11.

Tip For more information about the Navigation Pane, search Access Help for 

navigation pane and read the topic Guide to the Navigation Pane.

 4. Click the Microsoft Offi ce Button, and then click Close Database.

When you close a database in this way, you return to the Getting Started window. 

Tip You   can close Access entirely by clicking the Close button in the upper-right corner 

of the window, or by clicking the Microsoft Offi ce Button and then clicking Exit Access.

Exploring Tables
Tables  are the core database objects. Their purpose is to store information. The purpose 

of every other database object is to interact in some manner with one or more tables. An 

Access database can contain thousands of tables, and the number of records each table 

can contain is limited more by the space available on your hard disk than by anything else.

Tip For     detailed information about Access specifi cations, such as the maximum size of a 

database or the maximum number of records in a table, search Access Help for “Access 2007 
specifi cations” (including the quotes).

Troubleshooting If this is the fi rst time you’ve run Access, you might see a securityIf this is the fi rst time you’ve run Access, you might see a security

warning below the Ribbon. Just ignore this warning for the moment, but be sure towarning below the Ribbon. Just ignore this warning for the moment, but be sure to

read the sidebar “Enabling Macros and Other Database Content” to learn about Access read the sidebar “Enabling Macros and Other Database Content” to learn about Access 

security options.security options.

      
Shutter Bar Open/Close

      
Shutter Bar Open/Close
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Every  Access object has two or more views.    For tables, the two most common views are 

Datasheet view, in which you can see and modify the table’s data, and Design view, in 

which you can see and modify the table’s structure.    To open a table in Datasheet view, 

either double-click its name in the Navigation Pane, or right-click its name and then click 

Open.    To open a table in Design view, right-click its name and then click Design View. 

   After an object is open, you can switch between views by clicking one of the View icons 

in the lower-right corner of the program window, or by clicking the View arrow in the 

Views group on the Home tab, and then selecting a view from the list. If you simply click 

the View button  Access switches between views in a manner that at times seems logical. 

If the current view is not Design view, it switches to Design view. If you click it again, the 

table switches to Datasheet view. When other database objects are active, clicking the 

View switches between views in a similar manner.

When  you view a table in Datasheet view, you see the table’s data in columns (fi elds) and 

rows (records).

Row

Column

If two tables have one or more fi elds in common, you can embed the datasheet from 

one table in another.  By using an embedded datasheet, called a subdatasheet, you can 

see the information in more than one table at the same time. For example, you might 

want to embed an Orders datasheet in a Customers table so that you can see the orders 

each customer has placed.

In this exercise, you will open existing database tables and explore the table structures in 

different views.
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USE the 04_Tables database. This practice fi le is located in the Chapter01 subfolder under 

SBS_Access2007.

BE SURE TO start Access and display the Getting Started window before beginning this 

exercise.

Tip In this database, the Navigation Pane fi lter has been set to display all Access 

objects, but the Queries, Forms, and Reports object groups are collapsed. You    can 

collapse and expand groups to display only the ones you want, or you can   fi lter the 

database objects by clicking the list header, and then clicking the option you want 

under Filter By Group.

1. Click the Microsoft Offi ce Button, and then click Open.

2. In the Open dialog box, browse to your Documents\MSP\SBS_Access2007\
Chapter01 folder, and double-click the 04_Tables database.

The database opens.

3. In the Navigation Pane, double-click Categories.

The Categories table opens in Datasheet view.

This table contains a list of product categories and fi elds such as Category ID, 

Category Name, and Description.

USE thethe 04_Tables04_Tables database. This practice fi le is located in the database. This practice fi le is located in the Chapter01Chapter01 subfolder under subfolder under 

SBS_Access2007SBS_Access2007..7777

BE SURE TO start Access and display the Getting Started window before beginning this start Access and display the Getting Started window before beginning this 

exercise.exercise.
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Tip You can open any database object by right-clicking it in the Navigation Pane and 

then clicking the view you want to open it in. Clicking Open opens the object in its 

default Datasheet.

Tip You   can resize a table column by dragging the vertical bar in the header that 

separates it from the column to its right.   You can set the width of a column to the 

width of its widest entry by double-clicking the vertical bar.

 4. Maximize the table window if it isn’t already maximized. Then in the datasheet, 

click   the Expand button at the left end of the record for the Bulbs category.

The Bulbs category expands to reveal an embedded subdatasheet. Access displays 

the category records from the Categories table and product records from the 

Products table simultaneously.

 5. Click     the Collapse button to the left of the Bulbs category to hide the 

subdatasheet.

 6. Click the Close Window button in the upper-right corner of the table, to the 

right of its tab (not the Close button in the upper-right corner of the program 

window) to close the Categories table. If Access prompts you to save changes to 

the table layout, click Yes.

 7. In the Navigation Pane, double-click the Orders table to open it in Datasheet view.

ExpandExpand

CollapseCollapse
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Record navigation bar View toolbar

The   record navigation bar at the bottom of the window indicates that this table 

contains 87 records, and that the active record is number 1 of 87.

8. Move    through the table one record at a time by clicking the  Next Record button 

several times.

The selection moves down the OrderID fi eld, because that fi eld contains the insertion 

point.

Tip You can move the selection one record at a time by pressing the Up Arrow or 

Down Arrow key, one screen at a time by pressing the Page Up or Page Down key, or 

to the fi rst or last fi eld in the table by pressing Ctrl+Home or Ctrl+End.

9. Move   directly to record 40 by selecting the current record number in the record 

navigation bar, typing 40, and then pressing F.

10. In the Navigation Pane, double-click the Products table to open it in Datasheet 

view.

Notice that the table contains 189 records.

Next RecordNext Record
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 11. On   the View toolbar, click the Design View button.

Datasheet view displayed the data stored in the table, whereas Design view displays 

the underlying table structure.

CLOSE the Products and Orders tables without saving your changes, and then close the 

04_Tables database to return to the Getting Started window.

Design ViewDesign View
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Exploring Queries
You can locate specifi c information stored in a table, or in multiple tables, by creating 

a query specifying the parameters of the information you want to fi nd. For example, 

you might want to locate all your out-of-state customers who have purchased gloves 

within the last three months. You could fi nd this information by sorting, fi ltering, and 

cross-referencing table data, but that would be a diffi cult and time-consuming task. It 

is far simpler to create a query that returns all records in the Customers table with bill-

ing addresses not in your state, whose customer IDs map to records that appear in the 

Transactions table within the past quarter and include item IDs that map to records in 

the Inventory table that are classifi ed as gloves. That might sound complicated, but the 

process of creating a query to return the results described in this example is quite simple.

Running a query (also called querying the database) displays a datasheet containing the 

records that fi t your search criteria. You can use the query results as the basis for further 

analysis, create other Access objects (such as reports) from the results, or export the re-

sults to another format, such as an Excel spreadsheet or a Microsoft SharePoint list.

If you will want to locate records matching the search criteria at any time in the future, 

you can save the query, and run it again from the Queries section of the Navigation Pane. 

Each time you run a query, Access evaluates the records in the specifi ed table (or tables) 

and displays the current subset of records that match the criteria you have defi ned.

Don’t worry if this all sounds a bit complicated at the moment. When you approach 

queries logically, they soon begin to make perfect sense.   You can easily create queries 

by using the Query wizard that is available to help you structure the query, and if you 

create a query that you are likely to run more than once, you can save it. It then becomes 

part of the database and is displayed when you click Queries in the Navigation Pane.

See Also For more information about queries, see Chapter 6, “Locating Specifi c Information.”

In this exercise, you will explore two existing queries.

USE the 05_Queries database. This practice fi le is located in the Chapter01 subfolder under 

SBS_Access2007.

OPEN the 05_Queries database.

 1. In  the Navigation Pane, click Queries.

The database window displays all the queries that have been saved as part of this 

database.

USE thethe 05_Queries05_Queries database. This practice fi le is located in the database. This practice fi le is located in the Chapter01Chapter01 subfolder under subfolder under 

SBS_Access2007SBS_Access2007..7777

OPEN thethe 05_Queries05_Queries database. database.
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2. Right-click  the Current Product List query, and then click Object Properties.

Access displays the properties of the Current Product List query, including a descrip-

tion of its purpose.  The icon shown on the General tab matches the icon shown 

for this query in the Navigation Pane, and is an indication of the query’s type. The 

query type is also specifi ed in the Properties dialog box: this is a Select Query.

3. In the Properties dialog box, click Cancel.

4. Right-click the Products by Category query, and then click Open.

Access processes the query (commonly referred to as running the query) and 

produces a datasheet displaying the results.
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The record navigation bar indicates that 171 records are displayed; the database 

actually contains 189 records. To fi nd out why 18 of the records are missing, you 

need to look at this query in Design view.

 5. On the View toolbar, click   the Design View button.

Access displays the query in Design view.

Two boxes in the top part of the query window list the fi elds in the tables this 

query is designed to work with. The query is formed in the design grid at the 

bottom of the query window. Each column of the grid can refer to one fi eld from 

one of the tables above. Notice that <> Yes (not equal to Yes) has been entered 

in the Criteria row for the Discontinued fi eld. This query fi nds all the records that 

don’t have a value of Yes in that fi eld (in other words, all the records that have 

not been discontinued).

 6. As an experiment, in the Criteria row of the Discontinued fi eld, replace <> with 

=, and then on the Design contextual tab, in the Results group, click the  Run 

button.

Tip You   can also run a query by switching to Datasheet view.

This time, the query fi nds all the records that have been discontinued.

Design ViewDesign View
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The 18 discontinued products account for the difference between the number 

of records in the Products table and the number of records displayed by the 

original query.

CLOSE the Products By Category query without saving your changes, and then close the 

05_Queries database.

Exploring Forms
Access tables are dense lists of raw information. It will probably be quite simple for you to 

work directly with tables in a database you create for your own use, but might be over-

whelming for people who don’t know much about databases. To make it easier to enter, 

retrieve, display, and print information, you can design forms through which people can 

interact with your database.

A   form is essentially a window containing controls that either display information to 

people or accept information that people enter.  Access provides a collection of standard 

Windows controls, such as labels, text boxes, option buttons, and check boxes. With a 

little ingenuity, you can create forms that look and work much like the dialog boxes in 

all Windows applications.
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A form acts as a friendly interface for a table. Through a form, you can display and edit 

the records of the underlying table, or create new records. As  with tables and queries, 

you can display forms in several views.  The three most common views are:

 O Form view, in which you enter data

 O Datasheet view, which looks essentially like a table

 O Design view, in which you work with the elements of the form to refi ne the way it 

looks and works

Most forms link to only one table, but if you want to link to multiple tables from one 

form, you can embed other forms (subforms) within a form (then referred to as the main 
form). The form shown above in Design view includes      label controls containing text that 

appears in the form in Form view, and text box controls that will contain data from the 

underlying table. Although you can create a form from scratch in Design view, you will 

probably use this view most often to refi ne forms you create by using a wizard.

In this exercise, you will explore forms, subforms, and the available form controls.

USE the 06_Forms database. This practice fi le is located in the Chapter01 subfolder under 

SBS_Access2007.

OPEN the 06_Forms database.

1. In the Navigation Pane, under Forms, double-click Orders.

The Orders form opens. This form consists of a main form and a subform. The main 

form displays information from the Orders table. The subform, which looks like a 

datasheet in the middle of the main form, displays the information from the Order 

Details table for the current record.

USE thethe 06_Forms06_Forms database. This practice fi le is located in the  database. This practice fi le is located in the Chapter01Chapter01 subfolder under subfolder under 

SBS_Access2007SBS_Access2007..7777

OPEN thethe 06_Forms06_Forms database.database.



 Exploring Forms  25
 2. In the form window, on the record navigation bar, click the Next Record button a 

few times to display the next few records.

Notice that the subform changes with each click to display the items purchased on 

that order.

 3. Click the Bill To arrow to display a list of all customers who have placed orders. 

This is an example of a list box control. 

 4. In the Navigation Pane, under Forms, double-click Products.

The Products form opens in Form view.

Next RecordNext Record
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The purpose of this form is to edit or create product records.

 5. On the Home tab, in the Views group, click the View arrow, and then in the list, 

click Design View.

This is the view in which you can add controls to a form.

 6. Note that two Form Design Tools contextual tabs, Design and Arrange, were added 

to the Ribbon when you switched to Design view. Switch to Form view and then 

back to Design view to see this happen.

Contextual tabs are available only when you are working on an object that needs 

the tools on it.

 7. On the Design contextual tab, point to each of the buttons in the center section of 

the Controls group to display the name of the control in a ScreenTip. You can use 

these controls to assemble custom forms for your database.

CLOSE the Orders and Products forms without saving your changes, and then close the 

06_Forms database.
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Tip To change the level of detail displayed in ScreenTips, click Access Options on the Offi ce 

menu. The ScreenTip Style list at the top of the Popular page displays the detail options: 

Show feature descriptions in ScreenTips, Don’t show feature descriptions in ScreenTips, and 

Don’t show ScreenTips.

Exploring Reports
You can display the information recorded in your tables in nicely formatted, easily 

accessible  reports, either on your computer screen or on paper. A report can include 

items of information selected from multiple tables and queries, values calculated from 

information in the database, and formatting elements such as headers, footers, titles, 

and headings.

You   can look at reports in four views: 

 O Design View, in which you can manipulate the design of a report in the same way 

that you manipulate a form.

 O Report View, where you can scroll through the information in the report without 

the page breaks inserted when it is printed.

 O Print Preview, in which you see your report exactly as it will look when printed.

 O Layout View, which displays the data in the report (similar to Print Preview) but en-

ables you to edit the layout.

In this exercise, you will preview a report as it will appear when printed.

USE the 07_Reports database. This practice fi le is located in the Chapter01 subfolder under 

SBS_Access2007.

OPEN the 07_Reports database.

 1. In   the Navigation Pane, under Reports, right-click    Customer Labels, and then click 

Print Preview.

The Customer Labels report opens. 

 2. Click the preview document to display a larger view of it.

USE thethe 07_Reports07_Reports database. This practice fi le is located in the database. This practice fi le is located in the Chapter01Chapter01 subfolder under subfolder under

SBS_Access2007SBS_Access2007..7777

OPEN thethe 07_Reports07_Reports database.database.
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Tip If the report is too small to read in Print Preview, you can adjust the zoom level 

by clicking the Zoom In button or dragging the Zoom slider that appears in the 

lower-right corner of the Print Preview window.

This report prints customer names and addresses in a mailing label format. You are 

looking at it in a view that is much like Print Preview in other Offi ce programs.

Tip Access provides a wizard that can help you create a mailing label report. You can 

also use the Customers table as a source document for the Word 2007 mail merge 

tool to create labels like these.

3. In the Navigation Pane, right-click the Sales by Category report, and then click 

Print Preview.

4. Scroll through a few pages of the multi-page report by clicking the navigation 

buttons at the bottom of the window.



 Exploring Reports  29
 5. On the View toolbar, click the Design View button.

Access displays the report in Design view. In this view, the report looks similar to a 

form. The techniques you use to create forms can also be used to create reports.

CLOSE the Customer Labels report and the Sales By Category report without saving your 

changes, and then close the 07_Reports database.

Design ViewDesign View
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Exploring Other Access Objects
Tables, queries, forms, and reports are the objects you will use most frequently in Access. 

You can use them to create powerful and useful databases. However, you can also use 

macros and modules to substantially extend the capabilities of Access.

Tip Previous  versions of Access included Data Access Pages. Access 2007 doesn’t include 

these objects. If you are familiar with Data Access Pages and need something like this, you 

can deploy your database to a collaboration site built with Microsoft SharePoint products 

and technologies, and use the tools provided there.

Macros
A macro is a simple program that performs multiple actions. You can  use a macro to 

have Access respond to an event such as the click of a button, the opening of a form, or 

the updating of a record. Macros can be particularly useful when you expect that other 

people who are less experienced with Access than you will work in your database. For 

example, you can make routine database actions, such as opening and closing forms 

or printing reports, available as command buttons on switchboards. And by grouping 

together an assortment of menu commands and having users carry them out with the 

click of a button, you can ensure that everyone does things the same way.

Modules
More  powerful than macros, modules are Microsoft Visual Basic for Applications (VBA) 

programs.  VBA is a high-level programming language developed by Microsoft for the 

purpose of creating Windows programs. A common set of VBA instructions can be used 

with all programs in the Microsoft Offi ce system, and each program has its own set as 

well. Whereas macros can automate four to fi ve dozen actions, VBA includes hundreds 

of commands and can be extended indefi nitely with third-party add-ins. You could use 

VBA to carry out tasks that are too complex to be handled with macros, such as opening 

an Excel spreadsheet and retrieving specifi c information.

Tip The Microsoft 2007 Offi ce system installation CD and the online resources include a 

variety of sample databases that illustrate many of the principles of creating and using a 

database. You can use these to learn more about Access features, or as templates for your 

own databases. 

One of these, the Northwind 2007 database, is used as an example in many topics in the 

Access Help system, so it is a particularly good database for you to explore. You’ll fi nd a link 

to this database in the Sample category in the Getting Started window.
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Previewing and Printing Access Objects
Because  Access is a Windows application, it interacts with your printer through standard 

Windows dialog boxes and drivers. This means that any printer that you can use from 

other programs can be used from Access, and any special features of that printer, such 

as color printing or duplex printing, are available in Access.

As you have seen in this chapter, you can use different Access objects—tables, forms, 

reports, and so on—to display the information stored in your database. Within each ob-

ject there are several views available: Design view, Datasheet view, and so on.  You can 

choose the view you want by selecting it from the View group on the Home tab (the 

views available will depend on the object that is active) or by clicking the buttons on 

the View toolbar at the right end of the status bar at the bottom of the window.

The print-related commands are available from the Microsoft Offi ce Button or on the 

Ribbon when their use would be appropriate, which is determined by the object displayed 

and the current view of that object.

In this exercise, you will preview and print a table and a form.

USE the 09_Print database. This practice fi le is located in the Chapter01 subfolder under 

SBS_Access2007.

OPEN the 09_Print database.

 1. In the Navigation Pane, expand the Tables list, and then double-click the 

Employees table to open it in Datasheet view.

This table contains information about nine employees. You can see that there are 

more fi elds than will fi t on the screen.

USE thethe 09_Print09_Print database. This practice fi le is located in the  database. This practice fi le is located in the tt Chapter01Chapter01 subfolder under subfolder under

SBS_Access2007SBS_Access2007..7777

OPEN thethe 09_Print09_Print database. database.tt
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 2. To display the fi rst page of the datasheet printout, click the    Microsoft Offi ce 
Button, point to Print, and then click Print Preview.

 3. Click the preview document once to zoom in, so the table content is legible.

 4. At the bottom of the Print Preview window, click the Next Page button.

This datasheet will print as three short pages if you print it with the current settings. 

Notice that the information on the second and third pages is a continuation of the 

table started on the fi rst page.

 5. On the Print Preview tab, in the Page Layout group, click     the Landscape button.

In Landscape orientation, the datasheet fi ts onto two pages.

Microsoft Offi ce 
Button

Microsoft Offi ce 
Button

Next PageNext Page
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Tip In this book, when we give instructions to implement a command we tell you 

on what tab and in which group the command button appears. When directing you 

to use multiple command buttons on the same tab, we might omit the tab name to 

avoid needless repetition.

 6. In the Print group, click the  Print button.

The Print dialog box opens. You can select the printer and set print options from 

this dialog box.

Tip If you just want to send this datasheet to your default printer, click the Microsoft 

Offi ce Button, point to Print, and then click Quick Print.

 7. Close the Print dialog box and then in the Close Preview group, click   the  Close 
Print Preview button.

 8. In the Navigation Pane, under Forms, double-click Employees.

The Employees form opens in Form view.

The information for each employee appears on its own page. Notice that there are 

two tabs at the top of the page, one for company information and one for personal 

information.

 9. Click the Personal Info tab to see the information that is listed there, and then re-

turn to the Company Info tab.
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 10. Click the Microsoft Offi ce Button, point to Print, and then click Print Preview to 

preview the printout.

Notice that the preview shows information from only the active form tab. If you 

want to print information that appears on a different tab, you fi rst need to select 

that tab.

 11. On the View toolbar, click the  Form View button to return to that view.

See Also You use essentially the same methods to print information displayed in different 
Access objects. For more information, see “Previewing and Printing a Report” in Chapter 8, 
“Working with Reports.”

CLOSE the Employees table and the Employees form without saving your changes, and 

then close the 09_Print database.

Form ViewForm View
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Key Points
 O Access is part of the Microsoft Offi ce system, so the basic interface objects—

menus, toolbars, dialog boxes—work much the same as other Offi ce products or 

other Windows applications.

 O A database is the computer equivalent of an organized list of information. The 

power of a database is in your ability to organize and quickly retrieve precise infor-

mation from it, and then to manipulate, share, and distribute or use this informa-

tion in various ways. In Access, data is organized in tables comprised of columns 

and rows, called fi elds and records. Access is a relational database, so you can treat 

the multiple tables in one database as a single storage area and easily pull informa-

tion from different tables in whatever order and format that suits you.

 O The types of objects you can work with in Access include tables, queries, forms, 

reports, macros, and modules. Tables are the core database objects and the pur-

pose of every other database object is to interact with one or more tables.

 O Every Access object has two or more views. For example, you view data in a table in 

Datasheet view and defi ne how the data is displayed in Design view.

 O One way to locate information in an Access database is to create and run a query. 

You use queries to fi nd information so that you can view, change, or analyze it in 

various ways. You can view queries in Datasheet view or Design view. You can use 

the results of a query as the basis for other Access objects, such as a form or report.

 O Forms make it easy for users to enter, retrieve, display and print information stored 

in tables. A form is essentially a window in which you can place controls that either 

give users information or accept information they enter. Forms can be viewed in 

Form view, Datasheet view, or Design view.

 O Reports display information from your tables in a nicely formatted, easily acces-

sible way, either on your computer screen or on paper. A report can include items 

of information from multiple tables and queries, values calculated from information 

in the database, and formatting elements such as headers, footers, titles, and head-

ings. Reports can be viewed in Design view, Print Preview, and Layout Preview.

 O Macros and modules substantially extend the capabilities of Access. Macros can 

be used to make routine database actions available as command buttons in 

forms, which help less experienced users work in your database. Modules are VBA 

programs. Whereas macros can automate many actions, VBA can be used to carry 

out tasks that are too complex to be handled with macros.
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22 Creating a  Creating a 
 Database Database

In this chapter, you will learn to:

 � Create a database from a template.

 � Create a table manually or from a template.

 � Manipulate table columns and rows.

Creating the structure for a database is easy. But an empty database is no more useful 

than an empty document or worksheet.  It is only when you fi ll, or populate, a database 

with data in tables that it starts to serve a purpose. As you add queries, forms, and reports, 

it becomes easier to use.  If you customize it with a switchboard or custom categories and 

groups, it moves into the realm of being a database application.

Not  every database has to be refi ned to the point that it can be classifi ed as an appli-

cation. Databases that only you or a few experienced database users will work with can 

remain fairly rough-hewn. But if you expect an administrative assistant to enter data or 

your company’s executives to generate their own reports, spending a little extra time 

in the beginning to create a solid database application will save a lot of work later. 

Otherwise, you’ll fi nd yourself continually repairing damaged fi les or walking people 

through seemingly easy tasks.

Microsoft  Offi ce Access 2007 takes a lot of the diffi cult and mundane work out of creating 

and customizing a database by providing database applications in the form of templates 
that you modify and fi ll with your own information. Access 2007 also provides templates 

for common types of tables, and improved ways to import content from other applications 

to instantly create and populate tables. Using one of these methods to create something 

that is similar to what you need and then modifying your creation is generally easier than 

creating the same thing manually. If none of the templates or import methods match your 

needs, you can create tables manually—another process that has been improved in this 

version of Access.
  37
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In this chapter, you will create a database from a template, create a table manually, and 

create a single table from a template. Then, you’ll adjust the display of a data table to fi t 

your needs. By the end of this chapter, you will have a database containing three tables 

that will serve as the foundation for many of the exercises in this book.

See Also Do you need only a quick refresher on the topics in this chapter? See the Quick 
Reference entries on pages xxxix–lxv.

Important Before you can use the practice fi les in this chapter, you need to install them 

from the book’s companion CD to their default location. See “Using the Book’s CD” on page 

xxv for more information.

Troubleshooting Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and you 

experience trouble following the instructions as written, please refer to the “Information for 

Readers Running Windows XP” section at the beginning of this book.

Creating a Database from a Template
A   few years ago (the distant past in computer time), creating a database structure in-

volved fi rst analyzing your needs and then laying out the database design on paper. 

You would decide what information you needed to track and how to store it in the data-

base. Creating the database structure could be a lot of work, and after you created it and 

entered data, making changes could be diffi cult. Templates have changed this process. 

Committing yourself to a particular database structure is no longer the big decision it once 

was.  By using pre-packaged templates, you can create a dozen database applications in 

less time than it used to take to sketch the design of one on paper. Access templates might 

not create exactly the database application you want, but they can quickly create some-

thing very close that you can tweak to fi t your needs.

In this exercise, you will open and explore a database application based on the Contacts 

template. This  template is typical of those provided with Microsoft Offi ce Access 2007, 

in that it looks nice and demonstrates a lot of the neat things you can do in a database, 

such as adding command buttons and embedded macros to link to other Offi ce applica-

tions or Windows commands. Due to the complexity of these templates, you probably 

shouldn’t try to modify them until you are comfortable working with simpler tables and 

forms in Design view. There are no practice fi les for this exercise.

Troubleshooting Graphics and operating system–related instructions in this book refl ect Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and youthe Windows Vista user interface. If your computer is running Microsoft Windows XP and you

experience trouble following the instructions as written, please refer to the “Information forexperience trouble following the instructions as written, please refer to the “Information for

Readers Running Windows XP” section at the beginning of this book.Readers Running Windows XP” section at the beginning of this book.
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BE SURE TO start Access before beginning this exercise.

1. In the Template Categories list, click Local Templates.

Tip When     you are connected to the Internet, you can fi nd additional templates and 

other resources in the From Offi ce Online area of the Getting Started With Microsoft 

Offi ce Access screen.

Access   displays a list of the templates that are available from the default template 

location (C:\Program Files\Microsoft Offi ce\Templates\1033\Access).

Tip When you point to a template icon, Access displays a description of the database 

in a pop-up window, called a ScreenTip. For more information about these templates, 

search Access Help for Guide to the Access 2007 templates.

2. Click  the Contacts template icon.

A description of the template appears on the right side of the program window, 

along with a box in which you can assign a name to the database and a folder 

button to browse to the place you want to store the database.

BE SURE TO start Access before beginning this exercise.start Access before beginning this exercise.
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3. In the File Name box, type Contacts Template, and note the default path.

Tip Naming    conventions for Access database fi les follow those for Microsoft 

Windows fi les. A fi le name, including its path, can contain up to 260 characters, 

including spaces, but creating a fi le name that long is not recommended. File names 

cannot contain the following characters: \ / : * ? “ < > |. 

The extension for an Access 2007 database fi le is .accdb, instead of the .mdb exten-

sion used for previous versions. For information about the differences between the 

two formats, search Access Help for accdb.

4. Click   the Create button.

Access briefl y displays a progress bar, and then your new database opens.

5. If the Navigation Pane is closed, press ~ to open it.

Notice that the Navigation Pane displays a custom category named Contacts, and a 

custom group named Supporting Objects.

Notice    the commands above the column headers. These commands are examples 

of the embedded macros that make this an application rather than a database.

Tip Access   stores embedded macros as properties of the object to which they 

are attached, rather than as a macro common to all database objects. Any modifi -

cations you make to an embedded macro are specifi c to the active object.

Restricting the scope of a macro by embedding it provides the added comfort of 

knowing that Access will not consider its actions “unsafe” and therefore will not 

block it.
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 6. Enter your own contact information into the fi rst record.

 7. Explore the Contacts Template database on your own.

CLOSE the Contacts Template database.

BE SURE TO delete the Contacts Template database from the default storage location if 

you don’t want to use it again.

Tip Access      creates new databases in your Documents folder. You can change the location as 

you create each database, or change the default save location. To do so, click the Microsoft 

Offi ce Button, click Access Options, and then on the Personalize page, under Creating 

Databases, click the Browse button. In the Default Database Path dialog box  , browse to the 

folder you want to select as the default database storage folder. Then click OK in each of the 

open dialog boxes.

Creating a Table Manually
In the previous exercise, you created a contact management database application based 

on an Access 2007 template. The database had all the tables, forms, reports, and code 

needed to import, store, and use basic information about people. But suppose you need 

to store different types of information for different types of contacts. For example, you 

might want to maintain different types of information about employees, customers, and 

suppliers. In addition to the standard information—such as names, addresses, and phone 

numbers—you might want to track these other kinds of information:

 O Employee Social Security numbers, dates of hire, marital status, deductions, and 

pay rates

 O Customer orders and account status

 O Supplier contacts, current order status, and discounts

You   could start with the template, add a lot of extra fi elds to the Contacts table, and 

then fi ll in just the ones you want for each contact type; but cramming all this informa-

tion into one table would soon get pretty messy. In this instance, it’s better to manually 

create a database that includes one table for each contact type: employee, customer, 

and supplier.
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Important With   most computer programs, it is important to save your work frequently 

to avoid losing it if your computer crashes or the power goes out. With Access, it is not only 

not important to save your data, it is not possible to manually save it. When you move the 

insertion point out of a record after entering or editing information, Access saves that record. 

This means that you don’t have to worry about losing your changes, but you do have to re-

member that most data entry changes you make are permanent and can be undone only by 

editing the record again.

Note,   however, that changes to properties and layout are not saved automatically. If you 

create a new table, form, or report, or modify the properties or layout of an existing one,

you will be prompted to save the changes before closing the object or the database.

See Also For information about ways of controlling table content, see Chapter 7, “Keeping 
Your Information Accurate.”

In this exercise, you will open a blank database, create a table, manually add a record, 

and import some records. There are no practice fi les for this exercise.

BE SURE TO start Access before beginning this exercise.

 1. On   the Getting Started with Microsoft Access page, under New Blank Database, 

click Blank Database.

Access displays information about the selected template on the right side of the 

program window.

 2. In the File Name box, type 02_Manual, click the  Browse for a location button and 

browse to the Documents\MSP\SBS_Access2007\Chapter02 folder. Then click OK.

Important You    can’t create a blank database without saving it. If you don’t provide a 

path and fi le name in the File Name box, Access saves the fi le in a default location and 

with a sequentially-numbered default name. The usual location is in the Documents 

folder, and the name is in the format Database1.accdb.

 3. Click     Create to create the blank database in the specifi ed location.

The database opens, displaying a new blank table named Table1 , in a group named 

Table1.

BE SURE TO start Access before beginning this exercise.start Access before beginning this exercise.

Browse for a 
location

Browse for a 
location
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Tip Notice   that the fi rst column is titled ID and the second is titled Add New Field. 

Access automatically creates the ID fi eld—you can delete it if you don’t need it.  The 

ability to add fi elds to a table by simply typing data in the fi rst row is new with Access 

2007. As you enter information in the cells, Access adds fi elds to the table and guesses 

at the data type and other properties.

Troubleshooting At   press time, there was an unresolved bug in the process for 

adding the fi rst record to a table. The result of the bug is that if you don’t save the 

fi rst record after adding the fi rst fi eld, and before adding the second fi eld, then 

Access increments the record ID value for each fi eld you add to the fi rst record. If 

you add seven fi elds, Access assigns the value “7” to the ID fi eld of the fi rst record. To 

avoid this bug, simply click the record selector after adding a value to the fi rst fi eld of 

the fi rst record in the table. This will save the record and Access will assign a value of 

“1” to the ID fi eld. Then continue adding the rest of your fi elds.

4. Click   in the empty cell below Add New Field, type Big Things Freight, and then 

press D to move to the next cell.

Access  automatically assigns the value “1” to the ID fi eld, assigns the name “Field1” 

to the fi rst column, and moves the Add New Field heading to the third column. The 

Unsaved Record icon  (two dots followed by a pencil) in the Record Selector box at 

the left of the record indicates that this record has not yet been saved.

Troubleshooting At At press time, there was an unresolved bug in the process for press time, there was an unresolved bug in the process for 

adding the fi rst record to a table. The result of the bug is that if you don’t save the adding the fi rst record to a table. The result of the bug is that if you don’t save the 

fi rst record after adding the fi rst fi eld, and before adding the second fi eld, thenfi rst record after adding the fi rst fi eld, and before adding the second fi eld, then

Access increments the record ID value for each fi eld you add to the fi rst record. If Access increments the record ID value for each fi eld you add to the fi rst record. If 

you add seven fi elds, Access assigns the value “7” to the ID fi eld of the fi rst record. To you add seven fi elds, Access assigns the value “7” to the ID fi eld of the fi rst record. To 

avoid this bug, simply click the record selector after adding a value to the fi rst fi eld of avoid this bug, simply click the record selector after adding a value to the fi rst fi eld of 

the fi rst record in the table. This will save the record and Access will assign a value of the fi rst record in the table. This will save the record and Access will assign a value of 

“1” to the ID fi eld. Then continue adding the rest of your fi elds.“1” to the ID fi eld. Then continue adding the rest of your fi elds.
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 5. Type   the following information into the next six cells, pressing D after each entry:

 John Woods

 345 S. 34th St.

 Ventura

 CA

 83003

 805 555-0154

As the insertion point moves out of each cell, its name changes to Field followed by 

a number.

 6. Double-click    the ID column name, and then type ShipperID to rename it.

 7. Repeat Step 6 for the other columns, changing the column names to the following:

 Field1 Company Field5 State

 Field2 Contact Field6 ZIP

 Field3 Street Field7 Phone

 Field4 City

 8. On   the View toolbar in the lower-right corner of the program window, click the 

Design View button to switch to Design view.

Tip The   buttons displayed on the View toolbar change depending on the type of 

object that is active. They are a handy way to switch views if the pointer is near the 

bottom of the window. Most instructions to switch views in this book refer to the View 

button in the Views group on the Home tab.

Design ViewDesign View
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Access prompts you to provide a name, because you need to save the table before 

changing to Design view.

9. In  the   Save As dialog box, type Shippers, and then click OK.

In  Design view, the top portion of the window contains a list of the table’s fi elds. 

The Field Name column contains the names you specifi ed when you created the 

table. The Data Type column specifi es the type of data that the fi eld can contain. 

The Description column can contain a description of the fi eld.

Tip You   can use fi eld names that include spaces, but this can affect how queries and 

modules have to be written, so it is best not to do so.

Notice the Primary Key icon (a key and right-pointing arrow) to the left of the 

ShipperID fi eld.  The value in the primary key fi eld is used to uniquely identify each 

record; that is, no two records can have the same value in this fi eld. You can enter 

this value yourself, or you can let Access help you with this chore.  When the data 

type of a fi eld is set to AutoNumber, as it is here, Access fi lls this fi eld in every new 

record with the next available number.

Tip If   you no longer want the table to have a primary key, select the fi eld designated as 

the primary key in the top portion of the window, and on the Design tab, click Primary 

Key.   If you want to assign a different fi eld as the primary key, select that fi eld, and click 

Primary Key on the Design tab to make it the primary key and move the icon to that fi eld.
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 10. Click   the Data Type for the ZIP fi eld, click the arrow that appears, and then in the 

list, click Text.

Tip If   you use only fi ve-digit ZIP codes, the numeric data type would be fi ne. But 

setting it to Text is a good idea so users can enter ZIP codes in the ZIP + 4 format.

 11. Click  each fi eld name in turn, and then in the Field Properties area, change the 

Field Size to the following:

 Company 40

 Contact 50

 Street 50

 City 50

 State 2

 ZIP 10

 Phone 24

Troubleshooting If you change any fi eld properties that might cause data to be 

lost (for example, making the size of the fi eld smaller), Access will warn you of this 

when you attempt to save the table.

CLOSE the table, saving your changes, and then close the database.

Creating a Table from a Template
Although manually creating a table is relatively easy, if one of the available table templates 

is close to what you want, using it might save you a little time and effort.

In this exercise, you will use a table template to add an Employees table to an existing 

database.

USE the 03_TableTemplate database. This practice fi le is located in the Chapter02 subfolder 

under SBS_Access2007.

OPEN the 03_TableTemplate database.

 1. On   the Create tab, in the Tables group, click the Table Templates button to display 

the list of available templates, and then click Contacts.

A new table opens. This table contains fi elds appropriate for many common kinds 

of contact information, but some aren’t needed and you will need a few more.

Troubleshooting If you change any fi eld properties that might cause data to be If you change any fi eld properties that might cause data to be 

lost (for example, making the size of the fi eld smaller), Access will warn you of this lost (for example, making the size of the fi eld smaller), Access will warn you of this 

when you attempt to save the table.when you attempt to save the table.

USE thethe 03_TableTemplate03_TableTemplate database. This practice fi le is located in the database. This practice fi le is located in the Chapter02Chapter02 subfolder  subfolder 

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 03_TableTemplate03_TableTemplate database. database.
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 2. On the Datasheet contextual tab, in the Views group, click the upper half of the View 

button . In the   Save As dialog box that appears, type Employees, and then click OK.

 3. Right-click   anywhere in the Company row, and then click Delete Rows.

 4. Repeat the previous step to delete the E-Mail Address, Business Phone, Mobile 

Phone, Fax Number, Country, and Web Page rows.

Tip You     can select and delete adjacent records by clicking one and then shift-clicking 

another. You can’t select multiple non-adjacent records.

 5. In   the Job Title fi eld name, select Job and then press the A key, so the fi eld name 

is just Title.

 6. Change the ID fi eld name to EmployeeID.

Changing the name of the ID fi eld makes it easier to differentiate the ID fi eld of this 

table from the ID fi eld of other tables.

 7. Change the Attachments fi eld name to Photograph.

Tip The ability to store and display attachments in a database is new in Access 2007.
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 8. Click  in the fi rst blank Field Name cell and type BirthDate. Then press F, type d 

to scroll the list to Date/Time, and press D twice.

The selection moves to the fi rst column in the next row.

 9. Repeat the previous step to add a fi eld named DateHired.

 10. On the Quick Access Toolbar, click the  Save button.

The Navigation pane now includes two tables, Shippers and Employees.

CLOSE the 03_TableTemplate database.

Manipulating Table Columns and Rows
When you refi ne a table’s structure by adding fi elds and changing fi eld properties, you 

affect the data that is stored in the table. But    sometimes you will want to reorganize the 

table itself to get a better view of the data. If you want to look up a phone number, for 

example, but the names and phone numbers are several columns apart, you will have to 

scroll the table window to get the information you need. You might want to rearrange or 

hide a few columns to be able to see the fi elds you are interested in at the same time.

You can manipulate the columns and rows of an Access table without affecting the 

underlying data in any way. You can size both rows and columns, and you can also 

hide, move, and freeze columns. You can save your table formatting so that the table 

will look the same the next time you open it, or you can discard your changes without 

saving them.

In this exercise, you will open a table and manipulate its columns and rows.

USE the 04_Manipulating database. This practice fi le is located in the Chapter02 subfolder 

under SBS_Access2007.

OPEN the 04_Manipulating database.

 1. In    the Navigation Pane, double-click the Customers table to open it in Datasheet 

view.

 2. Drag   the vertical bar at the right edge of the Address column header to the left 

until the column is about a half inch wide.

The column is too narrow to display the entire address.

SaveSave

USE thethe 04_Manipulating04_Manipulating database. This practice fi le is located in the database. This practice fi le is located in the Chapter02Chapter02 subfolder subfolder

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 04_Manipulating04_Manipulating database.database.
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3. Point to the vertical bar between the Address and City column headers, and when 

the pointer changes to a double-headed arrow, double-click the vertical bar.

Access resizes the column to the left of the vertical bar to the minimum width that 

will display all the text in that fi eld in all records. This technique is particularly useful 

in a large table where you can’t easily determine the length of a fi eld’s longest entry.

4. On    the left side of the datasheet, drag the horizontal bar between any two record 

selectors downward to increase the height of all rows in the table.
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 5. On the Home tab, in the Records group, click the More button, and then click Row 
Height.

 6. In the      Row Height dialog box, select the Standard Height check box, and then 

click OK.

Access resets the height of all rows to the default setting. (You can also set the rows 

to any other height in this dialog box.)

 7. Click   anywhere in the First Name column. In the Records group, click the More 

button, and then click Hide Columns.

The First Name column disappears, and the columns to its right shift to the left.

Tip If you select several columns before clicking Hide Columns, they all disappear. 

You can select adjacent columns by clicking in the header of one, holding down the 

Shift key, and then clicking in the header of another. The two columns and any col-

umns in between are selected.

 8. To      restore the hidden fi eld, in the Records group, click the More button, and then 

click Unhide Columns.

The Unhide Columns dialog box opens.

 9. In the Unhide Columns dialog box  , select the First Name check box, and then click 

Close.

Access redisplays the First Name column.
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 10. Drag the right side of the database window to the left to reduce its size so that you 

cannot see all fi elds in the table.

 11. Point     to the Customer ID column header, hold down the mouse button, and drag 

through the First Name and Last Name column headers. With the three columns 

selected, click the More button in the Records group, and then click Freeze.

 12. Scroll the window to the right.

The fi rst three columns remain in view.

 13. In the Records group, click More, and then click Unfreeze to restore the columns 

to their normal condition.

Tip The commands to hide, unhide, freeze, or unfreeze columns are available from 

the shortcut menu that appears when you right-click a column header.

CLOSE the table without saving your changes, and then close the 04_Manipulating 

database. If you are not continuing directly on to the next chapter, quit Access.

Key Points
 O Access 2007 includes templates to help you quickly and easily create databases and 

tables.

 O In Design view, you can modify any object you created manually or from a 

template.

 O Rather than storing all information in one table, you can create different tables 

for each type of information, such as employee, customer, and supplier contact 

information, or book, video, and CD catalog information.

 O Properties determine what data can be entered in a fi eld, and how the data will look 

on the screen. In Design view, you can change some properties without affecting 

the data stored in the table; but changing some might affect the data, so you must 

exercise caution when modifying properties.

 O You can adjust the structure of a table—by manipulating or hiding columns and 

rows—without affecting the data stored in the table.
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33 Populating a  Populating a 
 Database Database

In this chapter, you will learn to:

 � Import information from another Access database.

 � Import information from an Excel worksheet.

 � Import or link to a SharePoint list.

 � Collect data through e-mail.

 � Import information from a text fi le, an XML fi le, an HTML fi le, or a dBASE fi le.

 � Import information from an Outlook folder.

Not  many people enjoy typing information into a database table, so an important goal 

when designing a relational database is to structure the tables in such a way that the 

database user never has to enter the same information more than once. If, for example, 

you are designing a database to track customer orders, you don’t want sales clerks to 

have to type the name of the customer in each order. You need a customer table to 

hold all the pertinent information about each customer, and you can then simply refer-

ence the customer ID in the order form. If information about a customer changes, it is 

updated in only one place in the database: the customer table. In this way, the only item 

of customer information in the order records (the ID) remains accurate. An added ben-

efi t of this system is that you reduce the confusion that can result from typographical 

errors and from having the same information appear in different formats throughout 

the database.

Good database design saves keystrokes when you’re entering new information and 

maintaining the database, but you can save even more time and effort in another way. 

Microsoft Offi ce Access 2007 can easily share information with the other programs in 

the Microsoft Offi ce system. This  makes it easy to populate a database by importing 

information from existing fi les in other formats.

If the information that you intend to store in an Access database already exists in almost 

any other electronic document, it is quite likely that you can move it into Access without 

retyping it.
  53
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I
A

If your information is still being actively maintained in another program and you want 

to bring it into Access to analyze it, create reports, or export it to another format, you 

should consider linking your Access database to the existing information in its original 

program rather than importing the information. When you link to data in another pro-

gram, you can view and edit it in both programs, and what you see in Access is always 

up to date.

In this chapter, you will experiment with different ways of getting information into 

an Access database, including importing information from another database, from a 

Microsoft SharePoint site, from Microsoft Offi ce Outlook, and from a text, XML, or 

HTML fi le. You will learn how to collect data through e-mail and link to data. You will 

also learn how to migrate an existing database created in an earlier version of Access 

to Access 2007.

See Also Do you need only a quick refresher on the topics in this chapter? See the Quick 
Reference entries on pages xxxix–lxv.

Important Before you can use the practice fi les in this chapter, you need to install them 

from the book’s companion CD to their default location. See “Using the Book’s CD” on page 

xxv for more information.

mporting Information from Another 
ccess Database

Suppose  you already have an Access database that includes tables of information about 

products and orders, and another that includes contact information, but you want to 

have just one database containing all the information you use on a regular basis. You can 

save time by importing the product and order information into the contacts database (or 

vice versa), rather than re-creating it all.

You can easily import any of the standard Access objects: tables, queries, forms, reports, 

pages, macros, and modules.   When importing a table, you have the option of importing 

only the table defi nition (the structure that you see in Design view), or both the defi nition 

and the data.   When importing a query, you can import it as a query or you can import 

the results of the query as a table.

When you import an Access object, the entire object is imported as an object of the 

same name in the active database. You don’t have the option of importing selected 

fi elds or records. If the active database already has an object of the same name, Access 

imports the new object with a number appended to the end of its name.
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Tip If     you need only some of the fi elds or records from a table in another database, you 

can create a query in the other database to select only the information you need and then 

import the results of the query as a table. Alternatively, you can import the table and either 

edit it in Design view or clean it up by using queries.

In this exercise, you will import tables from one Access database into another.

USE the 01_ImportAccess and 01_Products databases. These practice fi les are located in the 

Chapter03 subfolder under SBS_Access2007.

OPEN the 01_ImportAccess database.

 1. On   the External Data tab, in the Import group, click the  Access button.

The Get External Data wizard  starts. The pages of the wizard are specifi c to 

the import operation you selected—in this case, Access Database appears in the 

title bar.

 2. On the Select the source and destination of the data page, click Browse.

 3. In   the File Open dialog box, navigate to your Documents\MSP\SBS_Access2007\
Chapter03 folder, click the 01_Products database, and then click Open.

USE thethe 01_ImportAccess01_ImportAccess and  and 01_Products01_Products databases. These practice fi les are located in thedatabases. These practice fi les are located in the

Chapter03Chapter03 subfolder under subfolder under SBS_Access2007SBS_Access2007..7777

OPEN thethe 01_ImportAccess01_ImportAccess database. database.
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4. On the Select the source and destination of the data page, with the Import 
tables, queries, forms, reports, macros, and modules into the current database 

option selected, click OK.

The Import Objects dialog box   opens.

5. Click Select All to select both tables in the list (Categories and Products). Then click 

OK to import the tables.

Access   offers you the option of saving the import steps. There is no need for this 

exercise, but if you repeat this process often, you will save some time by doing so.

6. On the Save Import Steps page, click Close.

7. From the All Tables list, open the Categories and Products tables to confi rm that 

records were imported into the database.

CLOSE the 01_ImportAccess database.
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Migrating a Database from a Previous Version of Access
Access  2007 stores data in a format that is different from earlier versions. Access 

2007 can open databases created in earlier versions and save information to the 

earlier versions, but earlier versions of Access cannot open a database saved in 

the 2007 format.

If  there is a chance that you or someone else will need to work on a database 

using a previous version of Access, then you might want to leave it in that 

format—Access 2007 will open it and automatically save it in the same format. 

However, some of the features that are new in Access 2007 won’t be available 

unless you update the database to the new format.

Follow these steps to migrate a database from an earlier version of Access:

 1. Open       the database.

 2. Click the  Microsoft Offi ce Button, point to the Save As arrow, and then click 

Access 2007 File Format.

 3. In the   Convert Database Into dialog box, specify a name and location for the 

database, and then click Save.

A message box appears, informing you that the database has been saved in 

the Access 2007 format and cannot be opened by previous versions of Access.

Importing Information from an Excel Worksheet
Access   works well with Microsoft Offi ce Excel. You can import entire worksheets or 

a named range from a worksheet into either a new table (one that is created during 

the import) or an existing table. You can also import specifi c fi elds from a worksheet 

or range.

Excel is a good intermediate format to use when importing information that isn’t set 

up to import directly into Access. For example, if you want to add or remove fi elds, 

combine or split fi elds, or use complex mathematical functions to manipulate data 

before importing it into Access, Excel is a great place to do it.

Migrating a Database from a Previous Version of Access
Access Access 2007 stores data in a format that is different from earlier versions. Access 2007 stores data in a format that is different from earlier versions. Access 

2007 can open databases created in earlier versions and save information to the2007 can open databases created in earlier versions and save information to the

earlier versions, but earlier versions of Access cannot open a database saved inearlier versions, but earlier versions of Access cannot open a database saved in

the 2007 format.the 2007 format.

IfIf there is a chance that you or someone else will need to work on a database there is a chance that you or someone else will need to work on a database ff

using a previous version of Access, then you might want to leave it in that using a previous version of Access, then you might want to leave it in that 

format—Access 2007 will open it and automatically save it in the same format. format—Access 2007 will open it and automatically save it in the same format. 

However, some of the features that are new in Access 2007 won’t be availableHowever, some of the features that are new in Access 2007 won’t be available

unless you update the database to the new format.unless you update the database to the new format.

Follow these steps to migrate a database from an earlier version of Access:Follow these steps to migrate a database from an earlier version of Access:

1. 1. OpenOpen the database. the database.

2. 2. Click theClick the Microsoft Offi ce ButtonMicrosoft Offi ce Button, point to the , point to the Save AsSave As arrow, and then click  arrow, and then click 

Access 2007 File FormatAccess 2007 File Format..

3. 3. In theIn the Convert Database IntoConvert Database Into dialog box, specify a name and location for the dialog box, specify a name and location for the

database, and then click database, and then click SaveSave..

A message box appears, informing you that the database has been saved in A message box appears, informing you that the database has been saved in 

the Access 2007 format and cannot be opened by previous versions of Access.the Access 2007 format and cannot be opened by previous versions of Access.

Microsoft Offi ce 
Button

Microsoft Offi ce 
Button
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In this exercise, you will import customer information from an Excel worksheet into an 

existing table in an Access database.

USE the 02_ImportExcel database and the 02_Customers workbook. These practice fi les are 

located in the Chapter03 subfolder under SBS_Access2007.

OPEN the 02_ImportExcel database.

 1. On the External Data tab, in the Import group, click the  Excel button.

The Get External Data wizard starts.

 2. On the Select the source and destination of the data page, click Browse.

 3. In     the File Open dialog box, navigate to your Documents\MSP\SBS_Access2007\
Chapter03 folder, click the 02_Customers workbook, and then click Open.

 4. On the Select the source and destination of the data page, select the Append 
a copy of the records to the table option, click Customers in the list, and then 

click OK.

The Import Spreadsheet wizard  starts.

USE thethe 02_ImportExcel02_ImportExcel database and the database and the ll 02_Customers02_Customers workbook. These practice fi les are workbook. These practice fi les are 

located in thelocated in the Chapter03Chapter03 subfolder under subfolder under SBS_Access2007SBS_Access2007..7777

OPEN thethe 02_ImportExcel02_ImportExcel database.database.ll
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Important When importing information into  an existing table, all the fi eld names 

and data types must match exactly; otherwise, Access can’t import the fi le and dis-

plays an error. If the structure matches but data in a fi eld is too large or has some 

other minor problem, Access might import the record containing the fi eld into an 

ImportError table , rather than into the intended table. You can fi x the problem in 

the ImportError table, and then copy and paste the record into the correct table.

On the fi rst page of the wizard, you can browse the contents of any worksheets or 

named ranges in the selected worksheet. Sample data from the selected worksheet 

or named range appears at the bottom of the page.

5. With Customers selected in the Show Worksheets list, click Next.

6. Select the First Row Contains Column Headings check box if it is not already selected.

7. Click Next, and then click Finish.

Access imports the worksheet into the Customers table.

8. On the Save Import Steps page, click Close.

9. Open the Customers table to confi rm that Access imported the customer list.

CLOSE the 02_ImportExcel database.
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Linking to Information
Linking to Information
Instead   of importing data into an Access database from another program, you can 

leave the data in the other program and link to it. Although working with data that 

is stored in your own database is faster, safer, and more fl exible, sometimes linking 

is preferable.

The most common reason for linking to data in another Access database or a dif-

ferent program is because you don’t own the data. Perhaps another department 

in your organization maintains the data in a SQL database, and they are willing to 

give you permission to read the tables and queries but not to change them. Other 

reasons are security and ease of data distribution.

You can usually link to information in any application from which you can import 

information. The only difference in the process is the option you select on the 

Select The Source And Destination Of The Data page of the Get External Data wiz-

ard. Rather than the Import or Append option, select the Link To The Data Source 

By Creating A Linked Table option.

If    you link to a fi le on a local area network (LAN), be sure to use a universal 
naming convention (UNC) path, rather than a mapped network drive. A UNC 

path includes the computer name as well as the drive letter and folder names, so 

it is less likely to change.

Access   indicates a linked table by an arrow to the left of the table icon.

Importing or Linking to a SharePoint List
If    your organization utilizes a collaboration site built with Microsoft SharePoint products 

and technologies, you can work with content from SharePoint lists in Access just as you 

can other content.

You can bring a list into Access in either of two ways—by importing from or by linking to 

a SharePoint list.

Importing a SharePoint list creates a copy of the list in the destination Access database. 

During the import operation, you can specify the lists that you want to copy, and, for 

each selected list, you can specify whether you want to import the entire list or only 

a specifi c view. The import operation creates a table in Access, and then copies the 

columns and items from the source list (or view) into that table as fi elds and records. 

Changes made to the imported data in either Access or SharePoint will not be replicated.
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If you’re likely to import the list again—for example, to update the data stored in 

Access—you can save the   import parameters. To repeat the saved import process, click 

the Saved Imports button in the Import group on the External Data tab, select the im-

port specifi cation you want, and then click Run.

If you want to work with data from a SharePoint list in Access but keep the information 

in both locations current, create a linked table. The process is the same for both opera-

tions. Linked tables are indicated in the Access Navigation Pane by a blue arrow point-

ing to a yellow table. Information you update in Access is refl ected in the SharePoint list 

when you refresh the view, and vice versa.

Imported lists

Linked lists

In this topic, we demonstrate the process of importing a SharePoint list from a collabora-

tion site.

 1. Locate the SharePoint site containing the lists you want to import, and make a note 

of the site address.

A  valid site address starts with http:// followed by the name of the server, and 

ends with the path to the specifi c site on the server. For example, http://sbsteam or 

http://sbs/sales/quarterly/.

 2. On the SharePoint site, identify the lists you want to copy to the database, and then 

decide whether you want the entire list or just a particular view.
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You   can import multiple lists in a single import operation, but you can import only 

one view of each list. If one of the standard views doesn’t fi t your needs, create a 

custom view containing only the fi elds and list items you want, before proceeding.

 3. Review the columns in the source list or view, and identify the database into which 

you want to import the lists.

When you import a SharePoint list, Access creates a table with the same name as 

the source list. If that name is already in use, Access appends a number to the new 

table name—for example, Contacts1. (If Contacts1 is also already in use, Access 

creates Contacts2, and so on.)

Tip Access will never overwrite a table in the destination database or append the 

contents of a list or view to an existing table.

 4. On the External Data tab, in the Import group, click the  SharePoint List button.

The Get External Data wizard starts, displaying a list of known sites. You are not 

limited to this list.

 5. On the Select the source and destination of the data page, under Specify a 

SharePoint site, click the address of the site you want to connect to, or type it in 

the box below.

 6. Select the Import the source data or Link to the data source option, and click 

Next. Then, if prompted to do so, enter your site credentials.

The Import Data From List page displays all the lists available on the selected 

SharePoint site.

Troubleshooting While testing the prerelease version of this software, the Items 

To Import list did not update to include a list box for each of the SharePoint lists until 

Step 8. This might have been fi xed in a the release version of the software.

 7. In the Import column, select the check box of each list you want to import into 

the database.

 8. In the Items to Import column, for each of the selected lists, select the view 

(arrangement of data) that you want to import into the database.

Troubleshooting If the Items To Import list does not include a list box for the 

SharePoint list you are importing, click in the column where the list box should be, 

and it will appear. This might have been fi xed in a later version of the software.

Troubleshooting While testing the prerelease version of this software, the ItemsWhile testing the prerelease version of this software, the Items

To Import list did not update to include a list box for each of the SharePoint lists until To Import list did not update to include a list box for each of the SharePoint lists until 

Step 8. This might have been fi xed in a the release version of the software.Step 8. This might have been fi xed in a the release version of the software.

Troubleshooting If the Items To Import list does not include a list box for the If the Items To Import list does not include a list box for the 

SharePoint list you are importing, click in the column where the list box should be,SharePoint list you are importing, click in the column where the list box should be,

and it will appear. This might have been fi xed in a later version of the software.and it will appear. This might have been fi xed in a later version of the software.
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 9. With the Import display values instead of IDs for fi elds that look up values 
stored in another list check box selected, click OK.

This option controls which data is imported for lookup columns in the selected 

lists.

No progress bar appears while Access imports the lists, and this process could take 

some time. Resist clicking the OK button more than once. When the import process 

completes, the last page of the wizard appears.

 10. If you want to save the import parameters for reuse, select the Save import steps 
check box. On the Save Import Steps page, enter a name and description for the 

specifi cation, and then click Save Import.

Tip If you use Microsoft Offi ce Outlook 2007, you can opt to place a task corre-

sponding to the saved import specifi cation on your calendar by selecting the Create 

Outlook Task check box.

After you import or link to a list, open the resulting table in Datasheet view. Ensure that 

all of the fi elds and records were imported, and that there are no errors. You can review 

the data type and other fi eld properties by switching to Design view.
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Collecting Data Through E-Mail
If  you’re running Microsoft Offi ce Outlook 2007, you can create forms that you can send 

to other people in e-mail, and then automatically add the responses to a database table. 

You might use this to process surveys, status reports, orders, or bugs via e-mail. With a 

little imagination, the uses for this feature are practically unlimited.

For this process to work, the survey recipients need to have an e-mail client that supports 

e-mail formatted as HTML; most major e-mail clients support this.

See Also For information about additional options and refi nements you can make to e-mail 
surveys, see the Access Help fi le.

The Collect Data Through E-mail Messages wizard  guides you through the process of 

creating an e-mail survey form. You can create different types of surveys depending on 

the applications that are installed on your computer.

 1. Create a database table containing the fi elds you want to include in your survey. 

Position the insertion point in the fi rst empty record.

 2. On the External Data tab, in the Collect Data group, click the  Create E-mail 
button.

 3. Follow the steps in the wizard to create the form, add and reorder the fi elds from 

the table, change fi eld labels, specify the Outlook folder to which the survey results 

will be delivered, elect to have Outlook automatically add replies to the original 

Access database table, and specify the survey recipients. 

If you do not have Outlook add the survey responses to the database, this option, 

you can manually add individual survey replies to the table by right-clicking each in 

Outlook, and then clicking Export Data To Microsoft Offi ce Access.

 4. Customize the text of the e-mail message that will be created, and then on the 

Create the e-mail message page, click Create.

Troubleshooting You might see a warning that you have the database open in 

an exclusive locked state. Don’t worry about this. You can close the database after 

sending the e-mail and then re-open it without the lock.

Outlook starts (if it wasn’t already running) and displays a generic message along 

with a form based on the selected table.

 5. Make any changes to the message you want, address it to the survey recipients, 

and then send it.

Troubleshooting You might see a warning that you have the database open in You might see a warning that you have the database open in 

an exclusive locked state. Don’t worry about this. You can close the database after an exclusive locked state. Don’t worry about this. You can close the database after 

sending the e-mail and then re-open it without the lock.sending the e-mail and then re-open it without the lock.
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When sending a data collection e-mail message to more than one person, it is good 

e-mail etiquette to put your own e-mail address in the To box and other people’s 

addresses in the Bcc box. That way, if a message recipient clicks Reply All, his or her 

response will go only to you, rather than to all the original recipients.

Message recipients respond to the survey by replying to your message. Outlook delivers 

survey responses to the Access Data Collection Replies folder (which it creates the fi rst 

time you need it). You can view individual survey responses and the status of the data 

collection process for each in this folder, and view the survey data in the original table. 

To change the way Access processes message replies, and resend or delete messages, 

display the table and then click the Manage Replies button in the Collect Data group.

Importing Information from a Text File
Text fi les  are the common denominator of all document types. Almost every program 

that works with words and numbers can generate some kind of a text fi le. Access can 

import tabular data (tables and lists) from delimited and fi xed-width text fi les. 

In   a delimited text fi le, each record ends in a carriage return, and each fi eld is separated 

from the next by a comma or some other special character, called a delimiter. If a fi eld 

contains one of these special characters, you must enclose the entire fi eld in quotation 

marks.     (Some people enclose all fi elds in quotation marks to avoid having to locate and 

enclose the special cases.)

In   a fi xed-width text fi le, the same fi eld in every record contains the same number of 

characters. If the actual data doesn’t fi ll a fi eld, the fi eld is padded with spaces so that 

the starting point of the data in the next fi eld is the same number of characters from 

the beginning of every record. For example, if the fi rst fi eld contains 12 characters, the 

second fi eld always starts 13 characters from the beginning of the record, even if the 

actual data in the fi rst fi eld is only 4 characters.

Fixed-width text   fi les used to be diffi cult to import into databases because you had to 

carefully count the number of characters in each fi eld and then specify the fi eld sizes in 

the database or in the import program. If the length of any fi eld was even one character 

off, all records from that point on would be jumbled. That is no longer a problem with 

Access because the Import Text wizard makes importing a fi xed-width text fi le simple. 

The only way to get the data of many older programs into Access is to export the data 

to a fi xed-width text fi le and then import that fi le into Access.

In this exercise, you will import information from a comma-delimited text fi le into an 

existing table in an Access database.
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USE the 05_ImportText database and the 05_Employees text fi le. These practice fi les are 

located in the Chapter03 subfolder under SBS_Access2007.

OPEN the 05_ImportText database.

 1. On     the External Data tab, in the Import group, click the  Text File button.

Tip Text  fi les typically have a .txt extension. However, some programs save delimited 

text fi les with a .csv or .tab extension. You will also occasionally see text fi les with an 

.asc (for ASCII) extension. Fixed-width text fi les are sometimes stored with a .prn (for 

printer) extension, but Access doesn’t recognize this extension, so you would have to 

rename it with one it does recognize. Access treats fi les with all acceptable extensions 

the same way.

The Get External Data wizard  starts.

 2. On the Select the source and destination of the data page, click Browse. 

 3. In the   File Open dialog box, navigate to your Documents\MSP\SBS_Access2007\
Chapter03 folder, click the 05_Employees text fi le, and then click Open.

 4. Select the Append a copy of the records to the table option, and in the list, click 

Employees. Then click OK.

The Import Text wizard  starts, displaying the content of the selected delimited 

text fi le.

Each information fi eld is enclosed in quotation marks, and the fi elds are separated 

by commas.

USE thethe 05_ImportText05_ImportText database and the  database and the tt 05_Employees05_Employees text fi le. These practice fi les are text fi le. These practice fi les are

located in thelocated in the Chapter03Chapter03 subfolder under subfolder under SBS_Access2007SBS_Access2007..7777

OPEN thethe 05_ImportText05_ImportText database.database.tt
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5. Click the Advanced button.

The   05_Employees Import Specifi cation dialog box opens. You can make changes 

to the default settings.

Tip If you want to import several fi les that deviate in some way from the default 

settings, you can specify the new settings and save them. Then as you open each of 

the other fi les, you can display this dialog box and click the Specs button to select 

and load the saved specifi cations.

6. In the Import Specifi cation dialog box, click Cancel. Then in the Import Text 

wizard, click Next.

The wizard separates the fi le into fi elds, based on its assumption that items are 

separated by commas. From the neat columns you see here, this assumption is 

obviously a good one. If the columns were jumbled, you could choose a different 

delimiter from the options at the top of this page.

7. Select the First Row Contains Field Names check box, and click Next. Then click 

Finish.

Access imports the text fi le into the Employees table.

8. On the Save Import Steps page, click Close. 

9. Open the Employees table to confi rm that Access imported seven records from the 

text fi le.

CLOSE the 05_ImportText database.
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Importing Information from Other Sources
Access 2007 groups the less-common types of fi les you can import on the More list 

in the Import group on the External Data tab. These additional fi le types include:

 O ODBC Database (includes a variety of fi le types, such as Access and Microsoft 

SQL Server)

 O HTML Document

 O Outlook Folder

 O dBASE File

 O Paradox File

 O Lotus 1-2-3 File

The process of importing data from any of these fi le types follows the same gen-

eral pattern. The Get External Data wizard guides you through the process. In the 

next three exercises, you will experiment with this by importing data from several 

of these fi le types. 

Importing Information from an XML File
Extensible Markup Language (XML) fi les are often used for exchanging information 

between programs, both on and off the Web.  XML fi les are similar to HTML fi les in two 

ways: both are plain text fi les that indicate formatting within tags, and both use start and 

end tags. However, HTML tags describe how elements should look, whereas XML tags 

specify the structure of the elements in a document. Also, as its name implies, the XML 

tag set is extensible—there are ways to add your own tags. Here is an example of a 

simple XML fi le:

<?xml version=”1.0”?>
<ORDER>
   <CUSTOMER>Mindy Martin</CUSTOMER>
   <PRODUCT>
      <ITEM>Sterilized Soil</ITEM>
      <PRICE>$8.65</PRICE>
      <QUANTITY>1 bag</QUANTITY>
   </PRODUCT>
</ORDER>

This simple fi le describes an order that Mindy Martin (the customer) placed for one bag 

(the quantity) of Sterilized Soil (the item) at a cost of $8.65 (the price). As you can see, 

when the data’s structure is tagged rather than its appearance, you can easily import the 

Importing Information from Other Sources
Access 2007 groups the less-common types of fi les you can import on the More list Access 2007 groups the less-common types of fi les you can import on the More list 

in the Import group on the External Data tab. These additional fi le types include:in the Import group on the External Data tab. These additional fi le types include:

O ODBC Database (includes a variety of fi le types, such as Access and MicrosoftODBC Database (includes a variety of fi le types, such as Access and Microsoft

SQL Server)SQL Server)

O HTML DocumentHTML Document

O Outlook FolderOutlook Folder

O dBASE FiledBASE File

O Paradox FileParadox File

O Lotus 1-2-3 FileLotus 1-2-3 File

The process of importing data from any of these fi le types follows the same gen-The process of importing data from any of these fi le types follows the same gen-

eral pattern. The Get External Data wizard guides you through the process. In theeral pattern. The Get External Data wizard guides you through the process. In the

next three exercises, you will experiment with this by importing data from several next three exercises, you will experiment with this by importing data from several 

of these fi le types. of these fi le types. 
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data into a database table. An actual fi le created for this purpose would contain many 

instances of the <order> through </order> block, one for each order.

The  information in an Access table consists of data and structure. When a table is exported 

to XML, the data and structure can be exported to separate fi les, in which case the data 

is placed in an .xml fi le, and the structure is placed in an .xsd fi le, which is referred to as a 

schema. (The structure can also be embedded in the .xml fi le.) In the following exercise, 

the Orders fi le contains both data and structure, and the Order Details fi les store the data 

in one fi le and the structure in another. If the structure is stored in an .xsd fi le, make sure 

it is in the same folder as the matching .xml fi le, otherwise Access will import the data and 

assign default properties to all fi elds.

In this exercise, you will import XML documents into an Access database.

USE the 06_ImportXML database, the 06_Orders XML fi le, and the 06_OrderDetails XML 

and schema fi les. These practice fi les are located in the Chapter03 subfolder under SBS_
Access2007.

OPEN the 06_ImportXML database.

 1. On   the External Data tab, in the Import group, click the  XML File button.

The Get External Data wizard  starts.

 2. On the Select the source and destination of the data page, click Browse. 

 3. In the File Open dialog box, navigate to your Documents\MSP\SBS_Access2007\
Chapter03 folder.

USE thethe 06_ImportXML06_ImportXML database, the  database, the 06_Orders06_Orders XML fi le, and the XML fi le, and the 06_OrderDetails06_OrderDetails XML XML

and schema fi les. These practice fi les are located in theand schema fi les. These practice fi les are located in the Chapter03Chapter03 subfolder under subfolder under SBS_SBS_
Access2007Access2007..7777

OPEN thethe 06_ImportXML06_ImportXML database.database.
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4. Click the 06_Orders XML data fi le, and then click Open.

You won’t see the extensions if your computer is set to hide extensions for known 

fi le types, but you can display them in a ScreenTip by pointing to each fi le name.

5. On the Select the source and destination of the data page, click OK.

The   Import XML dialog box opens.

Tip Access 2007    can apply a transform script to XML data as you import or export 

it. Transforms are a type of template used to convert XML data to other formats. 

When you apply a transform during import, the data is transformed before it enters 

the table, so you can adapt an XML fi le to a different table structure. For more infor-

mation about using transforms, search for transforms in the Access Help fi le.

6. With the Structure and Data import option selected, click OK.

Access imports the 06_Orders fi le and creates the Orders table with the imported 

data.

7. On the Save Import Steps page, click Close.

8. Repeat Steps 1 through 7 to import the 06_OrderDetails XML data fi le (the fi le with 

the .xml extension, not the fi le with the .xsd extension).

9. Open the Orders and OrderDetails tables to confi rm that Access imported the 

data and structure.
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CLOSE the 06_ImportXML database.

Importing Information from an HTML File
You  might be familiar with Hypertext Markup Language (HTML), which is used to create 

Web pages.  HTML uses tags to control the appearance and alignment of text when it is 

displayed in a Web browser. To display a table on a Web page, the table’s elements—rows 

and cells—are enclosed in appropriate HTML tags. For example, a simple HTML table 

might look like this:

.

.

.
<table>
<tr>
   <td>LastName</td><td>FirstName</td>
</tr>
   <td>Anderson</td><td>Nancy</td>
</tr>
</table>
.
.
.

Of course, a lot of other tags and text would appear above and below the table, and 

few tables are this simple, but the example conveys the general idea. With an HTML 

document, it is the <table>, <tr> (table row), and <td> (table data) tags that make the 

data look like a table when viewed in a Web browser.
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All the 2007 Offi ce programs can save a document in HTML format, and to a limited 

extent, they can read or import a document that was saved in HTML format by another 

program. If   you attempt to import an HTML document into Access, it will parse the 

document and identify anything that looks like structured data. You can then look at 

what Access has found and decide whether to import it.

Important If you want to import data into an existing table but the data structure isn’t 

the same as the table structure, it is often easier to import the data into Excel, manipulate it 

there, and then import it into Access.

In this exercise, you will import information from an HTML document into an existing 

table in an Access database.

USE the 07_ImportHTML database and the 07_NewCust HTML fi le. These practice fi les are 

located in the Chapter03 subfolder under SBS_Access2007.

OPEN the 07_ImportHTML database.

 1. Open the Customers table, and notice that it contains 107 records. Then close the 

table.

 2. On   the External Data tab, in the Import group, click the  More button, and then in 

the list, click HTML Document.

The Get External Data wizard  starts.

 3. On the Select the source and destination of the data page, click the Browse 

button. 

 4. In the   File Open dialog box, navigate to your Documents\MSP\SBS_Access2007\
Chapter03 folder, click the 07_NewCust HTML fi le, and then click Open.

 5. Select the Append a copy of the records to the table option, click Customers in 

the list, and then click OK.

The Import HTML wizard  starts.

The wizard displays the contents of the 07_NewCust fi le, divided into rows and 

columns. If a fi le contains multiple tables or lists, the wizard shows them here, and 

you can select the one you want to import.

USE thethe 07_ImportHTML07_ImportHTML database and thedatabase and the 07_NewCust07_NewCust HTML fi le. These practice fi les are HTML fi le. These practice fi les arett
located in thelocated in the Chapter03Chapter03 subfolder under subfolder under SBS_Access2007SBS_Access2007..7777

OPEN thethe 07_ImportHTML07_ImportHTML database. database.
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 6. Select the First Row Contains Column Headings check box, and then click Finish.

Access imports the information into the Customers table.

Tip You can click an active Finish button in a wizard at any time to accept the default 

setting for the remaining wizard pages.

 7. On the Save Import Steps page, click Close. 

 8. Open the Customers table to verify that it contains 110 records (the original re-

cords plus three imported from the HTML fi le).

CLOSE the 07_ImportHTML database.
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Importing Information from an Outlook Folder
You can import address books and folders from Microsoft Offi ce Outlook into an Access 

database. This could be useful if, for example, you had contact information in Outlook 

for all the members of a club you belong to, and wanted to import that into a database.

In this exercise, you will import data from an Outlook folder into a new table in an 

Access database. 

USE your Outlook Contacts folder for this exercise. If your Contacts folder is empty, create 

some contact records at this time or substitute another folder in the exercise.

BE SURE TO install and confi gure Outlook before beginning this exercise.

OPEN a blank database.

 1. Save the blank database in your Documents\MSP\SBS_Access2007\Chapter03 

folder as ImportOutlook.

 2. On     the External Data tab, in the Import group, in the More list, click Outlook 
Folder.

The Get External Data wizard starts.

 3. With the Import the source data into a new table in the current database option 

selected, click OK.

Outlook starts, if it isn’t already running, and then the Import Exchange/Outlook 

wizard  starts.

The wizard displays a list of all the address books and folders in your version of 

Outlook. You can click the Expand (+) or Collapse (–) button next to a folder if 

necessary to locate the folder you want.

USE your Outlook Contacts folder for this exercise. If your Contacts folder is empty, createyour Outlook Contacts folder for this exercise. If your Contacts folder is empty, create

some contact records at this time or substitute another folder in the exercise.some contact records at this time or substitute another folder in the exercise.

BE SURE TO install and confi gure Outlook before beginning this exercise.install and confi gure Outlook before beginning this exercise.

OPEN a blank database.a blank database.
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4. Expand    your primary mailbox folder, click the Contacts folder, and then click Next.

The wizard displays all the possible fi elds in the Contacts folder. You can display in-

formation about a fi eld by clicking it. You can edit the fi eld name and data type of 

the currently selected fi eld and specify whether to index or import the fi eld.  

5. On the Field Options page, click  an empty fi eld, and select the Do not import fi eld 

check box to instruct Access to skip that fi eld. Then click Next.

The wizard presents the primary key options. You can let Access create the key, 

create your own key, or have no key.

6. On the Primary Key page, with the Let Access add primary key option selected, 

click Next. Then click Finish to import the contents of the folder.

The   wizard offers you the option of saving the import steps. If you were going to 

repeat this process in the future, you could save time by selecting this option.

7. On the Save Import Steps page, click Close.

8. Open the Contacts table, to confi rm that all the fi elds are there other than the fi eld 

you chose to not import.

CLOSE the ImportOutlook database.
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Importing Information from a dBASE File
Importing   information from databases created in programs other than Access is usually an 

all-or-nothing situation, and quite often, what you get isn’t in the exact format you need. 

You might fi nd, for example, that transaction records include redundant information, such 

as the name of the product or purchaser, in every record. A database containing informa-

tion about people might include the full name and address in one fi eld, when you would 

prefer to have separate fi elds for the fi rst name, last name, street address, and so on. You 

can choose to import information as it is and manipulate it in Access, or you can move it 

into some other program, such as Excel or Microsoft Offi ce Word, and manipulate it there 

before importing it into Access.

Access can import data from the following versions of dBASE, Paradox, and Lotus 1-2-3:

 Program Versions

 dBASE III, IV, 5, and 7

 Paradox 3, 4, 5, 8

 Lotus 1-2-3 WKS, WK1, WK3, WK4

In this exercise, you will import information from a dBASE fi le into an existing table in an 

Access database. The process of importing the other fi le types is essentially the same.

USE the 09_ImportDbase database and the 09_Ship dBase fi le. These practice fi les are 

located in the Chapter03 subfolder under SBS_Access2007.

OPEN the 09_ImportDbase database.

 1. On   the External Data tab, in the Import group, in the More list, click dBASE File.

The Get External Data wizard starts.

 2. On the Select the source and destination of the data page, click the Browse button.

 3. In the File Open dialog box  , navigate to your Documents\MSP\SBS_Access2007\
Chapter03 folder, click the 09_Ship fi le, and then click Open.

 4. Select the Import the source data into a new table in the current database option, 

and then click OK.

Access imports the data and creates the 09_Ship table.

 5. On the Save Import Steps page, click Close. 

 6. Open the 09_Ship table to confi rm that fi ve records were imported properly.

CLOSE the 09_ImportDbase database.

USE thethe 09_ImportDbase09_ImportDbase database and the database and the 09_Ship09_Ship dBase fi le. These practice fi les are dBase fi le. These practice fi les are 

located in thelocated in the Chapter03Chapter03 subfolder under subfolder under SBS_Access2007SBS_Access2007..7777

OPEN thethe 09_ImportDbase09_ImportDbase database. database.
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Key Points
 O Importing information into Access 2007 from numerous other programs is easy. 

If the information is still being actively maintained in another program and you 

want to bring it into Access to work with it, you can link your Access database to 

the existing data fi le.

 O You can import entire Excel worksheets, or a named range from a worksheet, into a 

new table or an existing table. You can also import specifi c fi elds from a worksheet 

or range.

 O You can import single or multiple SharePoint lists into an Access database, and 

even limit the data imported to a specifi c view of the SharePoint list.

 O You can create forms to send in Outlook e-mail, and automatically update an 

Access database with the responses.

 O You can use the Import wizard to import delimited and fi xed-width text fi les into 

your Access database.

 O You can easily import one or more of the standard Access objects, such as tables, 

queries, forms, reports, pages, macros, and modules.

 O You can import data from certain versions of dBASE, Lotus 1-2-3, and Paradox into 

Access. You can choose to import information as it is and manipulate it in Access, or 

you can move it into some other program, such as Excel or Word, and manipulate it 

there before importing it into Access.

 O You can import a document saved in HTML format by another program into 

Access. If you attempt to import an HTML document into Access, it will parse the 

document and identify anything that looks like structured data. You can then look 

at what Access has found and decide whether to import it.

 O You can import XML fi les into Access. XML consists of data and a schema, which 

describes the structure of the data. Programs that export to XML might combine 

the data and schema in one fi le, or might create two fi les. If the program exports 

two separate fi les, you will need both fi les to import both the data and the struc-

ture into Access.

 O You can link your database to data in other programs, without actually importing 

the data into your database. This option can be useful if someone else maintains 

the other data, and you want to have the current information whenever it changes.
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  4 4 Sharing and  Sharing and 
  Reusing Information  Reusing Information

In this chapter, you will learn to:

 � Export information to another Access database.

 � Export information to Excel.

 � Export information to a SharePoint list.

 � Export information to Word.

 � Export information to a text fi le, an XML fi le, or an HTML fi le.

 � Copy information to other Offi ce programs.

You   can export Microsoft Offi ce Access database objects in a variety of formats. From 

Access 2007, you can export database objects to all the fi le formats from which you 

can import data. By installing an add-in, you can also export information to Portable 

Document Format (PDF) and XML Paper Specifi cation (XPS) fi les. The specifi c formats 

available depend on the object you are trying to export. Tables, for example, can be ex-

ported in pretty much the same formats in which they can be imported. Macros, on the 

other hand, can be exported only to another Access database. 

Available export formats include:

Database object Valid export formats

Table ACCDB, XLS, XLSB, XLSX,  SharePoint List, PDF, XPS, RTF, TXT, XML, 

ODBC, HTML, dBASE, Paradox, Lotus 1-2-3, Word Merge

Query ACCDB,  XLS, XLSB, XLSX, SharePoint List, PDF, XPS, RTF, TXT, XML, 

ODBC , HTML, dBASE, Paradox, Lotus 1-2-3, Word Merge

Form ACCDB , XLS, XLSB, XLSX, PDF, XPS, RTF, TXT, XML, HTML

Report ACCDB , PDF, XPS, RTF, TXT, XML, Snapshot, HTML

Macro ACCDB 

Module ACCDB, TXT 
   79
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Tip To  display a list of valid export fi le formats for a specifi c Access object, right-click the 

object in the Navigation Pane, and then point to Export.

When you import information to an Access database, the data being imported usually 

needs to match certain patterns, or the import process will fail. There aren’t any such 

restrictions when exporting data from an Access database, and the process rarely fails. 

However, some exported database objects aren’t very useful in certain formats.

In this chapter, you will export a variety of objects from an Access database to other 

2007 Microsoft Offi ce system applications, as well as to PDF, XPS, XML, HTML, and text 

fi le formats. You will also copy and paste data directly from an Access database into a 

Microsoft Offi ce Word document and a Microsoft Offi ce Excel spreadsheet.

See Also Do you need only a quick refresher on the topics in this chapter? See the Quick 
Reference entries on pages xxxix–lxv.

Important Before you can use the practice fi les in this chapter, you need to install them 

from the book’s companion CD to their default location. See “Using the Book’s CD” on page 

xxv for more information.

Troubleshooting Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and you 

experience trouble following the instructions as written, please refer to the “Information for 

Readers Running Windows XP” section at the beginning of this book.

Exporting Information to Another Access Database
It is very simple to export any single object from one Access 2007 database to either 

another Access 2007 database or to an Access 2003 database. You can’t, however, export 

multiple objects in one operation.

Tip Data types that are new in Access 2007, such as Attachment or Rich Text, will not 

export properly to Access 2003. Rich text is exported as tagged HTML, and attachments 

are exported as the fi lename of the attachment.

Troubleshooting Graphics and operating system–related instructions in this book refl ect Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and youthe Windows Vista user interface. If your computer is running Microsoft Windows XP and you

experience trouble following the instructions as written, please refer to the “Information forexperience trouble following the instructions as written, please refer to the “Information for

Readers Running Windows XP” section at the beginning of this book.Readers Running Windows XP” section at the beginning of this book.
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In this exercise, you will export a table from one Access database to another.

USE the 01_ExportAccess and 01_Exported databases. These practice fi les are located in the 

Chapter04 subfolder under SBS_Access2007.

BE SURE TO start Access before beginning this exercise.

OPEN the 01_ExportAccess database.

 1. In   the Navigation Pane, under Tables, click Suppliers.

Because you will export the entire table, there is no need to open it fi rst. You only 

need to select it in the Navigation Pane.

 2. On the External Data tab, in the Export group, click the More button, and then in 

the list, click Access Database.

 3. In the Export – Access Database wizard, click the Browse button.

 4. In the File Save dialog box, navigate to the Documents\MSP\SBS_Access2007\
Chapter04 folder, click 01_Exported.accdb, and then click Save.

 5. In   the Export – Access Database wizard, click OK.

The Export dialog box opens.

USE thethe 01_ExportAccess01_ExportAccess and and 01_Exported01_Exported databases. These practice fi les are located in thedatabases. These practice fi les are located in thedd
Chapter04Chapter04 subfolder under subfolder under SBS_Access2007SBS_Access2007..7777

BE SURE TO start Access before beginning this exercise.start Access before beginning this exercise.

OPEN thethe 01_ExportAccess01_ExportAccess database. database.
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 6. In the Export dialog box, with Suppliers showing in the Export Suppliers to: box 

and Defi nition and Data selected under Export Tables, click OK.

Access exports the selected table.

 7. In the   Save Export Steps dialog box, click Close.

Tip You   can open only one database at a time in a single instance of Access. If 

you open a second database without fi rst closing the one you are working in, Access 

prompts you to save recent changes and then closes the fi rst database before open-

ing the second. To open two databases at the same time, launch a second instance 

of Access from the Start menu, and then open the second database from the File 

menu; or launch Access and open the database by double-clicking the database 

fi le in Windows.

 8. In Windows Explorer, navigate to the Documents\MSP\SBS_Access2007\Chapter04 

folder and double-click 01_Exported.accdb.

The 01_Exported database opens in a separate instance of Access 2007.

 9. In the Navigation Pane, under Tables, double-click Suppliers and verify that the 

table exported correctly, then close this instance of Access.

CLOSE the 01_ExportAccess database.

Exporting Information to Excel
You    can export a single table, form, or query from an Access 2007 database to an Excel 

2007 workbook, and to earlier versions of Excel clear back to Microsoft Excel 5.0/95. You 

cannot, however, export macros, modules, or reports. When you export a form or table 

that contains a subform or subdatasheet, Access exports only the main form or data-

sheet.   To export a subform or subdatasheet you must perform another export operation 

on each object. To combine multiple Access objects into a single Excel workbook, you 

fi rst export the individual objects to different workbooks, then merge all the worksheets 

from within Excel.
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In this exercise, you will export a table from a database to an Excel workbook.

USE the 02_ExportExcel database. This practice fi le is located in the Chapter04 subfolder 

under SBS_Access2007.

OPEN the 02_ExportExcel database, then open the Suppliers table in Datasheet view.

 1. On the External Data tab, in the Export group, click the  Export to Excel spread-
sheet button.

 2. In the Export – Excel Spreadsheet wizard, click the Browse button. In the File Save 

dialog box, navigate to the Documents\MSP\SBS_Access2007\Chapter04 folder, and 

then click Save.

By default, the spreadsheet has the same name as the table it’s based on. You can 

change the spreadsheet name in the File Save dialog box.

 3. In the Export – Excel Spreadsheet wizard, select the Export data with 
formatting and layout check box. Then select the Open the destination fi le 
after the export operation is complete check box.

 4. With  Excel Workbook selected in the File format list, click OK.

Access exports the table to an Excel workbook. Excel starts, and the workbook 

opens.

USE thethe 02_ExportExcel02_ExportExcel database. This practice fi le is located in the database. This practice fi le is located in thell Chapter04Chapter04 subfolder  subfolder 

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 02_ExportExcel02_ExportExcel database, then open the Suppliers table in Datasheet view.database, then open the Suppliers table in Datasheet view.ll

Export to Excel 
spreadsheet

Export to Excel 
spreadsheet



84  Chapter 4 Sharing and Reusing Information
CLOSE the Suppliers workbook and quit Excel. Then close the Export – Excel Spreadsheet 

wizard and the 02_ExportExcel database.

Exporting Information to a SharePoint List
Access   2007 can export a table or the results of a query directly to a SharePoint site. If 

you have permission to create content on a SharePoint site, you can export data to a 

SharePoint list; when you do so, Access creates a copy of the selected table or query 

database object, and stores the copy as a list.

The list content is static and will not refl ect changes made to the source table or query 

after the export operation. You can’t overwrite or add data to an existing list.
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In this topic, we demonstrate the process of exporting the contents of a table to a 

SharePoint site.

 1. In the Navigation Pane, select (but don’t open) the object you want to export.

Tip You can export only one object at a time. However, when exporting a table, 

Access also exports all related tables.

 2. On the External Data tab, in the Export group, click the  SharePoint List button.

 3. In the Export – SharePoint Site wizard, specify the SharePoint site where you want 

to create the list, change the list name and type a description if you want, and then 

click OK. Enter your SharePoint site credentials if prompted to do so.

Access creates and opens the list on the SharePoint site. If the SharePoint site 

already includes a list of the same name as the one you are exporting, you are 

prompted to specify a different name for the new list.
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Troubleshooting You might need to switch to the SharePoint site by clicking its 

taskbar button.

In the resultant SharePoint list, the data type selected for each column is based 

on the corresponding source fi eld. Any errors or explanations about limited func-

tionality appear at the bottom of the list.

 4. In      the Export – SharePoint Site wizard, if you plan to repeat the export operation 

in the future, select the Save export steps check box. 

 5. If you want to be reminded to perform the operation at fi xed intervals, such as 

weekly or monthly, select the Create Outlook Task check box.

Saved export operations appear in the Navigation Pane.

Troubleshooting You might need to switch to the SharePoint site by clicking itsYou might need to switch to the SharePoint site by clicking its

taskbar button.taskbar button.
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Exporting Information to Word
All    Microsoft Offi ce products can share information in various ways. If you need to move 

a table or the results of a query to an existing Word document, it is often easiest to sim-

ply copy and paste the records from the datasheet. But if you want to work with the con-

tents of the Invoice report in Word, then you need to export the Invoice report.

When   you export information from Access 2007 to Word, Access creates a Rich Text 

Format (RTF) document, which can be opened by Word and various other applications.

In this exercise, you will export a form from a database to an RTF document.

USE the 04_ExportWord database. This practice fi le is located in the Chapter04 subfolder 

under SBS_Access2007.

OPEN the 04_ExportWord database.

 1. In the Navigation Pane, under Forms, double-click Customers.

The Customers form opens in Form view.

USE thethe 04_ExportWord04_ExportWord database. This practice fi le is located in the database. This practice fi le is located in the dd Chapter04Chapter04 subfolder subfolder

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 04_ExportWord04_ExportWord database.database.dd
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 2. On the External Data tab, in the Export group, click the   Word button.

 3. In the Export – RTF File wizard, click Browse. In the File Save dialog box, navi-

gate to your Documents\MSP\SBS_Access2007\Chapter04 folder, and then click 

Save.

 4. In the Export – RTF File wizard, select the Open the destination fi le after the ex-
port operation is complete check box, and then click OK.
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Access exports the table to a Word document. Word starts and the document 

opens. Notice that Word presents the information in a different format than Access, 

where only one record is displayed at a time. To see all fi elds on one page in Word, 

select the header row, then right-click the selection, point to Auto-fi t, and click 

AutoFit to Window.

CLOSE the Customers document and quit Word. Then close the Export – RTF File wizard 

and the 04_ExportWord database.

Exporting Information to PDF and XPS Files
You     can download an add-in from Microsoft that enables you to export informa-

tion from 2007 Microsoft Offi ce system applications to Portable Document Format 

(PDF) and XML Paper Specifi cation (XPS) fi les. The export process follows the same 

steps as exporting to other formats.

You  are probably familiar with the PDF format developed by Adobe Systems, as it 

has been around for many years. Information converted to this format should dis-

play exactly the same on any computer or operating system.  The XPS format is a 

relatively new one developed by Microsoft to serve a similar purpose. It doesn’t yet 

have the broad support of PDF, but is worth exploring. Because the primary pur-

pose of both formats is to maintain the appearance of the content as it is displayed 

by various systems, they are good formats to use when publishing reports.

Tip The  XML Paper Specifi cation describes the XPS Document format. A document 

in XPS Document format (XPS Document) is a paginated representation of electronic 

paper described in an XML-based format. The XPS Document format is an open, 

cross-platform document format that allows customers to effortlessly create, share, 

print, and archive paginated documents. XPS Documents use a fi le container that 

conforms to the Open Packaging Conventions. The 2007 Microsoft Offi ce system 

also uses the Open Packaging Conventions for organizing data into fi les, allowing 

businesses to manage documents from the 2007 Microsoft Offi ce system and XPS 

Documents in the same manner.

You can learn more about XPS and download several XPS viewers by visiting

www.microsoft.com/whdc/xps/.

To   view a PDF document, install Adobe Reader from 

www.adobe.com/products/acrobat/readstep2.html.

Exporting Information to PDF and XPS Files
YouYou can download an add-in from Microsoft that enables you to export informa-can download an add-in from Microsoft that enables you to export informa-

tion from 2007 Microsoft Offi ce system applications to Portable Document Format tion from 2007 Microsoft Offi ce system applications to Portable Document Format 

(PDF) and XML Paper Specifi cation (XPS) fi les. The export process follows the same (PDF) and XML Paper Specifi cation (XPS) fi les. The export process follows the same 

steps as exporting to other formats.steps as exporting to other formats.

YouYou are probably familiar with the PDF format developed by Adobe Systems, as it are probably familiar with the PDF format developed by Adobe Systems, as it

has been around for many years. Information converted to this format should dis-has been around for many years. Information converted to this format should dis-
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pose of both formats is to maintain the appearance of the content as it is displayedpose of both formats is to maintain the appearance of the content as it is displayed

by various systems, they are good formats to use when publishing reports.by various systems, they are good formats to use when publishing reports.

Tip The The XML Paper Specifi cation describes the XPS Document format. A documentXML Paper Specifi cation describes the XPS Document format. A document

in XPS Document format (XPS Document) is a paginated representation of electronic in XPS Document format (XPS Document) is a paginated representation of electronic 

paper described in an XML-based format. The XPS Document format is an open, paper described in an XML-based format. The XPS Document format is an open, 
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Exporting Information to a Text File
Text fi les    are the lowest common denominator fi le format. Most applications can open, 

display, and save information in text format. The downside to text fi les is that they don’t 

contain any formatting information, so they look consistently plain in all applications.

Depending on what type of content you are trying to export from a database, you may 

have the option to export the formatting and layout along with the data. If you select 

this option, the unformatted text will be arranged in the text fi le much as it is in the 

Access object. If you don’t choose this option, the information will be saved as either 

delimited or fi xed-length lines.

In this exercise, you will export a table from a database fi rst as a formatted text fi le, and 

then as an unformatted text fi le.

USE the 05_ExportText database. This practice fi le is located in the Chapter04 subfolder 

under SBS_Access2007.

OPEN the 05_ExportText database, then open the Shippers table in Datasheet view.

 1. On the External Data tab, in the Export group, click the  Text File button.

 2. In the Export – Text File wizard, click Browse. In the File Save dialog box, navigate 

to the Documents\MSP\SBS_Access2007\Chapter04 folder, change the default fi le 

name from Shippers.txt to Shippers_delim.txt, and then click Save.

 3. Select   the Export data with formatting and layout check box. Then select the 

Open the destination fi le after the export operation is complete check box.

USE thethe 05_ExportText05_ExportText database. This practice fi le is located in the database. This practice fi le is located in thett Chapter04Chapter04 subfolder  subfolder 

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 05_ExportText05_ExportText database, then open the Shippers table in Datasheet view.database, then open the Shippers table in Datasheet view.tt
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4. In the Export – Text File wizard, click OK.

The Encode As dialog box   opens. From here you can select the encoding format 

options you want.

5. With the Windows option selected, click OK.

Access exports the table as a formatted text fi le. Your default text editor displays 

the Shippers_delim text fi le.

Notice that ASCII characters have been used to separate the rows and columns in 

the table.

6. Close the text fi le and the Export – Text File wizard.

7. Repeat Steps 1 through 4 to export the table again, but this time change the name 

to Shippers_fi xed.txt, and don’t select the Export data with formatting and lay-
out and Open the destination fi le after the export operation is complete check 

boxes.

The Export Text wizard   starts. This will guide you through the process of setting 

various options. At any point in the wizard, you can click Finish to accept the 

default selection for all remaining options.
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Tip You can move forward and backward through this wizard by clicking the Next 

and Back buttons. You can experiment with different options and move along as far 

as the last page before backing up and trying a different option.

8. With    the Delimited option selected, click Next.

The options on this page are different depending on whether you are exporting a 

delimited or fi xed-width fi le.

9. With the Comma option selected, click Finish.

Access exports the table as an unformatted text fi le. You can use Windows Explorer 

to navigate to where you saved the Shippers_fi xed text fi le and double-click it to 

open it in your default text editor.

CLOSE the two Shippers text fi les, the Export Text wizard, and the 05_ExportText database.
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Exporting Information to an XML File
Access complies with the 2001 XML Schema recommendation described at www.w3.org/
2001/XMLSchema/. You can therefore export data from Access in an XML format that 

can be used by other applications that are also in compliance. This makes it possible for 

you to output XML data that can be used by Microsoft Visual Studio .NET programs.

Access 2007 supports exporting tables, queries, forms, and reports to an XML format. 

You can export the data (.xml fi le) and schema (.xsd fi le) fi les separately, or you can 

embed the schema in the exported XML data document. You can also export an XLS 

Stylesheet for use in HTML or ASP presentations of the data.

In   this exercise, you will export a table from a database to an XML fi le.

USE the 06_ExportXML database. This practice fi le is located in the Chapter04 subfolder 

under SBS_Access2007.

OPEN the 06_ExportXML database, then open the Customers table in Datasheet view.

 1. On the External Data tab, in the Export group, click the  More button, and then in 

the list, click XML File.

 2. In the Export – XML File wizard, click Browse. In the File Save dialog box, navigate 

to the Documents\MSP\SBS_Access2007\Chapter04 folder, and then click Save.

USE thethe 06_ExportXML06_ExportXML database. This practice fi le is located in the database. This practice fi le is located in the Chapter04Chapter04 subfolder  subfolder 

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 06_ExportXML06_ExportXML database, then open the Customers table in Datasheet view. database, then open the Customers table in Datasheet view.
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 3. In the Export – XML File wizard, click OK.

The Export XML dialog box   opens.

 4. With the Data (XML) and Schema of the data (XSD) check boxes selected, click OK.

 5. In the Export – XML File wizard, click Close.

 6. In Windows Explorer, navigate to the Documents\MSP\SBS_Access2007\Chapter04 

folder. 

Notice that Access created a data fi le named Customers.xml, and a schema fi le 

named Customers.xsd fi le from the exported Customers table. You can view the 

XML fi le in Windows Internet Explorer and the XSD fi le in any text editor.

Tip To export a table as a combined data/schema fi le, in the Export XML dialog box  , 

click More Options. On the Schema tab that appears, select the Embed Schema In 

Exported XML Data Document option, and then click OK.

CLOSE the 06_ExportXML database.

Exporting Information to an HTML File
Many organizations that store accounting, manufacturing, marketing, sales, and other 

information on their computers have discovered the advantages of sharing this informa-

tion within the company through an intranet, or with the rest of the world through the 

Internet. With Access, you can speed up this process by exporting the information stored 

in a database as Hypertext Markup Language (HTML) pages.

You can export tables, queries, forms, and reports to an HTML fi le. Access converts a 

table, query, or form to an HTML table when you export it, and converts a report to 

a series of linked HTML fi les (one for each page of the report). 
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Tip If  you export to an HTML fi le, you can view the table in a browser, such as Internet 

Explorer. To see the tags that defi ne the structure of the table, either view the source in the 

browser or open the fi le in a text editor.

In this exercise, you will export a report from a database to an HTML fi le.

USE the 07_ExportHtml database. This practice fi le is located in the Chapter04 subfolder 

under SBS_Access2007.

OPEN the 07_ExportHtml database.

 1. In the Navigation Pane, under Reports, double-click Alphabetical List of Products.

The Alphabetical List of Products report opens in Report view.

 2. On the External Data tab, in the Export group, click the More button, and then in 

the list, click HTML Document.

USE thethe 07_ExportHtml07_ExportHtml database. This practice fi le is located in the database. This practice fi le is located in thell Chapter04Chapter04 subfolder  subfolder 

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 07_ExportHtml07_ExportHtml database.database.ll
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3. In the Export – HTML File wizard, click Browse. In the File Save dialog box, 

navigate to the Documents\MSP\SBS_Access2007\Chapter04 folder, and then 

click Save.

4. Select the Open the destination fi le after the export operation is complete check 

box, and then click OK.

The HTML Output Options dialog box opens. You can select the encoding you 

want to use for saving the fi le from this dialog box.

5. With the Default encoding option selected, click OK.

For each page of the report, Access creates an HTML fi le with navigation links at 

the bottom. The report opens in your default Web browser.
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 6. Browse the HTML fi les, comparing them to the report in Access.

CLOSE your Web browser, the Export – HTML Document wizard, and the 07_ExportHtml 
database.

Copying Information to Other Offi ce Programs
All the methods of exporting data described in this chapter work well, but they aren’t 

the only ways to share information with other programs.

Sometimes  the quickest and easiest way to get information into or out of a database is 

to just copy it and paste it where you want it. This   technique works particularly well for 

getting data out of an Access table and into Word or Excel. Information that you paste 

into a Word document becomes a Word table, complete with a header row containing 

the fi eld captions as column headings. Information that you paste into an Excel work-

sheet appears in the normal row-and-column format.

Getting  data into an Access table by using this technique is a little more complicated. 

The data you are pasting must meet all the criteria for entering it by hand (input mask, 

validation rules, fi eld size, and so on), and you must have the correct cells selected when 



98  Chapter 4 Sharing and Reusing Information

 

you use the Paste command. If Access encounters a problem when you attempt to paste 

a group of records, it displays an error message and pastes the problem records into a 

Paste Errors table . You can then troubleshoot the problem in that table, fi x whatever is 

wrong, and try copying and pasting again.

Tip To paste an entire table from one Access database to another, open both databases, 

copy the table from the source database to the Clipboard, and then paste it in the destina-

tion database. You can paste the table data and/or table structure as a new table or append 

the data to an existing table.

In this exercise, you will copy and paste records between an Access database table, an 

Excel worksheet, and a Word document.

USE the 08_CopyOffi ce database. This practice fi le is located in the Chapter04 subfolder 

under SBS_Access2007.

OPEN the 08_CopyOffi ce database, then open the Customers table in Datasheet view.

1. Select   about six records by pointing to the row selector of the fi rst record you want 

to select (the pointer changes to a right arrow), holding down the primary mouse 

button, and dragging to the last record you want to select.

USE thethe 08_CopyOffi ce08_CopyOffi ce database. This practice fi le is located in the database. This practice fi le is located in the Chapter04Chapter04 subfolder  subfolder 

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 08_CopyOffi ce08_CopyOffi ce database, then open the Customers table in Datasheet view.database, then open the Customers table in Datasheet view.
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 2. On the Home tab, in the Clipboard group, click the  Copy button.

 3. Start Excel, open a blank worksheet, and then click cell A1. 

 4. On the Home tab, in the Clipboard group, click the  Paste button.

Excel pastes the records into the worksheet, complete with the same column 

headings. (You will have to widen the columns to see all the data.)

 5. Press J+D to switch back to Access.

 6. Select a block of cells in the middle of the table by pointing to the left edge of the 

fi rst cell you want to select (the pointer changes to a thick cross) and then dragging 

until you have selected all the desired cells. Then in the Clipboard group, click the 

Copy button.

 7. Press J+D to switch back to Excel, click a cell below the records you inserted in 

Step 4, and then click the Paste button.

Excel pastes in the new selection, again with column headings. The copied data 

remains on the Offi ce Clipboard

CopyCopy
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 8. Start Word and open a blank document.

 9. On the Home tab, in the Clipboard group, click the  Paste button.

Word pastes the selection as a nicely formatted table with the title Customers, 
refl ecting the name of the table from which this data came.

 10. Quit Word and Excel without saving your changes.

CLOSE the Customers table and the 08_CopyOffi ce database. If you are not continuing 

directly on to the next chapter, quit Access.
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Key Points
 O You can export information from an Access database in a variety of formats, 

depending on the object you are trying to export.

 O You can export any table, query, form, or report to another Access database. You 

can also export some of these objects to Excel, Word, PDF, XPS, XML, HTML, and 

text fi le formats.

 O You can merge the information in an Access table with a Word mail merge docu-

ment, publish the table in a Word document, or export the table to an Excel 

worksheet.

 O You can copy and paste information from your database into other programs. 
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  5 5 Simplifying Data  Simplifying Data 
  Entry by Using   Entry by Using 
  Forms  Forms

In this chapter, you will learn to:

 � Create a form by using the Form tool.

 � Refi ne form properties.

 � Change the arrangement of a form.

 � Add controls to a form.

 � Enter data in a form by using VBA.

 � Create a form by using an AutoForm.

 � Add a subform to a form.

A database that contains the day-to-day records of an active company is useful only 

if it is kept current and if the information stored in it can be found quickly. Although 

Microsoft Offi ce Access 2007 is fairly easy to use, entering, editing, and retrieving infor-

mation in Datasheet view is not a task you would want to assign to someone who’s not 

familiar with Access. Not only would these tasks be tedious and ineffi cient, but working 

in Datasheet view leaves far too much room for error, especially if details of complex 

transactions have to be entered into several related tables. The solution to this problem, 

and the fi rst step in the conversion of this database to a database application in which 

you can effi ciently manage information, is to create and use forms.

A  form is an organized and formatted view of some or all of the fi elds from one or more 

tables or queries. Forms work interactively with the tables in a database.  You use controls 

in the form to enter new information, to edit or remove existing information, or to locate 

information. Like  printed forms, Access forms can include label controls that tell users what 

type of information they are expected to enter, as well as  text box controls in which they 

can view or enter information. Unlike printed forms, Access forms can also include a variety 
   103
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of other controls, such as option buttons and command buttons that transform Access 

forms into something very much like a Microsoft Windows dialog box or wizard page.

Tip You can also create forms to navigate among the features and functions of a database 

application and have little or no connection with its actual data.  A switchboard is an example 

of this type of form.

As with other Access objects, you can create forms manually or with the help of a wizard. 

It is best to create navigational and housekeeping forms, such as switchboards, manually 

in Design view. However, you should always create forms that are based on tables by using 

a wizard, and then refi ne the form manually—not because it is diffi cult to drag the neces-

sary controls onto a form, but because there is simply no point in doing it manually.

See Also For more information about switchboards, see “Creating a Switchboard” in Chapter 9, 
“Making Your Database Easy to Use.”

In this chapter, you will discover how easy it is to create forms—either by using the Form 

tool or by using the Form wizard—that you can modify to suit your needs, and how to 

present information from multiple tables in one form by using subforms. You will control a 

form’s function and appearance by inserting controls and modifying the form and control 

properties. Then you will learn how to automatically enter data in a form by using Microsoft 

Visual Basic for Applications (VBA) when a user performs an action in the control, such as 

clicking or entering text.

See Also Do you need only a quick refresher on the topics in this chapter? See the Quick 
Reference entries on pages xxxix–lxv.

Important Before you can use the practice fi les in this chapter, you need to install them 

from the book’s companion CD to their default location. See “Using the Book’s CD” on page 

xxv for more information.

Troubleshooting Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and you 

experience trouble following the instructions as written, please refer to the “Information for 

Readers Running Windows XP” section at the beginning of this book.

Creating a Form by Using the Form Tool
Before  you begin creating a form, you need to know which database query or table to 

base it on, and have an idea of how the form will be used. After making these decisions, 

Troubleshooting Graphics and operating system–related instructions in this book refl ect Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and youthe Windows Vista user interface. If your computer is running Microsoft Windows XP and you

experience trouble following the instructions as written, please refer to the “Information forexperience trouble following the instructions as written, please refer to the “Information for

Readers Running Windows XP” section at the beginning of this book.Readers Running Windows XP” section at the beginning of this book.
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you  can create a form in many ways. Remember that like almost any other object in 

Access, after you create the form, you can customize it in Design view if it does not quite 

meet your needs.

The quickest way is to select a table or query in the Navigation Pane, and then click the 

Form button in the Forms group on the Create tab. This creates a simple form using all 

the fi elds in the table or query, and opens it in Layout view.

If there is one (and only one) other table in the database that has a one-to-many rela-

tionship with the table on which your form is based, then the Form tool adds a datasheet 

(called a subform) which displays all the records in the related table that pertain to the 

current record in the main form.

In this exercise, you will use the Form tool to create a form based on a table.

USE the 01_CreateFormTool database. This practice fi le is located in the Chapter05 

subfolder under SBS_Access2007.

BE SURE TO start Access before beginning this exercise.

OPEN the 01_CreateFormTool database.

 1. In the Navigation Pane, under Tables, double-click Customers.

The Customers table opens in Datasheet view.

USE thethe 01_CreateFormTool01_CreateFormTool database. This practice fi le is located in the database. This practice fi le is located in thell Chapter05Chapter05
subfolder under subfolder under SBS_Access2007SBS_Access2007..7777

BE SURE TO start Access before beginning this exercise.start Access before beginning this exercise.

OPEN the the 01_CreateFormTool01_CreateFormTool database.database.ll
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2. On  the Create tab, in the Forms group, click the Form button.

Access creates and displays a simple form based on the active table.

Tip You don’t have to open a table to create a form based on it. You can simply click 

the table in the Navigation Pane to select it, then click the Form button on the Create 

tab in the Forms group. But it is sometimes useful to have the table open behind the 

form in order to verify the form contents against the table contents.

The Form tool automatically added a title (Customers) and a placeholder for a logo 

in the form header.

 3. Scroll through a few of the records by using the navigation controls at the bottom 

of the form.

You can compare the information shown in the form to that in the datasheet view 

of the table by alternately clicking the Customers table tab and the Customers form 

tab in the database window to easily switch back and forth between views.

CLOSE the Customers form (without saving your changes) and the 01_CreateFormTool 
database.
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Relationships
In Access, a relationship is an association between common fi elds in two tables. 

You can use this association to link information in one table to information 

in another table. For example, you can establish a relationship based on the 

CategoryID fi eld between the Categories table and the Products table. Each 

product is in only one category, but each category can contain many products, 

so this type of relationship—the most common—is known as a one-to-many 
relationship.

Less common relationships include:

O One-to-one relationships, in which each record in one table can have one 

and only one related record in the other table.

This type of relationship isn’t commonly used because it is easier to put all the 

fi elds in one table. However, you might use two related tables instead of one 

to break up a table with many fi elds, or to track information that applies to 

only some of the records in the fi rst table.

O Many-to-many relationships, which are really two one-to-many relationships 

tied together through a third table.

You could see this relationship in a database that contains Products, Orders, 

and Order Details tables. The Products table has one record for each prod-

uct, and each product has a unique ProductID. The Orders table has one 

record for each order placed, and each record in it has a unique OrderID. 

However, the Orders table doesn’t specify which products were included in 

each order; that information is in the Order Details table—the table in the 

middle that ties the other two tables together. Products and Orders each 

have a one-to-many relationship with Order Details. Products and Orders 

therefore have a many-to-many relationship with each other. In plain lan-

guage, this means that every product can appear in many orders, and every 

order can include many products.

If there is a one-to-many relationship between two tables in a database, an 

excellent way to display this is through the use of a form containing a subform. 

The main, or primary, form displays one record from the “one” side of the one-

to-many relationship, and the subform lists all the pertinent records from the 

“many” side of the relationship.

Relationships
In Access, aIn Access, a relationship is an association between common fi elds in two tables.is an association between common fi elds in two tables.

You can use this association to link information in one table to information You can use this association to link information in one table to information 

in another table. For example, you can establish a relationship based on the in another table. For example, you can establish a relationship based on the 

CategoryID fi eld between the Categories table and the Products table. EachCategoryID fi eld between the Categories table and the Products table. Each

product is in only one category, but each category can contain many products, product is in only one category, but each category can contain many products, 

so this type of relationship—the most common—is known as a so this type of relationship—the most common—is known as a one-to-many 
relationship..

Less common relationships include:Less common relationships include:

O One-to-one relationships, in which each record in one table can have one , in which each record in one table can have one 

and only one related record in the other table.and only one related record in the other table.

This type of relationship isn’t commonly used because it is easier to put all the This type of relationship isn’t commonly used because it is easier to put all the 

fi elds in one table. However, you might use two related tables instead of onefi elds in one table. However, you might use two related tables instead of one

to break up a table with many fi elds, or to track information that applies to to break up a table with many fi elds, or to track information that applies to 

only some of the records in the fi rst table.only some of the records in the fi rst table.

O Many-to-many relationships, which are really two one-to-many relationships, which are really two one-to-many relationships

tied together through a third table.tied together through a third table.

You could see this relationship in a database that contains Products, Orders, You could see this relationship in a database that contains Products, Orders, 

and Order Details tables. The Products table has one record for each prod-and Order Details tables. The Products table has one record for each prod-

uct, and each product has a unique ProductID. The Orders table has one uct, and each product has a unique ProductID. The Orders table has one 

record for each order placed, and each record in it has a unique OrderID.record for each order placed, and each record in it has a unique OrderID.

However, the Orders table doesn’t specify which products were included inHowever, the Orders table doesn’t specify which products were included in

each order; that information is in the Order Details table—the table in the each order; that information is in the Order Details table—the table in the 

middle that ties the other two tables together. Products and Orders each middle that ties the other two tables together. Products and Orders each 

have a one-to-many relationship with Order Details. Products and Orders have a one-to-many relationship with Order Details. Products and Orders 

therefore have a many-to-many relationship with each other. In plain lan-therefore have a many-to-many relationship with each other. In plain lan-

guage, this means that every product can appear in many orders, and everyguage, this means that every product can appear in many orders, and every

order can include many products.order can include many products.

If there is a one-to-many relationship between two tables in a database, an If there is a one-to-many relationship between two tables in a database, an 

excellent way to display this is through the use of a form containing aexcellent way to display this is through the use of a form containing a subform. . 

The main, or primary, form displays one record from the “one” side of the one-The main, or primary, form displays one record from the “one” side of the one-

to-many relationship, and the subform lists all the pertinent records from the to-many relationship, and the subform lists all the pertinent records from the 

“many” side of the relationship.“many” side of the relationship.



108  Chapter 5 Simplifying Data Entry by Using Forms
Refi ning Form Properties
As  with tables, you can work with forms in multiple views.     The two most common views 

are Form view, in which you view or enter data, and Design view, in which you add con-

trols to the form or change the form’s properties or layout.

When  you create a form by using the Form tool or the Form wizard, every fi eld included 

on the form is represented by a text box control and its associated label control.  A form 

like the one you created earlier in this chapter is linked, or bound, to the table it’s based 

on. Each text box is bound to a specifi c fi eld in the table.   The table is the record source, 

and the fi eld is the control source.   Each control has a number of properties, such as font, 

font size, alignment, fi ll color, and border. You can change the default values of these 

properties to improve the form’s appearance.

A  form inherits some of its properties from the table on which it is based. For instance, 

text box names on the form match fi eld names in the source table, text box labels match 

the Caption property of each fi eld, and the width of each text box is determined by the 

Field Size property. However, the properties of a form are not bound to their source. 

After you have created a form you can change the properties of the fi elds independently 

in the table and on the form.

In this exercise, you will edit the properties of a form.

USE the 02_Refi neProperties database. This practice fi le is located in the Chapter05 

subfolder under SBS_Access2007.

OPEN the 02_Refi neProperties database.

 1. In    the Navigation Pane, under Forms, right-click Customers, and then click 

Design View.

The Customers form opens in Design view. The  form is arranged in a Stacked layout 

that limits the extent of changes you can make to the form.

USE the the 02_Refi neProperties02_Refi neProperties database. This practice fi le is located in the database. This practice fi le is located in the Chapter05Chapter05
subfolder under subfolder under SBS_Access2007SBS_Access2007..7777

OPEN the the 02_Refi neProperties02_Refi neProperties database. database.
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Label Text box

2. Click the top border of the blue Form Footer header and drag the Form Footer 

down about three inches to enlarge the Detail grid.

3. Click the Detail section of the form above the Region label, and then drag to draw 

a rectangle through some portion of all the controls on the right side of the form 

to select them.

4. Drag the selected group of controls down and to the left, positioning them just be-

low the City label, then click any blank section of the grid to release the selection.

5. On the Customers form, click the CustomerID label (not its text box).

6. On    the Design contextual tab, in the Font group, click the Font arrow, and then in 

the list, click MS Sans Serif.

7. With the label still selected, click the Font Size arrow, and then in the list, click 8.

The label text becomes slightly smaller.

8. If   the Property Sheet pane is not visible, right-click the CustomerID text box (not 

its label), and then click Properties.
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All the settings available in the Font group (plus a few more) are available in the 

Property Sheet pane associated with each control. From this pane, you can display 

the properties of any object on the form, including the form itself.

You can display related types of properties by clicking the appropriate tab: Format, 

Data, Event, or Other, or display all properties by clicking the All tab.

9. In the Property Sheet pane, click the Format tab, scroll to the Font Name property, 

and change it to MS Sans Serif. Then set the Font Size property to 8, and the Font 
Weight property to Bold.

The CustomerID text in the form refl ects your changes.

Tip You  can change the width of a task pane by dragging its edge, and you can 

undock it so it fl oats in the program window by dragging it by the title bar.
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10. Click    the arrow in the Property Sheet pane header, and then in the property list, 

click Label3 to select the label to the left of the FirstName text box.

11. Repeat Step 9 to change the font of the text in the FirstName label box.

These different ways of selecting a control and changing its properties provide 

some fl exibility and convenience, but it would be a bit tedious to make changes to 

a few dozen controls in a form. The next two steps provide a faster method.

12. Click anywhere in the Detail section of the form, and then drag diagonally to draw 

a rectangle through some portion of all the controls to select them.

Tip You    can select all the controls in a form, including those in the header and 

footer, by pressing Ctrl+A.

Small    handles appear around the selected controls. In the Property Sheet pane, 

the Selection type changes to Multiple selection, and the Objects box is blank. 

Only the Format settings that are the same for all the selected controls are dis-

played. Because the changes you made in the previous steps are not shared by 

all the selected controls, the Font Name, Font Size, and Font Weight settings are 

now blank.

13. Repeat Step 9 to set the same Font Name, Font Size, and Font Weight properties 

for all the selected controls.

14.  With   all the controls still selected, on the Format tab of the Property Sheet pane, 

set the Back Style property to Normal.

The background of the labels is no longer transparent.

15. Click   the Back Color property, and then click the ellipsis button that appears.

16. In the Color Builder gallery that opens, click the yellow square, and then press F.

The background of all the controls changes to a bright yellow and the hexadecimal 

number representing this shade (#FFF200) appears in the Back Color property box.

Tip If    the Color Builder doesn’t include a color you want to use, click More Colors at 

the bottom of the gallery, select a color on the Standard or Custom tab of the Colors 

dialog box, and then click OK to set the color and add it to the list of recent colors at 

the bottom of the gallery.

17. In the Back Color property box, replace #FFF200 with #FFFFCC.

The background color changes to a pale yellow.

Ellipsis buttonEllipsis button
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18. Set  the Special Effect property to Shadowed, and the Border Color property to 

green.

19. In   the form, click away from the selected controls to release the selection (in other 

words, to deselect the controls).

20. Click   the FirstName label. In the Property Sheet pane, scroll up to the Caption 

property, change it from FirstName to Name, and then press F.

21. Repeat Step 20 to change Phone Number to Phone.

Tip You   can edit the Caption property of a label or the Control Source property of 

a text box by selecting it, clicking its text, and then editing the text as you would in 

any other Windows program. However, take care when editing the Control Source 

property, which defi nes where the content of the text box comes from.

22. Drag   through all the controls on the form to select them. On the Arrange tab, in 

the Control Layout group, click the Remove button.

Removing the Stacked layout gives you more options for arranging the controls.

23. Click away from the selected controls to release the selection.
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 24. Click   the label to the left of LastName, and then press the A key.

 25. Select    all the labels, but not their corresponding text boxes, by holding down the 

G key as you click each of them or by dragging through just the labels. Then in 

the Property Sheet pane, set the Text Align property to Right.

Now let’s size the bottom four label boxes to match the ones above, and line up 

their associated text boxes.

 26. Select the bottom four labels, but not their text boxes, and change their width 

property to 0.8847".

 27. Select all the labels again. On   the Arrange contextual tab, in the Size group, click 

the  Size to Fit button to resize the labels to fi t their contents, and then click any-

where in the form (but outside the controls) to release the selection.

Tip The order in which you make formatting changes, such as the ones you just 

made, can have an impact on the results. If you don’t see the expected results, click 

the Undo button on the Quick Access Toolbar, or press Ctrl+Z, to step back through 

your changes. Then try again.

Size to FitSize to Fit
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 28. Select   all the text boxes (but not their corresponding labels), and in the Property 
Sheet pane, change the Left setting to 1.5" to line up the text boxes and insert 

space between them and the labels.

 29. Change the Font Weight property to Normal, and then click anywhere in the form, 

but outside the controls, to deselect them.

 30. On the Quick Access Toolbar, click the Save button to save the design of the 

Customers form.

CLOSE the 02_Refi neProperties database.

Tip Unless you close the Property Sheet pane, it remains open until you close all open forms.

Changing the Arrangement of a Form
Both automatically-generated forms and forms created by a wizard are functional, not 

fancy. However, it’s fairly easy to customize the layout to suit your needs and preferences. 

You can add and delete labels, move both labels and text controls around the form, add 

logos and other graphics, and otherwise improve the layout of the form to make it attrac-

tive and easy to use.

While   you work with a form’s layout, you should pay attention to the shape of the pointer, 

which changes to indicate the manner in which you can change the selected item. Because 

a text box and its label sometimes act as a unit, you have to be aware of the pointer’s shape 

before making any change. The shape of the pointer indicates the action to be taken:

Four-headed arrow. Drag to move both controls together, or independently 

if the pointer is over a large square in the upper-left corner of the control.

Pointing fi nger. Drag to move just the control.

Vertical arrow. Drag the top or bottom border to change the height.

Horizontal arrow. Drag the right or left border to change the width.

Diagonal arrow. Drag the corner to change both the height and width.

In this exercise, you will rearrange the label and text box controls in a form.

SaveSave
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USE the 03_Refi neLayout database. This practice fi le is located in the Chapter05 subfolder 

under SBS_Access2007.

OPEN the 03_Refi neLayout database.

 1.  In the Navigation Pane, under Forms, right-click Customers, and then click 

Design View.

The  form is divided into three sections: Form Header, Detail, and Form Footer. We 

are interested in only the Detail section right now.

Form Header section Detail section

Form Footer section

Troubleshooting If you can’t see the Form Footer you may have to use the scroll 

bar to scroll down in the form until the footer appears. You can also right-click an 

inactive section of the Ribbon and then click Minimize The Ribbon to gain more 

screen space for your form. Click the minimized Ribbon and click Minimize The 

Ribbon again to restore the Ribbon.

 2. Point   to the right edge of the Detail grid, and when the pointer changes to a double-

headed arrow, drag the edge of the background to the right until you can see about 

seven full grid sections.

USE thethe 03_Refi neLayout03_Refi neLayout database. This practice fi le is located in the database. This practice fi le is located in the tt Chapter05Chapter05 subfolder subfolder 

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 03_Refi neLayout03_Refi neLayout database.database.tt

Troubleshooting If you can’t see the Form Footer you may have to use the scroll If you can’t see the Form Footer you may have to use the scroll 

bar to scroll down in the form until the footer appears. You can also right-click anbar to scroll down in the form until the footer appears. You can also right-click an

inactive section of the Ribbon and then click Minimize The Ribbon to gain moreinactive section of the Ribbon and then click Minimize The Ribbon to gain more

screen space for your form. Click the minimized Ribbon and click Minimize Thescreen space for your form. Click the minimized Ribbon and click Minimize The

Ribbon again to restore the Ribbon.Ribbon again to restore the Ribbon.
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3. Click the LastName text box, and then slowly move the pointer around its border, 

from handle to handle (there are eight handles), noticing how the pointer changes 

shape.

Item selector

If a label or text box can be moved independently, then it will have a larger item 

selector in its upper-left corner.

4. Move the pointer over the LastName text box and when it changes to a four-headed 

arrow, drag it up and to the right of the FirstName text box.

Tip If you can’t move the label independently of the text box, the form is probably 

in Stacked layout. Drag through all the controls to select them, and then click the 

Remove button in the Control Layout group on the Arrange tab.

5. Resize each control, and then arrange them in logical groupings on the form.
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Tip To   fi ne-tune the position of a control, click it and then move the control by 

pressing the Up Arrow, Down Arrow, Left Arrow, or Right Arrow key. To move the 

control lesser distances, hold down the Ctrl key while pressing the arrow key. To 

fi ne-tune the size of a control, hold down the Shift key while pressing the arrow key.

 6. On   the Arrange contextual tab, in the AutoFormat group, click the AutoFormat 
button.

The   AutoFormat gallery opens.

 7. At the bottom of the AutoFormat gallery, click AutoFormat Wizard.

The   AutoFormat wizard starts. Unlike most wizards, this one has only one page.

 8. In the AutoFormat dialog box, click the Customize button.

The Customize AutoFormat   wizard starts. Unlike most wizards, this one has only 

one page.
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9. In   the Customize AutoFormat dialog box, select the Create a new AutoFormat 
based on the Form ‘Customers’ option, and then click OK.

Tip Form   controls inherit whatever theme is set in the operating system. To change 

the theme, open Control Panel, click Appearance And Personalization, and then under 

Personalization, click Change The Theme. In the Theme Settings dialog box  , select the 

theme you want, and then click OK.

The New Style Name dialog box   opens.

10. In the Style Name box, type Customers, and then click OK.

In the AutoFormat wizard, the new style appears in the Form AutoFormats list. This 

style will now be available in any database you open on this computer.

11. In the AutoFormat wizard, click OK.

Tip Access saves data automatically as you enter it, but you must manually save 

layout changes to any object.

CLOSE the Customers form, saving your changes, and then close the 03_Refi neLayout 
database.
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Adding Controls to a Form
Every form has three basic sections: Form Header, Detail, and Form Footer. When you 

use the Form tool or a wizard to create a form, they add a set of controls for each fi eld 

that you select from the underlying table to the Detail section, add a logo placeholder 

and/or caption to the Form Header, and leave the Form Footer section blank.   Because 

the Footer section is empty, Access collapses it, but you can resize the Footer section by 

dragging its selector.  Although labels and text box controls are perhaps the most com-

mon controls found in forms, you can also enhance your forms with many other types of 

controls. For example, you can add groups of option buttons, check boxes, and list boxes 

to present people with choices instead of having them type entries in text boxes.

The controls that you can add to a form are located on the Design tab in the Controls 

group.

In this exercise, you will replace the logo and caption automatically placed in a form by 

the Form tool. You will also replace a text box control in the Detail section with a combo 

box control, and remove the record selector bar from the program window.

USE the 04_AddControls database and the 04_CustomersFormLogo graphic. These practice 

fi les are located in the Chapter05 subfolder under SBS_Access2007.

OPEN the 04_AddControls database. Then open the Customers form in Design view.

 1. In the Customers form, point   to the horizontal line between the Form Header 
section selector and the Detail section selector, and when the pointer changes 

to a double-headed arrow, drag the Detail section selector down a little more 

than an inch.

Tip Use the rulers along the top and left side of the form as guides.

USE thethe 04_AddControls04_AddControls database and the database and the 04_CustomersFormLogo04_CustomersFormLogo graphic. These practicegraphic. These practice

fi les are located in thefi les are located in the Chapter05Chapter05 subfolder under subfolder under SBS_Access2007SBS_Access2007..7777

OPEN thethe 04_AddControls04_AddControls database. Then open the Customers form in Design view.database. Then open the Customers form in Design view.
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2. Select the logo and the caption in the Form Header, and then press A.

3. On the Design contextual tab, in the Controls group, click the  Image button, 

and then, at the left end of the Form Header section, drag diagonally to draw a 

rectangle about 1 inch high and 1.5 inches wide.

To view information about a control, point to its button in the Controls group. After 

a few seconds a ScreenTip is displayed.

Tip Access  2007 has a new Logo control   that prompts you to enter a graphic name, 

and then automatically inserts the graphic in the form header.

4. In the Insert Picture dialog box, navigate to the Documents\MSP\SBS_Access2007\
Chapter05 folder, and then double-click the 04_CustomersFormLogo graphic.

Troubleshooting If the practice fi le isn’t visible, change the Files Of Type setting to 

Graphics Files.

The logo appears inside the image control.

ImageImage

Troubleshooting If the practice fi le isn’t visible, change the Files Of Type setting toIf the practice fi le isn’t visible, change the Files Of Type setting to

Graphics Files.Graphics Files.
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Tip How an image fi ts into an image control is determined by the Size Mode 

property of the control. If the property is set to Clip and the control isn’t large 

enough to display the entire image, the image is cropped. If the property is set to 

Stretch, you can enlarge the control to display the entire image. If the property is 

set to Zoom, the image will automatically resize to fi t the control.

 5. In the Controls group, click the Label button, and then drag diagonally to draw 

another rectangle in the header section.

Access inserts a label control containing the insertion point, ready for you to enter 

a caption.

 6. In the active label control, type Customers. Then press F.

The Customers label takes on the formatting of the other labels.

Troubleshooting Access displays a Smart Tag next to the control, warning you that 

the label is not associated with any other control. You can ignore this, or click Ignore 

Error to make it go away.

 7. If the Property Sheet pane is not already open, press $ to open it.

Tip You can toggle the display of the Property Sheet pane by pressing the F4 key.

 8. Change the Font Size property to 18, and the Text Align property to Center. Then 

close the Property Sheet pane.

 9. On the Arrange tab, in the Size group, click the Size to Fit button.

The size of the label control changes to fi t the text.

Troubleshooting Access displays a Smart Tag next to the control, warning you that Access displays a Smart Tag next to the control, warning you that 

the label is not associated with any other control. You can ignore this, or click Ignore the label is not associated with any other control. You can ignore this, or click Ignore 

Error to make it go away.Error to make it go away.

Size to FitSize to Fit
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 10. Adjust the size and position of the image and label controls so that they are 

side-by-side.

 11. On   the Design tab, in the Controls group, look at the  Use Control Wizards button. 

If the button is active (orange), click it to deactivate it.

Turning off the Control Wizards feature enables you to add a control with all the 

default settings, without having to work through the wizard’s pages.

 12. In   the Controls group, click the  Combo Box button. Then drag diagonally to draw 

a rectangle just below the Country text box.

When   you release the mouse button, Access displays a combo box control, which is 

unbound (not attached to a fi eld in the Customers table).

Troubleshooting Access assigns a number to each control when it is created. Don’t 

be concerned if the number displayed in your control is different from what you see 

in the graphics in this book.

 13. Click     the Country text box. In the Font group, click the  Format Painter button and 

then click the combo box control.

Access copies the formatting of the text box to the combo box control and its label.

 14. If the Property Sheet pane is not open, right-click the combo box, and then click 

Properties.

 15. In    the Property Sheet pane, on the Data tab, click the Control Source arrow, and 

then in the list, click Country.

 16. In the Row Source box, type

SELECT DISTINCT Customers.Country FROM Customers;

Use Control 
Wizards

Use Control 
Wizards

Combo BoxCombo Box

Troubleshooting Access assigns a number to each control when it is created. Don’t Access assigns a number to each control when it is created. Don’t 

be concerned if the number displayed in your control is different from what you seebe concerned if the number displayed in your control is different from what you see

in the graphics in this book.in the graphics in this book.

Format PainterFormat Painter



 Adding Controls to a Form  123
There is a period (but no space) between Customers and Country, and a semicolon 

at the end of the text.

This line of code is a query that extracts one example of every country in the 

Country fi eld of the Customers table and displays the results as a list when you click 

the Country arrow.

You might have to widen the Property Sheet pane to display the entire query.

Tip If you need to add a customer from a country that is not in the list, you can type 

the country’s name in the combo box. After the record is added to the database, that 

country shows up when the combo box list is displayed.

 17. If it isn’t already, set the Row Source Type to Table/Query.

 18. Click the combo box label. (If you can’t see the combo box label, move the 

Property Sheet pane.)

 19. In the Property Sheet pane, on the Format tab, change the Caption to Country. 

Then close the Property Sheet pane.

 20. Delete the original Country text box and its label, and then move the new combo 

box and label into their place, resizing them as needed.

 21. On the Home tab, in the Views group, click  the  View button to see your form in 

Form view.

Tip When a form is in Layout view or Design view, you can switch to Form view by 

clicking the View button.
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 22. Scroll through a couple of records, and then click the combo box arrow to display 

the country list.

 23. You    don’t need the record selector—the gray bar along the left edge of the 

form—for this exercise, so return to Design view and display the Property Sheet 
pane for the entire form by clicking the Form selector (the box at the junction of 

the horizontal and vertical rulers) and pressing $ (if the sheet is not already dis-

played). Then on the Format tab, change Record Selectors to No, and Scroll Bars 
to Neither. Then press $ again to close the Property Sheet pane.

 24. Save the form’s new design, and then switch to Form view for a fi nal look.

CLOSE the 04_AddControls database.

Entering Data in a Form by Using VBA
As  you might suspect by now, almost everything in Access, including the Access program 

itself, is an object.  One of the characteristics of objects is that they can recognize and 

respond to events, which are essentially actions. Different objects recognize different 

events.   The basic events, recognized by almost all objects, are Click, Double Click, Mouse 
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Down, Mouse Move, and Mouse Up. Most objects recognize quite a few other events. A 

text control, for example, recognizes 17 different events; a form recognizes more than 50.

Tip The events recognized by an object are listed on the Event tab in the object’s Property 

Sheet pane.

While you use a form, objects are signaling events, or fi ring events, almost constantly. 

However, unless you attach a macro or VBA procedure to an event, the object is really 

just fi ring blanks. By default, Access doesn’t do anything obvious when it recognizes 

most events. So without interfering with the program’s normal behavior, you can use 

an event to specify what action should happen. You can even use an event to trigger a 

macro to run or a VBA procedure to perform a set of actions.

Sound complicated? Well, it’s true that events are not things most casual Access users 

tend to worry about. But because knowing how to handle events can greatly increase the 

effi ciency of objects such as forms, it is helpful to have an idea of what they’re all about.

For example, while looking at customer records in one of the exercise databases, you 

might have noticed that the CustomerID is composed of the fi rst three letters of the 

customer’s last name and the fi rst two letters of his or her fi rst name, all in capital letters. 

This technique usually generates a unique ID for a new customer. If you try to enter an ID 

that is already in use, Access won’t accept the new entry, and you’ll have to add a number 

or change the ID in some other way to make it unique. Performing trivial tasks, such as 

combining parts of two words and then converting the results to capital letters, is some-

thing a computer excels at. So rather than typing the ID for each new customer record 

that is added to the database, you can let VBA do it for you.

In this exercise, you will write a few lines of VBA code and attach the code to an event in 

a form. This is by no means an in-depth treatment of VBA, but this exercise will give you 

a taste of the power of VBA.

USE the 05_VBA database and the 05_AftUpdate text fi le. These practice fi les are located in 

the Chapter05 subfolder under SBS_Access2007.

OPEN the 05_VBA database. Then open the Customers form in Design view.

 1. In the Customers form, click the LastName text box, and then if the Property 
Sheet pane isn’t already open, press $ to open it.

 2. Click  the Event tab.

This tab lists the events to which the LastName text box control can respond.

USE thethe 05_VBA05_VBA database and thedatabase and the 05_AftUpdate05_AftUpdate text fi le. These practice fi les are located in text fi le. These practice fi les are located in

thethe Chapter05Chapter05 subfolder under subfolder under SBS_Access2007SBS_Access2007..7777

OPEN thethe 05_VBA05_VBA database. Then open the Customers form in Design view. database. Then open the Customers form in Design view.
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3. In the 
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The Project Explorer pane  lists any objects in the database to which you can attach 

code; in this case, only the Customers form (Form_Customers) appears in the list. 

New forms and reports appear here automatically.

The Code window displays a placeholder for the procedure that Access will use to 

handle the After Update event for the LastName text box control. This procedure 

is named Private Sub LastName_AfterUpdate(), and at the moment it contains 

only the Sub and End Sub statements that mark the beginning and end of any 

procedure.

5. Navigate to your Documents\MSP\SBS_Access2007\Chapter05 folder, double-click 

the 05_AftUpdate text fi le to open it in your default text editor, and then copy the 

following lines of text to the Clipboard.

     'Create variables to hold first and last names
     ' and customer ID
     Dim fName As String
     Dim lName As String
     Dim cID As String

     'Assign the text in the LastName text box to
     ' the lName variable.
     lName = Forms!customers!LastName.Text

     'You must set the focus to a text box before
     ' you can read its contents.
     Forms!customers!FirstName.SetFocus
     fName = Forms!customers!FirstName.Text

     'Combine portions of the last and first names
     ' to create the customer ID.
     cID = UCase(Left(lName, 3) & Left(fName, 2))

     'Don't store the ID unless it is 5 characters long
     ' (which indicates both names filled in).
     If Len(cID) = 5 Then
          Forms!customers!CustomerID.SetFocus

          'Don't change the ID if it has already been
          ' entered; perhaps it was changed manually.
          If Forms!customers!CustomerID.Text = "" Then
               Forms!customers!CustomerID = cID
          End If
     End If

     'Set the focus where it would have gone naturally.
     Forms!customers!Address.SetFocus
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Important A   line of text beginning with an apostrophe is a comment that 

explains the purpose of the next line of code. In the VBA Editor, comments are 

displayed in green.

 6. Switch back to the Code window, and then paste the copied text between the 

Private Sub LastName_AfterUpdate() and End Sub statements.

 7. On the File menu, click Save 05_VBA to save your changes.

 8. On   the File menu, click Close and Return to Microsoft Access to return to the 

Access window. Then close the Property Sheet pane.

 9. Switch to Form view. On the Navigation bar, click the  New Record button.

A blank Customers form appears.

 10. In the new record, press the D key to move the insertion point to the FirstName 

box, type Chris, press D to move to the LastName box, type Sells, and then press 

D again.

If you followed the above steps correctly, SELCH appears in the CustomerID box.

New RecordNew Record
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 11. Change the fi rst name to Dana and the last name to Birkby.

Notice that the original CustomerID doesn’t change, even when the names from 

which it was derived do.

 12. Press the P key to remove your entry, and then try entering the last name fi rst, 

followed by the fi rst name.

Access does not create a Customer ID. The code does what it was written to do, but 

not necessarily what you want it to do, which is to create an ID regardless of the 

order in which the names are entered. There are several ways to fi x this problem. 

For example, you could write a similar procedure to handle the After Update event 

in the FirstName text box, or you could write one procedure to handle both events 

and then jump to it when either event occurs.

  13. Press P to clear your entries.

CLOSE the 05_VBA database.

Creating a Form by Using an AutoForm
Although  a form doesn’t have to include all the fi elds from the underlying table, when 

it is intended as the primary method of creating new records, it usually does. The quick-

est way to create a form that includes all the fi elds from one table is to use the Form 

button, as you did in the fi rst exercise in this chapter. Another method, which provides 

more control over the creation of the form, is to use a wizard. In either case you can 

easily customize the forms created.

In this exercise, you will use a wizard to create a form that displays information about 

each of the product categories.

USE the 06_CreateWizard database. This practice fi le is located in the Chapter05 subfolder 

under SBS_Access2007.

OPEN the 06_CreateWizard database. Then open the Categories table in Datasheet view.

 1. On  the Create tab, in the Forms group, click the More  Forms button and then in 

the list, click Form Wizard.

The Form wizard starts.

USE thethe 06_CreateWizard06_CreateWizard database. This practice fi le is located in the database. This practice fi le is located in thedd Chapter05Chapter05 subfolder  subfolder 

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 06_CreateWizard06_CreateWizard database. Then open the Categories table in Datasheet view.database. Then open the Categories table in Datasheet view.dd
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 2. With the Categories table selected in the Tables/Queries list, click the Move All 
button to move all the table fi elds to the Selected Fields list, and then click Next.

On the second page of the wizard, you choose the layout of the fi elds in the new 

form. When you select an option on the right side of the page, the preview area on 

the left side shows what the form layout will look like with that option applied.

 3. With the Columnar option selected, click Next.

On the third page of the wizard, you can select a style option to see how the style 

will look when applied to the form.

 4. In the list of styles, click Offi ce, and then click Next.

Access suggests the base table name as the form’s title.

 5. With the Open the form to view or enter information option selected, click Finish.

The new Categories form opens, displaying the fi rst category record in the 

Categories table.

Move AllMove All
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6. Scroll through a few records by using the navigation controls at the bottom of 

the form.

Tip To change the style of a form after you create it, switch to Design view, and on 

the Arrange tab, in the AutoFormat group, click AutoFormat. In the list displayed, click 

the style you would like to use.

7. Switch to Design view so that you can make a few more changes.

8. Delete   the word Category from the Category Name label.

9. You     don’t want to expose the CategoryID fi eld to form users, because that value 

should never be changed. Click the CategoryID text box, and if the control’s 

Property Sheet pane isn’t open, press $ to display it.

10. In the Property Sheet pane, on the Data tab, change Enabled to No. Then press 

$ to close the Property Sheet pane.

Disabling the CategoryID text box changes it, and the label text, to gray.

11. Switch to Form view, and then scroll through a few categories. Try to edit entries in 

the CategoryID fi eld to confi rm that you can’t.

12. You don’t need scroll bars or a record selector in this form, so return to Design view, 

and then display the form’s Property Sheet pane by clicking the Form selector (the 

box in the upper-left corner) and pressing $.

13. In      the Property Sheet pane, on the Format tab, change Scroll Bars to Neither and 

Record Selectors to No. Then close the Property Sheet pane.

14. Switch to Form view to see the effect of your changes.

CLOSE the Categories form, saving your changes, and then close the 06_CreateWizard 

database.
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Simultaneously Creating Forms and Subforms
If you know when you create a form that you are going to add a subform, you can 

create the form and its subform by using the Form wizard. To do so:

 1. On  the Create tab, in the Forms group, click the  More Forms button, and 

then in the list, click Form Wizard.

 2. In the Form wizard, in the Tables/Queries list, click the table on which you 

want to base the form. Then click the  Move All button to include all the table 

fi elds in the new form.

 3. In the Tables/Queries list, click the table on which you want to base the subform.

 4. In the Available Fields list, double-click the fi elds you want to include in the 

subform to move them to the Selected Fields list, and then click Next.

Simultaneously Creating Forms and Subforms
If you know when you create a form that you are going to add a subform, you can If you know when you create a form that you are going to add a subform, you can 

create the form and its subform by using the Form wizard. To do so:create the form and its subform by using the Form wizard. To do so:

1. 1. OnOn thethe CreateCreate tab, in the  tab, in the FormsForms group, click thegroup, click the More FormsMore Forms button, and  button, and 

then in the list, click then in the list, click Form WizardForm Wizard..

2. 2. In theIn the FormForm wizard, in the  wizard, in the Tables/QueriesTables/Queries list, click the table on which youlist, click the table on which you

want to base the form. Then click thewant to base the form. Then click the Move AllMove All button to include all the tablebutton to include all the table

fi elds in the new form.fi elds in the new form.

3. 3. In the In the Tables/QueriesTables/Queries list, click the table on which you want to base the subform. list, click the table on which you want to base the subform.

4. 4. In theIn the Available FieldsAvailable Fields list, double-click the fi elds you want to include in the list, double-click the fi elds you want to include in the 

subform to move them to the subform to move them to the Selected FieldsSelected Fields list, and then click list, and then click NextNext..
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 5. With your primary table and Form with subform(s) selected, click Next.

 6. With Datasheet selected, click Next.

 7. On the last page of the wizard, select a style, and then click Finish.

The wizard creates and opens the form and subform.

You can edit the form created by the Form wizard to suit your needs.

If there is only one one-to-many relationship between the tables you want to include 

in the form, and that relationship has been defi ned in the Relationships window, the 

fastest way to create the form and its subform is by using the Form tool. Simply select 

the primary table then on the Create tab, in the Forms group, click Form.

The Form tool creates and displays a form and subform, each containing all the 

fi elds of its source table.

Troubleshooting If the relationship between the selected tables has not been 

defi ned, Access displays a message containing a link to the Relationships window. If 

this occurs, you will need to defi ne the relationship and then re-start the wizard.

Adding a Subform to a Form
A form can display information (fi elds) from one or more tables or queries.  If you want to 

display fi elds from several tables or queries in one form, you have to give some thought 

to the relationships that must exist between those objects.

5. 5. With your primary tableWith your primary table andand Form with subform(s)Form with subform(s) selected, click selected, click NextNext..

6. 6. With With DatasheetDatasheet selected, click selected, click NextNext..

7. 7. On the last page of the wizard, select a style, and then click On the last page of the wizard, select a style, and then click FinishFinish..

The wizard creates and opens the form and subform.The wizard creates and opens the form and subform.

You can edit the form created by the Form wizard to suit your needs.You can edit the form created by the Form wizard to suit your needs.

If there is only one one-to-many relationship between the tables you want to includeIf there is only one one-to-many relationship between the tables you want to include

in the form, and that relationship has been defi ned in the Relationships window, thein the form, and that relationship has been defi ned in the Relationships window, the

fastest way to create the form and its subform is by using the Form tool. Simply selectfastest way to create the form and its subform is by using the Form tool. Simply select

the primary table then on the Create tab, in the Forms group, click Form.the primary table then on the Create tab, in the Forms group, click Form.

The Form tool creates and displays a form and subform, each containing all the The Form tool creates and displays a form and subform, each containing all the 

fi elds of its source table.fi elds of its source table.

Troubleshooting If the relationship between the selected tables has not beenIf the relationship between the selected tables has not been

defi ned, Access displays a message containing a link to the Relationships window. If defi ned, Access displays a message containing a link to the Relationships window. If 

this occurs, you will need to defi ne the relationship and then re-start the wizard.this occurs, you will need to defi ne the relationship and then re-start the wizard.
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In this exercise, you will add a subform to an existing form.

USE the 07_AddSubform database. This practice fi le is located in the Chapter05 subfolder 

under SBS_Access2007.

OPEN the 07_AddSubform database. Then open the Categories form in Design view.

 1. Drag the Form Footer section selector down about 1 inch to give yourself about 

3 inches of vertical space to work in the Details section of the form.

 2. On the Design tab, in the Controls group, make sure the  Use Control Wizards 
button is active (orange).

 3. In  the Controls group, click the  Subform/Subreport button, and then drag 

diagonally to draw a rectangle in the lower portion of the Detail section.

A white object appears in the form, and the SubForm wizard starts.

Tip If prompted to do so, follow the instructions to install this wizard.

USE thethe 07_AddSubform07_AddSubform database. This practice fi le is located in the database. This practice fi le is located in the Chapter05Chapter05 subfoldersubfolder

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 07_AddSubform07_AddSubform database. Then open the Categories form in Design view. database. Then open the Categories form in Design view.

Use Control 
Wizards

Use Control 
Wizards

Subform/
Subreport
Subform/
Subreport
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4. With the Use existing Tables and Queries option selected, click Next.

5. In the Tables/Queries list, click Table: Products.

6. In the Available Fields list, double-click the ProductName, CategoryID, 

QuantityPerUnit, UnitPrice, and UnitsInStock fi elds to add them to the Selected 
Fields list. Then click Next.

Because  the CategoryID fi eld in the subform is related to the CategoryID fi eld in 

the main form, the wizard selects Show Products For Each Record In Categories 

Using CategoryID as the Choose From A List option.
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Tip If the wizard can’t fi gure out which fi elds are related, it selects the Defi ne My 

Own option and displays list boxes in which you can specify the fi elds to be related.

7. With the Defi ne my own option selected, click Finish.

Access displays the Categories form in Design view, with an embedded Products 

subform. The size and location of the subform is determined by the size and loca-

tion of the original rectangle you created in the form.

8. Adjust the size and location of the objects in your form as needed to view the 

entire subform.
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 9. Notice the layout of the subform in Design view, and then on the View toolbar in 

the lower-right corner of the Access program window, click the  Form View button 

to switch views.

The format of the subform has totally changed. In Design view, it looks like a simple 

form, but in Form view, it looks like a datasheet.

 10. Switch back to Design view, make any necessary size adjustments, and then open 

the Property Sheet pane if it isn’t already open.

 11. Click   the Form selector in the upper-left corner of the subform twice.

The fi rst click selects the Products subform control, and the second click selects the 

form. A small black square appears on the selector.

Tip You  can quickly adjust the width of columns to fi t their data by double-clicking 

the double arrow between column headings.

Form ViewForm View
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Products subform Form selector

12. In the Property Sheet pane, on the Format tab, change the Record Selectors and 

Navigation Buttons properties to No.

13. Close the Property Sheet pane, switch back to Form view, and then adjust the width 

of the columns by dragging the column dividers, until you can see all the fi elds.

14. Scroll   through several categories by using the navigation buttons.
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As each category appears at the top of the form, the products in that category are 

listed in the datasheet in the subform.

 15. Click the  First Record button to return to the fi rst category (Bulbs). In the subform 

click Bulbs in the Category column to the right of the fi rst product (Magic Lily).

The arrow at the right end of the box indicates that this is a combo box.

 16. Click the arrow to display the list of categories, and then change the category 

to Cacti.

 17. Click the  Next Record navigation button to move to the Cacti category.

Magic Lily is now included in this category.

 18. Display the category list to the right of Magic Lily, and return it to the Bulbs 
category.

 19. To prevent people from changing a product’s category, return to Design view, click 

the CategoryID text box control in the subform, and then press A.

The CategoryID text box and its label no longer appear on the form.

Important You included the CategoryID fi eld when the wizard created this subform 

because it is the fi eld that relates the Categories and Products tables. The underlying 

Products table uses a combo box to display the name of the category instead of its ID 

number, so that combo box also appears in the subform.

 20. Save the form, switch back to Form view, and then adjust the width of the subform 

columns and the size of the Form window until you can clearly see the fi elds.

CLOSE the 07_AddSubform database. If you are not continuing directly on to the next 

chapter, quit Access.

First RecordFirst Record

Next RecordNext Record
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Key Points
 O A form is an organized and formatted view of some or all of the fi elds from one or 

more tables or queries. Forms work interactively with the tables in a database. You 

use controls in the form to enter new information, to edit or remove existing infor-

mation, or to locate information.

 O The quickest way to create a form that includes all the fi elds from one table is by 

using the Form tool. You can easily customize the form later in Design view.

 O When you know what table to base your form on, and have an idea of how the 

form will be used, you can use the Form wizard to quickly create a form. You can 

make modifi cations to the form in Design view.

 O The two most common views to work with forms in are Form view, in which you 

view or enter data, and Design view, in which you add controls, change form prop-

erties, and change the form layout.

 O Each text box in a form is bound to a specifi c fi eld in the underlying table. The 

table is the record source and the fi eld is the control source. Each control has a 

number of properties, such as font style, font size, and font color, which you can 

change to improve a form’s appearance.
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 O You can resize the three basic sections of a form: the Form Header, Detail, and 

Form Footer. You can customize any section of your form’s layout by adding and 

deleting labels, moving labels and text controls, and adding logos and other graph-

ics. The most popular controls are available in the Controls group on the Design 

tab.

 O The objects in your form can recognize and respond to events, which are essential-

ly actions. But without a macro or VBA procedure attached to it, an event doesn’t 

actually do anything. Knowing how to handle events can greatly increase the effi -

ciency of objects, such as forms.

 O If you want to display fi elds from several tables or queries in one form, you have to 

give some thought to the relationships that must exist between those objects. In 

Access, a relationship is an association between common fi elds in two tables, and 

you can relate the information in one table to the information in another table. 

There are three types of relationships that Access recognizes: one-to-one, one-to-

many, and many-to-many.

 O After you defi ne a relationship between tables, you can add subforms to your 

forms. For example, for each category displayed in your main form, you might have 

a subform that displays all the products in that category.
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66 Locating Specifi c  Locating Specifi c 
 Information Information

In this chapter, you will learn to:

 � Sort and fi lter information in a table.

 � Filter information by using a form.

 � Locate information that matches multiple criteria.

 � Create a query manually or by using a wizard.

 � Perform calculations by using a query.

A database is a repository for information. It might contain only a few records or 

thousands of records, stored in one table or multiple tables. No matter how much 

information a database contains, it is useful only if you can locate the information 

you need when you need it. In a small database you can fi nd information simply by 

scrolling through a table until you fi nd what you are looking for. But as a database 

grows in size and complexity, locating and analyzing information becomes more 

diffi cult.

Microsoft Offi ce Access 2007 provides a variety of tools you can use to organize the 

display of information stored in a database and to locate specifi c items of information.    

Using these tools, you can organize all the records in a table by quickly sorting it based 

on any fi eld or combination of fi elds, or you can fi lter the table so that information con-

taining some combination of characters is displayed or excluded from the display. With 

a little more effort, you can create queries to display specifi c fi elds from specifi c records 

from one or more tables. You can save queries and run the saved queries to generate 

updated results when data changes.

In this chapter, you will learn how to sort and fi lter information in a table, display selected 

information in a form; and locate information that matches multiple criteria. Then you will 

create queries to locate information and to perform calculations.
  143
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See Also Do you need only a quick refresher on the topics in this chapter? See the Quick 
Reference entries on pages xxxix–lxv.

Important Before you can use the practice fi les in this chapter, you need to install them 

from the book’s companion CD to their default location. See “Using the Book’s CD” on page 

xxv for more information.

Troubleshooting Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and you 

experience trouble following the instructions as written, please refer to the “Information for 

Readers Running Windows XP” section at the beginning of this book.

Sorting Information in a Table
You   can sort the information stored in a table based on the values in one or more fi elds, 

in either ascending or descending order. For example, you could sort customer informa-

tion alphabetically by last name and then by fi rst name. This would result in the order 

found in telephone books.

Last First

Smith Denise

Smith James

Smith Jeff

Thompson Ann

Thompson Steve

Sorting a table groups all entries of one type together, which can be useful. For example, 

to qualify for a discount on postage, you might want to group customer records by 

postal code before printing mailing labels.

Troubleshooting Graphics and operating system–related instructions in this book refl ect Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and youthe Windows Vista user interface. If your computer is running Microsoft Windows XP and you

experience trouble following the instructions as written, please refer to the “Information forexperience trouble following the instructions as written, please refer to the “Information for

Readers Running Windows XP” section at the beginning of this book.Readers Running Windows XP” section at the beginning of this book.
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How Access Sorts
The  concept of sorting seems quite intuitive, but sometimes your computer’s 

approach to such a concept is not so intuitive.   Sorting numbers is a case in point. 

In Access, numbers can be treated as text or as numerals. Because of the spaces, 

hyphens, and punctuation typically used in street addresses, postal codes, and 

telephone numbers, the numbers in these fi elds are usually treated as text, and 

sorting them follows the logic applied to sorting all text. Numbers in a price or 

quantity fi eld, on the other hand, are typically treated as numerals.

When   Access sorts text, it sorts fi rst on the fi rst character in the selected fi eld in 

every record, then on the next character, then on the next, and so on—until it runs 

out of characters. When Access sorts numbers, it treats the contents of each fi eld 

as a single value, and sorts the records based on that value. This tactic can result 

in seemingly strange sort orders. For example, sorting the list in the fi rst column of 

the following table as text produces the list in the second column. Sorting the same 

list as numerals produces the list in the third column.

Original Sort as text Sort as numerals

1 1 1

1234 11 3

23 12 4

3 1234 11

11 22 12

22 23 22

12 3 23

4 4 1234

If a fi eld with the Text data type contains numbers, you can sort the fi eld numeri-

cally by padding the numbers with leading zeros so that all entries are the same 

length. For example, 001, 011, and 101 are sorted correctly even if the numbers are 

defi ned as text.

How Access Sorts
TheThe concept of sorting seems quite intuitive, but sometimes your computer’s concept of sorting seems quite intuitive, but sometimes your computer’s 

approach to such a concept is not so intuitive.approach to such a concept is not so intuitive. Sorting numbers is a case in point. Sorting numbers is a case in point. 

In Access, numbers can be treated as text or as numerals. Because of the spaces,In Access, numbers can be treated as text or as numerals. Because of the spaces,

hyphens, and punctuation typically used in street addresses, postal codes, and hyphens, and punctuation typically used in street addresses, postal codes, and 

telephone numbers, the numbers in these fi elds are usually treated as text, and telephone numbers, the numbers in these fi elds are usually treated as text, and 

sorting them follows the logic applied to sorting all text. Numbers in a price orsorting them follows the logic applied to sorting all text. Numbers in a price or

quantity fi eld, on the other hand, are typically treated as numerals.quantity fi eld, on the other hand, are typically treated as numerals.

When When Access sorts text, it sorts fi rst on the fi rst character in the selected fi eld inAccess sorts text, it sorts fi rst on the fi rst character in the selected fi eld in

every record, then on the next character, then on the next, and so on—until it runsevery record, then on the next character, then on the next, and so on—until it runs

out of characters. When Access sorts numbers, it treats the contents of each fi eldout of characters. When Access sorts numbers, it treats the contents of each fi eld

as a single value, and sorts the records based on that value. This tactic can result as a single value, and sorts the records based on that value. This tactic can result 

in seemingly strange sort orders. For example, sorting the list in the fi rst column of in seemingly strange sort orders. For example, sorting the list in the fi rst column of 

the following table as text produces the list in the second column. Sorting the samethe following table as text produces the list in the second column. Sorting the same

list as numerals produces the list in the third column.list as numerals produces the list in the third column.

OriginalOriginal Sort as textSort as text Sort as numeralsSort as numerals

11 11 11

12341234 1111 33

2323 1212 44

33 12341234 1111

1111 2222 1212

2222 2323 2222

1212 33 2323

44 44 12341234

If a fi eld with the Text data type contains numbers, you can sort the fi eld numeri-If a fi eld with the Text data type contains numbers, you can sort the fi eld numeri-

cally by padding the numbers with leading zeros so that all entries are the same cally by padding the numbers with leading zeros so that all entries are the same 

length. For example, 001, 011, and 101 are sorted correctly even if the numbers arelength. For example, 001, 011, and 101 are sorted correctly even if the numbers are

defi ned as text.defi ned as text.
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In this exercise, you will sort records fi rst by one fi eld, and then by multiple fi elds.

USE the 01_SortTable database. This practice fi le is located in the Chapter06 subfolder 

under SBS_Access2007.

OPEN the 01_SortTable database.

1. In the Navigation Pane, under Tables, double-click Customers.

The Customers table opens in Datasheet view.

2. Click   the arrow at the right side of the Region column header, and then click 

Sort A to Z.

Access rearranges the records in alphabetical order by region, and displays a 

narrow upward-pointing arrow at the right side of the column header to indicate 

the sort order.

3. To   reverse the sort order by using a different method, on the Home tab, in the Sort 
& Filter group, click the  Descending button.

The sort order reverses. The records for customers living in Washington (WA) are 

now at the top of your list. In both sorts, the region was sorted alphabetically, but 

the City fi eld was left in a seemingly random order. 

USE the the 01_SortTable01_SortTable database. This practice fi le is located in the database. This practice fi le is located in the Chapter06Chapter06 subfolder  subfolder 

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 01_SortTable01_SortTable database.database.

DescendingDescending



 

 

 

 

 

 

 Sorting Information in a Table  147
Suppose that you want to see the records arranged by city within each region. You 

can do this by sorting the City column and then the Region column, or by moving 

the Region column to the left of the City column, selecting both, and then sorting 

them together.

Tip Access   can sort on more than one fi eld, but it sorts consecutively from left to 

right. So the fi elds you want to sort must be adjacent, and they must be arranged in 

the order in which you want to sort them.

4. To sort the cities in ascending order within the regions, fi rst click the City sort order 

arrow, and then click Sort A to Z.

Access sorts the records alphabetically by city.

5. To fi nish the process, right-click anyplace in the Region column, and then click 

Sort A to Z.

The two columns are now sorted so the cities in each region are listed in ascending 

order.

6. To   sort both columns at the same time in descending order, move the Region fi eld 

to the left of the City fi eld by clicking its header to select the column, and then 

dragging the column to the left until a dark line appears between Address and 

City. Release the mouse button to complete the move operation.

7. With the Region column selected, hold down the G key and click the City head-

er to extend the selection so that both the Region and City columns are selected.

8. In the Sort & Filter group, click the  Descending button to arrange the records with 

the regions in descending order and the city names also in descending order within 

each region (or in this case, each state).

9. Experiment with various ways of sorting the records to display different results.

Tip You   can sort records while viewing them in a form. Click the fi eld on which you 

want to base the sort, and then click the Sort command you want. You can’t sort by 

multiple fi elds at the same time in Form view, but you can sort on one fi eld then the 

next to achieve the same results.

CLOSE the Customers table without saving your changes, and then close the 01_SortTable 

database.
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Filtering Information in a Table
Sorting   the information in a table organizes it in a logical manner, but you still have 

the entire table to deal with. To locate only the records containing (or not containing) 

specifi c information, fi ltering is more effective than sorting. For example, you could 

quickly create a fi lter to locate only customers who live in Seattle, only items that were 

purchased on January 13, or only orders that were not shipped by standard mail.

You  can apply simple fi lters while viewing information in a table or form. To fi lter 

information by multiple criteria, you can apply additional fi lters to the results of the 

fi rst one.

Wildcards
If   you want to locate records containing certain information but aren’t sure of all 

the characters, or want your search to return multiple variations of a base character 

set, you can include wildcard characters in your search criteria. The most common 

wildcards are:

 O * (asterisk) represents any number of characters For example

LastName = Co* returns entries including Colman and Conroy

 O ? (question mark) represents any single alphabetic character. For example

FirstName = er?? returns entries including Eric and Erma

 O # (number sign) represents any single numeric character. For example 

ID = 1## returns any ID from 100 through 199

Tip Access supports several sets of wildcards. For more information on these, 

search Access Help for wildcards and read the topic titled “Access wildcard character 

reference.”

When searching for information in a text fi eld, you can also use the Contains text 

fi lter to locate records containing words or character strings.

Wildcards
IfIf you want to locate records containing certain information but aren’t sure of all you want to locate records containing certain information but aren’t sure of all 

the characters, or want your search to return multiple variations of a base character the characters, or want your search to return multiple variations of a base character 

set, you can include set, you can include wildcard characters in your search criteria. The most common in your search criteria. The most common

wildcards are:wildcards are:

O * (asterisk) represents any number of characters For example* (asterisk) represents any number of characters For example

LastName = Co* returns entries including Colman and ConroyLastName = Co* returns entries including Colman and Conroy

O ? (question mark) represents any single alphabetic character. For example? (question mark) represents any single alphabetic character. For example

FirstName = er?? returns entries including Eric and ErmaFirstName = er?? returns entries including Eric and Erma

O # (number sign) represents any single numeric character. For example# (number sign) represents any single numeric character. For example

ID = 1## returns any ID from 100 through 199ID = 1## returns any ID from 100 through 199

Tip Access supports several sets of wildcards. For more information on these,  Access supports several sets of wildcards. For more information on these, 

search Access Help forsearch Access Help for wildcardswildcards and read the topic titled “Access wildcard character  and read the topic titled “Access wildcard character 

reference.”reference.”

When searching for information in a text fi eld, you can also use the Contains text When searching for information in a text fi eld, you can also use the Contains text 

fi lter to locate records containing words or character strings.fi lter to locate records containing words or character strings.
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In this exercise, you will fi lter records by a single criterion and then by multiple criteria.

Tip The  Filter commands you will use in this exercise are available in the Sort & Filter group 

on the Home tab, on the column menu displayed when you click a column header arrow, 

and on the shortcut menu displayed when you right-click a column. However, not all Filter 

commands are available in each of these places.

USE the 02_FilterTable database. This practice fi le is located in the Chapter06 subfolder 

under SBS_Access2007.

OPEN the 02_FilterTable database, and then open the Customers table in Datasheet view.

 1. In the City fi eld, click any instance of Vancouver.

 2. On the Home tab, in the Sort & Filter group, click the  Selection button, and then 

in the list, click Equals “Vancouver”.

The number of customers displayed in the table (and on the status bar at the 

bottom of the table) changes from 110 to 6, because only six customers live in 

Vancouver. 

Access displays a small fi lter icon at the right side of the City column header to 

indicate that the table is fi ltered by that fi eld. The Toggle Filter button  in the 

Sort & Filter group and the Filter status on the status bar changes to Filtered.

Important When you fi lter a table, Access doesn’t remove the records that don’t 

match the fi lter; it simply hides them.

USE thethe 02_FilterTable02_FilterTable database. This practice fi le is located in the database. This practice fi le is located in the Chapter06Chapter06 subfolder  subfolder 66
under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 02_FilterTable02_FilterTable database, and then open the Customers table in Datasheet view. database, and then open the Customers table in Datasheet view.
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 3. In  the Sort & Filter group, click the  Toggle Filter button.

Access removes the fi lter and displays all the records. If you click the Toggle Filter 

button again, the last fi lter used will be reapplied.

Suppose that you want a list of all customers with postal codes starting with 880.

 4. Click the PostalCode column header arrow, point to Text Filters, and then click 

Begins With.

Tip The sort and fi lter options displayed when you click the column header arrow are 

determined by the fi eld type. If this were a numeric fi eld, then the submenu would be 

Number Filters and different options would be listed. U.S. Zip Codes and international 

postal codes are usually text fi elds to allow for the ZIP+4 codes.

The Custom Filter dialog box   opens.

 5. In the PostalCode begins with box, type 880. Then click OK.

The fi ltered table includes 30 records that have postal codes starting with 880.
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 6. In the Sort & Filter group, click the Toggle Filter button to remove the fi lter and 

display all the records.

Suppose you want to display only those customers who live outside of the United 

States.

 7. In the Country column, right-click any instance of USA, and then click Does Not 
Equal “USA”.

Access displays all the customers from countries other than the United States (in 

this case, only Canada).

 8. Remove the fi lter, save and close the Customers table, and then open the Orders 
table in Datasheet view.

 9. In  the EmployeeID fi eld, right-click Emanuel, Michael, and then click Equals 
“Emanuel, Michael”.

Troubleshooting If you continued with the 01_SortTable database from the 

previous exercise, the EmployeeID fi eld does not list employee names. To complete 

this exercise, you must use the 02_FilterTable database.

 10. In the OrderDate fi eld, right-click 2/1/2007, and then click On or After 2/1/2007.

Tip To   see a list of the available options for date fi lters, right-click any cell in the 

OrderDate column and then point to Date Filters.

You now have a list of orders placed with the selected employee on or after the 

specifi ed date. You could continue to refi ne the list by fi ltering on another fi eld, or 

you could sort the results by a fi eld.

Tip After    you locate the information you want, you can display the results in a form 

or report. To do so, on the Create tab, click the object you want to create.

CLOSE the Orders table without saving changes, and then close the 02_FilterTable database.

Tip You can fi lter records while displaying them in a form by using the same commands as 

you do to fi lter forms in a table.

Troubleshooting If you continued with theIf you continued with the 01_SortTable01_SortTable database from the database from the

previous exercise, the EmployeeID fi eld does not list employee names. To completeprevious exercise, the EmployeeID fi eld does not list employee names. To complete

this exercise, you must use thethis exercise, you must use the 02_FilterTable02_FilterTable database. database.
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Expressions
In  Access lingo, expressions are synonymous with formulas. An     expression is a com-

bination of operators, constants, functions, and control properties that evaluates to 

a single value. Access builds formulas using the format a=b+c, where a is the result 
and =b+c is the expression. You can use an expression to assign properties to tables 

or forms, to determine values in fi elds or reports, as part of queries, and so on.

The expressions you use in Access combine multiple criteria to defi ne a set of 

conditions that a record must meet to be included in the result of a fi lter or query. 

Multiple criteria are combined using logical, comparison, and arithmetic operators. 

Different types of expressions use different operators.

The   most common logical operators are:

O And.     This operator selects records that meet all the specifi ed criteria.

O Or.     This operator selects records that meet at least one of the criteria.

O Not.     This operator selects records that don’t match the criteria.

Common    comparison operators include:

O < (less than)  

O > (greater than)  

O = (equal to)  

You can combine these basic operators to form:

O <= (less than or equal to)  

O >= (greater than or equal to)  

O <> (not equal to)  

The   Like operator is sometimes grouped with the comparison operators and is used 

to test whether or not text matches a pattern.

You use arithmetic operators  with numerals. The most common are:

O + (add)  

O - (subtract)  

O * (multiply)  

O / (divide)  

A related operator, & (a text form of +) is used to concatenate (combine) two 

text strings.

Expressions
InIn Access lingo,Access lingo, expressions are synonymous with are synonymous with formulasformulas. An. An expression is a com-expression is a com-

bination of bination of operators, , constants, , functions, and , and control properties that evaluates tothat evaluates to

a single value. Access builds formulas using the format a single value. Access builds formulas using the format a=b+ca=b+c, where , where aa is the is the result
and and =b+c=b+c is the expression. You can use an expression to assign properties to tables is the expression. You can use an expression to assign properties to tablescc
or forms, to determine values in fi elds or reports, as part of queries, and so on.or forms, to determine values in fi elds or reports, as part of queries, and so on.

The expressions you use in Access combine multiple criteria to defi ne a set of The expressions you use in Access combine multiple criteria to defi ne a set of 

conditions that a record must meet to be included in the result of a fi lter or query. conditions that a record must meet to be included in the result of a fi lter or query. 

Multiple criteria are combined using logical, comparison, and arithmetic operators.Multiple criteria are combined using logical, comparison, and arithmetic operators.

Different types of expressions use different operators.Different types of expressions use different operators.

TheThe most commonmost common logical operators are:are:

O And.And. This operator selects records that meet all the specifi ed criteria.This operator selects records that meet all the specifi ed criteria.

O Or. Or. This operator selects records that meet at least one of the criteria.This operator selects records that meet at least one of the criteria.

O Not. Not. This operator selects records that don’t match the criteria.This operator selects records that don’t match the criteria.

CommonCommon comparison operators include:include:

O < (less than) < (less than) 

O > (greater than)> (greater than)

O = (equal to) = (equal to) 

You can combine these basic operators to form:You can combine these basic operators to form:

O <= (less than or equal to) <= (less than or equal to) 

O >= (greater than or equal to) >= (greater than or equal to) 

O <> (not equal to)<> (not equal to)

TheThe Like operator is sometimes grouped with the comparison operators and is used Like operator is sometimes grouped with the comparison operators and is used

to test whether or not text matches a pattern.to test whether or not text matches a pattern.

You use You use arithmetic operators with numerals. The most common are:with numerals. The most common are:

O + (add)+ (add)

O - (subtract) - (subtract) 

O * (multiply) * (multiply) 

O / (divide) / (divide) 

A related operator, & (a text form of +) is used to concatenate (combine) two A related operator, & (a text form of +) is used to concatenate (combine) two 

text strings.text strings.



 Filtering Information by Using a Form  153
Filtering Information by Using a Form
The Filter By   Form command, available from the Advanced Filter Options list, provides a 

quick and easy way to fi lter a table based on the information in several fi elds. When you 

invoke this command within a table, Access displays a Look For tab containing a fi ltering 

form that looks like an empty datasheet. However, each of the blank cells is actually a 

combo box containing a list of all the entries in that fi eld. You can select a fi lter criterion 

from the list, or enter a new one. Then you click the Toggle Filter button  to display only 

the records containing your selected criteria.

Using Filter By Form on a table that has only a few fi elds, such as the one shown above, 

is easy. But using it on a table that has a few dozen fi elds gets a bit cumbersome, and it 

is simpler to fi nd information by using the Filter By Form command in the form version 

of the table. When you invoke this command within a form, Access fi lters the form in the 

same way it fi lters a table.

In a fi ltered form, you move between records by clicking the navigation buttons at the 

bottom of the form window.

Tip Filter By Form offers the same features and techniques whether you are using it in a form 

or a table. Because defi ning the fi lter is sometimes easier in a form and viewing the results is 

sometimes easier in a table, you might consider creating a simple form based on the table, 

fi ltering the data within the form, and then switching to Datasheet view to display the results.
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In this exercise, you will locate a record by using the Filter By Form command.

USE the 03_FilterForm database. This practice fi le is located in the Chapter06 subfolder 

under SBS_Access2007.

OPEN the 03_FilterForm database.

 1. In the Navigation Pane, under Forms, double-click Customers.

The Customers form opens in Form view.

 2. On the Home tab, in the Sort & Filter group, click the  Advanced button, and then 

in the list, click Filter By Form.

The Customers form, which displays the information from one record, is replaced 

by its Filter By Form version, which has a blank box for each fi eld and the Look For 

and Or tabs at the bottom.

 3. Click the second text box to the right of the Name label (the box intended to 

contain the surname), type s*, and then press F.

USE thethe 03_FilterForm03_FilterForm database. This practice fi le is located in the database. This practice fi le is located in the Chapter06Chapter06 subfoldersubfolder66
under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 03_FilterForm03_FilterForm database.database.
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Access   converts your entry to the proper format, or syntax, for this type of 

expression: Like “s*”.

 4. In the Sort & Filter group, click the  Toggle Filter button.

Access displays all records including last names starting with S.

 5. Click the  Filter By Form button again to switch back to the fi lter form.

Your fi lter criteria are still displayed. When you enter fi lter criteria using any 

method, they are saved as a form property and are available until they are 

replaced by other criteria.

 6. Click the box to the right of Region, click the arrow that appears, and then in the 

list, click CA.

 7. Click the Toggle Filter button to see only the customers living in California whose 

last names begin with S.

Access replaces the fi lter window with the regular Customers form, and the status 

bar at the bottom of the form indicates that three fi ltered records are available.
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 8. Click the Filter By Form button again to switch back to the fi lter form.

 9. At the bottom of the form window, click the Or tab.

Tip Criteria you enter on the Look For tab are joined with the And operator to 

reduce the number of possible hits in the underlying table. Criteria entered on 

the Or tabs tend to increase the number of hits. 

This tab has the same blank cells as the Look For tab. You can switch between the 

two tabs to confi rm that your criteria haven’t been cleared.

Tip When you display the Or tab, a second Or tab appears so that you can include a 

third criterion if you want.

 10. Type s* in the LastName box, type or click WA in the Region box, and then click 

the Toggle Filter button.

You can scroll through the fi ltered Customers form to view the six records 

containing WA in the Region fi eld.

CLOSE the Customers form and the 03_FilterForm database.

Locating Information That Matches Multiple Criteria
The  fi ltering methods discussed earlier in this chapter are quick and easy ways to 

narrow down the amount of information displayed, as long as your fi lter criteria are 

fairly simple. But suppose you need to locate something more complex, such as all the 

orders shipped to Midwest states between specifi c dates by either of two shippers. 

When you need to search a single table for records that meet multiple criteria, or with 

criteria based on complex expressions as criteria, you can use the Advanced Filter/Sort 

command, available from the Advanced Filter Options list.

You   work with the Advanced Filter/Sort command in the design grid.
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In this exercise, you will fi lter a table to display customers located in two states. Then you 

will experiment with the design grid to better understand its fi ltering capabilities.

USE the 04_MultipleCriteria database. This practice fi le is located in the Chapter06 subfolder 

under SBS_Access2007.

OPEN the 04_MultipleCriteria database. Then open the Customers table in Datasheet view.

 1. On the Home tab, in the Sort & Filter group, click the  Advanced Filter Options 
button, and then in the list, click Advanced Filter/Sort.

The CustomersFilter1 query window opens, displaying the Customers fi eld list in a 

fl oating window at the top, and the design grid at the bottom.

Design grid

 2. In the Customers fi eld list, double-click LastName to copy it to the Field cell in the 

fi rst column of the design grid.

USE thethe 04_MultipleCriteria04_MultipleCriteria database. This practice fi le is located in the database. This practice fi le is located in the Chapter06Chapter06 subfolder  subfolder 66
under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 04_MultipleCriteria04_MultipleCriteria database. Then open the Customersdatabase. Then open the Customers table in Datasheet view.table in Datasheet view.
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 3. In the Criteria cell under LastName, type s*, and then press F.

Access changes the criterion to Like “s*”.

 4. In the Customers fi eld list, double-click Region to copy it to the next available 

column of the design grid.

 5. In the Criteria cell under Region, type ca or wa, and then press F.

Your entry changes to “ca” Or “wa”. The query will now fi lter the table to display 

only customers with last names beginning with the letter S who live in California or 

Washington.

 6. In the Sort & Filter group, click the  Toggle Filter button to display only records 

that match the criteria.

Access switches to the Customers table and displays the query results. There are 

six customers with last names beginning with S who live in either California or 

Washington.
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 7. Click the CustomersFilter1 tab to switch to the fi lter window. In the or cell under 

LastName, type b*, and then press F.

 8. In the Sort & Filter group, click the Toggle Filter button.

The result includes records for all customers with last names that begin with s or b, 

but some of the b names live in Montana and Oregon. If you look again at the design 

grid, you can see that the fi lter is formed by combining the fi elds in the Criteria row 

with the And operator, combining the fi elds in the “Or” row with the And operator, 

and then using the Or operator to combine the two rows. So the fi lter is searching 

for customers with names beginning with s who live in California or Washington, or 

customers with names beginning with b, regardless of where they live.

 9. Switch to the fi lter window, type ca or wa in the or cell under Region, press F, 

and then apply the fi lter to display only customers with last names beginning with 

B or S located in California and Washington.

CLOSE the Customers table without saving your changes, and then close the 

04_MultipleCriteria database.
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Creating a Query Manually
A  query can do more than simply return a list of records from a table. You can use 

functions in a query to perform calculations on the information in a table to produce 

the sum, average, count, and other mathematical values.

When you want to work with more than one table, you need to move beyond fi lters and 

into the realm of queries. Common types of queries include the following:

 O A select query   retrieves data from one or more tables and displays the results in 

a datasheet. You can also use a select query to group records and calculate sums, 

counts, averages, and other types of totals. You can work with the results of a 

select query in Datasheet view to update records in one or more related tables 

at the same time. This is the most common type of query.

 O A duplicate query is   a form of select query that locates records that have the 

same information in one or more fi elds that you specify. The Find Duplicates 

Query wizard guides you through the process of specifying the table and fi elds 

to use in the query.

 O An unmatched query   is a form of select query that locates records in one table that 

don’t have related records in another table. For example, you could use this to lo-

cate people in the customer table who don’t have an order in the order table. The 

Find Unmatched Query wizard guides you through the process of specifying the 

tables and fi elds to use in the query.

 O A parameter query   prompts you for information to be used in the query—for ex-

ample, a range of dates. This type of query is particularly useful when used as the 

basis for a report that is run periodically.

 O A crosstab query   calculates and restructures data for easier analysis. You can use a 

crosstab query to calculate a sum, average, count, or other type of total for data that 

is grouped by two types of information—one down the left side of the datasheet and 

one across the top. The cell at the junction of each row and column displays the re-

sults of the query’s calculation.



 

 

 

 

 Creating a Query Manually  161
 O An   action query updates multiple records in one operation. It is essentially a select 

query that performs an action on the results of the selection process. Four types of 

actions are available: 

O Delete queries,     which delete records from one or more tables

O Update queries,   which make changes to records in one or more tables

O Append queries,   which add records from one or more tables to the end of 

one or more other tables

O Make-table queries,   which create a new table from all or part of the data in 

one or more tables

Tip In addition to these, you can create Structured Query Language (SQL) queries. 

SQL queries are beyond the scope of this book.

Access includes wizards that guide you through the creation of the common queries, but 

you create less common queries by hand in Design view, using the design grid.

A complex query,  
shown in Design view
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The fi eld lists (in the small windows at the  top of the query window) list the fi elds in the 

four tables that can be included in this query.   The lines connecting the tables indicate 

that they are related by virtue of common fi elds. The fi rst row of the grid contains the 

names of the fi elds actually included in the query, and the second row shows which 

table each fi eld belongs to. The third row (labeled Total) performs calculations on the 

fi eld values, and the fourth row indicates whether the query results will be sorted on this 

fi eld.  A selected check box in the fi fth row (labeled Show) means that the fi eld will be 

displayed in the results datasheet. (If the check box isn’t selected, the fi eld can be used in 

determining the query results, but it won’t be displayed.) The sixth row (labeled Criteria) 

contains criteria that determine which records will be displayed, and the seventh row 

(labeled or) sets up alternate criteria.

You can create a query by hand or by using a wizard. Regardless of what method you 

use to create the query, what you create is a statement describing the conditions that 

must be met for records to be matched in one or more tables. When you run the query, 

the matching records appear in a new datasheet.

Filters and Sorts vs. Queries
The    major differences between fi ltering a table, sorting a table, and querying a 

table are:

O The Filter and Sort commands are usually faster to implement than queries.

O The Filter and Sort commands are not saved, or are saved only temporarily. 

You can save a query permanently and run it again at any time.

O The Filter and Sort commands are applied only to the table or form that 

is currently open. A query can be based on multiple tables and on other 

queries, which don’t have to be open.

In this exercise, you will create a form based on a select query that combines information 

from two tables into a datasheet and calculates the extended price of an item based on 

the unit price, quantity ordered, and discount.

Filters and Sorts vs. Queries
TheThe major differences between fi ltering a table, sorting a table, and querying a major differences between fi ltering a table, sorting a table, and querying a

table are:table are:

O The Filter and Sort commands are usually faster to implement than queries.The Filter and Sort commands are usually faster to implement than queries.

O The Filter and Sort commands are not saved, or are saved only temporarily.The Filter and Sort commands are not saved, or are saved only temporarily.

You can save a query permanently and run it again at any time.You can save a query permanently and run it again at any time.

O The Filter and Sort commands are applied only to the table or form that The Filter and Sort commands are applied only to the table or form that 

is currently open. A query can be based on multiple tables and on other is currently open. A query can be based on multiple tables and on other 

queries, which don’t have to be open.queries, which don’t have to be open.
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USE the 05_QueryDesign database. This practice fi le is located in the Chapter06 subfolder 

under SBS_Access2007.

OPEN the 05_QueryDesign database.

 1. On  the Create tab, in the Other group, click the  Query Design button.

A query window opens in Design view, and the Show Table dialog box opens. In 

this dialog box  , you can specify which tables and saved queries to include in the 

current query.

 2. In  the Show Table dialog box, on the Tables tab, double-click Order Details and 

then Products to add each table to the query window. Then close the dialog box.

Each of the selected tables is represented in the top portion of the window by a 

small fi eld list window with the name of the table—in this case, Order Details and 

Products—in its title bar.

USE thethe 05_QueryDesign05_QueryDesign database. This practice fi le is located in the database. This practice fi le is located in the Chapter06Chapter06 subfolder subfolder66
under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 05_QueryDesign05_QueryDesign database. database.
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An asterisk at the top of each list represents all the fi elds in the list. The primary 

key fi eld in each list is indicated by a key icon. The line from ProductID in the Order 

Details table to ProductID in the Products table indicates that these two fi elds are 

related.

Tip To  add more tables to a query, reopen the Show Table dialog box by right-

clicking a blank space in the top portion of the query window and then clicking 

Show Table, or by clicking the Show Table button  in the Query Setup group on the 

Design contextual tab.

The lower area of the query window contains the design grid where you will specify 

the query’s criteria.

3. Drag   the following fi elds from the fi eld lists to consecutive columns in the 

design grid:

From this table Drag this fi eld

Order Details OrderID

Products ProductName

Order Details UnitPrice

Order Details Quantity

Order Details Discount

The query will include only the fi elds that are in the design grid.

Tip You can quickly copy a fi eld to the next available column in the design grid by 

double-clicking the fi eld.

To   copy all fi elds to the grid, double-click the title bar above the fi eld list to select 

the entire list, and then drag the selection over the grid. When you release the 

mouse button, Access adds the fi elds to the columns in order. You can drag the 

asterisk to a column in the grid to include all the fi elds in the query, but you also 

have to drag individual fi elds to the grid if you want to sort on those fi elds or add 

conditions to them.
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4. On   the Design contextual tab, in the Results group, click the  Run button.

Access runs the query and displays the results in Datasheet view.
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The results show that the query is working thus far. There are two things left to do: 

sort the results on the OrderID fi eld and add a fi eld for calculating the extended 

price, which is the unit price times the quantity sold minus any discount.

5. Switch to Design view.

The third row in the design grid is labeled Sort. You can select Ascending, 

Descending, or (not sorted) in this cell for any of the query fi elds.

6. In the OrderID column, click the Sort arrow, and then in the list, click Ascending.

Neither of the tables includes an extended price fi eld. Rather than creating the fi eld 

in a table, you will use the Expression Builder to insert an expression in the design 

grid that computes this price from existing information.

7. Right-click  the Field cell in the fi rst blank column in the design grid (the sixth column), 

and then click Build.

The Expression Builder dialog box   opens.

Here is the expression you will build:

CCur([Order Details]![UnitPrice]*[Order Details]![Quantity]*(1-[Order 
Details]![Discount]))

The CCur function converts the results of the math inside its parentheses to 

currency format.
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Tip If you were to type this expression directly into the fi eld, you could simplify it a 

bit to this:
ExtendedPrice: CCur([Order Details]![UnitPrice]*[Quantity]*(1-
[Discount]))
The [Order Details]! part is required only with fi elds that appear in both tables. It tells 

the query which table to use.

8. In   the fi rst column of the elements area, double-click the Functions folder to 

display its contents, and then click Built-In Functions.

Categories of built-in functions appear in the second column; actual functions 

within each category appear in the third column.

9. In  the second column, click Conversion to limit the functions in the third column to 

those in that category. Then in the third column, double-click Ccur.

You’ve inserted the currency conversion function into the expression box. The 

<<expr>> inside the parentheses represents the other expressions that will 

eventually result in the number Access should convert to currency format.

10. In the expression box, click <<expr>> to select it so that the next thing you enter 

will replace it.

The next element you want in the expression is the UnitPrice fi eld from the Order 

Details table.

11. In the fi rst column, double-click the Tables folder, and click Order Details. 

Then in the second column, double-click UnitPrice.
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The insertion point is currently situated after UnitPrice, which is exactly where you 

want it. Now you want to multiply the amount in the UnitPrice fi eld by the amount 

in the Quantity fi eld.

 12. In     the row of operator buttons below the expression box, click the Multiply button.

Access inserts the multiplication sign and another <<Expr>> placeholder.

 13. In the expression box, click <<Expr>> to select it, and then in the second column, 

double-click Quantity.

What you have entered so far calculates the total cost by multiplying the price of 

an item by the quantity ordered. However, suppose the sale price is discounted due 

to quantity or another factor. The discount, which is stored in the Order Details table, 

is expressed as the percentage to deduct. But it is easier to compute the percentage 

to be paid than it is to compute the discount and subtract it from the total cost.

 14. In the expression box, type *(1-. In the second column, double-click Discount, and 

type ). If the entire expression isn’t visible in the window, widen the window by 

dragging its right edge.

Although the discount is formatted in the datasheet as a percentage, it is actually 

stored in the database as a decimal number between 0 and 1. (For example, a 

discount displayed as 10% is stored as 0.1). So if the discount is 10%, the result 

of *(1-Discount) is *.9. In other words, the formula multiplies the unit price by the 

quantity and then multiplies that result by 0.9.

MultiplyMultiply
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15. In the Expression Builder dialog box, click OK.

Access enters the expression in the design grid.

16. Press F to move the insertion point out of the fi eld and complete the entry of 

the expression.

Access labels the expression Expr1, which isn’t particularly meaningful.

Tip You  can quickly make a column in the design grid as wide as its contents by 

double-clicking the line in the gray selection bar that separates the column from the 

column to its right.

17. In    the design grid, double-click Expr1, and then type ExtendedPrice as the label 

for the expression.

18. Switch to Datasheet view.

The orders are now sorted by the OrderID fi eld, and the extended price is 

calculated in the last fi eld.

19. Scroll down to see a few records with discounts.

If you check the math, you will see that the query calculates the extended price 

correctly.

20. Close   the query window. In the Microsoft Offi ce Access message box asking 

whether to save the query, click Yes. In the Save As dialog box, type Order Details 
Extended, and then click OK. 

CLOSE the 05_QueryDesign database.
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Expression Builder
To  create an expression as a fi lter or query option, you can either type the expres-

sion or use the Expression Builder. You can open the Expression Builder by clicking 

Build on a shortcut menu, clicking Builder in the Query Setup group, or clicking 

the Build button  (which resembles an ellipsis) at the right end of a box that can 

accept an expression.

The Expression Builder isn’t a wizard; it doesn’t lead you through the process of 

building an expression. But it does provide a hierarchical list of the most common 

elements that you can include in an expression. You can either type your expression 

in the expression box, or you can select functions, operators, and other elements to 

copy them to the expression box.

Creating a Query by Using a Wizard
The   process of creating a simple select query by using the Query wizard is almost 

identical to that of creating a form by using the Form wizard. Within the Query wizard, 

you can build a new query based on one or more fi elds from existing tables or queries. 

You can also create Crosstab, Find Duplicates, and Find Unmatched queries with the 

wizard.

For Access to work effectively with multiple tables, it must understand the relationships 

between the fi elds in those tables. If these relationships don’t already exist.

See Also For more information about creating relationships, see the sidebar “Relationships” in 
Chapter 5, “Simplifying Data Entry by Using Forms.”

In this exercise, you will use the Query wizard to create a query that combines infor-

mation from two tables related through common fi elds.

USE the 06_QueryWizard database. This practice fi le is located in the Chapter06 subfolder 

under SBS_Access2007.

OPEN the 06_QueryWizard database.

 1. On the Create tab, in the Other group, click the Query Wizard button.

The New Query dialog box   opens.

Expression Builder
ToTo create an expression as a fi lter or query option, you can either type the expres-create an expression as a fi lter or query option, you can either type the expres-

sion or use the Expression Builder. You can open the Expression Builder by clickingsion or use the Expression Builder. You can open the Expression Builder by clicking

Build on a shortcut menu, clicking Builder in the Query Setup group, or clickingBuild on a shortcut menu, clicking Builder in the Query Setup group, or clicking

the Build buttonthe Build button (which resembles an ellipsis) at the right end of a box that can (which resembles an ellipsis) at the right end of a box that can 

accept an expression.accept an expression.

The Expression Builder isn’t a wizard; it doesn’t lead you through the process of The Expression Builder isn’t a wizard; it doesn’t lead you through the process of 

building an expression. But it does provide a hierarchical list of the most common building an expression. But it does provide a hierarchical list of the most common 

elements that you can include in an expression. You can either type your expression elements that you can include in an expression. You can either type your expression 

in the expression box, or you can select functions, operators, and other elements to in the expression box, or you can select functions, operators, and other elements to 

copy them to the expression box.copy them to the expression box.

USE thethe 06_QueryWizard06_QueryWizard database. This practice fi le is located in the database. This practice fi le is located in thedd Chapter06Chapter06 subfolder  subfolder 66
under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 06_QueryWizard06_QueryWizard database.database.dd
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 2. With  Simple Query Wizard selected in the list, click OK.

The Simple Query wizard starts.

 3. In the Tables/Queries list, click Table: Orders. Then click the  Move All button to 

move all the fi elds from the Available Fields list to the Selected Fields list.
Move AllMove All
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4. In the Tables/Queries list, click Table: Customers.

5. In the Available Fields list, double-click the Address, City, Region, PostalCode, and 

Country fi elds to move them to the Selected Fields list, and then click Next.

Tip If the relationship between two tables hasn’t already been established, you will 

be prompted to defi ne it and then restart the wizard.

6. With the Detail option selected, click Next.

7. With the Open the query to view information option selected, click Finish.

Access runs the query and displays the results in Datasheet view. You can scroll 

through the results and see that information is displayed for all the orders.



 

 

 Creating a Query by Using a Wizard  173
8. Switch  to Design view.

Notice that the Show check box is selected by default for each of the fi elds used 

in the query. If you want to use a fi eld in a query—for example, to sort on, to set 

criteria for, or in a calculation—but don’t want to see the fi eld in the results data-

sheet, you can clear its Show check box.

9. Clear the Show check box for OrderID, CustomerID, and EmployeeID, and then 

switch back to Datasheet view.

The three fi elds have been removed from the results datasheet.
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 10. Switch to Design view.

This query returns all records in the Orders table. To have the query match 

the records for a range of dates, you will convert it to a parameter query, which 

requests the date range each time you run it.

 11. In the OrderDate column, type the following text in the Criteria cell, exactly as shown:

Between [Type the beginning date:] And [Type the ending date:]

 12. On the Design contextual tab, in the Results group, click the  Run button to run the 

query.

 13. Enter a beginning date of 1/1/07, and then press F.

 14. Enter an ending date of 1/31/07, and then press F.

Access redisplays the datasheet, this time listing only orders between the specifi ed 

dates.

CLOSE the datasheet, saving the changes to the query, and then close the 

06_QueryWizard database.

Performing Calculations by Using a Query
You   typically use a query to locate all the records that meet some criteria. But sometimes 

you are not as interested in the details of all the records as you are in summarizing them 

in some way. For example, you might want to know how many orders have been placed 

this year or the total dollar value of all orders placed. The easiest way to get this informa-

tion is by creating a query that groups the necessary fi elds and does the math for you. 

To   do this, you use aggregate functions in the query.

Access queries support the aggregate functions shown in the following table.
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Function Calculates

Sum Total  of the values in a fi eld

Avg Average  of the values in a fi eld

Count Number  of values in a fi eld, not counting Null (blank) values

Min Lowest  value in a fi eld

Max Highest  value in a fi eld

StDev Standard  deviation of the values in a fi eld

Var Variance  of the values in a fi eld

In this exercise, you will create a query that calculates the total number of products in an 

inventory, the average price of all the products, and the total value of the inventory.

USE the 07_Calculate database. This practice fi le is located in the Chapter06 subfolder 

under SBS_Access2007.

OPEN the 07_Calculate database.

 1. On the Create tab, in the Other group, click the  Query Design button.

Access opens the query window and the Show Table dialog box  .

 2. In the Show Table dialog box, double-click Products, and then click Close.

Access adds the Products table to the query window and closes the Show Table 

dialog box.

 3. In the Products Items fi eld list, double-click ProductID and then UnitPrice.

Access copies both fi elds to the design grid.

 4. On the Design contextual tab, in the Show/Hide group, click the  Totals button.

Access adds a row named Total to the design grid.

 5. In   the ProductID column, click the Total arrow, and then in the list, click Count.

Access enters the word Count in the Total cell. When you run the query, this 

function will return a count of the number of records containing a value in the 

ProductID fi eld.

 6. In   the UnitPrice column, click the Total arrow, and then in the list, click Avg.

USE the the 07_Calculate07_Calculate database. This practice fi le is located in the database. This practice fi le is located in the Chapter06Chapter06 subfolder subfolder 

under under SBS_Access2007SBS_Access2007..7777

OPEN the the 07_Calculate07_Calculate database. database.
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When you run the query, this function will return the average of all the UnitPrice values.

 7. In the Results group, click the    Run button.

The query returns a single record containing the count and the average price.

 8. Switch back to Design view.

 9. In the third column, in the Field cell, type UnitPrice*UnitsInStock, and press F.

Access changes the expression you typed to

Expr1: [UnitPrice]*[UnitsInStock]

This expression will multiply the price of each product by the number of units in stock.

 10. Select Expr1 and type Value of Inventory to re-label the expression.

 11. In   the third column, click the Total arrow, and then in the list, click Sum.

Access will return the sum of all the values calculated by the expression.
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 12. On the Design tab, in the Results group, click the Run button.

CLOSE the query window without saving your changes, and then close the 07_Calculate 

database. If you are not continuing directly on to the next chapter, quit Access.

Key Points
 O Microsoft Offi ce Access 2007 provides a variety of tools you can use to organize 

the display of information in a database and to locate specifi c items of information. 

These tools make it easy to search through and fi nd information in your database, 

even as it grows in size and complexity.

 O You can sort a table in either ascending or descending order, based on the values 

in any fi eld (or combination of fi elds). In Access, numbers can be treated as text or 

numerals.

 O You can fi lter a table so that information containing some combination of charac-

ters is displayed (or excluded from the display). You can apply simple fi lters while 

viewing information in a table or a form. These fi lters are applied to the contents 

of a selected fi eld, but you can apply another fi lter to the results of the fi rst one to 

further refi ne your search.

 O The Filter By Form command fi lters a table or form based on the information in 

several fi elds.

 O The Advanced Filter/Sort command searches a single table for records that meet 

multiple criteria or that require complex expressions as criteria.

 O You can create queries to display specifi c fi elds from specifi c records from one or 

more tables, even designing the query to perform calculations for you. You can 

then save your queries for later use.
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  7 7 Keeping Your  Keeping Your 
  Information   Information 
  Accurate  Accurate

In this chapter, you will learn to:

 � Restrict the type and amount of data in a fi eld.

 � Specify the format of data in a fi eld.

 � Restrict data by using validation rules.

 � Create a simple or multi-column lookup list.

 � Update information in a table.

 � Delete information from a table.

 � Prevent database problems.

Depending on how much information you have and how organized you are, you might 

compare a database to an old shoebox or to a fi le cabinet, into which you toss items 

such as photographs, bills, receipts, and a variety of other paperwork for later retrieval. 

However, neither a shoebox nor a fi le cabinet restricts anything other than the physical 

size of what you can place in it or imposes any order on its content. It is up to you to 

decide what you store there and to organize it properly so that you can fi nd it when 

you next need it.

When you create a database by using Microsoft Offi ce Access 2007, you can set proper-

ties that restrict what can be entered and impose order on the database contents, thereby 

helping you to keep the database organized and useful. You would not, for example, want 

employees to enter text into a price fi eld, or to enter a long text description in a fi eld when 

a simple “yes” or “no” answer would work best. 

To  ensure the ongoing accuracy of a database, you can create and run action queries 

that quickly update information or delete selected records from a table. You could, for 

example, increase the price of all products in one category by a certain percentage, or 
   179
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remove all the elements of a specifi c product line. This type of updating is easy to do 

with an action query. Not only does using a query save time, but it helps to avoid errors.

In this chapter, you will restrict the type, amount, and format of data allowed in a fi eld, 

and create a list from which a database user can choose a specifi c option. Then you will 

create and run an update query and a delete query.

See Also Do you need only a quick refresher on the topics in this chapter? See the Quick 
Reference entries on pages xxxix–lxv.

Important Before you can use the practice fi les in this chapter, you need to install them 

from the book’s companion CD to their default location. See “Using the Book’s CD” on page 

xxv for more information.

Troubleshooting Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and you 

experience trouble following the instructions as written, please refer to the “Information for 

Readers Running Windows XP” section at the beginning of this book.

Restricting the Type of Data in a Field
The  Data Type setting restricts entries in a fi eld to a specifi c type of data, such as text, 

numbers, or dates. If, for example, the data type is set to Number and you attempt to 

enter text, Access refuses the entry and displays a warning.

The fi eld properties you can set to control input are:

 O Required

 O Allow Zero Length

 O Field Size

 O Input Mask

 O Validation Rule

The     Required and Allow Zero Length properties are fairly obvious. If the Required property 

is set to Yes, the fi eld can’t be left blank.  However, Access differentiates between a blank 

fi eld (which it refers to as a Null fi eld) and a fi eld that looks blank, but contains an   empty 

string. If Allow Zero Length is set to Yes, you can enter an empty string (two quotation 

marks with nothing in between), which looks like a blank fi eld, but it is classifi ed as empty 

rather than Null. This differentiation might seem silly, but if you are using programming 

Troubleshooting Graphics and operating system–related instructions in this book refl ect Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and youthe Windows Vista user interface. If your computer is running Microsoft Windows XP and you

experience trouble following the instructions as written, please refer to the “Information forexperience trouble following the instructions as written, please refer to the “Information for

Readers Running Windows XP” section at the beginning of this book.Readers Running Windows XP” section at the beginning of this book.
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code to work with an Access database, you will fi nd that some commands produce differ-

ent results for Null fi elds than they do for empty fi elds.

The Field Size, Input Mask, and Validation Rule properties are more complex, so the 

exercises in this chapter will focus on them.

Tip Each fi eld property has many options. For more information, search for fi eld property 

in Access Help.

In this exercise, you will add fi elds of the most common data types to a table, and then 

use the Data Type setting and Field Size property to restrict the data that can be entered 

into the table.

USE the 01_FieldTest database. This practice fi le is located in the Chapter07 subfolder 

under SBS_Access2007.

OPEN the 01_FieldTest database. Then display the Field Property Test table in Design view.

1. Click  in the fi rst available Field Name cell (below the automatically-generated ID 

fi eld), type fText, and then press the D key to move to the Data Type cell.

The data type defaults to Text.

2. In the second Field Name cell, type fNumber, and then press D.

3. Click    the Data Type arrow, and in the list, click Number.

Tip You can scroll the list to the data type you want by typing the fi rst letter of its 

name in the cell.

4. Repeat Steps 2 and 3 to add the following fi elds:

Field Data type

fDate Date/Time

fCurrency Currency

fBoolean Yes/No

Tip The   data type referred to as Yes/No in Access is more commonly called Boolean 

(in honor of George Boole, an early mathematician and logistician). This data type can 

hold either of two mutually exclusive values, often expressed as yes/no, 1/0, on/off, or 

true/false.

USE the the 01_FieldTest01_FieldTest database. This practice fi le is located in the database. This practice fi le is located in thett Chapter07Chapter07 subfolder  subfolder 77
under under SBS_Access2007.SBS_Access2007.

OPEN thethe 01_FieldTest01_FieldTest database. Then display the Field Property Test table in Design view.database. Then display the Field Property Test table in Design view.tt
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 5. Click the fText fi eld name to select it.

Access displays the properties of the selected fi eld in the lower portion of the 

dialog box.

 6. Repeat Step 5 to review the properties of each fi eld, and then on the Quick Access 
Toolbar, click the  Save button.

 7. On the View toolbar, click the  Datasheet View button.

 8. In the fText cell, type This entry is 32 characters long.

 9. In the fNumber cell, type Five hundred.

SaveSave

Datasheet ViewDatasheet View
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The data type for this fi eld is Number. Access does not accept your text entry, and 

displays a warning offering you several options.

10. In the Microsoft Offi ce Access message box, click Enter new value. Then replace 

Five Hundred with 500.

11. In the fDate cell, type date, and then press D.

Access does not accept the unexpected data format.

12. In   the Microsoft Offi ce Access message box that appears, click Enter new value, 

type Jan 1, and then press D.

The fDate fi eld accepts almost any entry that can be recognized as a date, and 

displays it in the default date format. Depending on the default format on your 

computer, Jan 1 might be displayed as 1/1/2007, 1/1/07, or in some other format.

Tip If  you enter a month and day but no year in a date fi eld, Access assumes the date 

is in the current year. If you enter a month, day, and two-digit year from 00 through 

30, Access assumes the year is 2000 through 2030. If you enter a two-digit year that is 

greater than 30, Access assumes you mean 1931 through 1999.

13. In   the fCurrency fi eld, type the word currency, and then press D.

Access does not accept the unexpected data format.

14. In the Microsoft Offi ce Access message box that appears, click Enter new value, 

type –45.3456, and then press D.

Access stores the number you entered but displays ($45.35), the default format for 

negative currency numbers.

Tip Access   uses the regional settings in the Windows Control Panel to determine 

the display format for date, time, currency, and other numbers. You can create 

custom formats to ensure that the correct currency symbol is always displayed 

with your values. Otherwise, the numbers won’t change, but the currency symbol 

might, for instance from dollars to pounds, pesos, or euros.

15. In  the fBoolean fi eld, enter 123. Then click anywhere in the fi eld to toggle the 

check box between No (not checked) and Yes (checked), fi nishing with the fi eld in 

the checked state.
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This fi eld won’t accept anything you type; you can switch only between two 

predefi ned values.

Tip In   Design view, you can open the Properties dialog box, and on the Lookup tab, 

set the Boolean fi eld to display as a check box, text box, or combo box. You can set 

the Format property on the General tab to use True/False, Yes/No, or On/Off as the 

displayed values in this fi eld (though the stored values will always be -1 and 0).

CLOSE the table without saving your changes, and then close the 01_FieldTest database.

Restricting the Amount of Data in a Field
The Field Size   property, which is valid for the Text, Number, and AutoNumber data types, 

restricts the number of characters that can be entered in a text fi eld (from 0 to 255) and 

the number of digits that can be entered in a number or AutoNumber fi eld.   You can set 

number fi elds to any of the following values:

Setting Description

Byte Stores whole numbers from 0 to 255

Integer Stores whole numbers from –32,768 to 32,767

Long Integer (The default.) Stores whole numbers from –2,147,483,648 to 2,147,483,647

Single Stores negative numbers from –3.402823E38 to –1.401298E–45 and 

positive numbers from 1.401298E–45 to 3.402823E38

Double Stores negative numbers from –1.79769313486231E308 

to –4.94065645841247E–324 and positive numbers from 

1.79769313486231E308 to 4.94065645841247E–324

Decimal Stores numbers from -10 2̂8 -1 through 10 2̂8 -1

AutoNumber  fi elds are automatically set to Long Integer.



.
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By setting the Field Size property to a value that allows the largest valid entry, you pre-

vent the user from entering certain types of invalid information. If you try to type more 

characters in a text fi eld than the number allowed by the Field Size setting, an audio 

alert sounds, and Access refuses to accept the entry. Likewise, Access rejects any value 

that is below or above the limits of a number fi eld when you try to move out of the fi eld

In this exercise, you will change the Field Size property for several fi elds to see the impact

this has on data already in the table and on new data that you enter.

USE the 02_Size database. This practice fi le is located in the Chapter07 subfolder under 

SBS_Access2007.

OPEN the 02_Size database. Then open the Field Property Test table in Datasheet view.

 1. Review the contents of the one record.

 2. On the View toolbar, click the  Design View button.

 3. Click  any cell in the fText row, and then in the Field Properties area, change the 

Field Size property from 255 to 12.

 4. Click     any cell in the fNumber row, click the Field Size arrow, and then in the list, 

click Byte.

Access restricts the number of characters that can be entered in the text fi eld to 

12, and the values that can be entered in the number fi eld to the range from 

0 to 255 (inclusive).

 5. Switch to Datasheet view, clicking Yes when prompted to save the table.

The table contains data that doesn’t fi t these new property settings, so Access 

displays a warning that some data might be lost.

USE thethe 02_Size02_Size database. This practice fi le is located in the database. This practice fi le is located in the Chapter07Chapter07 subfolder under subfolder under77
SBS_Access2007SBS_Access2007..7777

OPEN thethe 02_Size02_Size database. Then open the Field Property Test table in Datasheet view. database. Then open the Field Property Test table in Datasheet view.

Design ViewDesign View
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 6. Click Yes to acknowledge the risk, and click Yes again to accept the deletion of the 

contents of one fi eld.

fText now contains only 12 characters, rather than the 32 you entered. The other 

20 characters have been permanently deleted. fNumber is empty because it is now 

limited to whole numbers from 0 through 255, and the value of 500 that you en-

tered was deleted.

 7. In    the fNumber fi eld, type 2.5, and then press the F key.

Access rounds the entered value to the nearest whole number.

CLOSE the Field Property Test table and the 02_Size database.

Specifying the Format of Data in a Field
When you use masks in tables or forms, people entering information can see at a glance 

the format in which they should make entries and how long they should be. You can use 

the InputMask property  to control how data is entered in text, number, date/time, and 

currency fi elds. This property has three sections, separated by semicolons, like the mask 

for a telephone number, shown here:

!\(000”) “000\-0000;1;#

The fi rst section contains characters that are used as placeholders for the information 

to be typed, as well as characters such as parentheses and hyphens. Together, all these 

characters control the appearance of the entry.  The following table explains the purpose 

of the most common input mask characters:
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Character Description

0 Required digit (0 through 9).

9 Optional digit or space.

# Optional digit or space; blank positions are converted to spaces; plus and 

minus signs are allowed.

L Required letter (A through Z).

? Optional letter (A through Z).

A Required letter or digit.

a Optional letter or digit.

& Required character (any kind) or a space.

C Optional character (any kind) or a space.

< All characters that follow are converted to lowercase.

> All characters that follow are converted to uppercase.

! Characters typed into the mask fi ll it from left to right. You can include the 

exclamation point anywhere in the input mask.

\ Character that follows is displayed as a literal character.

“any text” Access treats the string enclosed in double quotation marks as a literal string.

Password Creates a password entry box. Any character typed in the box is stored as the 

character but displayed as an asterisk (*).

Any characters not included in this list are displayed as literal characters. If you want 

to use one of the special characters in this list as a literal character, precede it with the 

\ (backslash) character.

The second and third sections of the input mask are optional. Including a 1 in the second 

section or leaving it blank tells Access to store only the characters entered; including a 0 

tells it to store both the characters entered and the mask characters. Entering a character 

in the third section causes Access to display that character as a placeholder for each of 

the characters to be typed; leaving it blank displays an underscore as the placeholder.

The input mask !\(000”) “000\-0000;1;# creates this display in a fi eld in either a table or 

a form:

(###) ###-####

In this example, you are restricting the entry to ten digits—no more and no less. The 

database user does not enter the parentheses, space, or dash, nor does Access store 

those characters (although you could display them in your table, form, or report if you 

set the correct format property). Access stores only the ten digits.
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In this exercise, you will use the Input Mask wizard to apply a predefi ned telephone 

number input mask to a text fi eld, forcing entered numbers into the (XXX) XXX-XXXX 

format. You will then create a custom mask to force the fi rst letter entered in another 

text fi eld to be uppercase (a capital letter).

USE the 03_Accurate database. This practice fi le is located in the Chapter07 subfolder 

under SBS_Access2007.

OPEN the 03_Accurate database. Then display the Field Property Test table in Design view.

 1. In the fi rst blank Field Name cell, type fPhone, and leave the data type set to Text.

 2. Click the row selector to select the row, and then drag the selected fi eld up to 

place it just below the ID fi eld.

 3. Save  the table design, and with fPhone still selected, click Input Mask in the Field 
Properties area.

 4. Click  the ellipsis button to the right of the cell to start the Input Mask wizard and 

display the fi rst page of the wizard. (If you are prompted to install this feature, click 

Yes.)

 5. With   Phone Number selected in the Input Mask list, click Next.

The second page of the wizard displays the input mask and gives you the 

opportunity to change the placeholder character that will indicate what to 

type. The exclamation point causes Access to fi ll the mask from left to right with 

whatever is typed. The parentheses and hyphen are characters that Access will 

insert in the specifi ed places. The nines represent optional digits, and the zeros 

USE the the 03_Accurate03_Accurate database. This practice fi le is located in the  database. This practice fi le is located in the Chapter07Chapter07 subfolder subfolder77
under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 03_Accurate03_Accurate database. Then display the Field Property Test table in Design view. database. Then display the Field Property Test table in Design view.

Ellipsis buttonEllipsis button
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represent required digits. This allows you to enter a telephone number either 

with or without an area code.

Tip Because Access fi lls the mask from left to right, you would have to press the 

Right Arrow key to move the insertion point past the fi rst three placeholders to enter 

a telephone number without an area code.

6. Change  999 to 000 to require an area code, and then change the placeholder 

character to #.

7. Click Next.

On the third page of the wizard, you specify whether you want to store the sym-

bols with the data. If you store the symbols, the data will always be displayed in 

tables, forms, and reports in this format. However, the symbols take up space, 

meaning that your database will be larger.
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8. Accept the default selection—to store data without the symbols—by clicking Finish.

Access closes the wizard and displays the edited mask as the Input Mask property.

9. Press F to accept the mask.

Access changes the format of the mask to !\(000”) “000\-0000;;#. Notice the two 

semicolons that separate the mask into its three sections. Because you told Access 

to store data without the symbols, nothing is displayed in the second section of the 

mask. Notice also that Access added double quotation marks to ensure that the 

closing parenthesis and following space are treated as literals.

Tip When you press Enter, a button appears in front of the Input Mask. This is the 

Property Update Options button , and if you click it, a list of options is displayed. In 

this case, the only options are to apply the input mask everywhere fPhone is used, 

and to provide help. This button disappears when you edit any other property or 

change to a different fi eld.

10. Save your changes, and then switch to Datasheet view.

11. Press  the N key to move to the new record, then press the D key to move to the 

fPhone fi eld. Type a series of numbers and letters to see how the mask works.

Access formats the fi rst ten numbers you enter as a telephone number, ignoring 

any letters or additional digits you type. If you type fewer than ten digits and then 

press Tab or Enter, Access warns that your entry doesn’t match the input mask.

Tip An  input mask can contain more than only placeholders for the data to be 

entered. If, for example, you type “The number is” in front of the telephone number 

in the Input Mask property, the default entry for the fi eld is The number is (###) 
###-####. Then if you place the insertion point at the beginning of the fi eld, the 

numbers you type replace the # placeholders, not the text. The Field Size setting 

is not applied to the characters in the mask, so if this setting is 15, the entry is not 

truncated even though the number of displayed characters (including spaces) is 28.
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 12. Switch to Design view, and add a new fi eld below fBoolean. Name it LastName. 

Leave the Data Type setting as the default, Text.

 13. Select  the new fi eld, click Input Mask, type >L<?????????????????? (18 question 

marks), and press F.

The greater than symbol (>) forces all following text to be uppercase. The L 

requires a letter. The less than symbol ()< forces all following text to be lower-

case. Each question mark allows any letter or no letter, and there is one fewer 

question mark than the maximum number of letters you want to allow in the 

fi eld (19, including the leading capital letter). The Field Size setting must be 

greater than this maximum.

 14. Save your changes, return to Datasheet view, type smith in the LastName fi eld of 

one of the records, and press D. Try entering SMITH, and then McDonald.

Regardless of how you type the name, only its the fi rst letter appears in the 

record capitalized, This type of mask has its limitations, but it can be useful in 

many situations.

CLOSE the Field Property Test table and the 03_Accurate database.

Tip You can create an input mask manually for text, number, date, or currency fi elds, or 

you can apply one of several standard masks for text and date fi elds by using the Input 

Mask wizard.

Restricting Data by Using Validation Rules
A validation rule  is an expression that can precisely defi ne the information that will be 

accepted in one or several fi elds in a record. You might use a validation rule in a fi eld 

containing the date an employee was hired to prevent a date in the future from being 

entered. Or if you make deliveries to only certain local areas, you could use a validation 

rule on the phone fi eld or ZIP code fi eld to refuse entries from other areas.

You  can type validation rules in by hand, or you can use the Expression Builder to create 

them. At the fi eld level, Access uses the rule to test an entry when you attempt to leave 

the fi eld. At the table level, Access uses the rule to test the content of several fi elds when 

you attempt to leave the record. If an entry doesn’t satisfy the rule, Access rejects the 

entry and displays a message explaining why.



192  Chapter 7 Keeping Your Information Accurate

 

 

 

 

In this exercise, you will create and test several fi eld validation rules and one table 

validation rule.

USE the 04_Validate database. This practice fi le is located in the Chapter07 subfolder under 

SBS_Access2007.

OPEN the 04_Validate database. Then display the Field Property Test table in Design view.

1. Select fPhone, and then click in the Validation Rule box.

An ellipsis  button appears at the end of the Validation Rule box. You can click this 

button to use the Expression Builder to create an expression, or you can type an 

expression in the box.

2. Type  Like “206*” Or Like “425*” in the Validation Rule box, and press F.

Troubleshooting Be sure to include the asterisk after the 206 and 425.

3. In  the Validation Text box, type Area code must be 206 or 425.

A rule is set for the fi rst three digits typed in the fPhone fi eld including the text 

that Access should display if someone attempts to enter an invalid phone number.

4. In the Caption box, type Phone Number.

USE thethe 04_Validate04_Validate database. This practice fi le is located in the database. This practice fi le is located in the Chapter07Chapter07 subfolder undersubfolder under77
SBS_Access2007SBS_Access2007..7777

OPEN thethe 04_Validate04_Validate database. Then display the Field Property Test table in Design view.database. Then display the Field Property Test table in Design view.

Troubleshooting Be sure to include the asterisk after the 206 and 425.Be sure to include the asterisk after the 206 and 425.
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5. Save the table.

Access warns that data integrity rules have changed. The table violates the new rule 

because it contains blank phone number fi elds.

6. Click No to close the message box without testing the data.

Tip When displaying tables as overlapping windows (rather than tabbed documents), 

you   can test the validation rules in a table at any time by right-clicking the title 

bar of the table in Design view and then clicking Test Validation Rules. For more 

information about display options, see “Working in Access 2007” in Chapter 1, 

“Exploring Access 2007.”

7. Return to Datasheet view, where the caption for the fi rst fi eld is now Phone Number.

8. Place the insertion point to the left of the fi rst # of any Phone Number fi eld, type 

3605550109, and then press F.

Tip To   select the entire fi eld, move the pointer to the left end of the Phone Number 

fi eld, and when the pointer changes to a thick cross, click the fi eld. The insertion point 

is then at the start of the area code when you begin typing.

The Validation Rule setting causes Access to display an alert box, warning you that 

the area code must be either 206 or 425.

9. Click OK to close the alert box, type a new phone number with one of the allowed 

area codes, and press F.

10. Return to Design view, and add another date fi eld. Type Date2 as the fi eld name, 

set the data type to Date/Time, and drag the new fi eld to just below fDate.

11. Right-click in the table window, and then click Properties.
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Tip The purpose of this Property Sheet is to set properties that apply to more than 

one fi eld in the table, as opposed to setting properties for a single fi eld in the Field 

Properties area.

 12. Click in the Validation Rule box, type [Date2]>[fDate], and press F.

 13. In the Validation Text box, type Date2 must be later than fDate, and then close 

the sheet.

A table validation rule is added that ensures that the second date is always later 

than the fi rst one.

 14. Save the table (click No to close the data-integrity alert box), and return to 

Datasheet view.

 15. In any record, type 6/1/07 in fDate and 5/1/07 in Date2, and then click in another 

record.

Access displays the Validation Text setting from the Table Properties dialog box, 

reminding you that Date2 must be later than fDate.

 16. Click OK, change Date2 to 6/2/2007, and then click in another record.

CLOSE the Field Property Test table and the 04_Validate database.

Creating a Simple Lookup List
It is interesting how many different ways people can come up with to enter the same 

items of information in a database. Asked to enter the name of their home state, for 

example, residents of the state of Washington will type Washington, Wash, or WA, plus 

various typographical errors and misspellings. If you ask a dozen sales clerks to enter the 

name of a specifi c product, customer, and shipper in an invoice, it is unlikely that all of 

them will type the same thing. In cases like this, in which the number of correct choices 

is limited (to actual product name, actual customer, and actual shipper), providing the 

option to choose the correct answer from a list will improve your database’s consistency.

Minor inconsistencies in the way data is entered might not be really important to some-

one who later reads the information and makes decisions. For example, Arizona and AZ 

refer to the same state. But a computer is very literal, and if you tell it to create a list so 

that you can send catalogs to everyone living in AZ, the computer won’t include anyone 

whose state is listed in the database as Arizona.
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You can limit the options for entering information in a database in several ways:

 O For only two options, you can use a Boolean fi eld represented by a check box. A 

check in the box indicates one choice, and no check indicates the other choice.

 O For several mutually exclusive options on a form, you can use option buttons to 

gather the required information.

 O For  more than a few options, a combo box is a good way to go. When you click the 

arrow at the right end of a combo box, a list of choices is displayed. Depending 

on the properties associated with the combo box, if you don’t see the option you 

want, you might be able to type something else, adding your entry to the list of 

possible options displayed in the future.

 O For  a short list of choices that won’t change often, you can have the combo box 

look up the options in a list that you provide. Although you can create a lookup list 

by hand, it is a lot easier to use the Lookup wizard.

In this exercise, you will use the Lookup wizard to create a list of months from which the 

user can choose.

USE the 05_SimpleLookup database. This practice fi le is located in the Chapter07 subfolder 

under SBS_Access2007.

OPEN the 05_SimpleLookup database. Then display the Field Property Test table in Design 

view.

1. Add   a new fi eld below LastName. Name it Month1, and set the data type to 

Lookup Wizard.

The Lookup wizard starts.

USE thethe 05_SimpleLookup05_SimpleLookup database. This practice fi le is located in the database. This practice fi le is located in the Chapter07Chapter07 subfolder  subfolder 77
under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 05_SimpleLookup05_SimpleLookup database. Then display the Field Property Test table in Design database. Then display the Field Property Test table in Design

view.view.
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You can use the Lookup wizard to create a combo box that provides the entry for a 

text fi eld. The combo box list can come from a table or query, or you can type the 

list in the wizard.

Tip If a   fi eld has a lot of potential entries, or if they will change often, you can link 

them to a table. (You might have to create a table expressly for this purpose.) If a fi eld 

has only a few possible entries that won’t change, typing the list in the wizard is easier.

2. Select the I will type in the values that I want option, and then click Next.

3. Leave the number of columns set to 1, and click in the Col1 box.

4. Enter the 12 months of the year (January, February, and so on), pressing D after 

each one to move to a new row.

5. Click Next, and then click Finish.

6. In the Field Properties area, click the Lookup tab to view the Lookup information 

for the Month1 fi eld.

The wizard entered this information, but you can easily fi gure out what you would 

have to enter to create a lookup list by hand.
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7. Switch to Datasheet view, clicking Yes to save your changes.

8. Double-click the vertical bars between the column headers to adjust the column 

widths so that you can see all the fi elds.

Tip You   can manually resize columns by dragging the vertical bars between the 

column headers.

9. Click  in the Month1 fi eld of a record, and then click the arrow that appears to 

display the list of options.

Notice the button below the Month1 options list. Clicking this button opens the 

Edit List Items dialog box  . This feature is new with Access 2007. The database user 

can open the editor by clicking the button, or by entering text that is not in the list 

and answering Yes when asked whether she or he wants to edit the list. If you don’t 

want users to be able to edit the list, you can disable this property, as we do later in 

this exercise.

10. If you opened it, close the Edit List Items dialog box and then click February to 

enter it in the fi eld.

11. Click in the next Month1 fi eld, type Jan, and press F.

As soon as you type the J, the combo box displays January. If you had typed Ju, the 

combo box would have displayed June.
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 12. In the next Month1 fi eld, type jly, and press F.

Even though the entry isn’t in the list, it is accepted just as you typed it. Although 

there might be times when you want to allow the entry of information other than 

the items in the list, this isn’t one of those times, so you need to change the fi eld 

properties to limit what can be entered.

 13. Return to Design view.

The  Limit To List property on the Lookup tab for Month1 is currently set to No, 

which allows people to enter information that isn’t in the list.

 14. Change Limit To List to Yes.

 15. Change Allow Value List Edits to No.

 16. Save the table, return to Datasheet view, type jly in a new Month1 fi eld, and then 

press F.

Access informs you that the text you entered is not in the list, and refuses the entry.

 17. In the Microsoft Offi ce Access message box, click OK.

 18. In the Month1 list, click July.

The month of July is displayed in the fi eld.

CLOSE the 05_SimpleLookup database, saving your changes.

Creating a Multi-Column Lookup List
Selecting  a month from a list of names is convenient for people, but if your computer 

has to deal with this information in some mathematical way, a list of the numbers 

associated with each month is easier for it to use.

In this exercise, you will use the Lookup wizard to create a two-column list of months 

from which the user can choose.

USE the 06_MulticolumnLookup database. This practice fi le is located in the Chapter07 

subfolder under SBS_Access2007.

OPEN the 06_MulticolumnLookup database. Then display the Field Property Test table in 

Design view.

 1. Add  a new fi eld below Month1. Name it Month2, and set the data type to Lookup 
Wizard.

USE thethe 06_MulticolumnLookup06_MulticolumnLookup database. This practice fi le is located in the database. This practice fi le is located in the Chapter07Chapter07
subfolder under subfolder under SBS_Access2007SBS_Access2007..7777

OPEN thethe 06_MulticolumnLookup06_MulticolumnLookup database. Then display the Field Property Test table in database. Then display the Field Property Test table in

Design view.Design view.
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2. Select the I will type in the values that I want option, and then click Next.

3. Type 2 to add a second column, and then click in the Col1 cell.

Access adds a second column, labeled Col2.

4. Enter the following numbers and months in the two columns:

Number Month

1 January

2 February

3 March

4 April

5 May

6 June

7 July

8 August

9 September

10 October

11 November

12 December

It is not necessary to adjust the width of the columns in the Lookup wizard other 

than to make them visible within the wizard itself.

5. Click Next, and then click Finish.
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6. In the Field Properties area, click the Lookup tab to view the Lookup information 

for the Month2 fi eld.

The wizard has inserted your column information into the Row Source box and set 

the other properties according to your specifi cations.

7. Change Limit To List to Yes and Allow Value List Edits to No.

Tip When  a property has two or more possible values, you can quickly cycle through 

them by double-clicking the value, rather than clicking the arrow to open the list.
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8. Save your changes, switch to Datasheet view, and then click the arrow in a Month2 

fi eld to display the list of options.

9. In the Month2 list, click January.

Access displays the number 1 in the fi eld, which is useful for the computer. 

However, people might be confused by the two columns and by seeing something 

other than what they clicked or typed.

10. Switch back to Design view, and in the Column Widths box—which appears as 

1”;1”—change the width for the fi rst column to 0 (you don’t have to type the 

symbol for inches) to prevent it from being displayed.

11. Save your changes, return to Datasheet view, and as a test, in the remaining 

records set Month2 to February in two records and to March in one record.

Only the name of the month is now displayed in the list, and when you click a 

month, that name is displayed in the fi eld. However, Access actually stores the 

associated number from the list’s fi rst column.

12. Right-click any cell in the Month2 column, point to Text Filters, and then click Equals.
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 13. In the Custom Filter box, type 2, and then press F.

Access now displays only the two records with February in the Month2 fi eld.

 14. Click the  Toggle Filter button, and then repeat Steps 12 and 13, this time typing 3 

in the box to display the one record with March in the Month2 fi eld.

CLOSE the 06_MulticolumnLookup database, saving your changes.

Updating Information in a Table
As you use a database and as it grows, you might discover that errors creep in or that 

some information becomes out of date. You can tediously scroll through the records 

looking for those that need to be changed, but it is more effi cient to use a few of the 

tools and techniques provided by Access for that purpose.

If  you want to fi nd or replace multiple instances of the same word or phrase, you can use 

the Find and Replace commands on the Edit menu. This command works much like the 

same commands in Microsoft Offi ce Word or Microsoft Offi ce Excel.

If  you want to change information stored in the database only under certain circum-

stances, you need the power of an update query, which is a select query that performs 

an action on the query’s results.

Tip Running an update query makes irreversible changes to the table; therefore, you 

should always create a backup copy of the table before running a query.

You   can quickly create a copy of a table by displaying the Tables list in the Navigation 

Pane, clicking the table you want to copy pressing Ctrl+C, and then pressing Ctrl+V to 

paste a copy. In the Paste Table As dialog box, type a name for the new table, and then 

click OK.

In this exercise, you will create an update query to increase the price of selected items by 

10 percent.
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USE the 07_Update database. This practice fi le is located in the Chapter07 subfolder under 

SBS_Access2007.

OPEN the 07_Update database.

 1. On   the Create tab, in the Other group, click the  Query Wizard button.

 2. In the New Query dialog box, with Simple Query Wizard selected, click OK.

 3. In the Tables/Queries list, click Table: Categories.

 4. In the Available Fields list, double-click CategoryName to move it to the Selected 
Fields list.

 5. In the Tables/Queries list, click Table: Products.

 6. In the Available Fields list, double-click ProductName and UnitPrice to move them 

to the Selected Fields list.

 7. In the Simple Query Wizard dialog box, click Finish to create the query using the 

default detail setting and title.

Access displays the query results in a datasheet. Only the Category Name, Product 

Name, and Unit Price fi elds are displayed.

USE thethe 07_Update07_Update database. This practice fi le is located in the database. This practice fi le is located in the Chapter07Chapter07 subfolder under subfolder under 77
SBS_Access2007SBS_Access2007..7777

OPEN thethe 07_Update07_Update database.database.
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 8. Display the query in Design view.

The current query results include the products in all categories. You want to raise 

the prices of only the products in the bulbs and cacti categories, so your next task is 

to change the query to select only those categories.

 9. In the Criteria row, under CategoryName, type bulbs. Then in the or row, type cacti.

 10. Click the    Run button to run the query to confi rm that only bulbs and cacti are 

listed, and then return to Design view.

The query now selects only the records you want to change. But to actually make a 

change to the records, you have to use an update query.

Tip You    can’t create an action query directly; you must fi rst create a select query and 

then change the query to one of the action types. With an existing select query open 

in Design view, you can fi nd the command to convert it to an action query in the Query 

Type group and on the shortcut menu that appears when you right-click the query 

window and then point to Query Type.
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 11. Display the query in Design view. On the Design contextual tab, in the Query Type 

group, click the  Update button.

Access converts the select query to an update query. In the design grid, the Sort 

and Show rows disappear and an Update To row appears.

 12. In the Update To row, under UnitPrice, type [UnitPrice]*1.1.

Tip Enclosing UnitPrice in brackets indicates that it is an Access object. If you use the 

Expression Builder to insert this expression, it looks like this: [Products]![UnitPrice]*1.1. 

Because this description of the fi eld includes the table in which it is found, you can 

also insert this expression in other tables.

 13. Display the query in Datasheet view.

In      a select query, clicking the View button is the same as clicking the Run button. 

But in an update query, clicking the View button simply displays a list of the fi elds 

that will be updated. In this case, you see a list of unit prices that matches the ones 

shown earlier in the select query.

 14. Switch to Design view. Then on the Query Tools Design contextual tab, in the 

Results group, click the  Run button.

Access displays a warning that you can’t undo the changes you are about to make, 

and asks you to confi rm that you want to update the records.

 15. In the Microsoft Offi ce Access message box, click Yes. Then click the View 

Datasheet button to display the UnitPrice fi eld, where all the prices have been 

increased by 10 percent.

 16. Save and close the query.

CLOSE the 07_Update database.
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Deleting Information from a Table
Over time, some of the information stored in a database might become obsolete. The 

Products table in our sample database, for example, lists all the products the company 

currently offers for sale or has sold in the past. You can indicate that a product is no 

longer available for sale by placing a check mark in the Discontinued fi eld. Discontinued 

products aren’t displayed in the catalog or offered for sale, but they are kept in the data-

base for a while in case it becomes practical to sell them again. A similar situation could 

exist with customers who haven’t placed an order in a long time or who have asked to 

be removed from a mailing list but might still place orders.

To  maintain an effi cient database, it is a good idea to clean house and discard outdated 

records from time to time. You could scroll through the tables and delete records manu-

ally, but if all the records you want to delete match some pattern, you can use a delete 

query to quickly get rid of all of them.

Important Keep   in mind several things when deleting records from a database. First, 

you can’t recover deleted records. Second, the effects of a delete query can be more 

far-reaching than you intend. If the table from which you are deleting records is linked 

to another table, and the Cascade Delete Related Records option for that relationship 

is selected, records in the second table will also be deleted. Sometimes this is what you 

want, but sometimes it isn’t. For example, you probably don’t want to delete records of 

previous sales at the same time you delete discontinued products. 

To safeguard against these problems, it is a good idea to back up your database before 

deleting the records, or to create a new table (perhaps named Deleted<file name>), and 

then move the records you want to delete to the new table, where you can review them 

before deleting them permanently.

In  this exercise, you will create a delete query to remove all discontinued products from 

a database table.

USE the 08_Delete database. This practice fi le is located in the Chapter07 subfolder under 

SBS_Access2007.

OPEN the 08_Delete database.

 1. On the Create tab, in the Other group, click the  Query Design button.

Access opens a new query object and the   Show Table dialog box.

 2. In the Show Table dialog box, double-click Products to add that table to the query 

window list area, and then click Close.

USE thethe 08_Delete08_Delete database. This practice fi le is located in the database. This practice fi le is located in the Chapter07Chapter07 subfolder under subfolder under77
SBS_Access2007SBS_Access2007..7777

OPEN thethe 08_Delete08_Delete database. database.
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3. In the Products fi eld list, double-click the asterisk to copy all the fi elds in the table 

to the query.

Products.* appears in the Field row of the fi rst column of the design grid, 

and Products appears in the Table row.

Important Double-clicking   the asterisk in the fi eld list is a quick way to move all 

the fi elds in a table to the query, without having each fi eld appear in its own column. 

However, selecting multiple fi elds in this way prevents you from setting Sort, Show, 

and Criteria values for individual fi elds. To set these values, you have to add the 

specifi c fi elds to the design grid, thereby adding them twice. To avoid displaying the 

fi elds twice, clear the check mark in the Show row of the duplicate individual fi elds.

4. In the Products fi eld list, double-click Discontinued to copy it to the next available 

column in the design grid.
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 5. In    the Query Type group, click the Delete button to convert this select query to a 

delete query.

A Delete row appears in the design grid, and the Sort and Show rows disappear.

In the fi rst column, which contains the reference to all fi elds in the Products table, 

the Delete row contains the word From, indicating that this is the table from which 

records will be deleted. When you add individual fi elds to the remaining columns, 

as you did with the Discontinued fi eld, the Delete row displays Where, indicating 

that this fi eld can include deletion criteria.

 6. In the Criteria row, under Discontinued, type Yes.

The   Discontinued fi eld is set to the Boolean data type, which is represented in the 

datasheet as a check box that is selected to indicate Yes and cleared to indicate 

No. To locate all discontinued products, you need to identify records with the 

Discontinued fi eld set to Yes.

 7. To   check the accuracy of the query, switch to Database view.
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Testing the query results in a list of 18 discontinued products that would be deleted 

if you ran the query. Scroll to the right to verify that all records display a check mark 

in the Products.Discontinued fi eld.

 8. Switch  to Design view. Then on the Design contextual tab, in the Results group, 

click the Run button to run the delete query.

Access displays a warning to remind you of the permanence of this action.

Tip Before   actually deleting records, you might want to display the Relationships 

window by clicking the Relationships button in the Show/Hide Group on the Database 

Tools tab. If the table you are deleting data from has a relationship with any table con-

taining information that shouldn’t be deleted, right-click the relationship line, click Edit 

Relationship, and make sure that the Enforce Referential Integrity check box is selected 

and the Cascade Delete Related Records check box is not selected.

 9. In the Microsoft Offi ce Access message box, click Yes to delete the records.

 10. Switch to Datasheet view and verify that all the records were deleted.
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 11. If you think you might run the same delete query in the future, save and name the 

query.

Tip If  you are concerned that someone might accidentally run a delete query and 

destroy records you weren’t ready to destroy, change the query back to a select query 

before saving it. You can then open the select query in Design view and change it to a 

delete query the next time you want to run it.

CLOSE the query and the 08_Delete database.

Preventing Database Problems
In the day-to-day use of an Access database—adding and deleting records, modifying 

forms and reports, and so on—various problems can develop. This is especially true if the 

database is stored on a network share, rather than on a local drive, and is accessed by 

multiple users. Access monitors the condition of database fi les as you open and work with 

them. If a problem develops, Access attempts to fi x it. If Access can’t fi x the problem, it 

usually provides additional information that might help you to fi nd a solution. But Access 

doesn’t always spot problems before they affect the database; if this happens, you might 

notice that the database performance seems to slow down or become erratic. Even if no 

actual errors occur, normal database use causes the internal structure of a database to 

become fragmented, resulting in a bloated fi le and ineffi cient use of disk space.

You don’t have to wait for Access to spot a problem. There are various things you can 

do to help keep your database healthy and running smoothly.   Your fi rst line of defense 

against damage or corruption in any kind of fi le is the maintenance of backups. Database 

fi les rapidly become too large to conveniently back up onto a fl oppy disk, but you have 

many other options: you can copy the fi le to another computer on the network or to 

removable media such as a USB fl ash drive, send it as an e-mail attachment to another 

location, create a tape backup, or burn a CD-ROM.

Tip To back up a database in Access 2007, click the Microsoft Offi ce Button, point to 

Manage, and then click Back Up Database.



 Preventing Database Problems  211
You can use the following Access utilities to keep your database running smoothly:

 O Compact and Repair Database. This  utility fi rst optimizes performance by re-

arranging how the fi le is stored on your hard disk, and then attempts to repair 

corruption in tables, forms, reports, and modules.

 O Performance Analyzer. This  utility analyzes the objects in your database and 

offers three types of feedback: ideas, suggestions, and recommendations. You 

can instruct Access to optimize the fi le by following through on any of the 

suggestions or recommendations.

 O Database Documenter. This  tool produces a detailed report containing enough 

information to rebuild the database structure if that were ever necessary.

 O Analyze Table. This  wizard tests database tables for compliance with standard 

database design principles, suggests solutions to problems, and implements those 

solutions at your request.

 O Microsoft Offi ce Diagnostics. This  command attempts to diagnose and repair 

problems with your Microsoft Offi ce programs.

Important Take care when running the Microsoft Offi ce Diagnostics utility, because 

it might change fi les and registry settings that affect all Offi ce programs.

In this exercise, you will back up a database and then run the Compact And Repair 

Database, Performance Analyzer, and Database Documenter utilities.

USE the 09_Prevent database. This practice fi le is located in the Chapter07 subfolder under 

SBS_Access2007.

OPEN the 09_Prevent database. Do not display any of the database tables.

 1. Click   the Microsoft Offi ce Button, point to Manage, and then click Back Up 
Database.

 2. In the Save As dialog box, navigate to your Documents\MSP\SBS_Access2007\
Chapter07 folder, and then click Save.

USE thethe 09_Prevent09_Prevent database. This practice fi le is located in the database. This practice fi le is located in the tt Chapter07Chapter07 subfolder under subfolder under 77
SBS_Access2007SBS_Access2007..7777

OPEN thethe 09_Prevent09_Prevent database. Do not display any of the database tables. database. Do not display any of the database tables.tt
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Tip When you back up a database, Access appends the current date to the database 

fi le name in the following format: 09_Prevent_2007-04-22.accdb. You can change 

the fi le name to suit your needs.

Access creates a compacted copy of the database in the specifi ed folder.

3. Click the Microsoft Offi ce Button, point to Manage, and then click Database 
Properties.

The Database Properties dialog box   opens, displaying information about your 

database on fi ve tabs.

4. On the General tab, note the size of the database. Then click OK to close the 

dialog box.

5. Click  the Microsoft Offi ce Button, point to Manage, and then click Compact and 
Repair Database. Acknowledge the safety warning if prompted to do so.

The utility takes only a few seconds to run, and you will see no difference in the 

appearance of the database.

Troubleshooting If you don’t have enough space on your hard disk to store 

a temporary copy of the database, you don’t have appropriate permissions, or 

another user also has the database open, the Compact And Repair Database 

function will not run.

Troubleshooting If you don’t have enough space on your hard disk to storeIf you don’t have enough space on your hard disk to store

a temporary copy of the database, you don’t have appropriate permissions, ora temporary copy of the database, you don’t have appropriate permissions, or

another user also has the database open, the Compact And Repair Database another user also has the database open, the Compact And Repair Database 

function will not run.function will not run.
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6. Repeat Steps 3 and 4 to display the database size, and compare it to the original 

database size.

You can expect a 10 to 25 percent reduction in the size of the database if you have 

been using it for a while.

Tip It is a good idea to compact and repair a database often. You can have Access 

do this automatically each time the database is closed. To do so, click the Microsoft 

Offi ce Button, click the Access Options button, and then on the Current Database 

page, select the Compact On Close check box, and click OK.

7. On the Database Tools tab, in the Analyze group, click the Analyze Performance 

button.

The Performance Analyzer dialog box   opens.

This dialog box contains a tab for each type of object the utility can analyze, and a 

tab displaying all the existing database objects.

8. On the All Object Types tab, click Select All, and then click OK to start the analyzer.

When it fi nishes, the Performance Analyzer displays its results. (The results you see 

might be different from those shown here.)
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The icons in the left column of the Analysis Results list indicate the category of 

each entry: Recommendation, Suggestion, and Idea. (After you perform any of the 

optimizations, Fixed entries will also appear in the list.) Clicking an entry displays 

information about it in the Analysis Notes section.

9. Scroll through the list, clicking each entry in turn, and read all the analysis notes.

Most of the suggestions are valid, though some, such as the one to change the 

data type of the PostalCode fi eld to Long Integer, are not appropriate for this 

database.

10. Close the Performance Analyzer dialog box.

11. On   the Database Tools tab, in the Analyze group, click the  Database Documenter 
button.

The Documenter dialog box   opens. This dialog box is identical to the Performance 

Analyzer database. It contains a tab for each type of object the utility can document, 

and a tab displaying all the existing database objects.
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12. On the Tables tab, click the Options button.

The Print Table Defi nition dialog box   opens.

The dialog box offers print options associated with the objects on the selected 

dialog box tab. The options differ for each tab, but all are similar to these, in that 

you can use them to specify the documentation to include for each type of object.

13. In the Print Table Defi nition dialog box, click Cancel.

14. On the All Object Types tab, click Select All, and then click OK to start the docu-

mentation process.

Tip You can’t save the report generated by the Documenter utility, but you can 

export it as a Word RTF fi le, Access database, text fi le, XML fi le, or HTML document. 

To do so, right-click the report, point to Export, and then click the format you want.
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When the process fi nishes, Access displays a report in Print Preview. This report can 

run to hundreds of pages, so you probably don’t want to print it. However, it is a 

good idea to create and save a report such as this for your own databases, in case 

you ever need to reconstruct them.

CLOSE the Object Defi nition report and the 09_Prevent database. If you are not continuing 

directly on to the next chapter, quit Access.
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Key Points
 O You can set properties that restrict the type and amount of data that can be entered 

into an Access database.

 O You can replace specifi c words or phrases by using the Replace command, or quickly 

enact conditional changes by running an action query.

 O The Data Type setting restricts entries to a specifi c type of data: text, numbers, dates, 

and so on. The Field Size property for the Text, Number, and AutoNumber data 

types restricts the number of characters allowed in a text fi eld or the number of 

digits allowed in a number or AutoNumber fi eld. The Input Mask property controls 

the format in which data can be entered.

 O You can use a validation rule to precisely defi ne the information that will be accepted 

in one or several fi elds in a record. At the fi eld level, Access tests each entry against 

the rule when you attempt to leave a fi eld. At the table level, Access tests the content 

of several fi elds against the rule when you attempt to leave a record. In both cases, 

Access rejects any entry that doesn’t comply with the rule.

 O For fi elds with a fi xed set of possible entries, you can use a lookup fi eld to ensure 

that users enter the right information. This helps prevent inconsistencies, thus 

making it easier to sort and search your data.

 O You can use an update query to quickly perform an action, such as replacing the 

contents of a fi eld, based on the results of a query.

 O You can use a delete query to quickly delete records that meet specifi c criteria. You 

should always back up your database before running a delete query, and you must 

exercise caution when deleting records in this way. The effects of a delete query 

can be far-reaching, and you can’t recover deleted records.

 O There are several utilities that you can use to keep your database running 

smoothly—Compact And Repair Database, Performance Analyzer, Database 

Documenter, and Microsoft Offi ce Diagnostics. You can keep your application 

healthy by taking advantage of these utilities before Access indicates there is a 

problem with your database.
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  8 8 Working with  Working with 
  Reports  Reports

In this chapter, you will learn to:

 � Create a report manually and by using a wizard.

 � Modify the design and content of a report.

 � Add a subreport to a report.

 � Preview and print a report.

Reports  generally represent summaries of larger bodies of information. For example, 

your database might hold detailed information about thousands of orders. If you want 

to edit those orders or enter new ones, you can do so directly in the table or through 

a form. If you want to summarize those orders to illustrate the rate of growth of the 

company’s sales, you generate a report.

Like a book report or an annual report of a company’s activities, a report created in 

Microsoft Offi ce Access 2007 is typically used to summarize and organize information 

to express a particular point of view to a specifi c audience. When designing a report, it is 

important to consider the point you are trying to make, the intended audience, and the 

level of information they will need.

In this chapter, you will create a report by using a wizard and another by building your 

own manually. You will learn how to modify the layout and content of a report, and how 

to embed reports within each other. Finally, you will preview a report as it will appear 

when printed.

See Also Do you need only a quick refresher on the topics in this chapter? See the Quick 
Reference entries on pages xxxix–lxv.

Important Before you can use the practice fi les in this chapter, you need to install them 

from the book’s companion CD to their default location. See “Using the Book’s CD” on page 

xxv for more information.
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Troubleshooting Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and you 

experience trouble following the instructions as written, please refer to the “Information for 

Readers Running Windows XP” section at the beginning of this book.

Forms vs. Reports
In   many ways, reports are like forms; for example:

O You can create them by using wizards and modify them in a design 

environment.

O You can add labels, text boxes, images, and other controls, and set their 

properties.

O You can display information from one or more records, or from one or more 

tables or queries.

O You can have multiple sets of headers and footers.

Forms and reports have one purpose in common: to give people easy access to 

the information stored in a database. The main differences between forms and 

reports are:

O Forms are used to enter, view, and edit information. Reports are used only to 

view information.

O Forms are usually displayed on-screen. Reports can be previewed on the 

screen, but they are usually printed.

O Forms generally provide a detailed look at records and are usually for the 

people who actually work with the database. Reports are often used to 

group and summarize data, and are often for people who don’t work with 

the database but who use the information stored in the database for other 

business tasks.

Forms and reports are suffi ciently alike that you can save a form as a report 

when you want to take advantage of additional report refi nement and printing 

capabilities.

Troubleshooting Graphics and operating system–related instructions in this book refl ect Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and youthe Windows Vista user interface. If your computer is running Microsoft Windows XP and you

experience trouble following the instructions as written, please refer to the “Information forexperience trouble following the instructions as written, please refer to the “Information for

Readers Running Windows XP” section at the beginning of this book.Readers Running Windows XP” section at the beginning of this book.

Forms vs. Reports
In In many ways, reports are like forms; for example:many ways, reports are like forms; for example:

O You can create them by using wizards and modify them in a designYou can create them by using wizards and modify them in a design

environment.environment.

O You can add labels, text boxes, images, and other controls, and set theirYou can add labels, text boxes, images, and other controls, and set their

properties.properties.

O You can display information from one or more records, or from one or moreYou can display information from one or more records, or from one or more

tables or queries.tables or queries.

O You can have multiple sets of headers and footers.You can have multiple sets of headers and footers.

Forms and reports have one purpose in common: to give people easy access toForms and reports have one purpose in common: to give people easy access to

the information stored in a database. The main differences between forms and the information stored in a database. The main differences between forms and 

reports are:reports are:

O Forms are used to enter, view, and edit information. Reports are used only to Forms are used to enter, view, and edit information. Reports are used only to 

view information.view information.

O Forms are usually displayed on-screen. Reports can be previewed on the Forms are usually displayed on-screen. Reports can be previewed on the 

screen, but they are usually printed.screen, but they are usually printed.

O Forms generally provide a detailed look at records and are usually for theForms generally provide a detailed look at records and are usually for the

people who actually work with the database. Reports are often used topeople who actually work with the database. Reports are often used to

group and summarize data, and are often for people who don’t work with group and summarize data, and are often for people who don’t work with 

the database but who use the information stored in the database for otherthe database but who use the information stored in the database for other

business tasks.business tasks.

Forms and reports are suffi ciently alike that you can save a form as a reportForms and reports are suffi ciently alike that you can save a form as a report

when you want to take advantage of additional report refi nement and printingwhen you want to take advantage of additional report refi nement and printing

capabilities.capabilities.
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Creating a Report by Using a Wizard
You can divide the content of an Access report into two general categories: information 

derived from records in one or more tables, and everything else. The everything else 

category includes the title, page headers and footers, introductory and explanatory text, 

logo, background and graphics, and calculations based on the database content.

You can create a basic report by using the Report wizard , which provides a simple layout, 

attaches styles, and adds a text box control and its associated label for each fi eld you 

specify. If the basic report doesn’t fi t your needs, you can refi ne it in Design view.

When you include more than one table in a report, the wizard evaluates the relationships 

between the tables, and offers to group the records in any logical manner available.

Important If relationships between tables aren’t already established in the Relationships 

window, you have to cancel the wizard and establish them before continuing. The necessary 

relationships have already been defi ned in the practice fi les.

See Also For information about creating relationships between tables, see the sidebar 
“Relationships” in Chapter 5, “Simplifying Data Entry by Using Forms.”

You  can group the information in a report based on the data in one or more fi elds. You 

can, for example, group products by category. When you do this the wizard fi rst sorts 

the table based on the category, then sorts the products in each category. It then creates 

a group header each time the category changes. It can also add a footer to each group, 

in which it summarizes the information in the group.

In this exercise, you will create a simple report that displays an alphabetical list of 

products. 

Tip The Report wizard  leads you through a series of questions and then creates a report 

based on your answers. This exercise guides you through the process of creating a stan-

dard report without justifying the data selected, but when you get around to creating 

your own reports you should fi rst consider the end result you want, and what information 

you need to include in the report to achieve that result.
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USE the 01_Wizard database. This practice fi le is located in the Chapter08 subfolder under 

SBS_Access2007.

BE SURE TO start Access before beginning this exercise.

OPEN the 01_Wizard database, and acknowledge the safety warning if prompted to do so.

1. On    the Create tab, in the Reports group, click the Report Wizard button.

The Report wizard starts.

2. On  the fi eld selection page, click the Tables/Queries arrow, and then in the list, 

click Table: Products.

Access displays the fi elds from the Products table.

3. In the Available Fields list, double-click ProductName, QuantityPerUnit, and 

UnitsInStock to move them to the Selected Fields list.

Tip Fields appear in a report in the same order that they appear in the Selected 

Fields list. You can save yourself the effort of rearranging the fi elds in the report by 

entering them in the desired order in the wizard.

4. In the Tables/Queries list, click Table: Categories to display the fi elds from the 

Categories table.

5. In the Selected Fields list, click ProductName.

The next fi eld you add will be inserted following the selected fi eld.

USE thethe 01_Wizard01_Wizard database. This practice fi le is located in the database. This practice fi le is located in the dd Chapter08Chapter08 subfolder under subfolder under

SBS_Access2007SBS_Access2007..7777

BE SURE TO start Access before beginning this exercise.start Access before beginning this exercise.

OPEN thethe 01_Wizard01_Wizard database, and acknowledge the safety warning if prompted to do so.database, and acknowledge the safety warning if prompted to do so.dd
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6. In the Available Fields list, double-click CategoryName.

Tip If  you are using more than two tables in a form or report, or if you will be 

using the same combination of tables in several places, you can save time by 

creating a query based on those tables, and by using the results of that query as 

the basis for the form or report.

7. On the fi eld selection page, click Next.

You can view the records in this example by category or by product; clicking either 

option depicts the arrangement in the right pane. 
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8. On the grouping   page, with by Products selected, click Next.

You can specify the fi elds used to establish grouping levels. When you group by a 

fi eld, the report includes a group header and footer around each group of records 

that have the same value in that fi eld.

9. On the grouping levels page, double-click ProductName to move it to the top of 

the preview pane. Then click the Grouping Options button.

The Grouping Intervals dialog box   opens.
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10. In the Grouping intervals list, click 1st Letter. Then click OK.

Selecting this option creates a new group header each time the fi rst letter of the 

category changes.

11. On the grouping levels page, click Next.

You   can sort report information by up to four fi elds, each in ascending or de-

scending order. When you sort by any fi eld that contains numeric information, 

the Summary Options button  appears at the bottom of the wizard page. In the 

Summary Options dialog box  , you can instruct Access to display the sum, average, 

minimum, or maximum value for the fi eld in the report.

The only numeric fi eld in this report is UnitsInStock, and there is no need to 

summarize it.
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12. Click the arrow to the right of the fi rst box to display a list of fi elds, and click 

ProductName. Then click Next.

13. In  the Layout area, select the Outline option. With the Portrait orientation 

option and the Adjust the fi eld width so all fi elds fi t on a page check box 

selected, click Next.

14. On the style selection page, in the list of styles, click Flow, then click Next to 

display the wizard’s fi nal page.

15. In   the title box, type Alphabetical List of Products, and then with the Preview the 
report option selected, click Finish.

Access creates and displays the report.
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CLOSE the Alphabetical List Of Products report and the 01_Wizard database.

Modifying Report Design
You can use the Report wizard to get a quick start on a report, but you will frequently 

want to modify the resultant report; you can do this in Design view. Refi ning a report is 

an iterative process: you switch back and forth between Design view and Print Preview 

to evaluate each change and plan the next.

In this exercise, you’ll modify the layout and formatting of a report.

USE the 02_ModifyDesign database. This practice fi le is located in the Chapter08 subfolder 

under SBS_Access2007.

OPEN the 02_ModifyDesign database.

 1. In the Navigation Pane, under Reports, right-click the Alphabetical List of 
Products report, and then click Print Preview.

USE thethe 02_ModifyDesign02_ModifyDesign database. This practice fi le is located in the database. This practice fi le is located in the Chapter08Chapter08 subfolder  subfolder 

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 02_ModifyDesign02_ModifyDesign database. database.
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2. Maximize   the window if it isn’t already, and then point to the previewed report page. 

The pointer changes to a magnifying glass with a plus sign in it to indicate that you 

can zoom in on the page. 

3. Click the previewed page once to zoom in.

Tip You can zoom in and out by dragging the Zoom slider in the lower-right corner 

of the window. The current zoom level appears to the left of the slider.
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Notice that the report has the following design problems:

 P There is no date below the title.

 P There is some extraneous text.

 P Labels need to be rearranged.

 P There are a number of general formatting issues.

 4. On the View toolbar at the bottom of the screen, click the  Design View button to 

switch views, and if the Field List pane opens, close it.

 5. Point   to the top edge of the Page Header selector. When the pointer changes to a 

two-headed vertical arrow, drag the selector down about a quarter inch to make 

room for a date.

Troubleshooting Depending on your printer settings, Access might display an 

error next to the Report Header alerting you that the report is wider than the page. 

You can ignore this error; it will go away when we change the width property for 

the report.

Tip The   rulers above and to the left of the report form help you judge the size 

of the printed report. You can toggle the rulers and the grid dots on and off by 

right-clicking the report and then clicking Ruler or Grid.

Design ViewDesign View

Troubleshooting Depending on your printer settings, Access might display anDepending on your printer settings, Access might display an

error next to the Report Header alerting you that the report is wider than the page.error next to the Report Header alerting you that the report is wider than the page.

You can ignore this error; it will go away when we change the width property forYou can ignore this error; it will go away when we change the width property for

the report.the report.
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 6. On   the Design contextual tab, in the Controls group, click the  Date & Time button.

The Date And Time dialog box   opens. 

 7.  Select the third date format option, and clear the Include Time check box. Then 

click OK to insert the current date in the report.

The Date text box is inserted in the upper-right corner of the Report Header. You 

may have to enlarge the report to see it.

 8. Drag the Date text box until it is just below the title, aligned with its left edge.

 9. With   the text box still selected, in the Font group, click the   Align Text Left button 

to align the date with the left edge of the text box.

 10. Drag through all the controls in the ProductName Header and Detail sections 

to select them. Then on the Arrange tab, in the Control Layout group, click the 

Remove button to remove the Stacked layout.

Removing the Stacked layout gives you more options for arranging the controls.

 11. In the ProductName Header section, delete the Product Name by 1st label, and 

then drag the text box to the left edge of the section.

 12. In the Page Footer section, click the text box containing =Now(), and then 

press A.

 13. In the Page Footer section, click the remaining text box to select it, and press 

$ to open the Property Sheet. Change the Width property to 2" and the Left 
property to 4.5".

 14. In   the upper-left corner of the report, click the Report Selector. In the Property 
Sheet pane, change the Width property to 6.5", and then close the pane.

Date & TimeDate & Time

Align Text LeftAlign Text Left
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Tip A square black dot within the Report Selector indicates that the report is 

currently selected.

If Access displayed the error earlier alerting you that the report width exceeded the 

page width, setting the Width properties in Steps 13 and 14 causes it to disappear.

15. Save your changes, and then on the View toolbar, click the Print Preview button.

Access displays a preview of the report as it will appear when printed. 

Next, you will insert a line at the bottom of each group, and prevent the groups 

from breaking across pages.

16. Switch back to Design view. On the Design tab, in the Grouping & Totals group, 

click the  Group & Sort button.

The Group, Sort, And Total pane appears below the Report window.

You can use this pane, which is a new feature in Access 2007, to quickly add 

grouping and sorting levels and set related properties.

Print PreviewPrint Preview
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 17. In   the Group, Sort, and Total pane, in the Group on ProductName bar, click More 

to see additional options. Then click the without a footer section arrow, and in the 

list, click with a footer section.

A ProductName Footer section selector appears above the Page Footer section.

 18. Click the do not keep group together on one page arrow, and then in the list, click 

keep whole group together on one page. Then close the Group, Sort, and Total 
pane by clicking the  Group & Sort button again.

 19. In   the Controls group, click the  Line button, and then click near the top of the 

ProductName Footer section to insert a short horizontal line.

 20. Press $ to display the Property Sheet pane, if it is not already visible.

 21. On   the Format tab, change the Left setting to 0, the Width setting to 6.5". Then in 

the Border Color list, click Text Black.

 22. Save your changes, and then switch to Print Preview to review them.

Access displays a preview of the report. You can make changes to the appearance 

of the report, such as realigning the columns.

 23. Switch back to Design view and in the ProductName Header and Detail sections, 

drag through the label and text box for Units In Stock to select them. Then in the 

Property Sheet pane, change the Left setting to 5.5".

Tip Drag through any portion of the two controls to select them.

 24. Select the label and text box for Quantity Per Unit. Change the Left setting to 4" 

and the Width setting to 1.25".

 25. Select the label and text box for CategoryName. Change the Left setting to 2.25" 

and the Width setting to 1.5".

 26. Select the label and text box for ProductName, and then change the Width 

setting to 1.5".

LineLine
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Tip To make changes to two or more controls, select all the controls you want to 

change, and then drag a handle of any selected control to change all of them the 

same way.

 27. Save your changes, and then switch to Print Preview to see the fi nal result.

CLOSE the Alphabetical List Of Products report and the 02_ModifyDesign database.

Creating a Report Manually
The fastest way to create a report that displays specifi c fi eld captions and contents from 

more than one table is by using the Report wizard. Sometimes, however, you might want 

to create a main report that serves as a shell for one or more subreports, but displays 

little or no information from the underlying tables. It can be easier to create the main 

report manually in Design view.
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In this exercise, you will create a main report based on a query. 

USE the 03_Manually database. This practice fi le is located in the Chapter08 subfolder 

under SBS_Access2007.

OPEN the 03_Manually database.

 1. On  the Create tab, in the Reports group, click the  Report Design button.

Access displays a blank report.

Tip The Page Header, Detail, and Page Footer sections you see in Design view are the 

default sections for a new report, but you can add or remove sections to fi t your needs.

 2. If the Field List pane isn’t open, click the  Add Existing Fields button in the Tools 
group.

Troubleshooting If the Field List pane covers the report, you can make the pane 

narrower by dragging its left edge to the right.

Field List paneReport Selector

USE the the 03_Manually03_Manually database. This practice fi le is located in the database. This practice fi le is located in theyy Chapter08Chapter08 subfoldersubfolder

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 03_Manually03_Manually database.database.yy

Troubleshooting If the Field List pane covers the report, you can make the paneIf the Field List pane covers the report, you can make the pane

narrower by dragging its left edge to the right.narrower by dragging its left edge to the right.
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 3. Right-click   the report, and then click Report Header/Footer.

Report Header and Report Footer sections now enclose the default Page Header, 

Detail, and Page Footer sections.

Troubleshooting  If the page header and footer disappear from your report, you 

can restore them by right-clicking the report and then clicking Page Header/Footer to 

restore them.

 4. In the Field List pane, expand the Categories fi eld list, and then double-click the 

CategoryName fi eld.

The selected label and text box appear in the Detail section of the report window.

 5. Close the Field List pane.

 6. On the Design contextual tab, in the Grouping & Totals group, click the Group & 
Sort button.

The Group, Sort, And Total pane opens below the report.

 7. In  the Group, Sort, and Total pane, click Add a group. 

The Group on bar appears, with the select fi eld pane open.

 8. In the select fi eld pane, click CategoryName.

A CategoryName section header appears in the report.

 9. Close the Group, Sort, and Total pane.

 10. Select the CategoryName label and text box, then move the two controls to the 

grid just below the CategoryName header.

 11. In the upper-left corner of the report, click the Report Selector, and then press $ 

to open the Property Sheet pane.

 12. On  the Format tab, set the Grid X and Grid Y properties to 10.

You might fi nd it easier to align controls against this larger grid.

 13. Click   the Report Header section, and then on the Format tab in the Property 
Sheet pane, set its Height property to 1".

Troubleshooting Throughout this book we refer to measurements in inches. If 

your computer is set to display measurements in centimeters, substitute the equiva-

lent metric measurement. As long as you are entering the default units, you don’t 

have to specify the unit type.

Troubleshooting If the page header and footer disappear from your report, youIf the page header and footer disappear from your report, you

can restore them by right-clicking the report and then clicking Page Header/Footer tocan restore them by right-clicking the report and then clicking Page Header/Footer to

restore them.restore them.

Report SelectorReport Selector

Troubleshooting Throughout this book we refer to measurements in inches. If Throughout this book we refer to measurements in inches. If 

your computer is set to display measurements in centimeters, substitute the equiva-your computer is set to display measurements in centimeters, substitute the equiva-

lent metric measurement. As long as you are entering the default units, you don’tlent metric measurement. As long as you are entering the default units, you don’t

have to specify the unit type.have to specify the unit type.
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 14. Repeat Step 13 to set the Height property for other sections of the report as 

follows: 

 Section Setting

 PageHeader 0"

 Category/Name Header 2.2"

 Detail 0"

 Page Footer 0.2"

 Report Footer 0"

Tip You can manually set the height of a section by dragging the top edge of the 

section selector up or down.

 15. On the Quick Access Toolbar, click the  Save button. In the Save As dialog box, 

type Sales by Category in the Report Name box, and then click OK.

 16. On the View toolbar, click the Report View button to see the results of 

your work.

CLOSE the Sales By Category report and the 03_Manually database.

SaveSave

Report ViewReport View
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Modifying Report Content
Whether you create a report with the Report wizard or manually, you can modify the 

report later in Design view to add content or change the layout or style of the content. 

In this exercise, you’ll modify the content of a report by inserting a title, date, and time in 

the header and page numbers in the footer, inserting and removing labels, and changing 

the appearance of text.

USE the 04_ModifyContent database. This practice fi le is located in the Chapter08 

subfolder under SBS_Access2007.

OPEN the 04_ModifyContent database. Then display the Sales By Category report in 

Design view.

 1. On   the Design contextual tab, in the Controls group, click the  Title button.

Access inserts a title (matching the report name) in the Report Header section.

 2. If the Property Sheet pane is not open, press $ to open it.   Then set the font 

properties as follows:

 Property Setting

 Font Name Times New Roman

 Font Size 20

 Font Weight Bold

 Font Italic Yes

The title text refl ects your changes, but no longer fi ts in its text box.

 3. Right-click  the title text box, point to Size, and then click To Fit.

Troubleshooting If Access displays an error when you navigate away from the 

label because it isn’t associated with a control, click the Smart Tag, and then click 

Ignore Error.

 4. In the Controls group, click the  Date & Time button.

The   Date And Time dialog box opens.

 5. With   the Include Date check box and the fi rst (long) date format options selected, 

clear the Include Time check box, and then click OK.

USE the the 04_ModifyContent04_ModifyContent database. This practice fi le is located in the database. This practice fi le is located in the tt Chapter08Chapter08
subfolder under subfolder under SBS_Access2007SBS_Access2007..7777

OPEN the the 04_ModifyContent04_ModifyContent database. Then display the Sales By Category report indatabase. Then display the Sales By Category report intt
Design view.Design view.

TitleTitle

Troubleshooting If Access displays an error when you navigate away from the If Access displays an error when you navigate away from the 

label because it isn’t associated with a control, click the Smart Tag, and then clicklabel because it isn’t associated with a control, click the Smart Tag, and then click

Ignore Error.Ignore Error.

Date & TimeDate & Time
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A text box containing =Date() appears in the upper-right corner of the Report 

Header section. When inserting the Date And Time control in a report that doesn’t 

have a Report Header section, the text box appears in the Detail section. You might 

have to close the Property Sheet pane in order to see the text box.

 6. Move the =Date() text box below the title and adjust its width to match the title 

text box.

 7. In the Font group, click the    Center button to center the date that will be displayed 

in this text box.

 8. Under the CategoryName Header, delete the Category Name label that appears 

to the left of the text box.

 9. Select the text box, and set its font properties to the same settings as those used in 

Step 2 for the report title.

 10. Right-click the CategoryName text box, point to Size, and then click To Fit.

 11. Position the text box with its top against the top of the section and its left edge 

two gridlines in from the left, and then drag the right edge of the text box to about 

the 2.4-inch mark.

 12. On the Design tab, in the Controls group, click the  Label button. Then click directly 

below the lower-left corner of the CategoryName text box.

 13. In the minimized text box that appears, type Product: and then press the F key.

Because this label is not associated with a control, an error appears. 

 14. Click the Smart Tag, and then in the list, click Ignore Error.

 15. Set the font properties for the label as follows:

 Property Setting

 Font Name Times New Roman

 Font Size 12

 Font Weight Bold

 Font Italic Yes

 16. Right-click the label, point to Size on the shortcut menu, and then click To Fit.

 17. Align the left edges of the label and the CategoryName text box.

Tip To precisely align the left edge of one control with that of another, set their Left 

properties to the same value.

CenterCenter

LabelLabel
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 18. In the Controls group, click the  Insert Page Number button. 

The Page Numbers dialog box   opens.

 19. In the Format area, select the Page N of M option. In the Position area, select the 

Bottom of Page [Footer] option. Click the Alignment arrow, and in the list, click 

Center. Then click OK.

Access inserts a text box containing the expression =”Page “ & [Page] & “ of “ & 
[Pages] in the center of the Page Footer section.

 20. Save the report, and then preview the results.

CLOSE the Sales By Category report and the 04_ModifyContent database.

Adding a Subreport to a Report
You can use a wizard to quickly create a report that is bound to the information in 

one table or in several related tables. However, reports often include multiple sets of 

information that are related to the topic of the report, but not necessarily related to 

each other. A report might, for example, include charts, spreadsheets, and other forms 

of information about several divisions or activities of a company. Or it might include 

information about production, marketing, sales, compensation, and the company’s 

pension plan. All these topics are related to running the business, but they don’t all fi t 

nicely into the structure of an individual Access report.

One  solution to this problem is to create separate reports and store them together, for 

example by printing them and placing them in a binder or by saving them in electronic 

format in a folder or on an intranet site. An easier and more graceful solution is to use 

subreports. A subreport is a report inserted within another report (usually with others). 

Insert Page 
Number

Insert Page 
Number
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You create a subreport as you would any other report, and then use a wizard either to 

insert it in a main report or to insert a subreport control in the main report. In either 

case, both the main report and the subreport appear as objects in the Reports pane of 

the database window.

You might frequently use queries as the basis for reports that require summary calcula-

tions or statistics. But you can also enhance the usefulness of both regular reports and 

subreports by performing calculations in the reports themselves. By inserting unbound 

controls and then using the Expression Builder to create the expressions that tell Access 

what to calculate and how, you can make information readily available in one place in-

stead of several.

Tip After  establishing the correct relationships, you can quickly insert an existing report as 

a subreport of another by opening the main report in Design view and then dragging the 

second report from the Reports pane to the section of the main report where you want to 

insert it as a subreport.

In this exercise, you will select a record source for a calculated query, and then add a 

subreport displaying calculated totals to a main report.

USE the 05_AddSubreport database. This practice fi le is located in the Chapter08 subfolder 

under SBS_Access2007.

OPEN the 05_AddSubreport database. Display the Sales By Category report in Design view, 

and then display the Property Sheet pane.

Troubleshooting The database created for this exercise contains additional 

queries; do not continue with the database from a previous exercise.

 1. If the Report Selector in the upper-left corner of the report does not display a 

black dot to indicate that the report is selected, click it.

 2. On the Data tab of the Property Sheet pane, click the Record Source arrow, and in 

the list, click Sales by Category. Then close the Property Sheet pane,

USE thethe 05_AddSubreport05_AddSubreport database. This practice fi le is located in the database. This practice fi le is located in thett Chapter08Chapter08 subfoldersubfolder

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 05_AddSubreport05_AddSubreport database. Display the Sales By Category report in Design view, database. Display the Sales By Category report in Design view, tt
and then display the Property Sheet pane.and then display the Property Sheet pane.

Troubleshooting The database created for this exercise contains additional The database created for this exercise contains additional 

queries; do not continue with the database from a previous exercise.queries; do not continue with the database from a previous exercise.
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 3. On  the Design contextual tab, in the Controls group, click the  Subform/Subreport 
button, and then click a point about two gridlines below the left edge of the 

Product label.

Access opens a blank, unbound subreport in the main report and then the 

SubReport wizard  starts.

 4. With the Use existing Tables and Queries option selected, click Next.

 5. In the Tables/Queries list, click Query: Sales by Category.

 6. In the Available Fields list, double-click CategoryID, ProductName, and 

ProductSales to move them to the Selected Fields list, and then click Next.

 7. With the Choose from a list option and Show Sales by Category for each record 
in Sales by Category using CategoryID selected, click Next.

 8. Click Finish to create a subreport with the suggested name, Sales by Category 
subreport.

The Sales By Category subreport takes the place of the unbound subreport in the 

main report.

 9. If the entire subreport isn’t selected, click  its top edge to select it. If the Property 

Sheet pane does not open automatically, press $.

Subform/
Subreport
Subform/
Subreport
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 10. On the Format tab, set the Width property to 6.6" and the Height property to 

1.5". Then press F.

 11. In the subreport, click an empty section of the Report Header grid, then press 

H+a to select all the controls.

 12. On the Arrange tab, in the Control Layout group, click the Remove button.

Removing the Stacked layout allows you to delete the Report Header without 

deleting the controls in the Detail section.

 13. In the subreport, right-click the Report Header section header, and then click 

Report Header/Footer to delete the existing header and footer sections. In the 

Microsoft Offi ce Access message box warning you that any controls in the sections 

will be deleted, click Yes.
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14. In the subreport, right-click the Page Header section header, and then click Page 
Header/Footer to delete the corresponding header and footer sections.

The subreport now consists of only a Detail section.

15. In the Detail section, click the CategoryID text box, and then press the A key.

16. Click the ProductName text box, and in the Property Sheet pane, change its 

Width property to 2.125".

17. Click the ProductSales text box, and in the Property Sheet pane, change its Left 
property to 2.3" and its Width property to 1".

The labels overlap.

18. In the main report, delete the partially hidden Sales by Category subreport label.

Tip If you  accidentally delete a control, press Ctrl+Z or click the Undo button to 

undo the deletion.
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19. Right-click in the grid below the subreport Detail section header, and then click 

Report Header/Footer to display those sections.

20. Scroll    the subreport to display the Report Footer section. (You might have to 

adjust the report window to see the scrollbar.) In the Controls group, click the 

Text Box button, and then click in the center of the Report Footer section.

Access inserts an unbound control and its label. You will use this control to perform 

the calculation.

21. Click  the label of the unbound control, and then in the Property Sheet pane, set 

the following properties:

Property Setting

Caption Total:

Font Name Arial

Font Size 9

Font Weight Bold

Text BoxText Box
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 22. Click the unbound text box control, and then in the Property Sheet pane, on 

the Data tab, click the ellipsis button in the Control Source property to start the 

Expression Builder.

Troubleshooting If you haven’t previously used the Expression Builder, Offi ce 

might install it at this time. The installation process might require you to insert the 

Offi ce installation CD.

 23. In the fi rst column, double-click Functions, and then click Built-In Functions. 

 24. In   the third column, double-click Sum.

Access displays Sum (<<expr>>) in the expression box.

 25. Click <<expr>>. Then click Sales by Category subreport in the fi rst column, and 

double-click ProductSales in the second column.

 26. Click OK to close the Expression Builder, and then press F to enter the calculation 

in the unbound text box in the Property Sheet pane.

 27. Set the font properties for the unbound text box as you did in Step 21.

 28. In  the Property Sheet pane, on the Format tab, click the Format arrow, click 

Currency, and then press F.

Access will now display the results of the calculation as currency.

 29. Set the Left and Width properties of the calculated control and its label to match 

the two controls in the Detail section.

EllipsisEllipsis

Troubleshooting If you haven’t previously used the Expression Builder, Offi ceIf you haven’t previously used the Expression Builder, Offi ce

might install it at this time. The installation process might require you to insert themight install it at this time. The installation process might require you to insert the

Offi ce installation CD.Offi ce installation CD.
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 30. Save your changes. Then on the View toolbar, click the Print Preview button to 

display the results of your work.

 31. On the View toolbar, click the Design View button to switch views.

Tip Several   factors affect the layout of the subreport in the main report when it is 

displayed in Print Preview. The width of the subreport sets the width of the space 

available for the display of text. The height of the subreport sets the minimum height 

of the area where product information is displayed (because the Can Shrink property 

for the subreport is set to No). The maximum height of the product display area is 

the length of the list (because the Can Grow property is set to Yes) plus the space 

between the bottom of the subreport and the bottom of the Detail section.

 32. Click  the subreport to select it. In the Property Sheet pane, on the Format tab, 

change the Border Style property to Transparent.

 33. Save your changes, and then preview the report. 

CLOSE the Sales By Category report and the 05_AddSubreport database.

Print PreviewPrint Preview
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Previewing and Printing a Report
Print Preview  in Access is very similar to Print Preview in other Microsoft Offi ce System 

products. If you look at your reports carefully in Print Preview, you won’t be in for any 

major surprises when you print them. But Access also provides a preview option called 

Layout Preview that displays real data and allows you to refi ne the layout.

In this exercise, you will preview a report in both Print Preview and Layout Preview, and 

then review the available printing options.

USE the 06_Printing database. This practice fi le is located in the Chapter08 subfolder under 

SBS_Access2007.

OPEN the 06_Printing database, and then display the Alphabetical List Of Products report 

in Design view.

 1. On  the Home tab, in the Views group, click the View arrow to display the list of 

views.

Each  of the four choices—Report View, Print Preview, Layout View, and Design 

View—has an associated icon. The current view is indicated by a border and back-

ground. The View button  displays the icon of the default view you will see (in this 

case, Report view) if you click the View button rather than selecting a view from the 

list. When you are in Design view, Report View, Print Preview, and Layout View are 

available from the list.

 2. In  the View list, click Print Preview.

The preview environment displays an image of how the report will look when it is 

printed. All tabs other than Print Preview are hidden. If you can’t see an entire page 

in the window, you can maximize the window, or slide the Zoom control to adjust 

the page magnifi cation.

USE thethe 06_Printing06_Printing database. This practice fi le is located in the database. This practice fi le is located in the Chapter08Chapter08 subfolder under subfolder under 

SBS_Access2007SBS_Access2007..7777

OPEN thethe 06_Printing06_Printing database, and then display the Alphabetical List Of Products report  database, and then display the Alphabetical List Of Products report 

in Design view.in Design view.
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Tip When   the pointer appears as a plus sign, clicking it zooms in on (magnifi es) the 

report. When it appears as a minus sign, clicking it decreases magnifi cation.

 3. On   the Navigation bar, click the Next Page button repeatedly to view each page 

of this report.

 4. In the Close Preview group, click the    Close Print Preview button.

Tip Automatic error checking identifi es common errors in forms and reports and 

gives you a chance to fi x them. For example, Access informs you if a report is wider 

than the page it will be printed on. To enable error checking, click the Microsoft 

Offi ce Button, then click Access Options. On the menu, click Object Designers, then 

scroll to the bottom of the window and select the Enable error checking check box 

and any other error checking options you want, and then click OK.

 5. In the View list, click Layout View.

Layout View   is a cross between Design view and Report view. After you create a 

report, you can add new fi elds, adjust the layout, and add grouping and sorting 

levels in Layout view. (You can’t create a report in Layout view, however.) Unlike 

Design view, Layout view looks very much like the fi nished report and displays real 

data from your records in the controls.

 6. Scroll through the report to see the results. 

 7. Click   the Microsoft Offi ce Button, and then click Print.

The Print dialog box   opens.

Next PageNext Page
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From here, you can click the Setup button to open the Page Setup dialog box, or you 

can click Properties to open a dialog box in which you can set properties specifi c to 

the printer designated in the Name box. You can also specify which pages to print 

and the number of copies of each. The options you see in this dialog box may vary 

depending on your individual system.

CLOSE the Print dialog box, the Alphabetical List Of Products report, and the 06_Printing 

database. If you are not continuing directly on to the next chapter, quit Access.

Key Points
 O A report created in Access 2007 typically summarizes and organizes information. 

When designing a report, consider the point you are trying to make, the intended 

audience, and the level of information they will need.

 O You can create a report from scratch or by using a wizard. After creating a 

report, you can refi ne it in Design view and view the results of your changes in 

Print Preview or Layout view.

 O You can create a main report and link from it to other reports, referred to as 

subreports.

 O You can add controls to reports and set the properties of those controls. You can 

display information from one or more records, tables, or queries, and you can add 

headers and footers specifi c to the report and to each of its pages.

 O You can display summary calculations or statistics in a report and enhance its 

usefulness by basing it on a query and performing calculations within the report. 

You describe calculation processes to Access by using the Expression Builder.
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99 Making Your  Making Your 
 Database  Database 
 Easy to Use Easy to Use

In this chapter, you will learn to:

 � Create a switchboard.

 � Create custom categories.

 � Control the features available to database users.

 � Make favorite Access commands quickly available.

A Microsoft Offi ce Access 2007 database is a complex combination of objects, informa-

tion, and the tools required to manage and manipulate them. In the fi rst eight chapters 

of this book, you learned how to work with these components to enter, organize, retrieve, 

and display information. You can create databases that you, or other people familiar with 

Access, can use.

However, if information will be entered and retrieved from your database by people 

who aren’t profi cient with Access, the information will be safer and the users happier 

if you take some steps to insulate them from the inner workings of Access. You need 

to turn your collection of objects and information into an application that organizes 

related tasks. Then users can focus on the job at hand, rather than on learning to use 

the program the database is running in.

With a little extra effort on your part, you can make it much easier for other people to 

access and manipulate your data, and much more diffi cult to unintentionally change or 

delete it. In previous versions of Access the most common ways to control access to a 

database application were through switchboards and startup options. Access 2007 has 

reduced support for switchboards and substantially changed the available startup options. 

Much of the functionality of switchboards is now available in custom groups, which are 

a new feature in Access 2007. However, the Switchboard Manager is still available for 

creating switchboards in Access 2007, and switchboards created in earlier versions of 

Access should for the most part still function correctly.
  251
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Troubleshooting Some legacy features, such as start-up options and global add-in 

menus, are available only if you open the database as an Access 2003 MDB fi le, rather than 

converting it to the Access 2007 format.

In this chapter, you will learn how to create a simple switchboard, create custom groups, 

add a custom menu to the ribbon, and set various startup options.

See Also Do you need only a quick refresher on the topics in this chapter? See the Quick 
Reference entries on pages xxxix–lxv.

Important Before you can use the practice fi les in this chapter, you need to install them 

from the book’s companion CD to their default location. See “Using the Book’s CD” on page 

xxv for more information.

Troubleshooting Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and you 

experience trouble following the instructions as written, please refer to the “Information for 

Readers Running Windows XP” section at the beginning of this book.

Creating a Switchboard
A  switchboard appears as a hierarchy of pages containing buttons that the user can click 

to open additional pages, display dialog boxes, present forms for viewing and entering 

data, preview and print reports, and initiate other activities. For example, a salesperson 

might use a switchboard to display a form to quickly enter orders or add new customers.

Although switchboards are being phased out, they still work in Access 2007 and are being 

included in this book for people who want to transition gently to the new format. If you 

haven’t created a switchboard in the past, and want this kind of feature, we suggest you 

skip this topic and investigate custom groups.

You  can create switchboards by hand or with the help of Switchboard Manager. A 

switchboard created by hand is made up of multiple forms (pages) of your own design 

that are linked together by macros and Microsoft Visual Basic for Applications (VBA) 

code. A switchboard created with the help of the Switchboard Manager consists of a 

Switchboard Items table and one generic form that serves as a template when the pro-

gram displays your switchboard. You can change the location of buttons and add other 

Troubleshooting Some legacy features, such as start-up options and global add-inSome legacy features, such as start-up options and global add-in

menus, are available only if you open the database as an Access 2003 MDB fi le, rather than menus, are available only if you open the database as an Access 2003 MDB fi le, rather than 

converting it to the Access 2007 format.converting it to the Access 2007 format.

Troubleshooting Graphics and operating system–related instructions in this book refl ect Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and youthe Windows Vista user interface. If your computer is running Microsoft Windows XP and you

experience trouble following the instructions as written, please refer to the “Information forexperience trouble following the instructions as written, please refer to the “Information for

Readers Running Windows XP” section at the beginning of this book.Readers Running Windows XP” section at the beginning of this book.
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visual elements (such as pictures) in Design view. Unlike a switchboard created by hand, 

you can change the number of active buttons and the action that is performed when 

each button is clicked only by editing information in the Switchboard Items table.

Tip You  don’t need to know how switchboards created with Switchboard Manager work to 

use one, but it helps to know what’s going on behind the scenes in case you need to make 

changes. When the switchboard is opened, Access runs VBA code that reads information 

stored in the Switchboard Items table and uses it to set form properties that determine the 

buttons that are visible in the generic form. The code also assigns labels and actions to the 

visible buttons. If you click a button to go to a second level in the switchboard hierarchy, 

the code reads the table again and resets the properties for the generic form to create the 

page for the new level.

In this exercise, you will create a simple switchboard by using Switchboard Manager.

USE the 01_Switchboard database. This practice fi le is located in the Chapter09 subfolder 

under SBS_Access2007.

OPEN the 01_Switchboard database.

 1. On  the Database Tools tab, in the Database Tools group, click the  Switchboard 
Manager button, and then click Yes when asked whether you want to create a 

switchboard.

The Switchboard Manager window lists any pages created by the Switchboard 

Manager. Because this database doesn’t currently have any switchboard pages, 

Access lists a default page to get you started.

 2. With Main Switchboard (Default) selected in the Switchboard Pages list, click Edit.

The Edit Switchboard Page window opens.

USE thethe 01_Switchboard01_Switchboard database. This practice fi le is located in the database. This practice fi le is located in the dd Chapter09Chapter09 subfolder  subfolder 

under under SBS_Access2007SBS_Access2007..7777

OPEN thethe 01_Switchboard01_Switchboard database.database.dd
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3. In   the Switchboard Name box, replace Main Switchboard with SBS Switchboard. 

Then click Close.

4. In the Switchboard Manager window, click New.

The Create New dialog box   opens. 

From this dialog box, you can name new pages as you add them to the 

switchboard.

5. Replace the default new switchboard page name with Forms, and then click OK.

6. Repeat Steps 4 and 5 to create a page named Reports.
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7. With   SBS Switchboard (Default) selected in the Switchboard Pages list, click Edit.

8. In the Edit Switchboard Page window, click New.

The Edit Switchboard Item dialog box   opens. From this dialog box, you can assign 

properties to the buttons on the generic switchboard page.

9. In the Text box, type Forms.

This text will become a button label for the command specifi ed in the Command 

box.

10. Click    the Command arrow to display the list of commands you can choose. Then 

click the original selection, Go to Switchboard.

With the current settings in the Edit Switchboard Item dialog box, when a user clicks 

the Forms button on the SBS Switchboard page, Access will display the switchboard 

page you specify in the Switchboard box.

11. Click the Switchboard arrow, and then in the list, click Forms.

The Switchboard list items refl ect the options for the currently selected command.

12. In the Edit Switchboard Item dialog box, click OK.

13. Repeat Steps 8 through 12, using the following information to create three more 

buttons on the SBS Switchboard page:

Text Command Switchboard or Macro

Reports Go to Switchboard Reports

Close Switchboard Run Macro Switchboard.closeSB

Close Database Exit Application (none)

When a user clicks the Close Switchboard button  on the SBS Switchboard page, 

Access will open the Switchboard macro group, and start running the macro at the 

closeSB line.
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Tip The Switchboard.closeSB macro  does not come with Access; it is a simple 

macro written specifi cally for this exercise. You  can review the macros included 

with the database, by clicking Macros on the Objects bar and then opening the 

macro you want in Design view.

The Edit Switchboard Page window lists the four items you’ve just created.

14. In the Edit Switchboard Page window, click Close to return to Switchboard 

Manager.

15. In the Switchboard Pages list, click Forms, and then click Edit.

16. Repeat Steps 8 through 12, using the following information to create fi ve buttons 

on the Forms switchboard page:

Text Command Form or Switchboard

Edit/Enter Categories Open Form in Edit Mode Categories

Edit/Enter Orders Open Form in Edit Mode Orders

Edit/Enter Products Open Form in Edit Mode Products

Edit/Enter Suppliers Open Form in Edit Mode Suppliers

Return Go to Switchboard SBS Switchboard
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17. Close the Edit Switchboard Page window to return to Switchboard Manager. In the 

Switchboard Pages list, click Reports, and then click Edit.

18. Use the following information to create fi ve buttons on the Reports switchboard 

page:

Text Command Report or Switchboard

Preview/Print Catalog Open Report Catalog

Preview/Print Customer Labels Open Report Customer Labels

Preview/Print Invoices Open Report Invoice

Preview/Print Products Open Report Open Report

Return Go to Switchboard SBS Switchboard

19. Close the Edit Switchboard Page dialog box and Switchboard Manager.

20. On   the Navigation Pane, under Forms, double-click Switchboard. 

Your new switchboard opens in Form view.
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21. On the SBS Switchboard page, click the Forms button, and then on the Forms 
switchboard, click the Edit/Enter Categories button to display the Categories form.

22. Close the Categories form, and then on the Forms switchboard, click the Return 

button to return to the central switchboard.

23. Switch to Design view.

The form, which currently has only one button and its default label text, is 

essentially a template for your switchboard. The Switchboard table created by 

the Switchboard Manager contains the information needed to add the buttons 

and labels.

Each event is associated with a variable in the Switchboard Items table. This 

variable is in turn associated with the command and parameters (if any) you 

specifi ed. When you click a button in Form view, Access refers to the On Click 

property, looks up the variable in the Switchboard Items table, and carries out 

the associated command.

24. Click the button or label, and press $ to open the Properties dialog box. 

25. Click    the Event tab of the Properties dialog box to display the On Click event for 

the buttons and labels.

The event that is fi red when the user clicks a button is in an embedded macro. 

Embedded macros are a new feature in Access 2007. They are stored with a form or 

report, rather than in the Macros group on the Navigation Pane, and offer a higher 

level of security than do normal macros. To view or edit the embedded macros you 

would click the ellipsis (…) button.
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Tip You can reopen Switchboard Manager to add more pages or commands, and 

you can open the Switchboard form in Design view to add graphics or other objects.

Everything needed to produce the working switchboard is contained in the Switchboard 

form and its Switchboard Items table. You can create a similar switchboard by copying or 

importing the form and the table to any other database, and modifying them as needed 

with Switchboard Manager.

CLOSE the Property sheet, save and close the Switchboard form, and then close the 01_
Switchboard database.

Creating Custom Categories
Although  you can use a switchboard to provide users with easy access to selected objects, 

when you’re working in Access 2007 it is a lot easier to do so by using a custom category.

As described in Chapter 1, “Exploring Access 2007,” the large bar at the top of the 

Navigation Pane is a category heading. Each of the smaller bars beneath it is a group 

heading. A number of built-in categories are available, and you can fi lter the groups listed 

under a category in various ways.

You can also create up to ten custom categories, each of which can contain multiple 

custom groups.  You can drag and drop any valid Access object into a custom group to 

create a shortcut to the object; the object itself remains in its original group. This combi-

nation of categories, groups, and object shortcuts can easily replace the most common 

aspects of switchboard pages, items, and commands. For example, if the accounting 

department runs a set of reports on the last day of each month, you could create an 

Accounting category containing a Month End Reports group, and add the reports to that 

group. Or if the Marketing department routinely works with several forms, queries, and 

reports, you could create a Marketing category for them. This category could contain one 

group holding shortcuts to all the objects, or a group for each object type—there are no 

restrictions in the mix of objects placed in one group.

In this exercise, you will create a custom category, and then add groups to it.
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USE the 02_CustomCategory database. This practice fi le is located in the Chapter09 

subfolder under SBS_Access2007.

OPEN the 02_CustomCategory database.

1. At the top of the Navigation Pane, right-click the All Access Objects category, and 

then click Navigation Options.

The Navigation Options dialog box   opens.

2. In  the Grouping Options area, click the  Add Item button.

A new category appears in the Categories list. The category name is selected.

3. Replace Custom Category 1 with SBS Category, and then press F.

The heading above the right pane changes to refl ect the selected category name.

4. Click the  Add Group button, and then in the Groups list, replace Custom Group 1 

with Forms.

Tip Every   category contains a default group named Unassigned Objects. This group 

contains a list of all objects in the database, and is the source for the shortcuts you 

create in your custom groups.

5. Repeat Step 4 to add a group named Reports. Then in the Navigation Options 
dialog box, click OK.

USE the the 02_CustomCategory02_CustomCategory database. This practice fi le is located in the database. This practice fi le is located in the yy Chapter09Chapter09
subfolder under subfolder under SBS_Access2007SBS_Access2007..7777

OPEN the the 02_CustomCategory02_CustomCategory database.database.yy
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Although you can’t see it now, your new category has been added to the 

Navigation Pane.

6. Click  the category header at the top of the Navigation Pane to display a list of 

categories, and then click your new category, SBS Category.

The Forms group that you created for your category appears in the upper section 

of the menu, followed by the Reports group and the Unassigned Objects group.

7. In  the Unassigned Objects group, click the Categories form (not the table—you 

can distinguish between the items by their icons), hold down the H key, and click 

the Orders, Products, and Suppliers forms. Release the H key, scroll the list back 

to the top, and then drag Categories on top of the Forms group header.

Tip The icon to the left of the object name identifi es the object type.

Access moves the shortcuts for the selected forms from Unassigned Objects to the 

Forms group.

8. In the Unassigned Objects group, click the Alphabetical List of Products report, 

hold down the H key, and click the Catalog, Customer Labels and Invoice reports. 

Then right-click any selected object, point to Add to group, and click Reports.

Access moves the shortcuts for the selected reports from Unassigned Objects to 

the Reports group.

Tip You   can leave the Unassigned Objects group visible in the Navigation Pane, 

or you can hide it. To hide it, right-click the Unassigned Objects title bar and then 

click Hide. To restore the group, display the Navigation Options dialog box, click SBS 

Category, select the Unassigned Objects check box, and then click OK.

9. To test the new shortcuts, open each form and report.

CLOSE the 02_CustomCategory database.

There were 25 complex steps in the Switchboard exercise and 9 simple ones in this 

exercise. Not only is creating categories much faster than creating switchboards, you 

can have different categories for different people or purposes, and you can add and 

remove objects easily.
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Controlling the Features Available to Database Users
If   your database will be used by people with little or no experience with Access, you 

might want to control which features are available when a database opens. There are 

several ways to do this. If you want users to be able to open only one database, you 

can add one or more options to the Access desktop shortcut and Start menu link. 

These options can open a specifi c database, run macros, and perform other tasks.  

For more information about the available options, search Microsoft Offi ce Access 

Help for Command-line switches.

A more common way to control the user’s environment is to set startup options in each 

database. You can use startup options to control the menus and Ribbon tabs available 

to the user, the initial form displayed (such as a switchboard), and other features. The 

startup form can include macros and VBA procedures that run automatically to set 

other conditions.

In this exercise, you will set startup options that tie together a switchboard and some 

custom menus to create a version of the database that is appropriate for inexperienced 

users. You will experiment with these options, and then bypass them.

Tip This exercise uses custom menus that were created specially for the sample database. 

For more information about how to create menus such as these, search for AddMenu in the 

Access Help system.

The Orders form in this exercise uses several custom macros. You can review these macros 

by clicking Macros on the Objects bar and then opening orderForm in Design view.

USE the 03_Features database and the 03_Icon icon. These practice fi les are located in the 

Chapter09 subfolder under SBS_Access2007.

OPEN the 03_Features database.

 1. Click the Microsoft Offi ce Button, and in the lower-right corner of the menu, click 

Access Options.

 2. In the left pane of the Access Options window, click Current Database.

Access displays the options for the current database.

USE thethe 03_Features03_Features database and the database and the 03_Icon03_Icon icon. These practice fi les are located in the  icon. These practice fi les are located in the 

Chapter09Chapter09 subfolder under subfolder under SBS_Access2007SBS_Access2007..7777

OPEN thethe 03_Features03_Features database. database.
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3. In   the Application Options area, type Features in the Application Title box, and 

then press the D key.

Access displays the text you entered in the database title bar, in place of the usual 

Microsoft Access title.

4. Click the Browse button to the right of the Application Icon box. In the   Icon 
Browser dialog box, navigate to the Documents\MSP\SBS_Access2007\Chapter09 

folder, and then double-click the 03_Icon icon.

5. Below the Application Icon box, click Use as Form and Report Icon.

The selected icon will appear at the left end of form and report title bars, or on 

their tabs, depending on the navigation properties you have set.

6. Click   the Display Form arrow, and then in the list, click Switchboard.

This switchboard will be displayed each time the database is opened.
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Tip With  the Use Access Special keys check box  selected, the following special key 

combinations are available to database users.

F11 shows and hides the Navigation Pane.

Ctrl+G shows the Immediate window in the Visual Basic Editor.

Alt+F11 switches to the Visual Basic Editor.

Ctrl+Break stops Access from retrieving records from the server.

It is useful to have these options available while developing a database, but you might 

want to disable them before you make the database available to other users.

7. Clear the Display Navigation Pane check box. 

This prevents the Navigation Pane from initially being displayed. If you disable 

the use of Access Special keys, the user won’t be able to display the Navigation 

Pane at all. 

8. In     the Ribbon and Toolbar Options area, clear the Allow Full Menus and Allow 
Default Shortcut Menus check boxes.

By disabling these options, you prevent the user from having access to these tools, 

which helps prevent inappropriate changes to the database. All they will see is the 

Home tab and any Add-In menus you create.
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Tip With the default Shortcut Menu Bar selected in the Ribbon And Toolbar area, the 

standard shortcut menu appears when a user right-clicks a form. You can also create 

a custom shortcut menu and specify it in this window or in the form’s properties, to 

provide just the necessary commands.

9. In the Access Options window, click OK.

Most startup options don’t go into effect until you close and reopen the database. 

The only changes you should see now are the name in the Access window’s title bar 

and the icon in the forms and reports.

10. Close and reopen the 03_Features database.

Access displays the selected startup options: you see the new title bar, the Home 

tab, and the Switchboard. From the fi rst exercise in this chapter you are familiar 

with the process of using the Switchboard to work with forms and reports. You can 

still do this in the current database, but we have also created an Add-In menu and 

attached it to the Switchboard form, so when that form is active, the Add-In menu 

is displayed. 

11. Press  ~.

This Access Special Key displays or hides the Navigation Pane—if you don’t want 

database users to have this ability, you will probably wnt to disable the Access 

Special Keys.

12. On the Add-Ins tab, in the Menu Commands group, click Forms, and then in the 

list, click Edit/Enter Categories.

The form appears on a new document tab. Note that the Add-Ins menu tab has 

disappeared. This menu is visible only while the object to which it is attached is 

active. 

13. Close the Categories form.

Note that the Switchboard is again active, and the Add-Ins menu is again visible.

14. In the Menu Commands group, on the Forms list, click Edit/Enter Orders.

The Orders form is displayed, but this time the Add-Ins menu remains visible. This 

is because it is attached to both the Switchboard form and the Orders form. There 

is no way for you to see how this is done in the current database, as most advanced 

functionality has been disabled by your settings in the Access Options.
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15. Close the 03_Features database.

16. While  holding down the G key, open the 03_Features database. If a safety 

warning appears, continue to hold the G key down while you acknowledge 

the warning.

Holding down the Shift key while you open the database bypasses all the startup 

options, so the database starts the same way it did before you set those options.

Tip The  only way to prevent a user from bypassing your startup options is to write 

and run a VBA procedure that creates the AllowByPassKey property and sets it to 

False. There is no way to set this property through Access. For information about how 

to do this, search for AllowByPassKey in the Visual Basic Editor Help fi le.

17. Open the Orders form in Design view, and then display its Property Sheet pane. 

Click the Other tab, and note the setting for Menu Bar. It should be set to sbMenu.

You attach a menu to a form or report by setting the Menu Bar property to the 

name of a macro. That macro (sbMenu in this case) lists the names of the menus 

to add to the menu Command group on the Add-Ins tab. It also points to other 

macros (TG1 and TG2 in this case) for information about the commands to display 

on each menu and the actions to take when they are clicked.
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You can open sbMenu, TG1, and TG2 in design view to see what they contain. If you 

want to learn more about this, or create your own menus, search for addmenu in the 

Access Help system.

You could create different menus for every form and report in your database, and 

use them in conjunction with custom groups or a switchboard to provide a great 

deal of control over what your users can do in the database.

CLOSE the 03_Features database.

Making Favorite Access Commands 
Quickly Available

The  commands you use to control Access are available from menus and toolbars within 

the program window. The basic command structure hasn’t changed substantially from 

that in previous versions of Access:  Buttons representing common commands are located 

on the Standard and Advanced toolbars, and other commands that you probably use less 

frequently can be found on the File, Edit, View, Go, Tools, Actions, and Help menus. You 

can also invoke many commands by using keyboard shortcuts.

Tip To see a list of the available keyboard shortcuts, click the Microsoft Offi ce Access Help 

button, type keyboard shortcuts in the Search box, and press Enter. Then click the Keyboard 

Shortcuts For Access topic.

As we fi rst discussed in “Introducing Microsoft Offi ce Access 2007” at the beginning 

of this book, big changes have been made to the way commands are presented within 

the Access object windows (tables, forms, reports, and so on).  Buttons representing 

commonly used commands are grouped on tabs to make them easily accessible in 

the specifi c context in which you’re working. This new design makes most of the com-

mands you need at any given time available with only one click. However, you might 

fi nd that the buttons you use most frequently are scattered on different tabs, or that 

certain commands you used in previous versions of Access are not available from the 

Ribbon.  To give you more control over the way you work in the 2007 Microsoft Offi ce 

system, Microsoft has provided the Quick Access Toolbar, the Offi ce equivalent of the 

Quick Launch bar available in Microsoft Windows XP and Windows Vista. The Quick 
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Access Toolbar is located to the right of the Microsoft Offi ce Button in Access object 

windows, as well as in the Microsoft Offi ce Word 2007, Microsoft Offi ce Excel 2007, 

Microsoft Offi ce PowerPoint 2007 program windows, and Microsoft Offi ce Outlook 

2007 item windows. You can add a button for any command to the Quick Access 

Toolbar so that it is always available no matter which tab is currently active.

In this exercise, you will add a button to the Quick Access Toolbar. There are no practice 

fi les for this exercise.

BE SURE TO start Access before beginning this exercise.

OPEN any recent database fi le.

 1. At     the right end of the Quick Access Toolbar, click the Customize Quick Access 
Toolbar button.

The Customize Quick Access Toolbar menu opens, displaying a short list of common 

commands that you can click to add to the toolbar.

 2. Near the bottom of the menu, click More Commands.

The Access Options window  opens, displaying the Customize The Quick Access 

Toolbar page. The commands currently appearing on the Quick Access Toolbar are 

listed (in order of appearance) in the right pane.

BE SURE TO start Access before beginning this exercise.start Access before beginning this exercise.

OPEN any recent database fi le.any recent database fi le.

Customize Quick 
Access Toolbar

Customize Quick 
Access Toolbar
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3. Click the Choose commands from arrow, and then in the list, click Create Tab.

The list displays all the commands available from the Create tab.

Tip You  can display an alphabetical list of all Access commands by clicking All 

Commands in the Choose Commands From list. In some cases, multiple instances 

of a command appear in the list—these correspond to the locations in which 

the command appears within the program. Pointing to a command displays the 

command location in a ScreenTip. Commands that appear on contextual tabs

and commands that don’t appear on any tab are also available from this list.

4. In the Create Tab list, point to the fi rst command, Advanced.

A ScreenTip displays the tab and group where you can locate this command. Point 

to a few other commands to view their ScreenTips and gain a better understanding 

of how commands are grouped and where you can fi nd them.
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 5. In the Create Tab list, click Table. Then between the two command lists, click Add.

Access adds the Table command  to the end of the list of commands available from 

the Quick Access Toolbar.

 6. In   the right pane, click Table, and then click the  Move Up button two times to 

move the selected command to the second position in the list.

 7. At the bottom of the Customize page, click OK.

The Table command button now appears on the Quick Access Toolbar so that you 

can conveniently create a new table from anywhere in Access.

Move UpMove Up
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You   can remove the button from the Quick Access Toolbar by repeating Steps 1 

and 2, selecting the command in the right pane, and then clicking Remove and OK.

Tip You can add any command to the end of the Quick Access Toolbar by right-

clicking the command on the Ribbon, and then clicking Add To Quick Access Toolbar. 

Similarly, you can delete any command from the Quick Access Toolbar by right-clicking 

the command on the toolbar, and clicking Remove From Quick Access Toolbar.

BE SURE TO remove the command from the Quick Access Toolbar if you don’t want to 

keep it there.

Key Points
 O You can create a switchboard and set startup options to make it easier for others 

to access and manipulate your data, and more diffi cult to unintentionally change 

or delete data.

 O You can use custom categories and groups to organize commonly-used forms, 

reports, and other objects for easy access, and to limit access to objects. This 

replaces the basic functionality of the switchboard.

 O You can place any command on the Quick Access Toolbar common to all data-

bases, or on a custom toolbar specifi c to one database.
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  Sharing Information  Sharing Information

In this chapter, you will learn to:

 � Assign a password to a database.

 � Prevent changes to database code.

 � Secure a database for distribution.

The  need for database security is an unfortunate fact of life. As with your house, car, 

offi ce, or briefcase, the level of security required for your database depends on the 

value of what you have and whether you are trying to protect it from curious eyes, 

accidental damage, malicious destruction, or theft.

The security of a company’s business information can be critical to its survival. For 

example, you might not be too concerned if a person gained unauthorized access 

to your products list, but you would be very concerned if a competitor managed to 

see—or worse, steal—your customer list. And it would be a disaster if someone de-

stroyed your critical order information.

Your goal as a database developer is to provide adequate protection without imposing 

unnecessary restrictions on the people who should have access to your database.  The 

type of security required to protect a database depends to a large extent on how many 

people are using it and where it is stored. If your database will never be opened by more 

than one person at a time, you don’t have to worry about the potential for corruption 

caused by several people trying to update the same information at the same time. If your 

database is sold outside of your organization as part of an application, you will want to 

take steps to prevent it from being misused in any way.

Tip In previous versions of Access you could set up workgroups and assign permissions 
to restrict the information available to members of each group and the actions they can 

perform. Access 2007 doesn’t offer this feature.
   273
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Another way to protect a database is by securing the distribution channel; for example, 

by making it available from a password-protected Web site.

In this chapter, you will explore ways to protect data from accidental or intentional 

corruption, and ways to make it diffi cult for unauthorized people to gain access to 

private information. Then you will learn about ways of sharing databases among 

team members and backing up a shared database.

See Also Do you need only a quick refresher on the topics in this chapter? See the Quick 
Reference entries on pages xxxix–lxv.

Important Before you can use the practice fi les in this chapter, you need to install them 

from the book’s companion CD to their default location. See “Using the Book’s CD” on page 

xxv for more information.

Troubleshooting Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and you 

experience trouble following the instructions as written, please refer to the “Information for 

Readers Running Windows XP” section at the beginning of this book.

Assigning a Password to a Database
You  can prevent unauthorized users from opening a database by assigning it a password. 

Access will prompt anyone attempting to open the database to enter the password. The 

database will open only if the correct password is entered.

Creating a Secure Password
You    can use any word or phrase as a password, but to create a secure password, 

keep the following in mind:

 O Passwords are case-sensitive. 

 O You can include letters, accented characters, numbers, spaces, and most 

punctuation. 

A good password includes uppercase letters, lowercase letters, and symbols or 

numbers, and isn’t a word found in a dictionary. For more information about 

strong passwords, visit 

www.microsoft.com/athome/security/privacy/password.mspx

Troubleshooting Graphics and operating system–related instructions in this book refl ect Graphics and operating system–related instructions in this book refl ect 

the Windows Vista user interface. If your computer is running Microsoft Windows XP and youthe Windows Vista user interface. If your computer is running Microsoft Windows XP and you

experience trouble following the instructions as written, please refer to the “Information forexperience trouble following the instructions as written, please refer to the “Information for

Readers Running Windows XP” section at the beginning of this book.Readers Running Windows XP” section at the beginning of this book.

Creating a Secure Password
YouYou can use any word or phrase as a password, but to create a can use any word or phrase as a password, but to create a secure password,,ddd
keep the following in mind:keep the following in mind:

O Passwords are case-sensitive. Passwords are case-sensitive. 

O You can include letters, accented characters, numbers, spaces, and most You can include letters, accented characters, numbers, spaces, and most 

punctuation.punctuation.

A good password includes uppercase letters, lowercase letters, and symbols or A good password includes uppercase letters, lowercase letters, and symbols or 

numbers, and isn’t a word found in a dictionary. For more information aboutnumbers, and isn’t a word found in a dictionary. For more information about

strong passwords, visitstrong passwords, visit

www.microsoft.com/athome/security/privacy/password.mspxwww.microsoft.com/athome/security/privacy/password.mspx



 Assigning a Password to a Database  275
A     secondary benefi t of assigning a password is that your database will automatically 

be encrypted each time you close it, and decrypted when you open it and provide the 

correct password. 

Tip In previous versions of Access, encrypting and decrypting a database was a separate 

function from assigning a password to it. If you open a database created in Access 2002 

or Access 2003 from Access 2007, you will still have the option of encoding or decoding it, 

which is what the process was called in those versions.

It  is easy to assign a database password, and certainly better than providing no protection 

at all, in that it keeps most honest people out of the database. However, many inexpensive 

password recovery utilities are available, theoretically to help people recover a lost pass-

word. Anyone can buy one of these utilities and “recover” the password to your database. 

Also, because the same password works for all users (and nothing prevents one person 

from giving the password to many other people), simple password protection is most 

appropriate for a single-user database.

To   assign a password to or remove a password from a database, you must fi rst open the 

database for exclusive use, meaning that no one else can have the database open. This 

will not be a problem for the database used in the following exercise, but if you want to 

set or remove a password for a real database that is located on a network share, you will 

need to make sure nobody else is using it.

Database Encrypting
A   database created in Microsoft Offi ce Access 2007 is a  binary fi le; if you open it in 

a word processor or a text editor, its content is mostly unreadable. However, if you 

look closely enough at the fi le, you can discover quite a bit of information. It is un-

likely that enough information will be exposed to allow someone to steal anything 

valuable. But if you are concerned that someone might scan your database fi le with a 

utility that looks for key words that will lead them to restricted information, you can 

encrypt the fi le to make it really unreadable.

In previous versions of Access, the process of encoding (encrypting) a database and 

assigning a password were separate. In Access 2007, they have been combined as 

one command.

Encrypting a fi le prevents people who don’t have a copy of Access from being able 

to read and perhaps make sense of the data in your fi le. 

Database Encrypting
AA database created in Microsoft Offi ce Access 2007 is adatabase created in Microsoft Offi ce Access 2007 is a binary fi le;; if you open it in if you open it in 

a word processor or a text editor, its content is mostly unreadable. However, if you a word processor or a text editor, its content is mostly unreadable. However, if you 

look closely enough at the fi le, you can discover quite a bit of information. It is un-look closely enough at the fi le, you can discover quite a bit of information. It is un-

likely that enough information will be exposed to allow someone to steal anything likely that enough information will be exposed to allow someone to steal anything 

valuable. But if you are concerned that someone might scan your database fi le with a valuable. But if you are concerned that someone might scan your database fi le with a 

utility that looks for key words that will lead them to restricted information, you canutility that looks for key words that will lead them to restricted information, you can

encrypt the fi le to make it really unreadable.the fi le to make it really unreadable.t

In previous versions of Access, the process of encoding (encrypting) a database andIn previous versions of Access, the process of encoding (encrypting) a database and

assigning a password were separate. In Access 2007, they have been combined as assigning a password were separate. In Access 2007, they have been combined as 

one command.one command.

Encrypting a fi le prevents people who don’t have a copy of Access from being able Encrypting a fi le prevents people who don’t have a copy of Access from being able 

to read and perhaps make sense of the data in your fi le. to read and perhaps make sense of the data in your fi le. 
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In this exercise, you will assign a password to a database.

USE the 01_Password database. This practice fi le is located in the Chapter10 subfolder 

under SBS_Access2007.

BE SURE TO start Access before beginning this exercise, but don’t open the 01_Password 

database yet.

 1. Click  the Microsoft Offi ce Button, and then on the menu, click Open.

 2. In   the Open dialog box, navigate to the Documents\MSP\SBS_Access2007\
Chapter10 folder, and click (don’t double-click) the 01_Password database. Then 

click the Open arrow, and in the list, click Open Exclusive.

Access opens the database for your exclusive use—no one else can open the 

database until you close it.

 3. On the Database Tools tab, in the Database Tools group, click the  Encrypt with 
Password button.

The Set Database Password dialog box   opens.

 4. In the Password box, type 2007!SbS, and then press the D key.

Access disguises the characters of the password as asterisks as you type them, to 

protect against other people seeing your password.

 5. In the Verify box, type 2007!SbS. Then click OK.

 6. Close and reopen the database.

USE the the 01_Password01_Password database. This practice fi le is located in the database. This practice fi le is located in thedd Chapter10Chapter10 subfolder subfolder 

under under SBS_Access2007SBS_Access2007..7777

BE SURE TO start Access before beginning this exercise, but don’t open thestart Access before beginning this exercise, but don’t open the 01_Password01_Password
database yet.database yet.

Microsoft Offi ce 
Button

Microsoft Offi ce 
Button



 Preventing Changes to Database Code  277
The Password Required dialog box   opens.

 7. In the Enter database password box, type 2007_SBS, and then click OK.

Access warns you that the password is not valid.

 8. In the Microsoft Offi ce Access message box warning you that the password you 

entered is not valid, click OK. 

 9. In the Password Required dialog box, type the correct password (2007!SbS), and 

then click OK.

The database opens.

CLOSE the 01_Password database.

Tip To  remove a password from a database, open the database exclusively, entering 

the password when prompted to do so. On the Database Tools tab, in the Database Tools 

group, click the Decrypt Database button . Enter the password, and then click OK. Access 

removes the password, allowing anyone to open the database.

Preventing Changes to Database Code
If     you have added Microsoft Visual Basic for Applications (VBA) procedures to a database, 

you certainly don’t want users who aren’t qualifi ed or authorized to make changes to your 

code. You can prevent unauthorized access in two ways: by protecting your VBA code with 

a password, or by saving the database as a Microsoft Database Executable (ACCDE) fi le  . If 

you set a password for the code, it remains available for editing by anyone who knows the 

password. If you save the database as an ACCDE fi le, people using the database application 

can run your code, but they can’t view or edit it.

See Also For information about saving a database as an executable fi le, see “Securing a 
Database for Distribution” later in this chapter.
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In this exercise, you will secure the VBA code in a database by assigning a password to it.

USE the 02_Prevent database. This practice fi le is located in the Chapter10 subfolder under 

SBS_Access2007.

BE SURE TO start Access before beginning this exercise.

OPEN the 02_Prevent database.

 1. On the Database Tools tab, in the Macro group, click the Visual Basic button.

The Visual Basic Editor   starts.

 2. On the Tools menu, click base Properties.

The Project Properties dialog box   opens.

 3. On the Protection tab, select the Lock project for viewing check box.

 4. In the Password box, type 2007!VbA, and then press the D key.

USE thethe 02_Prevent02_Prevent database. This practice fi le is located in the database. This practice fi le is located in thett Chapter10Chapter10 subfolder under subfolder under

SBS_Access2007SBS_Access2007..7777

BE SURE TO start Access before beginning this exercise.start Access before beginning this exercise.

OPEN thethe 02_Prevent02_Prevent database. database.tt
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Access disguises the characters of the password as asterisks as you type them, to 

protect against other people seeing your password.

Tip The Lock and Password settings operate independently. Selecting the Lock Project 

For Viewing check box requires the user to enter the password to view the project. If 

a password has been set and the Lock Project For Viewing check box is not selected, 

the user can view the project code but has to enter the password to open the Project 

Properties dialog box.

5. In the Confi rm Password box, type 2007!VbA, and then click OK.

The password is set, but you won’t have to enter it again until the next time you 

open the database and attempt to edit the VBA code.

6. Close the Visual Basic Editor, and then close the database.

7. Reopen the database, and then on the Database Tools tab, in the Macro group, 

click the Visual Basic button (or press J+~).

The Visual Basic Editor opens, displaying only the name of the project, and not the 

Code window.
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8. Click the Expand button to the left of the 02_Prevent database project.

The Password dialog box   opens.

9. In the Password dialog box, type 2007!VbA, and then click OK.

The project expands to display its components.

Tip You need to enter the password only once per database session. In other words, 

you won’t have to enter it again unless you close and reopen the database.

CLOSE the 02_Prevent database.

Tip To    remove the password, on the Visual Basic Editor Tools menu, click Base Properties. 

On the Protection tab, clear the Lock Project For Viewing check box, delete the asterisks 

from the two password boxes, and then click OK.

ExpandExpand
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Securing a Database for Distribution
When a database is used locally, on a local area network (LAN), or on a wide area 

network (WAN), you have considerable control over who has access to it. But if you 

send the database out into the world, on its own or as part of a larger application, you 

lose that control. There is no way you can know who is using the database or what 

tools they might have available to hack into it.     If this is of concern to you, consider 

distributing your database as an Access Database Executable (ACCDE) fi le.

Tip In previous versions of Access this was called a Microsoft Database Executable (MDE) 
fi le. The functionality and creation process are the same. If you open an older (Access 2002 

or Access 2003) MDB fi le in Access 2007, a Make MDE command appears in the Database 

Tools group on the Database Tools tab in place of the Make ACCDE command that appears 

when you’re working in an Access 2007 database. 

Suppose you want to make a database available for use by several organizations in the 

area, but the organizations don’t want their members to be able to change the data-

base objects and perhaps “break” things. Saving a database as an ACCDE fi le compiles 

all modules, removes all editable source code, and compacts the destination database. 

Users of the ACCDE fi le can view forms and reports, update information, and run queries, 

macros, and VBA code. They cannot do the following:

 O View, edit, or create forms, reports, or modules in Design view.

 O Add, delete, or change references to other objects or databases.

 O Modify VBA code.

 O Import or export forms, reports, or modules.

Access can save a database as an ACCDE fi le only if it is in Access 2007 format. Access 

2002 and Access 2003 databases can be saved as MDE fi les.

You can’t convert a database from ACCDE format to the source ACCDB format, so after 

saving a database as an ACCDE fi le, retain the original ACCDB fi le in a safe place. If you 

need to make changes to forms, reports, or VBA code, you will have to make them in the 

original database and then save it as an ACCDE again.

In this exercise, you will secure a database by saving it as a distributable ACCDE fi le. 
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USE the 03_Distribute database. This practice fi le is located in the Chapter10 subfolder 

under SBS_Access2007.

OPEN the 03_Distribute database.

 1. On the Database Tools tab, in the Database Tools group, click the  Make ACCDE 

button.

 2. In the Save As dialog box, navigate to the Documents\MSP\SBS_Access2007\
Chapter10 folder, and then click Save.

The process takes only a moment; no message alerts you when it is completed.

 3. Click the Microsoft Offi ce Button, and then click Open. 

 4. In the Open dialog box, navigate to the Documents\MSP\SBS_Access2007\
Chapter10 folder.

Access has created a database executable fi le named 03_Distribute.accde. The fi le 

icon displays a blue lock over the standard Access icon.

Tip The 03_Distribute.laccdb fi le indicates that your database is locked, because it is 

currently open. When you close the database, the .laccdb fi le will disappear.

 5. Double-click the 03_Distribute database executable fi le, and if the Microsoft Offi ce 
Access Security Notice message box appears, click Open.

USE the the 03_Distribute03_Distribute database. This practice fi le is located in the database. This practice fi le is located in the Chapter10Chapter10 subfolder  subfolder 

under under SBS_Access2007SBS_Access2007..7777

OPEN the the 03_Distribute03_Distribute database. database.

Microsoft Offi ce 
Button

Microsoft Offi ce 
Button
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6. In the Navigation Pane, right-click one object of each type (table, query, and so on), 

and note whether the Design View button on the shortcut menu is active.

The Design View button is available for tables, queries, and macros, but unavailable 

for all other object types. This prevents you or another user from making any design 

changes to forms or reports, or changing any VBA code associated with the database. 

CLOSE the 03_Distribute database.

Important When creating an ACCDE fi le from a database with multiple users, fi rst make 

sure that all other users close the database. You will know that someone else has the database 

open if you locate it in Windows Explorer and see a fi le of the same name, with an .laccdb 

(locked Access database) extension. If you open the database anyway, when you attempt to 

create the accde fi le you will be warned that the database is already opened by someone else 

(the username and machine name are provided) and told to try again later.

Collaborating Through SharePoint
If your organization has a Microsoft Offi ce SharePoint Server 2007 collaboration 

site, you can manage data collection and distribution through that site, by making 

your Access database available online, in one of these ways:

O Migrate a database to a collaboration site. The Move To SharePoint Site 

wizard creates SharePoint lists linked to your database. The linked data can 

be accessed and managed from the collaboration site or from Access.

O Publish a database to a collaboration site. You can publish your database to 

a SharePoint library, and provide forms, queries, and reports through which 

other people can update or extract information.

After you make the database available to collaboration site users, they can work 

with the information as they would with any other SharePoint list content—online 

or offl ine—but they can also view the content as it would appear in Access, without 

fi rst starting the program.

One benefi t of sharing a database in this way is that permissions are regulated by 

SharePoint rather than set for the individual database. Another is that you can track 

changes made to the data by site users and recover previous versions of informa-

tion, thus safeguarding against lost data in a way that you can’t with Access alone.

Conversely, you can create a database from existing SharePoint lists, and 

integrate workfl ow processes with a database.

Collaborating Through SharePoint
If your organization has a Microsoft Offi ce SharePoint Server 2007 collaborationIf your organization has a Microsoft Offi ce SharePoint Server 2007 collaboration

site, you can manage data collection and distribution through that site, by makingsite, you can manage data collection and distribution through that site, by making

your Access database available online, in one of these ways:your Access database available online, in one of these ways:

O Migrate a database to a collaboration site. The Move To SharePoint Site Migrate a database to a collaboration site. The Move To SharePoint Site 

wizard creates SharePoint lists linked to your database. The linked data can wizard creates SharePoint lists linked to your database. The linked data can 

be accessed and managed from the collaboration site or from Access.be accessed and managed from the collaboration site or from Access.

O Publish a database to a collaboration site. You can publish your database toPublish a database to a collaboration site. You can publish your database to

a SharePoint library, and provide forms, queries, and reports through whicha SharePoint library, and provide forms, queries, and reports through which

other people can update or extract information.other people can update or extract information.

After you make the database available to collaboration site users, they can workAfter you make the database available to collaboration site users, they can work

with the information as they would with any other SharePoint list content—online with the information as they would with any other SharePoint list content—online 

or offl ine—but they can also view the content as it would appear in Access, withoutor offl ine—but they can also view the content as it would appear in Access, without

fi rst starting the program.fi rst starting the program.

One benefi t of sharing a database in this way is that permissions are regulated byOne benefi t of sharing a database in this way is that permissions are regulated by

SharePoint rather than set for the individual database. Another is that you can track SharePoint rather than set for the individual database. Another is that you can track 

changes made to the data by site users and recover previous versions of informa-changes made to the data by site users and recover previous versions of informa-

tion, thus safeguarding against lost data in a way that you can’t with Access alone.tion, thus safeguarding against lost data in a way that you can’t with Access alone.

Conversely, you can create a database from existing SharePoint lists, and Conversely, you can create a database from existing SharePoint lists, and 

integrate workfl ow processes with a database.integrate workfl ow processes with a database.
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Key Points
 O Your goal as a database developer is to adequately protect your database and the 

information it contains, without imposing unnecessary restrictions on the people 

who use it. The type of security required to protect a database depends on how 

many people are using it and where it is stored.

 O You can encrypt a database, which does not prevent it from being opened and 

viewed in Access, but does keep people who don’t have a copy of Access from 

reading or making sense of the data.

 O You can assign a password to your database to prevent unauthorized users from 

opening it. The database is automatically encrypted when you assign it a password.

 O If your database contains VBA procedures, you can protect your VBA code 

by assigning it a password, or by saving the database as an Access Database 

Executable (ACCDE) fi le. If you set a password for the code, it remains available 

for editing by anyone who knows the password. If you save the database as an 

ACCDE fi le, people using the fi le can run your code, but they can’t view or edit it.

 O Other members of your organization can input and extract data through a 

SharePoint collaboration site. By making database information available 

through SharePoint, you can regulate permissions, track changes, and manage 

versioning in ways that you can’t within Access.
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Access Database Executable (ACCDE) A  com-

piled version of a database. Saving a database 

as an ACCDE fi le compiles all modules, removes 

all editable source code, and compacts the 

destination database.

action query A  type of query that quickly updates 

information or deletes selected records from a 

table. See also crosstab query, select query, and 

parameter query.

aggregate function A  function, such as Sum, 

Avg, or Count, that groups fi elds and performs 

calculations on the fi eld values.

append query A query  that adds, or appends, 

records from one or more tables to the end of 

one or more tables.

arithmetic operator An  operator that is used 

with numerals: + (addition), - (subtraction), * 

(multiplication), or / (division).

binary fi le A  fi le composed of data that appears 

as gibberish in a word processing application 

and can be read only by a computer.

bound Linked,  as when a text box is linked to a 

specifi c fi eld in a table. See also unbound.

combo box A  control that displays a list of choices 

when you click the arrow on its right side. It 

might also allow you to enter a different choice 

from those available on the list.

comma-delimited text fi le A  text fi le in which 

each fi eld is separated from the next by a 

comma.

command button A  control that appears as a 

button, which performs an action when clicked. 

comparison operator An  operator that com-

pares values: < (less than), > (greater than), 

and = (equal to). These operators can also be 

combined, as in <= (less than or equal to), >= 

(greater than or equal to), and <> (not equal to).

constant A  part of an expression that represents 

a constant value.

control An  object such as a label, text box, option 

button, or check box in a form or report that 

either displays information to people or allows 

people to enter information.

control property A  setting, accessible through 

the Properties dialog box, that determines a 

control’s appearance, and what kind of data it 

can display. 

control source The Access object, such as a fi eld, 

table, or query, to which  a control is bound. 

See also record source.

crosstab query A  query that calculates a sum, 

average, count, or other type of total for data 

that is grouped by two types of information. 

See also action query, parameter query, and 

select query.

custom group A user-created  group containing a 

combination of categories, groups, and object 

shortcuts.

database application A  database that is made 

easier to use by the inclusion of queries, forms, 

reports, a switchboard, custom categories and 

groups, and various other tools.
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database program An  application for creating 

databases, ranging from simple programs 

that can store one table per fi le (referred to 

as fl at databases) to more complex programs 

that can store information in multiple related 

tables (referred to as relational databases).

database security Protecting  data from acci-

dental or intentional corruption, and making 

it diffi cult for unauthorized people to gain 

access to private information, through the use 

of passwords, encryption, ACCDE fi les, and 

other security measures.

database window The  window in which all 

database objects are displayed.

Datasheet view The  view in which you can see 

and modify information in a table or query. 

Along with Design view, one of the two most 

common views for tables. See also view.

delete query A  query that deletes records that 

match a specifi ed pattern from one or more 

tables. 

delimited text fi le A  text fi le in which each 

record and each fi eld is separated from the 

next by a comma or other special character 

called a delimiter.

delimiter A character,  such as a comma (,), 

semicolon (;), or backslash (\), that is used 

to separate records and fi elds in a delimited 

text fi le.

deselect Clicking  away from selected data or 

controls to release the selection.

design grid In  Design view, the grid in which 

you can manually work with advanced fi lters 

and queries.

Design view The  view in which you can see 

and modify the structure of a table or query. 

Along with Datasheet view, one of the two 

most common views for tables. See also view.

Dialog Box Launcher A  button that launches 

a dialog box containing options for refi ning a 

command.

digital signature A  security mechanism used on 

the Internet that relies on two keys, one public 

and one private, which are used to encrypt 

messages before transmission and to decrypt 

them on receipt.

docking Dragging  a toolbar, task pane, or similar 

item so it connects to one edge of the program 

window.

duplicate query A  type of select query that fi nds 

records containing identical information in one 

or more specifi ed fi elds.

empty string An  Access fi eld that has two 

quotation marks with nothing in between. 

Access is able to differentiate between an 

empty string and a Null (blank) fi eld.

encrypting “Scrambling”  data and applying a 

password for security reasons.

event An  action, including Click, Double Click, 

Mouse Down, Mouse Move, and Mouse Up, 

to which code can be attached. The events 

recognized by an object are listed on the 

Event tab in the object’s Property Sheet pane.

exclusive use A setting  that permits only one 

person to have a database open, generally 

used when setting or removing a database 

password.

exporting The process  of converting an Access 

table or database into a format that can be 

used by other programs. See also importing.

expression A combination  of functions, fi eld 

values, constants, and operators that can be 

used to assign properties to tables or forms, 

to determine values in fi elds or reports, as 

a part of a query, and in many other places. 

Also known as a formula.
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Expression Builder A tool with which you can 

quickly create expressions (formulas) in queries, 

forms, and reports.  

Extensible Markup Language (XML) Plain 

text  fi les that indicate formatting within 

tags, similar to HTML tags, that specify the 

structure of the elements in a document.

fi eld A  specifi c category of information. 

Represented in Access as a column in a 

database table. See also record.

fi eld property A property that controls what 

can be put into a fi eld and how it can be 

placed there.

fi ltering A way  to organize information so that 

some combination of characters is displayed or 

excluded from the display.

fi ring event The  phrase used to describe when 

objects signal events in a form.

fi xed-width text fi le A  common text fi le format 

that is often used to transfer data from older 

applications. The same fi eld in every record 

contains the same number of characters. If the 

actual data doesn’t fi ll a fi eld, the fi eld is pad-

ded with spaces so that the starting point of 

the data in the next fi eld is the same number of 

characters from the beginning of every record.

fl at database A simple  database program that 

can store information in only one table. See 

also relational database.

form   An organized and formatted view of some 

or all of the fi elds from one or more tables 

or queries. Forms work interactively with the 

tables in a database.

function A named  procedure or routine in a 

program, often used for mathematical or 

fi nancial calculations.

group One of  four elements—the other three 

being object, permission, and user—on which 

the Access user-level security model is based.

groups An  organization of buttons on a tab.

grouping level The  level by which records are 

grouped in a report. When you group on a 

fi eld, the report will add a group header and 

and footer around each group of records that 

have the same value in that fi eld.

HTML See Hypertext Markup Language.

HTML tag An HTML  command that determines 

the display of tagged information in Web 

documents. 

Hypertext Markup Language (HTML) An 

authoring language with which you mark 

up documents with tags for publication to 

the Web.

importing The process  of converting outside 

data into a format that can be used by Access. 

See also exporting.

intranet A  local network used for sharing data 

exclusively within a company or group.

label control A  form control containing text as it 

will appear on the form.

LAN See local area network (LAN).

linking The  process of connecting to data in 

other applications so that you can view and 

edit it in both programs.

local area network (LAN) A  network of 

computers, printers, and other hardware 

that covers a small area, such as a home or 

an offi ce.

Lookup wizard An  Access wizard with which you 

can easily create a lookup list.

macro A simple  program that can perform 

multiple actions. A macro can respond to 

events such as opening forms, updating 

records, and clicking buttons. 

main form A  form that contains other embedded 

forms. See also subform.
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main report  A simple report that serves as a 

shell for one or more subreports, but displays 

little or no information from the underlying 

tables. See also subreport.

make-table query A  query that combines all or 

part of the data from one or more tables into a 

new table.

many-to-many relationship Two  one-to-many 

relationships tied together through a third 

table. See also one-to-many relationship; 

one-to-one relationship.

mapped network drive A network  drive to 

which you have assigned a drive letter so that 

it can be accessed as a hard drive on your local 

computer. See also universal naming convention 
(UNC) path.

mask A  property that controls the appearance, 

format, and type of data in a fi eld.

Microsoft Database Executable (MDE) See 

Access Database Executable (ACCDE).

Microsoft Offi ce Button A  button that gives 

access to a menu with commands that manage 

Word and Word documents as a whole (rather 

than document content).

module A  Microsoft Visual Basic for Applications 

(VBA) program.

named range A  group of cells in an Excel spread-

sheet that you can import into an Access table.

object One of the  components of an Access 

database, such as a table, query, form, report, 

page, macro, or module.

one-to-many relationship A relationship  in 

which each record in one table is linked to 

multiple records in another table. See also 

many-to-many relationship; one-to-one 
relationship.

one-to-one relationship A relationship  in which 

each record in one table has one and only 

one associated record in the other table. See 

also many-to-many relationship; one-to-many 
relationship.

operator See arithmetic operator; comparison 
operator.

option button A form control  with which users 

can choose preselected settings.

parameter query A  query that prompts for the 

information to be used in the query, such as 

a range of dates. This type of query is useful 

when used as the basis for a report that is run 

periodically. See also action query, crosstab 
query, and select query.

parsing The  process of analyzing an imported 

document, such as an HTML document, and 

identifying anything that looks like structured 

data.

password An  access code needed to open a 

secured database.

permission An  attribute that specifi es how a user 

can access data or objects in a database.

populate To  add data to a table or other object.

property A  setting applied to an object that can 

determine its content, such as the Required 

and Input Mask properties, and appearance, 

such as the Font and Alignment properties. 

publisher The  person or entity who digitally signs 

a database or other fi le, thereby guaranteeing 

its source.

query A  database object that locates specifi c 

information stored in a table and allows you 

to view and manipulate the results. The results 

of a query can be used as the basis for forms, 

reports, and data access pages.
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Quick Access Toolbar A  toolbar that displays 

the Save, Undo, Repeat, and Print buttons by 

default, but can be customized to show other 

commands.

record All  the items of information (fi elds) in a 

table that are related to one particular entity, 

such as a customer, employee, or project. 

Represented in Access as a row in a database 

table. See also fi eld.

record selector The  gray bar along the left 

edge of a table or form. You can select an 

entire record by clicking the record selector 

next to it.

record source The  source from which the data 

in a bound record originates. See also control 
source.

relational database A  complex type of data-

base in which data is stored in multiple related 

tables, allowing the tables to be treated as a 

single storage area. See also fl at database.

relationship An  association between common 

fi elds in two or more tables.

report A  database object used to display table 

information in a formatted, easily accessible 

manner, either on the screen or on paper. It 

can include items from multiple tables and 

queries, values calculated from information in 

the database, and formatting elements such as 

headers, footers, titles, and headings.

result In  an Access formula, the result equals the 

outcome of the equation.

Ribbon A  group of tabs that appears across 

the top of the program window, replacing 

the layers of menus and toolbars in earlier 

versions of Access.

schema The  structure of an XML fi le, contained 

in an .xsd fi le. 

ScreenTip A small  pop-up window containing 

information that appears when you hover the 

pointer over a command or control.

secure password A password  that includes 

uppercase letters, lowercase letters, and 

symbols or numbers, and is not a word found 

in a dictionary. Also called a strong password.

security warning A warning that appears when 

a database that contains one or more macros 

is opened.

select query A  query that retrieves, or selects, 

data matching specifi ed criteria from one or 

more tables and displays the results in a data-

sheet. See also action query, crosstab query, 

and parameter query.

selector A  small box attached to an object 

that you click to select the object, and drag 

to resize it.

signing The  act of guaranteeing the source 

and content of a fi le by attaching a digital 

signature.

sorting Arranging  information so that it’s based 

on any fi eld or combination of fi elds.

startup options Features  available to users when 

a database is opened.

subdatasheet A  datasheet that is contained 

within another datasheet.

subform A  form contained within another form. 

See also main form.

subreport A  report contained within another 

report. See also main report.

switchboard A  hierarchy of pages containing 

buttons that the user can click to open ad-

ditional pages, display dialog boxes, present 

forms for viewing and entering data, preview 

and print reports, and initiate other activities.
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syntax The required  format in which expressions 

must be entered.

tab An  area on the Ribbon that contains 

commands organized in groups, which are 

related to working with document content.

tabbed documents The  default display of objects 

in an Access window, in which the objects are 

displayed on tabbed datasheets, one behind 

the other.

table Information  arranged in columns (records) 

and rows (fi elds).

tags Codes  in HTML or XML that give instructions 

for formatting or defi ning the structure of a 

document, or other actions.

template A  ready-made database application 

or table that users can adapt to meet their 

personal requirements.

text box control A  control on a form or report 

in which text can be entered or edited.

title bar An  area at the top of a document that 

displays the name of the active database 

object and contains the Maximize, Minimize/

Restore Down, and Close buttons.

transaction record A  record of transactions.

transform A  type of template used to convert 

XML data to other formats.

unbound A  control that is not linked to a fi eld, as 

when it is being used to calculate values from 

multiple fi elds. See also bound.

undocking Dragging  a toolbar, task pane, or 

similar item so it fl oats in the program window.

universal naming convention (UNC) path 
A  path format that includes the computer 

name, drive letter, and nested folder names. 

It is the preferred format for linking to local 

area network (LAN) fi les. See also mapped 
network drive.

unmatched query A  select query that locates 

records in one table without any related 

records in another table.

update query A  select query that performs an 

action on the query’s results in some way, such 

as by changing a fi eld.

validation rule A  fi eld property that ensures 

entries contain only the correct types of 

information.

view The  display of information from a specifi c 

perspective. Each Access object has two or 

more views, such as Datasheet view and 

Design view.

wildcard character A  placeholder, such as an 

asterisk (*) or question mark (?) representing 

an unknown character or characters in search 

criteria.

workgroup A  group of users in a multiuser 

environment who share data and the same 

workgroup information fi le. When you install 

Access, the setup program creates a default 

workgroup and sets up two groups, Admins 

and Users, within that workgroup.

worksheet A  page in a Microsoft Offi ce Excel 

spreadsheet, which can be imported into an 

Access table.

XML See Extensible Markup Language (XML).



Index

A
.accdb fi le extension, 9, 40
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Help button, xxxiii–xxxiv
integration with other Offi ce programs, 10
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Access button (Import group), 55
Access Database Executable (ACCDE) fi les
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distributing databases as, 281
saving databases as, lxv

Access objects
defi ned, 124, 288
displaying all instances of, 14
events recognized by, 124
export formats available for, viewing, 80
exporting, 79
importing (see importing)
forms. See forms; AutoForms
macros. See macros
modules. See modules
queries. See queries; action queries; append 

queries; crosstab queries; delete queries; 
make-table queries; select queries; update 
queries

reports (see reports)
shortcuts, creating with custom groups (see 

custom groups)
tables (see tables)
uses for, 9
views (see views)

Access Options window, 269
action queries. See also append queries; crosstab 

queries; delete queries; make-table queries; 
select queries; update queries; queries

converting select queries to, 204
creating, lvii, 204
defi ned, 179, 285
types of, 161

actions
basic, 124
defi ned, 286
for objects, displaying list of, 125

Add Existing Fields button, 234
Add Group button, 260
add-ins for exporting to PDF/XPS fi les, 89
Add Item button, 260
address books (Outlook), importing from, 74
Advanced Filter Options button, 154, 157
Advanced Filter/Sort command, liv
aggregate functions, 174, 285
Align Left button, 230
Align Text Left button, 230
aligning

form controls, l, 113
report columns, lix
report text, lix, 230

Allow Zero Length fi eld property, 180
Analyze Table wizard, 211
analyzing performance, 211, 213
And operator, 152
append queries, 161, 285. See also action queries; 

crosstab queries; delete queries; make-table 
queries; queries; select queries; update queries

applications, database
defi ned, 285
macros in, 40
specialized commands in, 40
templates for (see templates)
when appropriate, 37

Apply Filter button, liv
arithmetic operators, 285

+ (add), 152
& (concatenate), 152
/ (divide), 152
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292  arrows, button
arithmetic operators (continued)
* (multiply), 152
- (subtract), 152

arrows, button, 3
AutoFormat dialog box, 117
AutoFormat gallery, 117
AutoFormats

creating, li
creating from forms, 118
form, 117

AutoForms, 129
automated functions. See macros
AutoNumber data type

defi ned, 45
Long Integer setting for, 184

autonumber fi elds, lv
Avg function, 174–75

B
backing up databases, lvii, 210–11
backward compatibility, 57
BE SURE TO paragraphs, xxiv
binary fi les, 275, 285
blank databases, 42
blank fi elds, 180
Boolean data type

defi ned, 181, 208
formatting display of, 184
toggling between yes and no, 183

bound controls, 285
Browse For A Location button, 42
Build button, 170
built-in functions, 167
buttons, general, 267

arrows on, 3
gray, 6
inactive, 6
margin icons for, xxiv
name bar, 3, 290
option, 288
ScreenTips, displaying, xxxiii
size and shape of, 6
switchboard, lxii

buttons, Quick Access Toolbar
adding, 268
moving, 270
removing, 271

buttons, specifi c
Access (Import group), 55
Add Existing Fields, 234
Add Group, 260
Add Item, 260
Advanced Filter Options, 154, 157
Align Left, 230
Align Text Left, 230
Apply Filter, liv
Browse For A Location, 42
Build, 170
Center, 238
Close, 3, 33
Close Print Preview, 248
Close Switchboard, 255
Combo Box, 122
Control Wizards, 134
Copy, 99
Create E-mail, 64
Database Documenter, 214
Datasheet View, 182
Date & Time, 230, 237
Delete, 208
Descending, 146–47
Design View, 44, 185, 229
Encrypt With Password, 276
Excel (Import group), 58
Export To Excel Spreadsheet, 83
Export To RTF File, 88
Export To Text File, 90
Export To Word, 88
Filter By Form, 155
First Record, 139
Form, 129
Form View, 34
Format Painter, 122
Group & Sort, 231–32
Image, 120
Insert Page Number, 239
Label, 121, 238
Landscape, 32
Line, 232
Make ACCDE, 282
Microsoft Offi ce, 2, 5, 11, 32, 57, 288
Microsoft Offi ce Access Help, xxxiii–xxxiv
Minimize, 3
More, 72, 93
More Forms, 132
Move All, 132, 171
Move Up, 270
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Multiply, 168
New Record, 128
Next Record, 18, 139
Paste, 99–100
Print, 33
Property Update Options, 190
Query Design, 163, 175, 206
Query Wizard, 203
Remove Database Password And 

Encryption, 277
Report Design, 234
Report Wizard, 222
Restore Down/Maximize, 3
Run, 22, 165, 174, 176, 204–05, 209
Save, 48, 182, 236
Selection, 149
SharePoint List, 62, 85
Show Table, 164
Show Table Of Contents, xxxv
Shutter Bar Open/Close, 14
Subform/Subreport, 134, 241
Summary Options, 225
Switchboard Manager, 253
Text Box, 244
Text File, 66

bytes, restricting number fi elds to, 185

C
calculating with queries, 174
calculations

comparison operators, 152
creating, 166, 170, 191–92
defi ned, 286
functions, entering, 167
logical operators in, 152
multiplying, 168
re-labeling, 169

captions in form controls, 112
categories, custom, 259

creating, lxii, 260
default groups in, 260
groups in (see custom groups)
shortcuts, adding, lxii
plus signs next to (see subdatasheets)

CD companion to book
how to use, xxiii
practice fi les on, xxv
resources available on, xxvii

Center button, 238
centering report text, 238
chapter thumb tabs, how to use, xxiii
Choose Builder dialog box, 126
Close button, 3, 33
CLOSE paragraphs, xxiv
Close Print Preview button, 248
Close Switchboard button, 255
closing

Access, 14
databases, xl
document windows, xl
Print Preview, xli, 33, 248
tables, xlii

code, protecting, 277
coding with VBA, 128
collapsing subdatasheets, 17
Collect Data Through E-mail Messages wizard, 64
collecting data through e-mail, 64
Color gallery, 111
colors, 111
columns, table

adding, 48
data types, changing, 46
defi ned, 10
freezing in place, xliii, 51
hiding, xliii, 50
locking into position, 51
moving, liii
names, editing, 47
names, spaces in, 45
as primary keys, 45
renaming, 44
resizing, xliii, 17, 48, 197
restoring after hiding, 50
selecting adjacent, 50
setting width to widest entry, 17
size, setting, 46
sorting together, 147
unhiding, 50
unique identifi ers, 45

Combo Box button, 122
combo boxes, 195

adding to forms, li
defi ned, 285
inserting, 122

comma-delimited text fi les
defi ned, 285
importing, 66
importing from, xlv
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command buttons
defi ned, 285
in switchboards, inserting, 255
in switchboards, On Click property for, 258

command lists, 3
commands

accessing via the Quick Access Toolbar (see 
Quick Access Toolbar)

defi ned, 267
displaying list of, 269

commands, Quick Access Toolbar
adding, 268
moving, 270
removing, 271

Compact And Repair Database utility, 211–12
compacting databases, lvii
companion CD

how to use, xxiii
practice fi les on, xxv
resources available on, xxvii

comparison operators, 285
= (equal to), 152
> (greater than), 152
>= (greater than or equal to), 152
< (less than), 152
<= (less than or equal to), 152
Like, 152
<> (not equal to), 152

connection speed required for Offi ce 2007, xxix
constants, 152, 285
contacts (Outlook), importing, 75
control captions

adding, li
defi ned, 112
editing, l

control labels, 24
changing, l
deleting, l
inserting, 121
selecting, l
sizing, l

control menu, 4
control properties

defi ned, 108, 152, 285
displaying, 109
editing, xlix
setting, l, 244

control source, 108, 285
Control Wizards button, 134

controls
aligning, l, 113
background properties, l
background style, 111
color, 111
combo boxes (see combo boxes)
defi ned, 23, 103, 285, 287
deleting, 113
deselecting, 112
font, 109
formatting, xlix, lii
formatting of, copying, 122
graphics, adding, li
label, 24, 103, 121
layout, changing, l
Logo, 120
margins, 114
modifying simultaneously, 233
moving, xlix, li
positioning precisely, 117
Property sheet, opening, 121
record selector, deleting, lii
scroll bars, deleting, lii
selecting, 110
selecting all, 111
selecting multiple, 111
shadow effect, 112
Size Mode property, 121
sizing, li
sizing to fi t, 113, 121
space between, inserting, l
standard, 23
text box, 24, 103, 290
theme, 118
types of, 119
unbound, 122, 290
unbound, inserting, 244
undeleting, 243
wizards, adding without, 122

Convert Database Into dialog box, 57
converting databases from previous 

versions, 57
Copy button, 99
copying

data, to other programs, 97
formatting, 122
records, 98
SharePoint lists, 60
tables, 202
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Count function, 174, 175
Create E-mail button, 64
Create New dialog box, 254
Create tab, 7
cropping in forms, avoiding, 121
crosstab queries, 160, 285. See also action 

queries; append queries; delete queries; 
make-table queries; queries; select queries; 
update queries

Currency data type, 183
custom categories, 259

creating, lxii, 260
default groups in, 260
groups in (see custom groups)
plus signs next to (see subdatasheets)
shortcuts, adding, lxii

Custom Filter dialog box, 150
custom groups

default, 260
defi ned, 259, 285
hiding, 261
shortcuts to objects, adding, 261
viewing, 261

custom menus, 264
custom toolbars, 264
Customize AutoFormat dialog box, 117
customizing

forms, 131
Quick Access Toolbar, 268

D
data

entering in tables, 44
entering via list (see lookup lists)
exporting (see exporting)
importing (see importing)
reorganizing, 48

data access pages, 30
data formatting in fi elds. See masks
data source, 122. See also forms
data types, 180

AutoNumber, 45, 184
Boolean, 208 (see Yes/No data type)
changing, 46, 181
Currency, 183
Date/Time, setting, 183
fi eld size, restricting, 184

for number fi elds, changing, 185
Number, setting, 181
setting, liv
Text, as default, 181
Yes/No (see Yes/No data type)
for ZIP codes, 46

database applications
defi ned, 285
macros in, 40
specialized commands in, 40
templates for (see templates)
when appropriate, 37

Database Documenter button, 214
Database Documenter utility, 211
database objects. See also specifi c object types

defi ned, 124, 288
displaying all instances of, 14
events recognized by, 124
export formats available for, viewing, 80
exporting, 79
importing (see importing)
shortcuts, creating with custom groups (see 

custom groups)
uses for, 9
views (see views)

database programs, 286. See also databases
database properties, 42, 180
Database Properties dialog box, 212
database security, 273. See also passwords

defi ned, 286
designing, 273
warnings, 12

Database Tools tab, 8
database window, 14

defi ned, 286
key combination for displaying, 265
tabs in, 4

databases
as Access Database Executable (ACCDE) 

fi les, 281
applications as (see database applications)
backing up, lvii, 210–11
blank, 42
closing, xl
code, protecting, 277
compacting, lvii, 211–12
complexity of, 9
controlling features available in, 262
creating, from templates, 40
creating, manually, 41–42
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databases (continued)
default folder, 41
documenting, lvii, 214
earlier versions, migrating, xliv
elements in (see database objects)
encoding/decoding, 275
encrypting, 275
entering data in, xlii
fi le extensions, 40
folder for storing, 41
formatting, xxxix
forms (see forms)
importing, 55
importing information to (see importing)
linking data in, 60
locking, 277
migrating from previous versions, 57
multiple, opening, 82
naming, 40
navigation pages (see forms)
non-Access, importing from, 76
objects (see database objects)
opening, xl, xlii, 13
opening for exclusive use, 275–76
opening multiple, 82
overview of, 10
password-protecting (see passwords)
performance, analyzing, lvii
populating, 37
restricting availability in, 262
saving, 42
saving as ACCDE fi les, lxv
saving in previous formats, 57
startup options (see startup options)
structure, creating with templates, 38 (see also 

templates)
tables (see tables)
templates for (see templates)
title, changing, 263
Trusted Locations list, adding to, xxxix
user-created dialog boxes in (see forms)

Datasheet view
defi ned, 286
layout of, 15
moving directly to row in, 18
opening tables in, 15, 48
running queries in, 22

Datasheet View button, 182
datasheets

columns (see columns, table)

displaying, in Print Preview, 32
embedding in other tables (see subdatasheets)
navigating, xli

Date & Time button, 230, 237
date and time

default year, 183
in reports, inserting, lviii, 230, 237
regional settings, changing, 183

Date And Time dialog box, 230, 237
Date/Time data type, 183
date fi lters, 151
dBASE fi les

importing to, 76
importing from, xlvi

decoding databases, 275
Default Database Path dialog box, 41
default template location, 39
Delete button, 208
delete queries, 161. See also action queries; 

append queries; crosstab queries; 
make-table queries; queries; select 
queries; update queries

converting select queries into, 208
creating, lvii, 206
defi ned, 286
preventing accidental use of, 210
relationships and, 209
testing, 208

deleting
adjacent records, 47
form control labels, l
form controls, 113
form layouts, 112
primary keys, 45
with queries (see delete queries)
Quick Access Toolbar commands, lxiii
record selector control, from forms, lii
records, precautions for, 206
scroll bar controls from forms, lii
table rows, xlii, 47
text boxes, from reports, lix

delimited text fi les, 65
defi ned, 286
exporting data as, 92
importing, 66

delimiters, 286
Descending button, 146–47
deselecting

defi ned, 286
form controls, 112
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design grid
columns, widening, 169
connecting lines in, 162
defi ned, 286
fi elds, adding, liv, 164
fi elds, copying all to, 165
fi elds, hiding in results datasheet, 162
fi ltering with, 156
related tables in, 162

Design view
displaying queries in, 22
forms, opening in, xli, 108
layout of, 45
opening tables in, 15
switching to, 44

Design View button, 44, 185, 229
dialog boxes

AutoFormat, 117
Choose Builder, 126
Convert Database Into, 57
Create New, 254
creating, in databases (see forms)
Custom Filter, 150
Customize AutoFormat, 117
Database Properties, 212
Date And Time, 230, 237
Default Database Path, 41
Documenter, 214
Edit List Items, 197
Edit Switchboard Item, 255
Encode As, 91
Export, 81
Export XML, 94
Expression Builder, 166
File Open, 55, 58, 66, 72, 76
Grouping Intervals, 224
help for, accessing, xxxiv
HTML Output Options, 96
Icon Browser, 263
Import Objects, 56
Import Specifi cation, 67
Import XML, 70
Navigation Options, 260
New Query, 170
New Style Name, 118
Page Numbers, 239
Password, 280
Password Required, 277
Performance Analyzer, 213
Print, 248

Print Table Defi nition, 215
Project Properties, 278
Row Height, 50
Save As, 45, 47
Save Export Steps, 82
Set Database Password, 276
Show Table, 163, 175, 206
Summary Options, 225
Theme Settings, 118
Unhide Columns, 50
user-created in databases (see forms)
in Windows XP, navigating, xvii

Dialog Box Launcher, 3, 7, 286
digital signatures, 286
disabling form fi elds, 131
displaying reports, 27. See also reports
divider lines, 232
docking, 286
Documenter dialog box, 214
documenting databases, lvii, 214
Documents folder

as default database location, 41
in Windows XP, xv

Does Not Equal fi lters, liii
downloading templates, 39
drop-down lists

allowing users to add items to (see combo 
boxes)

creating, lv, 195
fi ltering selections in, lvi
hiding columns in, lvi
limiting to preset items, 198
multi-column, creating, lvi, 198
restricting entries to, lvi
selecting options in, 197
values in, cycling through, 200

duplicate queries, 160, 286

E
Edit List Items dialog box, 197
Edit Switchboard Item dialog box, 255
editing

column names, 47
form captions, 112
reports, 227
source of form data, 122
switchboards, 255
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e-mail forms, xlv, 64. See also forms
embedded macros, 30. See also modules

in database applications, 40
enabling, xxxix
export formats available for, 79
settings, changing, xl
storage of, 40
trusted nature of, 40
viewing, 256

embedding datasheets in other tables. See 
subdatasheets

empty strings, 180, 286
Encode As dialog box, 91
Encrypt With Password button, 276
encrypting databases, 275, 286
ending. See closing
entering data

via list (see lookup lists)
in tables, 44

environment, 2
events

basic, 124
defi ned, 286
fi ring, 287
for objects, displaying list of, 124–25

Excel
exporting to, xlvii, 82
importing from, xliv, 57–58
pasting data into, 97

Excel button (Import group), 58
exclusive use, 286
exercises in book, system requirements, xxix
exiting. See closing
expanding

Help topics, xxxvi
subdatasheets, 17

Export dialog box, 81
Export Text wizard, 91
Export To Excel Spreadsheet button, 83
Export To RTF File button, 88
Export To Text File button, 90
Export To Word button, 88
Export XML dialog box, 94
exporting data

defi ned, 286–87
to Excel, 82
to PDF/XPS fi les, 89
reminder for, setting, 86
as RTF (Rich Text Format), 87
saving as Outlook task, 86
saving steps for, 86

to SharePoint, 84
as text, with formatting, 90
as text fi le, delimited, 92
to text fi les, 90
to Word, 87
to XML fi les, 93

exporting forms, xlvii
exporting objects, 79
exporting tables, xlvii, 81

to Excel workbooks, xlvii
to formatted text fi les, xlviii
to HTML fi les, xlviii
to SharePoint sites, xlvii
to XML fi les, xlviii

Expression Builder, 170, 191, 287
Expression Builder dialog box, 166
expressions

arithmetic operators, 152, 285 
comparison operators, 152, 285
creating, 166, 170, 191–92
defi ned, 286
functions, entering, 167
inserting for reports, 245
logical operators, 152
multiplying, 168
re-labeling, 169

Extensible Markup Language (XML) fi les
defi ned, 287
exporting data to, 93
exporting tables to, xlviii
importing from, xlvi, 69
schema, 69, 289
tags in, 68
transforms, applying, 70

F
fi eld properties, liv, 180
fi elds

adding, xlii
adding, by typing in fi rst row, 43
data format, specifying (see masks)
data in, specifying precisely (see validation 

rules)
data types (see data types)
default, in new tables, 43
defi ned, 287
empty strings, 180
form, 131
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formatting of data, specifying (see masks)
moving all to queries, 207
number, rounding in, 186
number, settings for, 184
properties in. See fi eld properties
renaming, xlii
resizing, xlii
selecting, lv, 193
size, changing, 185
size, restricting, 184
table (see columns, table)
tables, linking to, 196
validation rules (see validation rules)

fi le formats, 9, 40
File menu. See Offi ce menu
fi le names, 40
File Open dialog box, 55, 58, 66, 72, 76
fi les, HTML, 71

exporting tables to, xlviii
importing from, xlvi
importing to, 72
parsing, 72
structure tags, viewing, 95

fi les, XML
defi ned, 287
exporting data to, 93
exporting tables to, xlviii
importing from, xlvi, 69
schema, 69
tags in, 68
transforms, applying, 70

Filter By Form button, 155
fi ltering, 143

commands, location of, 149
by date, 151
defi ned, 287
with design grid, 156
drop-down lists, selections in, lvi
by forms, liv, 153
lookup lists, selections in, lvi
on multiple criteria, 148, 156
multiple fi elds, liv, 151
Navigation Pane, 16
results, displaying in forms/reports, 151
vs. sorting or queries, 162
syntax, 155
tables, 148

fi lters
date, 151
Does Not Equal, liii

Navigation Pane, changing, 16
removing, liii, 150
results, displaying in forms, 151
results, displaying in reports, 151
text, liii

fi nding. See also fi ltering
templates, 39
text, 202

fi ne-tuning form control placement, 117
fi ring events, 287
First Record button, 139
fi xed-width text fi les

defi ned, 287
ease of importing, 65

fl at databases, 9, 287
folders

adding to trusted locations, 12
default, for saving database fi les, 41

fonts
in forms , 109
in reports, 237

Form button, 129
form control captions

adding, li
defi ned, 112
editing, l

form control labels, 24
changing, l
deleting, l
inserting, 121
selecting, l
sizing, l

form control menu, 4
form control properties

defi ned, 108, 152, 285
displaying, 109
editing, xlix
setting, l, 244

form control source, 108, 285
form controls. See also label controls; text box 

controls
aligning, l, 113
background properties, l
background style, 111
color, 111
combo boxes (see combo boxes)
defi ned, 23, 103, 285, 287
deleting, 113
deselecting, 112
font, 109
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form controls (continued)
formatting, xlix, lii
formatting of, copying, 122
graphics, adding, li
layout, changing, l
Logo, 120
margins, 114
modifying simultaneously, 233
moving, xlix, li
positioning precisely, 117
Property sheet, opening, 121
record selector, deleting, lii
scroll bars, deleting, lii
selecting, 110
selecting all, 111
selecting multiple, 111
shadow effect, 112
Size Mode property, 121
sizing, li
sizing to fi t, 113, 121
space between, inserting, l
standard, 23
theme, 118
types of, 119
unbound, 122, 290
unbound, inserting, 244
undeleting, 243
wizards, adding without, 122

form properties
displaying, 109
editing multiple, xlix
inheritance of, 108

Form view, 24, 108
Form View button, 34
Format Painter button, 122
formatting

copying, 122
databases, xxxix

forms. See also AutoForms
AutoFormats, 117
AutoFormats, creating, li
AutoFormats, creating from existing 

forms, 118
binding of, 108
captions, editing, 112
columns, sizing to fi t, 138
control properties, xlix
control source, 108, 285
controls (see form controls)
creating, xlix, lii, 105–106, 129

creation of, 104
customizing, 131
data source, editing, 122
defi ned, 103, 287
design, saving, l
Design view, xli, 108
Detail area, expanding, l
displaying, 123
displaying by default, 263
elements, resizing, 115
in e-mail messages, xlv, 64
export formats available for, 79
exporting to RTF documents, xlviii
exporting to Word, 87
fi elds in, 108
fi elds in, hiding, 131
fi lter results, displaying in, 151
fi ltering by, 153
fonts in, 109
Form view, 108
label controls, 24
labels, xlix
layouts, deleting, 112
layouts, pointer shape and, 114
logos, inserting, 120
navigating, xli
for navigation only (see switchboards)
nested (see subforms)
overview of, 23
pictures, resizing to avoid cropping, 121
pointer shape and, 114
Property sheet, undocking, 110
record selectors, hiding, 124
record source, 108
vs. reports, 220
scroll bars, hiding, 131
sections in, resizing, 119
sections of, 115
Stacked layout, 108
styles for, 117–18
subforms (see subforms)
switchboards (see switchboards)
views for, 24, 108 (see also Datasheet view; 

Design view; Form view)
wizards, creating with, 132

formulas
comparison operators, 152
creating, 166, 170, 191–92
defi ned, 286
functions, entering, 167
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logical operators in, 152
multiplying, 168
re-labeling, 169

freezing columns, xliii, 51
functions, 152

aggregate, 174, 285
automated (see macros)
Avg, 175
built-in, 167
calculation, entering, 167
Count, 174, 175
defi ned, 287
expressions, entering, 167
formulas, entering, 167
Max, 174
Min, 174
StDey, 174
Sum, 176, 176, 245
Var, 174

G
galleries

AutoFormat, 117
Color, 111

Get External Data wizard, 55, 66, 69, 72
Getting Started With Microsoft Offi ce Access 

task pane, 11
glossary terms, formatting of, xxiv
graphics on form controls, li
gray buttons, 6
Group & Sort button, 231–32
grouping

report data, lix
report information, 224, 232

Grouping Intervals dialog box, 224
grouping levels, 287
groups, 287

H
hard disk requirements for Offi ce 2007, xxviii
headers and footers, 235
height, table row, 49
Help

categories, displaying, xxxv
for dialog boxes, accessing, xxxiv

displaying, xxxiii, 14
on the Internet, xxxvii
ScreenTips and, xxxiii, 289
searching, xxxvi
Table Of Contents, xxxv
topics, displaying, xxxiv
topics, expanding, xxxvi
topics, printing, xxxvi

help
with book/companion CD, xxxiii
with Word (see Help)

hiding
columns, xliii
custom groups, 261
form fi elds, 131
Navigation Pane, 14
record selectors in forms, 124, 131
Ribbon, xxxix
scroll bars in forms, 131
subdatasheets, 17
table columns, 50

Home tab, 5
horizontal lines, lix, 232
HTML fi les, 71

defi ned, 287
exporting tables to, xlviii
importing from, xlvi
importing to, 72
parsing, 72
structure tags, viewing, 95

HTML Output Options dialog box, 96
HTML tags, 71, 287, 290

I
Icon Browser dialog box, 263
ID fi eld, 43
Image button, 120
Import Exchange/Outlook wizard, 74–75
Import HTML wizard, 72
Import Objects dialog box, 56
Import Specifi cation dialog box, 67
Import Spreadsheet wizard, 58
Import Text wizard, 66
Import XML dialog box, 70
Important paragraphs, xxiv
ImportError tables, 59
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importing, 53–54. See also linking to data
address books, from Outlook, 74
from comma-delimited text fi les, xlv
contacts, from Outlook, 75
databases, 55
dBASE fi les, 76
from dBASE fi les, xlvi
errors when, 59
Excel worksheets, 57–58

importing (continued)
from Excel worksheets, xliv
HTML fi les, 72
from HTML fi les, xlvi
non-Access databases, 76
Outlook folders, 74
from Outlook folders, xlvi
queries, 54
query results , 55
saving steps for, 56, 75
SharePoint lists, xliv, 60–62
skipping fi elds when, 75
tables, xliii, 54–55
text fi les, 65–66
XML fi les, 70
from XML fi les, xlvi, 69

inactive buttons, 6
input masks. See also InputMask property

characters in, 186
creating, 188
defi ned, 288
optional vs. required characters in, 189
for phone numbers, creating, 188
placeholder text in, 190
restricting entry length with, 191
working with, 190

Input Mask wizard, lv, 188
InputMask property, 186. See also input masks
Insert Page Number button, 239
inserting

combo box controls, 122
label controls, 121

installing practice fi les, xxix
interface elements in exercises, formatting 

of, xxiv
intranet, 287

K
key combinations, 264

L
Label button, 121, 238
label controls, 24, 103, 121
labeling expressions, 169
labels, form. See controls, form
LAN (local area network), 287
Landscape button, 32
landscape orientation, switching to, 32
layout, saving changes to, 42
Layout view

defi ned, 248
viewing reports in, lxi

Like operator, 152
Line button, 232
lines in reports, lix, 232
linking to data. See also importing

defi ned, 60, 287
with universal naming convention (UNC) 

paths, 60
lists, lookup

allowing users to add items to (see combo 
boxes)

creating, lv, 195
fi ltering selections in, lvi
hiding columns in, lvi
limiting to preset items, 198
multi-column, creating, lvi, 198
restricting entries to, lvi
selecting options in, 197
values in, cycling through, 200

lists, SharePoint, xliv, 60, 62
local area network (LAN), 287
locking

databases, 277
table columns, 51

logical operators, 152
And, 152
Like, 152
Not, 152
Or, 152

Logo control, 120
lookup lists

allowing users to add items to (see combo 
boxes)

creating, lv, 195
fi ltering selections in, lvi
hiding columns in, lvi
limiting to preset items, 198
multi-column, creating, lvi, 198
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restricting entries to, lvi
selecting options in, 197
values in, cycling through, 200

Lookup wizard
adding, 198
defi ned, 287
starting, 195

M
macros, 30. See also modules

in database applications, 40
defi ned, 287
embedded (see embedded macros)
enabling, xxxix
export formats available for, 79
settings, changing, xl
storage of, 40
Switchboard.closeSB, 256
Trust Center settings, changing, xl
trusted nature of, 40
viewing, 256

mailing label reports, 28
main form, 287
main reports, 233, 288
Make ACCDE button, 282
make-table queries, 161, 288. See also action 

queries; append queries; crosstab queries; 
delete queries; queries; select queries; 
update queries

many-to-many relationships, 288
mapped network drives, 288
margins

in form controls, 114
in reports, changing, 232

masks. See also InputMask property
characters in, 186
creating, 188
defi ned, 288
optional vs. required characters in, 189
for phone numbers, creating, 188
placeholder text in, 190
restricting entry length with, 191
working with, 190

Max function, 174
MDE (Microsoft Database Executable) 

fi les. See ACCDE (Access Database 
Executable) fi les

memory requirement for Offi ce 2007, xxviii
menus, preventing changes to, 264
Microsoft Access

closing, 14
Help button, xxxiii–xxxiv
integration with other Offi ce programs, 10
objects. See Access objects
portability of skills, 9
size restrictions, viewing, 14
specifi cations, viewing, 14
starting, 13
starting, on Windows XP, xvi
versions of, outdated, updating databases 

from, 57
Microsoft Access objects. See also specifi c 

object types
defi ned, 124, 288
displaying all instances of, 14
events recognized by, 124
export formats available for, viewing, 80
exporting, 79
importing (see importing)
shortcuts, creating with custom groups (see 

custom groups)
uses for, 9
views (see views)

Microsoft Excel
exporting to, xlvii, 82
importing from, xliv, 57–58
pasting data into, 97

Microsoft Knowledge Base, xxxvii
Microsoft Offi ce Access Help button, 

xxxiii–xxxiv
Microsoft Offi ce Button, 2, 5, 11, 32, 57, 288
Microsoft Offi ce Diagnostics utility, 211
Microsoft Offi ce Online, 11
Microsoft Offi ce SharePoint Server

exporting data to, 84
import details, saving as a specifi cation, 61
lists, importing, xliv, 60, 62
sites, exporting to, xlvii
valid site addresses, 61

Microsoft Outlook
contacts, importing, 75
folders, importing from, xlvi, 74
tasks, saving export operations as, 86

Microsoft Press Knowledge Base, xxxiii
Microsoft Product Support Services, xxxvii
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Microsoft Visual Basic for Applications 
(VBA), 30. See also modules

comments in code, 128
password protecting code, lxiv
removing passwords from, lxv
returning to Access from, 128

Microsoft Windows XP
dialog boxes in, navigating, xvii
Documents folder in, xv
practice fi les, location of, xv
starting Access on, xvi

Microsoft Word
exporting data to, 87
pasting data into, 97

migrating databases from previous versions, 
xliv, 57

Min function, 174
Minimize button, 3
minimizing Navigation Pane, 14
modules, 30. See also macros

defi ned, 288
export formats available for, 79

monitor requirement for Offi ce 2007, xxviii
More button, 72, 93
More Forms button, 132
Move All button, 132, 171
Move Up button, 270
multiplication operator, 168
Multiply button, 168
My Documents folder. See Documents folder

N
name bar

buttons on, 3
defi ned, 290

named ranges, 288
naming

databases, 40
expressions, 169
reports, 226
switchboards, 254
table columns, 44
table columns, with spaces, 45

navigating
datasheets, xli
forms, xli
in Print Preview, 248
subforms, 139

Table Of Contents in Help window, xxxv
tables, xl, 18, 43

Navigation Options dialog box, 260
Navigation Pane

fi lter, changing, 16
groups, collapsing/expanding, 16
hiding, 14
minimizing, 14
moving, 14
view, changing, 16

nested forms
adding, lii
creating, lii, 134
defi ned, 289
exporting to Excel, 82
navigating, 139
related fi elds in, 135
selecting, 137

New Query dialog box, 170
New Record button, 128
New Style Name dialog box, 118
Next Record button, 18, 139
Not operator, 152
null fi elds, 180
Number data type, 181
number fi elds

bytes, specifying as entry, 185
data types, changing, 185 (see also data types)
Field Size property, setting, lv
rounding in, 186
settings for, 184

numbered steps, formatting conventions used 
in, xxiv

numbers, sorting, 145

O
objects. See also specifi c object types

defi ned, 124, 288
displaying all instances of, 14
events recognized by, 124
export formats available for, viewing, 80
exporting, 79
importing (see importing)
shortcuts, creating with custom groups (see 

custom groups)
uses for, 9
views (see views)

Offi ce 2007, xxviii
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Offi ce menu, 2, 5
Offi ce Online Web site, xxxv
On Click property, 258
one-to-many relationships, 288
one-to-one relationships, 288
OnTheCD icon, xxiv
OPEN paragraphs, xxiv
opening

Access, 13
databases, xl, xlii, 13
databases, exclusively, 275–76
databases, multiple, 82
forms, in Design view, 108
Help, 14
switchboards, 257
tables, xxxix
tables, in Datasheet view, 15, 48
tables, in Design view, 15
templates, xli

operating system required for Offi ce 2007, xxix
operators. See also expressions

arithmetic, 152, 285
comparison, 152, 285
logical, 152

option buttons, 288
Or operator, 152
orientation, changing, xli, 32
Outlook

contacts, importing, 75
folders, importing from, xlvi, 74
tasks, saving export operations as, 86

overlapping windows, 4

P
page numbers in reports, lx. See also reports
Page Numbers dialog box, 239
page orientation, xli, 32
painting formatting, 122
parameter queries, 160, 288
parsing

defi ned, 288
HTML fi les, 72

Password dialog box, 280
Password Required dialog box, 277
passwords, 274

assigning, lxiii, 276
defi ned, 288

encoding and, 275
for VBA code, lxiv
for VBA code, removing, lxv
for VBA code, testing, lxv
recovering, ease of, 275
removing, lxiv, 277, 280
secure, creating, 274
testing, lxiv
when to use, 275

Paste button, 99–100
Paste Errors table, 98
pasting data from other programs, 97
PDFs, 89
Performance Analyzer dialog box, 213
Performance Analyzer utility, 211
permissions, 288
phone numbers, input masks for, 188
pictures in forms, 121
plain text fi les

comma-delimited, importing from, xlv
delimited, 65
delimited, exporting as, 92
exporting as, 90
exporting as, with formatting, 90
fi le extensions for, 66
fi xed-width, 65
formatted, exporting tables to, xlviii
importing, 66
importing, enclosing fi elds in quotation 

marks, 65
populating databases, 37, 288
Portable Document Format (PDF) fi les, 89
practice fi les, xxv

installing, xxix
in Windows XP, location of, xv

previewing. See also Print Preview
reports, xli, lviii, lxi, 227
subreports, 246
tables, xli

primary keys, 45
Print button, 33
Print dialog box, 248
Print Preview, 247. See also previewing

adjusting magnifi cation in, 28
closing, xli, 33, 248
displaying datasheets in, 32
displaying reports in, 27
navigating in, 248
zooming in, 28, 248
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Print Table Defi nition dialog box, 215
printing, 31

changing page orientation when, 32
Help topics, xxxvi
reports, lxi, 248

processor requirement for Offi ce 2007, xxviii
program interface elements in exercises, 

formatting of, xxiv
Project Properties dialog box, 278
properties, 288

Field Size, setting, lv
InputMask, 186
On Click, 258
Size Mode, 121

properties, fi eld, liv
Allow Zero Length, 180
Required, 180

properties, form, 121
displaying, 109
editing multiple, xlix
inheritance of, 108

Property Update Options button, 190
protecting databases. See passwords; security
publisher, 288

Q
queries, 160. See also action queries; append 

queries; crosstab queries; delete queries; 
make-table queries; select queries; update 
queries

aggregate functions, 174
append, 161, 285
calculating with, 174
creating, liv, 163, 203
creating, with Query wizard, 170
crosstab, 160, 285
defi ned, 288
design grid (see design grid)
displaying, 20
displaying in Design view, 22
duplicate, 160
export formats available for, 79
fi elds, adding, liv, 164
fi elds, copying all to, 165
vs. fi ltering or sorting, 162
importing, 54

make-table, 161, 288
parameter, 160
properties, displaying, 21
properties, viewing, xli
results, hiding fi elds in, 173
running, xli, liv, 165, 176, 204
saving, 20, 169
table fi elds, moving all to, 207
tables, adding to, liv, 163, 164
type, displaying, 21
unmatched, 160

queries, action
converting select queries to, 204
creating, lvii, 204
defi ned, 179, 285
types of, 161

queries, delete, 161
converting select queries into, 208
creating, lvii, 206
defi ned, 286
preventing accidental use of, 210
relationships and, 209
testing, 208

queries, select, 160
converting into delete queries, 208
converting into action queries, 204
defi ned, 289
running, 205
View button in, 205

queries, update, 161, 202
creating, lvi, 203
defi ned, 290
View button in, 205

Query Design button, 163, 175, 206
query results, importing, 55
Query wizard, 170–71
Query Wizard button, 203
Quick Access Toolbar, 2, 267

commands, 2
commands, adding, lxii, 268
commands, deleting, lxiii, 271
commands, repositioning, lxiii, 270
customizing, 268
defi ned, 289
Ribbon commands, adding to, lxiii

Quick Launch bar. See Quick Access Toolbar
Quick Reference, how to use, xxiii
quitting. See closing
quotation marks, importing text fi les with, 65
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R
RAM requirement for Offi ce 2007, xxviii
record selectors

defi ned, 289
hiding, 124, 131

record source, 289
records

adjacent, working with, 47
copying, 98
defi ned, 289
deleting, precautions for, 206
deleting, with delete queries (see delete 

queries)
fi rst, bug when adding, 43
ID values incrementing in fi rst record, 43
primary keys, 45
sorting, from smallest to largest, liii
sorting, from within a form, 147
sorting, in alphabetical order, liii, 146
sorting, in descending order, 146
sorting, on multiple fi elds, 147
unique identifi ers, 45
unsaved, 43

records, table, 10
default height, setting to, 50
deleting, xlii, 47
height, setting to standard, 50
increasing height, 49
navigating, 18
plus signs next to (see subdatasheets)
resizing all, xliii
setting to standard height, xliii

regional settings, 183
relational databases, 9. See also databases

defi ned, 289
design of, 53

relationships, 133
defi ned, 289
delete queries and, 209

Remove Database Password And Encryption 
button, 277

renaming table columns, 44
reorganizing tables, 48
replacing text, 202
Report Design button, 234
Report View, 27
Report wizard, lviii

starting, 222
vs. self-created reports, 221

Report Wizard button, 222
reports, 219

aligning text in, lix
blank, starting, 234
centering text in, 238
columns, aligning, lix
controls, modifying multiple simultaneously, 

233
controls, moving as group, lix
creating, lviii
creating, from scratch, 233
currency, formatting text as, 245
date and time, inserting, lviii, 230, 237
defi ned, 289
Design view grid, changing, lx
displaying, 27
editing, 227
elements, moving, 229
elements, sizing to fi t, 237
export formats available for, 79
expressions, inserting, 245
fi elds, adding, 222
fi lter results, displaying in, 151
font properties, setting, 237
formatting, 229
vs. forms, 220
gridlines, displaying, 235
grouping and sorting data in, lix
grouping information in, 221, 224, 232
groups, adding, 235
headers and footers, 235
horizontal lines, inserting, lix
layout, selecting, 226
in Layout View, lxi
lines, inserting, 232
in mailing label format, creating, 28
main, 233, 288
margins, changing, 232
naming, 226
overview of, 27
page numbers, inserting, lx
previewing, xli, lviii, lxi, 227
printing, lxi, 248
rulers, toggling on and off, 229
saving, lx
sections, changing height of, lviii, lx
selecting, 230
sorting, 225
subreports (see subreports)
tables in, multiple, 223
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reports (continued)
templates for, 233, 288
text boxes in, lix
text in, aligning, 230
titles, inserting, lx, 237
unbound controls, inserting, 122, 244, 290
views for, 27
width, changing, lix
zooming in, 228

Request A Delivery Receipt command, 270
Required fi eld property, 180
resizing

columns, 197
form sections, 119
rows, to standard height, 50
table columns, 17, 48
table rows, 49

Restore Down/Maximize button, 3
restoring table columns after hiding, 50
restricting data. See masks; validation rules
results, 289
Ribbon, 3

commands, adding to Quick Access 
Toolbar, lxiii

Create tab, 7
Database Tools tab, 8
defi ned, 289
displaying, xxxix
External Data tab, 8
groups, 6
hiding, xxxix, 7
Home tab, 5

Rich Text Format (RTF) documents
exporting data as, 87
exporting forms to, xlviii

right-aligning form controls, 113
rounding in number fi elds, 186
routine actions, automating. See macros
Row Height dialog box, 50
rows, table, 10

default height, setting to, 50
deleting, xlii, 47
height, setting to standard, 50
increasing height, 49
navigating, 18
plus signs next to (see subdatasheets)
resizing all, xliii
setting to standard height, xliii

RTF (Rich Text Format) documents
exporting data as, 87
exporting forms to, xlviii

rulers, toggling on and off, 229
rules, 191

creating, lv, 192
defi ned, 290
Expression Builder, creating with, 170, 191, 287
testing, lv, 193
text for, entering, 192

Run button, 22, 165, 174, 176, 204–05, 209
running heads, how to use, xxiii
running queries, xli, liv, 22, 165, 176, 204–05

S
Save As dialog box, 45, 47
Save button, 48, 182, 236
Save Export Steps dialog box, 82
saving

blank databases, automatically, 42
database fi les, 41
databases, 42
export operation steps, 86
form design, l
import steps, 56, 75
older databases, as current version, 57
queries, 20, 169
reports, lx
tables, xlii, xliii

schemas, XML, 289. See also XML fi les
screen elements. See Ribbon
screen resolution requirement for Offi ce 2007, 

xxviii
ScreenTips, xxxiii, 289
scripts, transform

applying to XML fi les, 70
defi ned, 290

scroll bars in forms, hiding, 131
searching

Help, xxxvi
with wildcard characters, 148

secure passwords. See also passwords
creating, 274
defi ned, 289
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security. See also passwords
defi ned, 286
designing, 273
warnings, 12

See Also paragraphs, xxiv
select queries, 160. See also action queries; 

append queries; crosstab queries; delete 
queries; make-table queries; queries; 
update queries

converting into action queries, 204
converting into delete queries, 208
defi ned, 289
running, 205
View button in, 205

selecting
columns, adjacent, 50
fi elds, lv, 193
form control labels, l
form controls, 110–11
records, adjacent, 47
records, criteria for, 152
reports, 230
subforms, 137

Selection button, 149
selectors, 289
Set Database Password dialog box, 276
SharePoint

exporting data to, 84
import details, saving as a specifi cation, 61
lists, importing, xliv, 60, 62
sites, exporting to, xlvii
valid site addresses, 61

SharePoint List button, 62, 85
shortcuts to custom categories, adding, lxii
Show Table button, 164
Show Table dialog box, 163, 175, 206
Show Table Of Contents button, xxxv
Shutter Bar Open/Close button, 14
shutting down. See closing
signing, 289
Size Mode property of form controls, 121
sizing

form control labels, l
form controls, to fi t, 121
form controls, to fi t contents, 113
form elements, 115

sorting, 143, 145
columns, 147
defi ned, 289

vs. fi ltering or queries, 162
numbers, 145
reports, lix, 225
tables, 144
text, 145

sorting records
in alphabetical order, liii, 146
in descending order, 146
on multiple fi elds, 147
from smallest to largest, liii
from within a form, 147

spreadsheets, Excel
exporting to, xlvii, 82
importing from, xliv, 57–58
pasting data into, 97

starting
Access, 13
Access, on Windows XP, xvi
Report wizard, 222
Visual Basic Editor, 278

startup options
bypassing, 266
confi guring, 263
customizing, 262
database title, customizing, 263
defi ned, 289
preventing users from bypassing, 266

StDev function, 174
Step by Step series conventions, xxiii
strong passwords. See also passwords

creating, 274
defi ned, 289

structuring databases with templates, 38. See 
also templates

styles for forms, 117–18
subdatasheets, 15

collapsing, 17
defi ned, 289
expanding, 17
exporting to Excel, 82
hiding, 17
records in, hiding, xl
records in, viewing, xl

Subform/Subreport button, 134, 241
subforms

adding, lii
creating, lii, 134
defi ned, 289
exporting to Excel, 82
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subforms (continued)
navigating, 139
related fi elds in, 135
selecting, 137

SubReport wizard, 241
subreports, 239

borders, making transparent, 246
creating, 241
defi ned, 289
dragging to insert, 240
inserting, lx
previewing, 246
selecting, 241

Sum function, 174, 176, 245
summarizing information. See reports
Summary Options button, 225
Summary Options dialog box, 225
Switchboard Manager button, 253
Switchboard.closeSB macro, 256
switchboards, 104

buttons, creating, lxii, 255
buttons, On Click property for, 258
code behind, 253
commands, adding to, 255
creating, lxi, 252
creating, with Switchboard Manager, 253
defi ned, 289
editing, 255
naming, 254
opening, 257
pages, adding, lxi

switching views, xli, 15, 19
syntax, 155, 290
system requirements for Offi ce 2007, xxviii

T
tabbed documents, 4, 290
table columns

adding, 48
data types, changing, 46
defi ned, 10
freezing in place, xliii, 51
hiding, xliii, 50
locking into position, 51
moving, liii
names, editing, 47
names, spaces in, 45

as primary keys, 45
renaming, 44
resizing, xliii, 17, 48, 197
restoring after hiding, 50
selecting adjacent, 50
setting width to widest entry, 17
size, setting, 46
sorting together, 147
unhiding, 50
unique identifi ers, 45

table of contents, how to use, xxiii
Table Of Contents in Help window, xxxv
table rows, 10

default height, setting to, 50
deleting, xlii, 47
height, setting to standard, 50
increasing height, 49
navigating, 18
plus signs next to (see subdatasheets)
resizing all, xliii
setting to standard height, xliii

tables
arrow icons next to, 60
closing, xlii
columns in (see columns, table)
copying, 202
copying information between other Offi ce 

programs, xlix
as core database objects, 14
creating, manually, 41–42
creating, with queries, 161, 288
creating, with templates, xlii, 46
default names of, 42
defi ned, 290
display options (see views)
displaying information from (see reports)
embedding datasheets from other tables in (see 

subdatasheets)
Excel icons next to, 60
export formats available for, 79
exporting, xlvii, 81
exporting to Excel workbooks, xlvii
exporting to formatted text fi les, xlviii
exporting to HTML fi les, xlviii
exporting to SharePoint sites, xlvii
exporting to XML fi les, xlviii
fi elds, linking to, 196
fi elds in (see columns, table)
fi ltering, 148
importing, xliii, 54
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importing selected fi elds, 55
navigating, xl, 18, 43
Navigation bar, 18
number of records in, viewing, 18
as object types, 9
opening, xxxix
opening, in Datasheet view, 15, 48
opening, in Design view, 15
orientation when printing, changing, xli
previewing, xli
records in. See rows, table
reorganizing, 48
reports on. See reports
rows in (see rows, table)
saving, xlii, xliii
saving with new name, 45
sorting, 144
templates for (see templates)
validation rules (see validation rules)
viewing information from multiple (see 

subdatasheets)
views (see views)

tabs, 3, 267. See also Ribbon
Create, 7
Database Tools, 8
in database window, 4
defi ned, 290
External Data, 8
Home, 5

tags, HTML, 71, 287, 290. See also HTML fi les
templates, 37–38

benefi ts of, 38
creating databases from, 40
creating tables from, xlii, 46
default save location, 39
defi ned, 290
downloading, 39
fi nding, 39
opening, xli
viewing descriptions of, 39

testing, 281
delete queries, 208
validation rules, 193

text
in reports, aligning, lix
sorting, 145

Text Box button, 244
text box controls, 24, 103, 290
text boxes in reports, lix
text fi elds, lv

Text File button, 66
text fi les

comma-delimited, importing from, xlv
delimited, 65
delimited, exporting as, 92
exporting as, 90
exporting as, with formatting, 90
fi le extensions for, 66
fi xed-width, 65
formatted, exporting tables to, xlviii
importing, 66
importing, enclosing fi elds in quotation 

marks, 65
Theme Settings dialog box, 118
themes for form controls, 118
thumb tabs in book, how to use, xxiii
Tip paragraphs, xxiv
title bar

buttons on, 3
defi ned, 290

Title button, 237
titles in reports, 237
To Fit button, 113, 121
Toggle Filter button, 149, 150, 153, 155, 

158, 202
toolbars

preventing changes to, 264
primary (see Ribbon)
Quick Access (see Quick Access Toolbar)

Totals button, 175
transaction records, 290
transferring data into a database. See importing
transforms

applying to XML fi les, 70
defi ned, 290

triangles on buttons, 3
Trust Center macro settings, changing, xl
Trusted Locations list, adding to, xxxix, 12
Trusted Publishers list, adding to, xxxix
2007 Microsoft Offi ce system, xxviii

U
unbound controls

defi ned, 122, 290
inserting, 244

UNC (universal naming convention) paths
defi ned, 290
linking to data with, 60
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undocking, 290
Unhide Columns dialog box, 50
unhiding table columns, 50
universal naming convention (UNC) paths

defi ned, 290
linking to data with, 60

unmatched queries, 160, 290
Unsaved Record icon, 43
Update button, 205
update queries, 161, 202. See also action 

queries; append queries; crosstab queries; 
delete queries; make-table queries; queries; 
select queries

creating, lvi, 203
defi ned, 290
View button in, 205

updating databases from previous versions, 57
Use Access Special keys check box, 264
Use Control Wizards button, 122
USE paragraphs, xxiv
user environment, 2
user input in exercises, formatting of, xxiv

V
validation rules

creating, lv, 192
defi ned, 290
Expression Builder, creating with, 170, 191, 287
testing, lv, 193
text for, entering, 192

Var function, 174
VBA (Microsoft Visual Basic for Applications), 

30. See also modules
comments in code, 128
password protecting code, lxiv
removing passwords from, lxv
returning to Access from, 128

VBA Project Explorer pane, 127
versions of Access, outdated, updating 

databases from, 57
View button, 15, 47, 123, 137, 247, 205
View toolbar, 44
views, 15. See also Datasheet view; Design view

changing, 15
current, displaying, 247
defi ned, 290

displaying list of, 247
Layout View, 248
Overlapping Windows, 4
selecting, 31
switching, xli, 15, 19, 44
Tabbed Documents, 4

Visual Basic Editor
passwords, removing, 280
starting, 278

W
Web (HTML) fi les, 71

defi ned, 287
exporting tables to, xlviii
importing from, xlvi
importing to, 72
parsing, 72
structure tags, viewing, 95

width, column, 17
wildcard characters, 148, 290
window elements. See Ribbon
Windows XP

dialog boxes in, navigating, xvii
Documents folder in, xv
practice fi les, location of, xv
starting Access on, xvi

wizards
adding controls without, 122
Analyze Table, 211
Collect Data Through E-mail Messages, 64
creating forms with, 132
Export Text, 91
Get External Data, 55, 66, 69, 72
Import Exchange/Outlook, 74–75
Import HTML, 72
Import Spreadsheet, 58
Import Text, 66
Input Mask, lv, 188
Lookup, 195, 198, 287
Query, 170–71
Report, lviii, 221-22
SubReport, 241
turning off, for form controls, 122

Word
exporting data to, 87
pasting data into, 97
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workgroups, 290
worksheets, Excel

defi ned, 290
exporting to, xlvii, 82
importing from, xliv, 57–58
pasting data into, 97

X
XML File button, 69
XML fi les

defi ned, 287
exporting data to, 93
exporting tables to, xlviii
importing from, xlvi, 69
schema, 69
tags in, 68
transforms, applying, 70

XML Paper Specifi cation fi les, 89
XML schemes, 289
XP

dialog boxes in, navigating, xvii
practice fi les, location of, xv

XPS (XML Paper Specifi cation) fi les, 89

Y
Yes/No data type

defi ned, 181, 208
formatting display of, 184
toggling between yes and no, 183

Z
ZIP codes, data type for, 46
zooming

in Print Preview, 28, 248
in reports, 228
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